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CHAPTER 1 — INEIGHT CONTRACT
OVERVIEW

Traditionally, there are many offline activities associated with creating and administering contracts.
For example, logs are maintained, spreadsheets are updated, and meeting minutes are filed. As these
tasks are completed, the hope is that a corresponding update is made to keep the back end or financial
system in line with the reality in the field.

InEight Contract provides a consistent and intuitive overlay to not only perform these functions, but
also ensure that the underlying systems (such as your ERP system) are in sync with actions taking place
in the field. As an added benefit, the history and information associated with the activity is available in
real time and in one tool, making the contract management processes more efficient and accurate. It
eliminates the need for multiple side spreadsheets that require double-entry to keep up to date.

1.0.1 ERP INTEGRATION

Contract can integrate with your ERP system to manage payments and other resources. If your
organization does not want to integrate with an ERP system, they can operate with a proxy ERP. Your
system administrator uses an organization setting to indicate whether to integrate with the ERP or use
a proxy ERP.

To enable ERP integration, set the ERP integration toggle in the organization settings (Contract >
Contracts > Contract Configurations) to ERP integration. If you have the Edit contract configuration
permission, you can switch the toggle as needed.

1.0.1.1 CONSIDERATIONS FOR ERP SYSTEM INTEGRATION

When using an ERP system, the system administrator specifies whether to integrate the following ERP
system functions:

» Tax calculation before publishing a contract. When set to Yes, the ERP system calculates
the tax before publishing a contract. When set to No, the ERP system calculates the tax
and sends the result back to Contract when publishing.

» Equipment details when publishing a contract. When set to Yes, the equipment details are
included with the purchase order line item details when sent to the ERP system. When set
to No, no details are sent to the ERP system and are available in Contract only.

See your system administrator about the options used by your organization.
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1.0.1.2 CONSIDERATIONS FOR PROXY ERP

If your organization does not integrate with an ERP system, you are responsible for the following:

» Currency conversion. Currency conversions are typically handled by an ERP system. In a
proxy ERP environment, you can use the conversion table in the project details (Project >
Project details > Details) for reporting only. If you get a notification that the currency is not
maintained in project details, contract your project administrator.

 Invoices and payment forms. The proxy ERP allows only one invoice per payment form.

» Payment progress maintenance. If you have the correct permission, you can edit the
following fields on the Payment Progress tab: Date cashed, Check number, Method, Paid
amount, and Retention released.

The proxy ERP simulates the successful publishing of purchase orders, vendor change orders, goods
receipts, accruals, and payment forms by issuing an auto-response. Validations that are in place for an
ERP system are not performed, and you are responsible for the accuracy of this information.

1.0.2 CONTRACT WORKFLOW

The functionality of Contract is organized into two areas:
» Bid Packages
» Contracts

The diagram below provides the overall workflow for Contract and how it integrates with other
applications, including InEight Change, InEight Progress, InEight Control, and your ERP system.

Contracts

WS Structure

Bid Packages

Contract Setup Add EaiTaiE
Create Bid (Details & Line Supporting Approval
Package r— Items) Documents
: I

Execute
Contract

Contract
Approval

Create PO

col

)
Manage CONTRACT
Milestones

S
|
|
1
1

Add vCO

Contract
Award ’— VCO Approval
ECUTED

EXI

Contract
Closeout

Manage S
‘Schedule Procurement

+x
%8
. Payment Management
L= Estimate

Manage
Payment Convert

Claim Submit
T Create Payment Form N B
Control T Payment Form Approval I ——

Add Payment
Claim

Change Register

Submit Review and Add Create Goods.
Invoice Receive Invoice Supporting e Receipt &

{Vendor) (Contractor) Documents Accrual

Budget/Contract
Adjustments
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The Bid Packages module allows you to itemize out the scopes of work that you intend to put under
contract. Bid Packages are usually created after the estimate is completed and the project is awarded.
Bid Packages also can track milestones leading up to contract execution to ensure you meet product
and service delivery dates, and to help you move the package from concept to under contract.

Bidpackages > 13191 - DS - Concrete Executed

Status
Issued for owner review

oY

Scheduled dates

Scheduled item

= Kickoff date

* Project delivery (Needed by) date
Contract delivery (Lead time) (days)

Contract target exccution date

The diagram below illustrates the workflow followed in the Bid Packages module:

Value

08/15/2018
08/22/2018[
0

08/22/2018

SUPPORTING

OVERVIEW MILESTONES DOCUMENTS

Milestones

Original base value

Total estimate

$29.00

Cancel

Total available float: 7 days @ Remaining float: 7 days

@ Milestone Scheduled Forecasted

Duration (days) Completiond..  Float (days)
Issued for 0 08/15/2018 0 0
Proposal re o 08/15/2018 0 o

Letter of int.. 0 08/15/2018 (; 0 0

&

Create Bid

Package

Duration (days)

Bid Packages

WELGETE
WHES LS

Contract
Award

1.0.4 CONTRACTS

Actual compl... Complete

The Contracts module is where a contract’s lifecycle can be managed from creation to closeout.
Managing Contracts includes:
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Adding contract details and line items

Adding supporting documentation, including the executed contract agreement

Initiating a purchase order for the contract

Adding associated vendor change orders (tied to Change Management)

Allocating payments for invoices received in the field

Following a closeout process for the contract

Contracts > 7300000572 - Environmental T... View Overview -
Actions ¥ HEADER LINE ITEMS >
® Update purchase order s (o)) O] = % Q
Line items
Line ltem Type Material Descripti Product Quantity UoM Unit price Per Net
1] 1D on category amount
=) 0001 Material 000000016... SUBCONTR... MCC - SUBGR... 10.000 Ea $25,000.00 1 $250,000.00

The Contracts module follows the workflow indicated below.

Contracts
Contract Setup Add
(Documents, S Documents Contract Execute
Details & Line Approval Approval Contract
Documents = PP oods v y
Items) Receipts &
Accruals
Add VCO Create Payment Form Contract
Payment Form Approval Closeout 1 4
VCO Approval
Submit invoices
|
uted Iafes Receive payment progress, goods receipts
Contract

Update PO

1.0.5 WHO USES INEIGHT CONTRACT?

The primary users of InEight Contract differ from the typical roles that use the rest of the InEight cloud
platform, namely Contract Managers and Contract Administrators. In other words, the main users of
Contract are employees focused on contract management as their primary role.
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There are, however various touchpoints where other field personnel will use Contract as part of their
daily tasks. For example:

» Field Handlers that oversee specific work packages will perform specific functions in
Contract

» Field workers tasked with getting payment approvals for routing invoices will input that
information in Contract, where it will automatically sync to the back office system

» Project Engineers, Project Managers, and Controllers will access Pay Forms in Contract
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CHAPTER 2 - PROJECT SETUP

To manage contracts and bid packages successfully, the correct Contract settings must be set up
before project initiation. Some settings differ between the organization and project levels.

2.0.1 ORGANIZATION SETTINGS

Prior to initiation, the organization and project settings are significant to successfully manage a project
in Contract. Organization settings are distinct from the project settings since they are defined by the
administrative level of your organization.

2.0.1.1 CONTRACT TEMPLATES

Contract Writer is a customized contract document writer intended to generate a complete contract
for a vendor or subcontractor to eventually agree to, accept, and sign. Contract writer can create
project-specific documents such as contracts, payment forms, and vendor change orders by combining
Microsoft Word or Excel templates defined at the organization and project levels.

Each template is a collection of predefined contract writer tags that autofill the contract document
with the information from your contract.

TEMPLATE TYPES SUBTAB

The Template types subtab shows the templates register and gives you the tools you need to start
building templates.

You can download a sample template that gives you an idea of where to start with your template. You
can also get a list of general tags and collection table tags to be used in the template. After you have
opened the list, you can export the tags to a Microsoft Excel spreadsheet.

DOWNLOAD A SAMPLE TEMPLATE

You can download a sample template in Microsoft Word and Microsoft Excel formats. The samples
show how a contract could look in either format. This feature is available at both the organization and
project levels.

To download a sample template, click the Download sample template icon on the template register,
and then select either Download Word template or Download Excel template.
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= Clearallfilters B Q
Modified date Modified by

CREATE A CONTRACT TEMPLATE

To create a template for your contract documentation, you use predefined contract writer tags to
autofill your contract document with the information from the contract. From the Add contract
template record, select the View available tags icon to open a list of available tags. Select General tags
to see a list of tags that can be used in the body of the template only. Select Collection table tags to
see the list of tags that can be used in collection tables. General tags cannot be used in a collection
table.

The list shows the following information:

e Tag name.

» The location of the source of the data, which is the name of the page that Contract pulls the
information from when building the template.

» A description of the tag.

« Example text that shows what text might look like in your contract. Contract also uses the
example text in the sample template.

» The type of template for which the tags are valid.
* An example of how this information might look in the contract document.

« the type of template for which the tags are valid.

"3 = Tag names do not reflect custom labels that your organization might have set up. You can
refer to the Contract Custom Labels tab in project settings for custom label mappings.

After you have opened the list, you can export the tags to Excel. Refer to the instructions on the
Instructions tab of the Excel file for information about using tags and building a template.
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General tags

Utilize below general tags to build contract templates. Tags in the template would be replaced with the corresponding tag values, while 3
generating contract document Q

Tag name Location sou... Description Example Applicable for
Project detzils The project number 123456
Project details Metro
Project detzils The address of the project 1700 Nort]
Project details The address of the project Unit3
Project details The city of the project Scottzdale
Project details The state of the project Arnizona
Project details The cou Us
Project datails The postal or zip code of the project 85201
==Com, amess Project settings The na d to the project XYZ Company Inc
==Company code>> Project settings The code of the legal entity associated to the project 1032
==Contract number=>= Project details CA 139481029
<<QOriginal project value>=> Project details 10000000
Project details e date of th ject contract 43678
Project details onfract in words 1st of August 2019

MAINTAIN FIELD FORMATTING

Large text box fields, such as the Scope of the contract, Scope of change, Inclusions, Exclusions,
Warranty, Contract terms 1 - 4, and Vendor change order terms 1 - 4 fields, contain formatting tools
that let you use boldface type, numbered or bulleted lists, and other text formats. To preserve this
formatting in Micorosoft Word templates, you can insert a Word merge field instead of a tag for the
field.

To insert a merge field in a Word template, position the cursor, and then go to Insert > Quick parts >
Field. From the Field dialog box, select MergeField, and then enter the tag name without the brackets
in the Field Properties > Field name field (for example, Contract term 1). When a document is
generated, Word applies the formatting for the field.

Refer to the Instructions in the Contract templates tags spreadsheet for more information about merge
tags.

DOCUSIGN TAGS

DocuSign eSignature tags for recipients let you embed signee information to pull into your organization
or project templates. DocuSign tags used in a template are read when sending a document for
signature.

The DocuSign tags serve as placeholders for the eSignatures. Contract's DocuSign tags include tags that
serve as placeholders for text boxes, check boxes, drop-down lists, and radio buttons added by the
document sender in the DocuSign Sender view. These tags are available for eSign 1-10 and for each
project contact. When you add the tags in the template, you ensure the corresponding item is
consistently placed.
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For text and drop-down lists, you only place one tag in the template. For check boxes, you place one
tag for each option. For radio buttons, a single tag places two buttons in the document. You can add
more radio button tags for additional buttons.

When you open a document with these tags in the DocuSign Sender view, the tags are present, but
they do not have values. You can add the values from the Sender view. For example, if the template
has three check box tags, when the document is opened in DocuSign, three empty check boxes are

shown. You then add the value for each check box in DocuSign.

Refer to the instructions on the Instructions tab of the Excel file for more information about DocuSign
tags.

TEMPLATE TYPES

Contract templates are classified by the template type. This classification can help you ensure that the
template suits your business needs based on the purpose of the template. Contract supports the
following template types:

e Contract

» VCO

» Payment claim

e Payment form

e Purchase order

o Other (for supplemental and exhibit information)
The template type indicates which general tags and collection tags are valid for the template. For
example, a payment form template can use the tags that are applicable for payment form templates.

Any template can use the tags for all templates. The template tags are validated when you attach a
template file to the template.

If you have invalid tags, the Template file section of the Details page shows a message that there are
validation errors. You must go into the Word or Excel template and fix the errors. You cannot publish
the template f there are any errors.

TEMPLATE LANGUAGE

You can define the language in which the contract template is generated using the Select template
language field on the template Details page. Selecting a template language lessens the tags available.
For example, if you select Spanish as the template language, you can use only Spanish tags in the
template even if the language of your application is English. Upon generation, template and tags are
generated in Spanish.
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You cannot use tags in multiple languages in a single template. During template validation, the
application only searches the tags of the selected language instead of all languages.

COLLECTION TABLES

You can add multiple items to a contract, payment form, or vendor change order template by using a
collection table. You can create collection tables in Word or Excel that include those items and place it
into the template.

A collection table contains collection tags specific to a template type. General tags cannot be used in a
collection table. The Contract writer searches the information in the Contract application and returns
the values in the table. Collection tags are specific to the template type and table type. For example,
the Vendor Change Order template type has table types for VCO line items, VCO documents, VCO
issues, and others. A collection table can have tags for one table type only, but a template can have
multiple tables.

You can also use conditional table tags to set the language in a contract document collection table tag
based on the value specified in a custom field. Conditional tags let you set up different language and
tag string options that populate the contract document based on the value selected in the Custom list
field in the contract line item. For example, if the conditional field Line item Custom list 1 is set up with
values for line item, lump sum, and cost item, you can set up contract document text for line items,
text for lump sums, and text for cost items. See Conditional tag setup subtab for more information

about setting up conditions and using conditional tags in a collection table.

ADD A COLLECTION TABLE TO A TEMPLATE

1. Export the collection tags list and follow the instructions on the Instructions tab of the
spreadsheet.

2. Open or create a new template in Microsoft Word or Excel. Keep in mind the template type
(contract, vendor change order, or payment form).

Create a table in the document or spreadsheet.
Enter headers, if applicable, and format the table to suit your business needs.

Enter a tag in each column. The tag can be from one table type only.

S

Save your document.
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"o Collection tags do not show up on the Review templates page. If you have a template
that has only collection tags you see the message "No general tags found in this

template" in the review area. You can see collection tags in the preview. If there is an
error, you must fix it in the Word or Excel document. If a field is missing, you must go to
the contract and fix that item.

TIPS FOR USING TEMPLATE TAGS

Template tags are the building blocks of a Change document. The tags pull information from the
corresponding data field in the issue, PCO, or CCO detail to populate the document. Use the following
guidelines when you are adding tags to your template.

Additional instructions can be found in the tags export spreadsheet.

GENERAL TAG INFORMATION
¢ General tags cannot be used in a table.
e Equations are discarded in document generation. No tags in an equation are read.

¢ Some fields in the application have their own formatting that is applied in the template, such as
a bullet list. The general tags associated with those fields use the application's formatting, and
you do not have to enter additional formatting in the template.

COLLECTION TABLE TAGS
¢ Only collection table tags can be used in a collection table.

¢ Tags cannot be read from nested tables, such as a table within a table.

DOCUSIGN TAGS

¢ Change the color of DocuSign tags to white, otherwise the tags show in the document. The white
text matches the background and hides the tag.

¢ When adding a DocuSign tag to an Excel template, the column or row must be large enough for
the entire tag name. when the Excel file is converted to a PDF to send to DocusSign, the system
cannot read the tag if the whole tag name was not visible in Excel.

DOCUSIGN ADVANCED OPTIONS

Contract supports the use of DocuSign Advanced Options. The DocuSign Advanced Options are
configured in DocuSign. These options let you customize the DocuSign experience. Your DocuSign
administrator can set up the following options in DocuSign:
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Branding options let you select a logo and brand colors that were set up by the DocuSign
administrator, for the envelope.

Reminders options let you specify whether DocuSign sends reminders to signees, when to start
sending them, and how often to send them.

Expiration options let you set the number of days until the envelope expires and how often to
send alerts. After the envelope is expired, recipients can no longer view or sign the documents in
the envelope.

Comments options let senders and recipients enter comments on documents in the envelope.

Recipient privilege lets you give recipients options for how they sign the document, such as
signing on paper, assigning delegates, and editing documents.

MICROSOFT WORD DOCUMENTS

Any text formatted in Change on the Details pages are retained in Word documents.

MICROSOFT EXCEL DOCUMENTS

For large text cells where you can format text, the formatting is converted to plain text.
Any text formatted in Change on the Details pages is converted to plain text in Excel.

Only the first sheet in an Excel template is read and tag information inserted. To generate
multiple Excel sheets, create multiple Excel files and merge them into a single PDF.

The Change writer discards text boxes, word art, drawings, equations, and formulas inserted into
an Excel document.

Tags cannot be used in calculations.

The Pricing summary tags are not valid in Excel.

BUILD YOUR TEMPLATE

After the Excel file opens after downloading, you can copy the tags you need into a Word or Excel
version of your contract document, inserting them in the appropriate places within your

contract. Refer to the instructions on the Instructions tab of the Excel file for information about using
tags and building a template. You can insert tags into the body, header, or footer of the Word
template. You can also insert the tags in the body of an Excel template.
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Utiize below general tags to build contract templates. Tags in the template would be replaced with the cerresponding tag values, while

generating contract document

Q
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Tagname Location sou.. Description Example Applicable for
<<Project ID=> Project details The project mamber 123456 All temmplates
<=Project addressl=> Pojectdez file  Home  Insert  Pagelayout  Formulas  Data  Review  View  Help  Team
<Project addressl e Project dete (D PROTECTED VIEW B l—files from the Intemet can Unless you need to edit, it's safer to stay in Protected View. Enable Editing x
Project deta . »
D93 M The value (percentage) of the maximum allowable liquidated damages v
ate>> Project dete
country or regio. Project dets |
78| <<DORS-Title>> Contract hezder ision of respons: Business manager All templates
Project dete 79 | <<DORE-Name>> Contract hezder DOR User corresponding to title lose Riveria All tamplates
80 |<<DORETitle>> Conwact header Divisicn of respansibility Title Project manager All templates
<<Company code name>> Project settiB1 | <<DORT-Namev» Contract header DOR User corresponding to title Michael Johnson All templates
82 |<<DOR7-Title>> Contract header Division of responsibility Title Project engineer All templates
<<Company ¢ Projectseitigz | <DORE-Name>> Contract header DOR User corresponding to title lustin Janes Al templates
84 |<<DORETitle>> Conwact header Division of respans tle President Al templates
eContrat mumber=> Contract hezder DOR User corresponding to title Kris Campbelo All templates
<Origial projet vahue=> Contract hezder Vice presicient All templstes
Contract header DOR User corresponding to title Xu Michel Al templates
<<Project conmact date=> Contract header Division of responsibility Title Regional manager All templates
The default retention field. A perceitage which will be held back from each payment
e i Contract header until the contract is completed of reaches 3 pradetermined state 15.00 All tamplates
] Gencrol Togs (e N <<Engineering submittals cap>>  Contract header The value (percentage) of the maximum allowable |iquidated damages 25000.00 (98.5%) Al templates
t <<Delivery cap=> Contract header The value (percentage) of the maximum allowable liquidated damages 50000 (11.25%) All templates
ompletion caps>  Contract header The value of the maximum allowable liquidated damages 60000 (7.58%) All templates
93 |<«<Performance guarantee caps>  Contract header [The value of the maximum allowable liquidated damages 1 50000 (25.75%) All templates
94 | <<overall cap> Contract header The value (percentage) of the maximum allowable aggregate liuidated damages 75000 (12.58%) All templates
85 | <ccustom tagl>» Contract hezder Free text user defined fields Custom tag1 All templates
96 | <<custom taga>> Contract hezder Free text user defined fizlds Custom t2g10 All templates
97 |<<Custom tagd>» Conwact header Free text user defined fields Custom tag2 All templates
98 |<<Custom tagd»» Contract header Free text user defined fields Custom tag3 All templates
29 |<ccustom tagh>» Contract header Free text user defined fields Custom tagd All templates
100 <¢Custom tagh>> Contract header Free text user defined fields Custom tag5 All templates
101 <<Custom tag7>» Contract header Free text user defined fields Custom tags Al templates
102 <<Custom tag8>» Contract hezder Free text user defined fields Custom tag7 Al templates
103 <<Custom tage>> Contract hezder Free text user defined fizlds Custom tag8 Al templates
104 <<Custom tagl0>> Contract header Free text user defined fields Custom tagd All templates
105 <<agreement 1D Contract header Reference data Agreement 1D A1234 Al templates
106 <cagreement value>> Contract header Reference data Agreement value 300,000.00 Al templates
107|<¢Purchase Order numbers> Contract header Reference data purchase order number 4500000120 All templates =
General Tags ] >
Ready g Display Settings H - 1 + 85%

1. Insert tags into the document as shown in the example.

THIS SUBCONTRACT

Sample with Tags

is dated d:

(Effective Date) and is between

<<Vendor - name>> (Subcontractor), and <<Company code name>> (Contractor).

WHEREAS Contractor has entered into a contract dated <<Prime contract date>> (Prime

Contract)

h the <<Owner>> (Owner), for the <<Project name>>; and Subcontractor offered

to perform a portion of the Prime Contract as described more fully below.

NOW THEREFORE, Contractor and Subcontractor agree as follows:

11

Subcontractor shall furnish all supervision, labor, tools, eq

ARTICLE 1
WORK

ment, materials, supplies, services

and engineering necessary to perform the work described Article 4—Scope of Work (Work).
Subcontractor shall perform its subcontract obligations in accordance with the Subcontract Documents,
all applicable labor agreements, all applicable laws and regulations and good construction practices.

21

ARTICLE 2
CONTRACT SUM

For the Work Subcontractor performs as specified in this Subcontract, Contractor shall pay
Subcontractor the sum of [

] Dollars ($ <<Centract original value-numbers>>) (Contract Sum),

adjusted as necessary by differences between estimated and actual quantities for unit price Work items
(if any) and subject to changes, additions and deductions, as hereinafter provided i the Subcontract

Documents. As general retainage, Contractor may withhold <<Reter

allowed by law.

n>> each progress payment as

Contractor and Subcontractor are signing this Subcontract Agreement s of the Effective Date stated in

the introductory clause.

<<Company code name>>

<<Vendor - name>>

Contractor Subcontractor
By: By:

Name; Name: o
Title: Title:

Jlel 2 When adding tags for DocuSign, change the font color to white, so the tag name

does not show in the generated document.

2. Name the template and save as an MS Word (.docx) document.
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3. Return to the Contract template register, select the Add icon to create a new Contract template.
This opens the Details page.

Overview - Contract template Details

mm

1 Preview Opens a preview of your template using the default sample data.
sample

2 Create Creates a new version of the template. This feature lets you update
new the version of a template instead of inactivating it and then creating a
version new one.

3 Control Lets you cancel the template creation, save and publish, or only save
buttons to access later.

4 Detail Lets you name the template, specify the template type and language,
area and add a description of the template.

5 Setas Lets you specify at the organization level that a payment form or
default purchase order template is the default. The default template is

attached automatically to any payment form workflow. The toggle
switch is active only when the Template type field is set to Payment
Form or Purchase order.

6 Tags Area where you can view and download the general and collection
table tags.
7 Template  Attach the template file which was created with the downloaded tags.
file Tags are validated after the file has been attached.
8 Contract  Assigned contract types that could use this template. When the Set
types as default field value is Yes for a payment form or purchase order, the

template becomes the default template when you download a
payment form or purchase order for the specified contract type.

9 Attributes  Lets you add one or more market attributes that provide additional
ways to filter templates. Organization-level templates default to On for
project use. When a market is added to a template, the templates
default to Offfor projects that do not have a matching market. When a
market is added to the project, Contract turns on any matching
templates that had previously defaulted to Off.
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Setings > Coniracttemplates > PODefault New |

TEMPLATE DETAILS VERSION HISTORY

Preview with sample data

e( Cancel | [ Inactivate template_|

o Details Version 1 - Published  Tags G

“Tempiate name Tempiate type Set a¢ defaut @6
ves -

PODefault New | Purchase order

Select template language

English - EN

*Description s

PO Default New 1 Collection table tags/Contract) doc

e Contract types @ Assign contract types

Selected contract types.

ssType1 X

e Attributes

Market

@ assmaner

TEMPLATE VERSIONS

When you update templates with additional information, you can create a new version of the template
instead of deactivating it. The Create new version button is enabled when you edit a template.

When you create a new version, the version numbering starts after the previous version. The new
template version starts in the draft state. You can edit any of the fields except the template type and
language. You can then attach the new file. Only one draft version can exist for a template at a time.

Only one version of a template can be active at a time. After you publish a new version, the previous
version becomes inactive and is removed from the Templates register.

The Version column of the Templates register lets you see the template version. When you click the
version number, the template version history is shown. The template names are linked to the
Template details page, so you can quickly view the detail information.

Template Version History

Versi..  Status ame Description Created date Created by

’ C v Vendoraddress brea..  05/17/2022

1 essbr..  Vendor address brea. 05/10/2022
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The Version history subtab contains links to previous versions of a template. The version history shows
all versions in descending order, including inactive versions.

Decerption

Versions of organization-level templates are available for use at the project level, but you can only
create a new version of those templates at the organization level.

DEFAULT PAYMENT FORM TEMPLATE

You can use one template as the default payment form template. The default template is attached
automatically to any payment form or workflow. The default template is indicated by a yellow triangle

in the organization template register. You can set the default using the Set as default toggle setting on
the template Details page.

BUILD A CONTRACT TEMPLATE

1. From Organization settings > Contract, select Contract Templates.

2. Select the View available tags icon to view general or collection table tags. This example uses
general tags.

= Clear all filters 3 Q

o/2000  Collection table tags

level

The Contract writer tag document opens.
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Utilize below general tags to build contract templates. Tags in the template would be replaced with the corresponding tag values, while

generating contract document.

Tag name Location sou...

<<Project ID>> Project details
<<Project name>> Project details
<<Project address 1=> Project details
<<Project address2>> Project details
<<Project city>> Project details
<<Project state>> Project details
<<Project country of regio Project details
<<Project postal code>> Project details
<<Company code name>=> Project settings
<=Company code=> Project settings
<<Contract number>> Project details
<<Original project value=> Project details
<<Project contract date>> Project details
<<Project contract date-w. Project details

<<Date project started>> Project details

Description

The project number

The name of the project

The address of the project

The address of the project

The city of the project

The state of the project

The country of the project

The postal or zip code of the project

The name of the legal entity associated to the project

The code of the legal entity associated to the project

The projects contract mumber

The original value of the Project contract

The date of the Project contract

The date of the Project contract in words

The date the Project started

Example
23456

Metro Power Station

1700 Northwest Street

Unit3

Scottsdale

Arizona

Us

85201

XYZ Company Inc

1032

CA 135481025

10000000

43678

15t of August 2019

43738

P Q

Applicable for
All templates
All templates
All templates
All templates
All templates
All templates
All templates
All templates
All templates
All templates
All templates
All templates
All templates
All templates

All templates

Contract User Guide

3. Select the Export tag list icon to export it to your hard drive as an Excel file.

4. Save the exported file.

What do you want to do with Export.xlsx (3.2 KB)?
From: t01in8-ga-191-sea.hds.ineight.com

Open

Cancel

5. Open the Excel file you just saved. The value in the Applicable for column indicates the template
type that can use the tag.

GNEEEOREE

<<Project ID>>
<<Project name>>

<<Project address1>>

<<Project address2>>

<<Project city>>

<<Project state>>

<<Project country or region>>

<<Project postal code>>

<<Company code name>>

<<Company code>>

<<Contract number>>

<<Original project value>>

<<Project contract date>>

<<Project contract date-words>>

<<Date project started>>

<<Prime contract project start date-Words>>
<<Original contract completion date>>
<<Original contract completion date-Words>>

Project details
Project details
Project details
Project details
Project details
Project details
Project details
Project details
Project settings
Project settings
Project details
Project details
Project details
Project details
Project details
Project details
Project details
Contract header

The project number

The name of the project

The address of the project

The address of the project

The city of the project

The state of the project

The country of the project

The postal or zip code of the project

The name of the legal entity associated to the project
The code of the legal entity associated to the project
The projects contract number

The original value of the Project contract

The date of the Project contract

The date of the Project contract in words

The date the Project started

The date of the the Project started in words

The date of the contract completion

The date of the contract completion in words

123456 All templates

Metro Power Station All templates
1700 Northwest Street All templates
Unit 3 All templates

Scottsdale All templates

Arizona Al templates

Us All templates

85201 All templates

XYZ Company Inc All templates
1032 All templates

CA 139481029 All templates
10,000,000.00 All templates
8/1/2019 All templates

1st of August 2019 All templates
9/30/2019 All templates

30th of September 2019 Al templates
3/31/2021 All templates

315t of March 2021 All templates

6. Copy and paste the tags into the Microsoft Word or Microsoft Excel document you are creating

as

your new contract.
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¢ Tags must be inserted exactly as they appear in the Tag name column.

¢ Atemplate can use tags that are applicable to one template type plus the tags that are

applicable to all templates.

If applicable, you can insert one or more collection tables that are applicable to the template

type. Refer to the topic Collection tables for information about building a collection table.

template as [your initials — contract template].

9. Save it as a Word (.docx) or Excel (.xlsx) file.

e Below is an example of a Word document with inserted tags

sample with Tags

THIS SUBCONTRACT AGRE!

EMENT is dated <<Effective date>> (Effective Date) and is between <<Vendor
name>> (subcontractor), and <<

), and

WHEREAS Contractor ha
Contract)
to perform a px

NOW THEREFORE, Contractor and Subcontractor agree as follows:

ARTICLE 1
WORK

ARTICLE 2
CONTRACT SUM

o are signing this Subcontract Agreement as of the Effective Date stated in

<<Vendor name>>
Subcontractor

10. Return to the Contract templates tab and select the Add Contract icon.

11. In the Add a new template dialog box, fill in the fields with the following:

¢ Template name: Use the name you named your template

¢ Description: Test contract template

12. Under Contract types, select the following as your Assign contract types:

¢ Subcontract
¢ Service agreement

e Material contract

InEight Inc. | Release 25.3
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Assign contract types

Select the required contract types

O Contract type

Newcontracttype
New type
MMM Contract

Material contract

O o o o o

Master Service Agreement

13. Under the Template file section, select No template file attached.

Template file

|Hc| template file attached |

14. Find and select the contract template you created in Step 8 of this Step by Step.
15. After it has uploaded, select Add.

Template file

*Template file

Add file here SELECTFILE... =

L& My computer

Cowes ) [
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16. Validation notices for tags and collection tables are shown.

Template file

Article 4 - Scope of Work.docx

Tags Validated «*

Collection tables validated «*

« |f the document was not validated, select the Not validated link to view the errors, fix
the errors in your document, save and publish again.

e =0 The file can be closed but not published with invalid tags.

17. Click Save and Publish.
e Return to the Contract tab under Contracts.

You can edit the template name, description, markets, and set as default field for a published
template. Changes to these fields do not create a new version.

Overview - Contract Template Header

mm

1 Template The name you gave as the contract template.
2 Description The description you used when creating the template.
3 Status The status of the template after created. The status will show Draft,

Published or Saved.

4 Assigned The assignment(s) you made when creating the template.
contract Assignments can be shown as Multiple, None or one type.
types Hovering over the ellipse will show the contract types which were

selected during creation.

A None indicator with the gear will indicate that none were initially
selected. However, when you select the gear icon, it will allow you
to select and then save it as an assigned type.

5 Template The type of contract that can use the template. Valid types are
type Contract, Payment form, Purchase order, VCO, and Other.
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Overview - Contract Template Header (continued)

Definition

6 Template file Name of the file which was uploaded into the contract writer.
7 Created date Date which the contract template was created.
8 Created by Name of person who created the template.
9 Modified date Date which the last modifications were made to the template.
10 Modified by Name of the person who made the last modification to the
template.
11 Template The language of the tags in the template.
language
PS o ©.0--6 © -0 .0 @

Published Multiple ***  Contract 07/28/2020 07/28/2020

Published Multiple = vco 07/28/2020 07/28/2020

O 0O 0O o

TEMPLATE SETTINGS SUBTAB

Template settings let you configure characteristics for each template type at the organization level.
The Template settings subtab (Settings > Contract templates > Template settings) contains controls for
editing, watermark stamps, and PDF output.
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Template configurations

WORKFLOW conTRAGT s CONTRACT CUSTOM
ASSIGNMENTS TEMPLAT]
ate ypes  Template settings  Condltional tag seup [ cancel |

o vt 1303 edit

Allow users to edit the
document during
generation

Require a watermark
stamp upon document
generation

Output as PDF only

End watermark

InEight Inc. | Release 25.3

Espafol ESMX v

1303

Definition

Indicates whether users can edit a contract document of
this type when it is in the review stage. When set to Yes,
a user can edit the contract document from the Review
templates dialog box. When set to No, the contract
document cannot be edited from the dialog box, and the
user has to edit contract information in Contract.

Indicates whether to apply a watermark stamp when a
document of this type is generated. When set to Yes the
watermark is applied to the document, but is removed
after the document has been approved. You can
configure the watermark text and settings in the
Watermark stamp section of this page. When set to No,
the contract document does not have a watermark.

Indicates whether you can only generate a PDF when
you create a contract document of this type. When set
to Yes, you cannot generate a Microsoft Word or Excel
document or make changes to the contract files
individually.

Indicates the contract approval event that must occur
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Definition

requirement event before the watermark stamp is no longer required for
this template type. For example, if you set the End
watermark event field to Contract approval, the
watermark is no longer required after the contract is
approved. You can also indicate that the watermark
stamp is always required regardless of the contract
approval event. The watermark is removed from the
generated document when the document is approved.
This field is enabled only when the Require watermark
stamp upon document generation toggle is set to Yes.

The Watermark stamp section lets you define watermark text and layout for the Select watermark
stamp drop down list in the Contract writer. You can define the text for all languages used in your
templates. The language of the watermark matches the language of the template.

CONDITIONAL TAG SETUP SUBTAB

Conditional tags let you set the text used in a collection table based on the value specified in a custom
list. The conditional tags are based on Line item Custom list 1 and Line item Custom list 2. You can then
configure template text based on each value of the field. For example, if Line item Custom list 1 is set
up with values for line item, lump sum, and cost item, you can set up contract document text for line
items, text for lump sums, and text for cost items. The text that populates the table cell depends on
the value of the Line item Custom list 1 field.

You can configure the conditional tag text on the Conditional tag setup page (Organization settings >
Contract > Contract templates > Conditional tag setup).
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You can set up two conditional fields each for conditional tags for contracts, schedule of values, VCOs,
and payment forms.

SET UP CONDITIONAL TEXT

1. From the Conditional tag setup page, select a conditional tag in the Conditional tags column.

2. Click the Download conditional collection table tags icon to download instructions and lists of
valid tags for each conditional tag.

LABELS

Conditional tags

zzzzzzz

Click the Add conditional tag icon.

4. In the slide-out panel, select one of the field values for the conditional field. If applicable, select
the template language.

5. Inthe Conditional language filed, enter the text or tags for the condition. Refer to the conditional
collection table tags you downloaded in step 2 for a list of available tags. The image below shows
a mix of text and tags, with tags highlighted in yellow.
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Add Schedule of value: Conditional tag 1

*Field value

Unit price hd

Language selection

English - EN hd

Conditional language (EN) (3)

<<Contract: Line item custom list 2=> of <<Contract: Long ~
Description>= for the unit price of $<<Contract: Unit Price>>

<=Contract: UoM==. The estimated quantity of work to be performed

is ==Contract: Quantity>> <<Contract: UoM>=. e

To use conditional tags in a template, follow the instructions for setting up a collection table. In one of
the columns, enter the tag for the custom list such as, <<Contract: Line item custom list 1>>. In another
column enter the conditional tag such as, <<Contract: Line item Conditional tag 1>>. Refer to the
Conditional tag setup spreadsheet for a detailed example.

When you generate a contract document, Contact fills in the text that is specific to the condition of the
custom list.

2.0.1.2 CONFIGURATIONS

Organization-level configurations let you customize Contract for your organization. To see the
configuration settings, go to organization settings, and then select Contract >Configurations.
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» BID PACKAGES CONTRACTS A:;'fs;:fﬁs fg;;f:f: < conricumaTions  °OM mL:c;[:: STOM
= Clearallfiters  Q
\L] Configurations. Last modified by Last modified date
(5\ Bid package risk 10/23/2020
() Bidpackage type 08/14/2023
(%)  Bid package type configuration setup 08/27/2023
) contract status 08/17/2023
Contract type configuration setup 0012/2023
) gustom ls 08/30/2023
ID customization 09/07/2023
Line item type configuration setup 09/12/2023
@
~  Liquidated damage type 02/19/2021
Master agreement type configuration setup 09/01/2023
Payment claims configuration 04/14/2023
Bayment form status 08/15/2023
Taxsettings 08/31/2023
Vendor change order respongible party 02/11/2022
Vendor change order type 08/16/2023
Vendor €O status 08/14/2023

ACCRUAL/RECEIPT SETTINGS

The Accrual/ Receipt settings configuration lets you specify the accrual types for your organization. You
can also specify whether accrual submissions and receipt submissions require supporting documents.

Confgurstions > Eit configuration st Cancel

Accrual/Receipt settings

e cques supporting docur fecept ca docum
(] @
engisn Espaol s
Accrualtyperame AP acorual type Debit genera ledger ~Gredt general ledger e sccrualype name
® Selectone Select ©
s0010-c © ®
s @ ®
AcGType 1 563 501030 - Consumption - Guality Contrl 511425 - Aicrat-Maintenance/Repais © AGE Typed ®

For each accrual type, you must set up the following:

ooty | o

Accrualtype  The name of the accrual type to be used in the Accrual type drop-down field on
name the Accruals/Receipts Line ltems page.

ERP Accrual The name of the accrual type to be used in the ERP system.
type
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“seung | o

Debit general The general ledger account associated with debits.

ledger

Credit The general ledger account associated with credits

general

ledger

Active Indicates whether the accrual type is active in the organization.

BID PACKAGE TYPE CONFIGURATION

The Bid package type configuration setup lets you establish details by bid package type. You can also
indicate whether all milestones must be completed before converting to a contract.

Configuiations 5 Edit configuration list

Bid package type configuration setup
Bid pac ed here

®
0]

o o o o
0]

MILESTONE COMPLETION

When the All required milestones must be completed before converting to a contract toggle is set to
Yes, a bid package must complete all milestones before you can convert it to a contract. When set to
No, you can convert the bid package at any time. This setting applies to all bid package types.

ALLOW WORKFLOW WHEN OVER BUDGET

The Allow workflow when over budget toggle lets you control whether workflow can be initiated for a
bid package type based on budget. When the toggle is set to No and the original base value of the bid
package exceeds the WBS current budget, an error shows when you try to start the approval process.
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You should then check the original base value or reach out to the project controller. When the toggle is
set to Yes and the original base value of the bid package exceeds the WBS current budget, a yellow
warning banner shows at the top of the Budget check tab if there is a loss. You can still start the
workflow if the bid package exceeds the current budget.

INCLUDE BID PACKAGES IN PRIMARY REPORTING SECTION

The Include bid packages in primary reporting section toggle lets you control the default for the Include
this bid package in primary reporting section field (Bid package details > Additional Details >
Reporting). The field value can be changed in the Bid package details.

Show Primary Reporting Bid Packages Only is a parameter in some reports, such as Buyout Review.
When this parameter is selected, only bid packages with the Include this bid package in primary
reporting toggle in the bid package details set to Yes are shown in the report.

DEFINE CONTRACT TYPES

You can specify which contract types a bid package type is associated to. Click Assign contract types to
see a list of available contract types. Select the required contract types, and then click Add. You can
also click the X by the contract type in the Selected contract types field to delete a contract type.

REQUIRED FIELDS

You can enable or disable fields and specify if enabled fields are required or locked for workflow or
conversion to a contract.

For each bid package field, you can specify if it is enabled. If a field is enabled you can specify whether
it is required or locked. The settings for workflow and conversion work independently. When a field is
required for workflow or conversion, a value must be entered before you can start the approval
workflow or convert a bid package to a contract. Locking a field prevents users from changing values
after the workflow approval or conversion has been started.

The default for Enable settings is set to Yes for all fields, but you can disable any field except the
Currency field. When a field is disabled, it shows on the Bid package header tab, but it is dimmed, and
you cannot enter a value.

(\[e3p 2 The Currency field is required for workflow and converting the bid package to a contract.
This setting cannot be changed.

CONTRACT TYPE CONFIGURATION SETUP

The Contract type configuration settings let you establish details for contracts by contract type.

InEight Inc. | Release 25.3 Page 41 of 377



Contract User Guide

MASTER AGREEMENTS

As an organization, you can define which contract types should be considered a master agreement. To
set a contract type as a master agreement, set the Is this a master agreement field to Yes. When the
field is set to Yes, an additional tab is added in the application register home page for master
agreements. You can then specify whether to publish the master agreement to an ERP. When the Is
this a Master agreement field is set to Yes, the Allow Association to Master agreement field is set to No
and is disabled.

" Define the following options for this contract type

For contract types that are not master agreements, you can set the Allow association to Master
agreement field. When set to Yes, master agreements can be associated to the contract type, and the
Master Agreement tab is shown in the register home page.

USE CHANGE ORDERS FOR THIS CONTRACT TYPE

You can specify whether change orders are allowed for the contract type. When the Use change orders
for this contract type toggle is set to Yes, vendor change orders can be created in Contract. When set
to No, vendor change order functionality is not available.

ALLOW CHANGES TO EXISTING LINES

When the contract type uses change orders, you can specify if lines can be updated in a vendor change
order. The Allow changes to existing lines toggle lets you restrict updates to existing lines in a vendor
change order. This prevents users from adjusting existing lines and aligns with the functionality of their
ERP system.

When the field is set to Yes, line items can be edited or deleted from the vendor change order.

When the field is set to No, the Add existing line items option on the Vendor change order line items
tab is disabled, and then all lines added to the vendor change order are Add new line item only. You
can only add new lines to the vendor change order. You cannot add existing lines. Existing lines are not

Page 42 of 377 InEight Inc. | Release 25.3



Contract User Guide

editable and cannot be deleted. If the contract is associated to a master agreement, you can add a line
from the master agreement.

It is recommended that when you set the toggle to No, you also set the Maximum contract value
change allowed without a change order to be 0% to ensure that the line item cannot be changed. With
this configuration, every change must be a VCO and must be a new line.

MAXIMUM CONTRACT VALUE ALLOWED WITHOUT A CHANGE
ORDER (%)

The Maximum contract value allowed without a change order (%) field lets you specify the percent at
which a line can be updated before a change order is required. The setting validates both increases and
decreases made to the contract. If you want to allow all changes without a change order, select the
Unlimited check box. If you want all changes to require a change order, enter 0.

ALLOW OVERDELIVERY ON LINE ITEMS

The Allow overdelivery on line items toggle lets you specify whether the contract allows overdelivery
on a line item by a vendor. When the toggle is set to Yes, vendors can over deliver by a specified
percentage. When the toggle is set to No, vendors cannot overdeliver on line items.

When the Allow overdelivery on line items toggle is set to Yes, you can use the Maximum overdelivery
allowed per line item field to set the percentage of a line item that is allowed for overdelivery for the
organization. The project settings also have a Maximum overdelivery setting. You can select the
Unlimited check box to indicate that any percentage of overdelivery is allowed.

The project-level setting cannot be higher than the organization-level setting. If you change the value
of the organization-level setting to a number lower than the project limit, Contract updates the field in
the project settings for existing projects and contracts that had a limit set higher than the new
organization-level limit. If the organization setting is changed to a number greater than the project
limit, Contract does not update the project setting.

ALLOW OVERPAYMENT ON LINE ITEMS

The Allow overpayment on line items toggle lets you specify whether overpayment of a line item is
allowed. When the toggle is set to Yes, you can overpay on line item by a certain percentage. You can
specify an overpayment percentage, or you can select the Unlimited check box. When the toggle is set
to No, overpayment on a line item is not allowed, and the payment form is not allowed to go through
the approval workflow or be submitted.

When the overpayment exceeds the specified percentage, the payment form cannot go through the
approval workflow or be submitted.

For more information about overpayment tolerance, see Overpayment tolerance.
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USE PAYMENT CLAIMS FOR THIS CONTRACT TYPE

You can specify whether to allow payment claims functions for the contract type. When this toggle is
set to Yes and the Enable Payment claims toggle on the Payment claim configuration page is also set to
Yes, the payment claims features are available for the contract type. This option is enabled only when
the Use schedule of values for this contract type toggle is set to Yes.

The payment claims functions apply only to contracts created after payment claims are enabled.

ALLOW WORKFLOW WHEN OVER BUDGET

The Allow workflow when over budget toggle lets you control whether workflow can be initiated on a
contract type based on budget. When the toggle is set to No and the current value of the contract
exceeds the WBS current budget, an error shows when you try to start the approval process. You
should then check the current value or reach out to the project controller. When the toggle is set to
Yes and the current value of the contract exceeds the WBS current budget, a yellow warning banner
shows at the top of the Budget check tab if there is a loss. You can still start the workflow if the bid
package exceeds the current budget.

REQUIRED FIELDS

You can enable or disable fields and specify if enabled fields are required or locked for workflow and
purchase orders.

Contract type configuration setup

Contract type details established here will be available for all projects within this organization

red fields for this contract type

H
3
i

,\
o @O 3
o @

o ©

o

0]
0]

3]
0]

0]
0]
0]
(0]

(0]
O]
0]

For each contract header field, you can specify if it is enabled. If a field is enabled you can specify
whether it is required or locked. The settings for workflow and payment forms work independently.
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When a field is required for workflow or a payment form, a value must be entered before you can start
the approval workflow or generate a payment form. Locking a field prevents users from changing
values after the workflow approval or payment form has begun.

CUSTOM LIST

The Custom list setting lets your organization configure default lists that automatically populate
custom drop-down list fields for projects. The following custom lists are available:

e Contract custom list 1
e Contract custom list 2
¢ Line item custom list 1

¢ Line item custom list 2

Additional details

You can customize the name of the fields using the Custom labels settings. Use the Active toggle to
indicate whether the list item is active. When the value is active it is available in lists. If it is inactive,
the value is not available for use in future contracts or line items but is maintained where it was
previously used.

Custom lists 1 and 2 are also used in the Custom fields section of the Bid packages Overview page.
When the values are created in the bid packages module, the values are carried to the custom fields
when the bid package is converted to a contract.

After a custom list has been used you cannot delete it from the organization settings unless you delete
it from all line items. You also can inactivate a custom list, so it is not available for future use.

Custom lists set at the organization level are applied to the project level and default to Active.

DIVERSITY PARTICIPATION

The Diversity Participation page lets you define the values available in the applicable diversity
categories drop-down list in the Diversity participation section of the Contract header.

InEight Inc. | Release 25.3 Page 45 of 377



Contract User Guide

Diversity participation

. - i
@
o Small Business Business

) ® ® ® ®

Use the Move up and Move down arrows to set the order of the items in the list.

VCO ID CUSTOMIZATION

Contract lets you customize your VCO numbering scheme to ensure consistent numbering.
Configuration settings at the organization and project levels let you specify whether to generate VCO
IDs sequentially, and if so, a prefix and starting number.

You can configure customized IDs using the ID customization configuration list (Organization > Settings
> Configurations > ID customization).

The Generate VCO IDs sequentially settings indicate whether Contract generates numbers sequentially.
When set to No, you can enter any number as the ID when you create the VCO. When set to Yes, you

can specify a prefix and a starting number that Contract uses when it automatically generates the VCO
ID.

The Prefix and Starting number fields are enabled only when the Generate vendor change order IDs
sequentially toggle is set to Yes. The prefix on the VCO is added to the ID in the exact way it is entered
in the field. If you want a space between the prefix and the starting number, you must enter it in Prefix
field. You can edit the starting number until a VCO has been created. After a VCO has been created, the
field is disabled.
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The Allow projects to edit settings check box specifies whether you can override the settings at the
project level. When checked, the organization-level settings are the default at the project level, but the
project administrator can override the settings. When the check box is unchecked, the numbering
scheme is enforced at the project level. After you establish a starting number, and the first VCO is
created, you cannot change the starting number at the project level.

PAYMENT CLAIMS CONFIGURATION

The Payment claims configuration lets you enable payment claims functions and establish scheduled
dates.

Configurations >  Edit configuration list Cancel

Payment claim configuration e Allow projects to addedit payment claim settings

4 o (4;' © de pag Date d Ber

4 a 5 (©] Q

5 ting 2 @ ©

[ Date name 3 3 @ €]

7 testing 9 o ©

1 Enable Lets you indicate whether payment claims functions are used at the

Payment organization level. The toggle must be set to Yes if any project needs to use
claims payment claims. The payment claims functions can be turned off or on by
toggle contract type in the Contract type configuration set up. Payment claims are

enabled only for new contracts created after the feature has been turned on
for a contract type.

2 Push Indicates whether all existing project claim date settings are overwritten. If
updatesto setto Yes, dates in projects are overwritten. If set to No, the dates are
existing effective for new projects only.
projects
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I S

Allow Lets you indicate whether the organization-level settings can be edited at
projectsto the project level. When the box is not selected, fields on the project level
add/edit Payment claims configuration page are disabled.

payment

claim

settings

4 Payment The day of the month the claim is due. This date is used to calculate the
claimdue  scheduled dates. For example, if you process claims on the 15th day of
date each month, set this field to 15.

5 Payment The dates that certain requirements must be met.
claim
scheduled
dates

J[eag= When Push updates to existing projects is selected, the organization settings, project
settings, and the payment claim details are locked and cannot be edited while the values

are pushed to projects. A warning banner shows in the settings and detail pages to
indicate that the push might take several minutes.

PAYMENT CLAIM SCHEDULED DATES

The scheduled dates table lets you set up the timetable for claims. Each line in the table is an event
related to the payment claim date. The value in the Number of days column is the number of days
before (a negative value) or after (a positive value) from the payment claim date that the scheduled
event occurs. For example, if you require a meeting with the vendor five days before the payment
claim date, you could create a scheduled date called Vendor meeting and assign the number of days as
-5. If the certification of the payment claim takes place 12 days after the payment claim, you would set
the Certification date to 12.

You can specify whether each date is active or default. When a date is active (that is, the Active toggle
is set to Yes), it is available in the project, but you cannot edit the name or number of days at the
project level. When it is inactive, you can activate it at the project level and then rename it or change
the number of days. You cannot rename a date or change the number of days in the organization
settings unless the date is set to Active.

When the Default setting is set to Yes, the scheduled time automatically shows in the Payment Claim
Dates section of the Payment claims Details page.
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You can configure up to 10 dates The Submission date and the Certification date fields are required,
and you cannot rename them, make them inactive, or change the default.

SUPPORTING DOCUMENTS

The Supporting documents configuration settings let you add validations required document types that
must be authorized before publishing.

Supporting document type validations

---------------

rrrrrrrrr

For each contract type you can select an event, the type of document that is required, and whether
approval is required before publishing the associated event. You can configure multiple events to a
contract type and multiple document types to an event.

TAX SETTINGS

Tax settings help you estimate contract taxes before publishing a contract, so you can include taxes in
budgets and committed costs. This is particularly useful for organizations that use a proxy ERP because
you can estimate taxes without integrating with a third-party product. You can also specify whether
the payment form taxes are calculated based on gross price or net price and whether those taxes are
included in committed costs to InEight Control.

The tax settings at the organization level flow down to the project settings when the tax type's country
code matches the country listed in the project details. The organization can define the following:

¢ Position

e Tax description

e Tax type

e ERP Code

¢ Default percent

¢ Country code

¢ Calculate payment form tax (net amount or gross amount)
¢ Include in committed cost

e Active status
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Cancel ]

= Clearalifites  Q

The position indicates the order that the taxes are shown. To change the position of a tax, drag and
drop the line to the new position, and then click Save. The change position is available on all projects.

The tax description is a label that makes the tax recognizable to users. When a tax is referenced, the
tax description is shown in the InEight cloud platform, which matches the tax type or ERP code used in
APls. The tax description is shown in the total tax information you see when you click the information
icon.

The tax type is used to identify the tax. Tax types must be unique by country code. The tax type values
are especially important in a proxy ERP environment to identify and match the taxes in the response. If
you use an invoice response from OneDrive to overwrite the taxes with a tax type that does not match
the project settings, Contract cannot read, store, or display the tax.

The ERP code is used to send information to the ERP system. If you are an ERP customer, you must
match ERP codes. The Tax type code should be sent in purchase order responses. If you use a Proxy
ERP, this field is ignored. You can set a country code, so the tax is only applicable to projects in a
specific country. You can also indicate whether to calculate the tax on the payment form net amount
(after retention is withheld) or the gross amount (before retention is withheld).

How tax is calculated depends on whether Contract is integrated with an ERP system, whether
Contract Tax Request (Application integration > Other) is configured, and whether the contract has
been published. Prior to publishing or clicking Estimate tax, the line item taxes are always estimated
from project settings. The table below represents how taxes are calculated when the purchase order is
published or Estimate tax is clicked.

If tax is

calculated in | ERP system or proxy ERP Used to figure tax

Unpublished ERP with Contract: Tax Contract: Tax Request

contract Request configured
Unpublished ERP system without Settings
contract Contract: Tax Request
configured
Unpublished Proxy ERP Settings
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If tax is
ERP system or proxy ERP Used to figure tax

contract

Published ERP system PO response from ERP

contract

Published Proxy ERP Simulated purchase order response (using
contract settings)

Payment form Both Estimated proportionally from PO response
line items

Payment form Both User-entered tax when adding invoice. The tax
details fields and tax types are from the project settings
summary

The Include in committed cost toggle specifies whether to include the tax in the Contract and InEight
Control committed value.

VENDOR CHANGE ORDER RESPONSIBLE PARTY

You can configure vendor change-order responsible parties for the organization. The responsible
parties configured here populate the Responsible party drop-down list on the VCO record header.

You can delete a responsible party only if the party is not in use by a project. Additions or changes
made at the organization level are for new projects only.

2.0.1.3 CONTRACT CUSTOM LABELS

Contract has settings that let you customize field names in the application to align with your business
terminology. You can customize the fields in all languages supported in the application.
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You can enter the label text for each of the fields in each language. The custom text replaces the
default text in field names, tab names, messages, templates, and other labels throughout the system.

The Enable custom labels toggle lets you switch between using your custom labels and Contract's
default labels. When switched on, Contract uses the defined labels in all languages. If you have not
defined a label, Contract uses the default text for that field. When switched off, Contract uses the
default labels for all fields in all languages. You can refer to the Contract Custom Labels tab in Project
settings as a legend showing the custom labels and how they are referred to in tags and in the Contract
user interface.

When custom labels enabled at the organization level do not apply to your project, you can switch the
Enable custom labels toggle in the project settings to Off. When custom labels are disabled at the
organization level, they are automatically disabled for all projects.
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2.0.2 PROJECT SETTINGS

To manage a project successfully within Contract, the correct project settings need to be set up before
project initiation. project settings are distinct from organization settings, which are defined by the

administrative level of your organization. The image below shows you the ways you can access project

settings from the Project home landing page.

& Links

Organization

InEighty)
Steel Structure Job | 105092 Learn InEight
S Project
(@) capital
convac ©)

Bid packages

Contracts

<) Control

Manage budgets and forecasts

#:) Work packaging

Group work into plans and packages

=¥ Project notes

&

@ Settings

Project and application settings

7] Contracts

Status Count

M ge setting:
Settings
%) Project contract summary

Workflows
Assigned users Actual values
Assigned contacts

Original project value $0.00

Executed CCOs $0.00
Assigned operational resources
Assigned disciplines and commodities - Current project value $0.00

©2021 InEightInc. | Privacy Statement |  Terms & Conditions | va1s | vKog0

%) Change milestones
Schedule Date Calendar days
Contract date

Date project started

Original cantract co.

Mo = Some settings defined at the organization level will limit the settings you can define at

the project level

The following steps walk you through how to navigate to project settings.

OPEN PROJECT SETTINGS

1. From the InEight cloud platform home page, open the Main menu on the upper left side of the

page.

InEight Inc. | Release 25.3

Page 53 of 377



Contract User Guide

= @ Welcome
5t ®
Z5 Weather © Map Y C
a
<« » ar =
- 9
Enter city, country or zip code, country

Use my current location

® OpenStreethap contributors

2. Click on the All projects & organizations menu option.

{} Welcome

INEIGHT®

Main menu
FAVORITES
5100000 - PKS Inc
Rivers Edge One Office Building | 1...
Blue Water Energy Center | 103655
Van Nuys North Platform | 103442

MemFix 4 | 103660

Show more —|—

SETTINGS

All projects & organizations
iii Master data libraries

Suite administration

Profile
INEIGHT ONLINE
(D Explore products

® InEight learning and support

@ InEight.com

3. On the Projects tab of the All projects and organizations page, search for the Steel Training Job.
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) Allprojects & organizations - @ 9
PROJECTS ORGANIZATIONS
® ®
[ Name Status Organization Created by X
[} 103631 Active 3 - Power : SE2020 - Ki Power Delivery = Shannon Pechar Search
[} 103632 Active $D3007 - Infrastruct ast (SVP Level)  Danielle Sandilaf

4. Once found, click on the Project Name link of the Steel Training Job.

@ All pr:ﬁjects & organizations -
PROJECTS ORGANIZATIONS
1D Name Status Organization
105091 Steel Structure Job (Use for samples) Active 5100000 - (PKS Inc)
105092 Steel Structure Job, Active 5100000 - (PKS Inc)
105093 Steel Structure JobB‘\ New 5100000 - (PKS Inc)
105094 Steel Structure Job 4 Active 5100000 - (PKS Inc)

» The Project home landing page opens

» To access project settings, you can either select Settings under Project on the left
menu bar, click on the View project settings tile, or click on the second level menu
drop-down list and select Settings

5. Select Settings from the left navigation menu.
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= 4] / Project home
ﬁ- & Links
Add project image Organization
Minimum of 540px x 360px
InEightU
- Learn. InEight
Weekly time sheet - Project

Capital

Contract @
Bid packages
Contracts

Change a Project notes e

Compliance

Report

@] epiore

Dashboards
API documentation & Settings
Extensions Project and application settings

Billing

Manage settings
Project home

Project details

(ﬁﬂ Project contract summary

Workflows
Actual values
Assigned users

Assigned contacts. Original project value $0.00

Billing classes
Operational rate codes Brecuted CCOs $0.00
Assigned operational resources )

Current project value $0.00
Assianed discinlines and commaodities

» The Project settings page opens

6. Select the Contract icon on the left side of the page. You can use the expansion arrows to see
the application names.
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/ Settings

>
@’l = f / Settings
&) SETTINGS «
["] @I General
[’Lj I:{j Design
E‘?j [GJ Control
G () Plan
Uf-',' (‘?j Progress
Lﬁil LﬁPI Capital

I\f[,l/I Contract

I\£/| Change

Compliance

2.0.2.4 PROJECT SETTINGS HEADER

The project settings for Contract are organized into four tabs:

» Bid Packages
Contracts

Workflow Assignments

Contract Templates

Configurations

Contract Custom Labels

WORKFLOW CONTRACT CONTRACT CUSTOM
BID PACKAGES CONTRACTS ASSIGNMENTS TEMPLATES CONFIGURATIONS LABELS
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2.0.2.5 BID PACKAGES TAB

USE BID PACKAGES?

The first setting under Bid Packages is a toggle switch to control whether Contract will include the Bid
Packages functionality or not. Depending on how your organization runs things, you may or may not
want to use InEight Contract for managing the bid package part of the process.

@)  Steel Structure Job (105092) > Setings ~
CHAR

o~ BID PACKAGES CONTRACTS
@ General I MANAGE
(*¢") Control
Sl .
— Use bid packages?
(342) Plan
&) |
@ Progress I|
|| Contract
s Milestones
-}-] Design
U These bid package milestones will be available for projects in this erganization.

If there is already a bid package associated with your contract, you cannot turn off the bid package. If
you do, an alert appears to notify you.

X

Can't disable Bid Packages

The project has bid packages associated.

Close

MILESTONES

The second section under Bid Packages is populated by benchmarking milestones. On bid packages,
milestones are used to track your dates and deadlines and report on if you are ahead or behind
schedule.
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Milestones set up by your organization at the Organization level are inherited on the Project settings
tab, where you can decide which ones are required to use on bid packages and in what order.
However, you are not able to change milestones to not be required if they were set to Required at the
Organization level. You can add new milestones at the project level.

You can include or not include milestones by selecting and deselecting the Required Yes/No toggle.
You cannot add or delete milestones from the list in Project settings, but milestones can be added in
the Organization settings if you have access.

Bid package milestones

Bid package milestones displayed here are established at an Organization level. Required Org level milestones cannot be deleted. Additional milestones may be added if needed.

Upon 'Save’, all modifications will be reflected in all Bid packages

n O (3]
Position  *Milestone

] 0 sued for owner review
[ Technical bid analysis
(] 03 Proposal received

(M) 04 ssued for review

(] 05 Request for proposal

Term

Espafiol ES-MX e
ot D

. I
Required @  *Milestone !

e (5 '

solicitud de propuesta

Definition

1 Selection
column

2 Position
indicator

3 Milestone

4 Default
toggle

5 Remove
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Use to select a column for changing the position.

Notes the position of the milestone.

The name of the milestone.

Indicates whether the milestone is required by default for your
project. Toggles for milestones that are required by the
organization are dimmed, and you cannot change them to
optional.

Use to remove a milestone. After a milestone is removed, it no
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Term Definition
milestone longer appears in the milestone list on the project bid package
Milestone page.
6 Directional Move the selected milestone up or down in order.
arrows

o= The Letter of Intent/Award milestone represents selecting the vendor.

DIVISION OF RESPONSIBILITIES (DOR)

The third section of Bid Packages is Division of responsibilities (DOR). These are roles that will be
available to assign a person to when creating a bid package.

You can remove a role from being needed on a bid package. The drop-down list for that role then does
not appear when creating a new bid package.

Division of responsibilities (DOR)

These bid package responsibilities will be available for this project.

English Spanish
nglis panis E - -

Responsibility Responsibility

General Manager
Responsible engineer
Contract manager
Purchasing manager
Field handler

Purchasing agent
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General Manager

Ingenierc responsable

Gerente de contrato

Gerente de compras

Controlador de campo

Agente de compras

OONOINOINOINO)

If there is already a responsibility associated with a bid package, you cannot turn off the role. If you do,
an alert appears to notify you.
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® Unable to remove responsible engineer

You must remove the responsibility from all bid packages before
it can be removed.

Close

2.0.2.6 CONTRACTS TAB

To access Contract-related settings, select the Contracts tab.

WORKFLOW
BID PACKAGES. CONTRACTS ASSIGNMENTS

CONTRACT CONFIGURATIONS

The first section under Contracts is Contract configurations, where you can adjust by contract type if
overdelivery on line items is allowed and what percentage per line item is allowed.

WORKFLOW CONTRACT

BID PACKAGES CONTRACTS ASSIGNMENTS TEMPLATES

Line item account settings  Delivery address  Project ERP attributes  Notifications  Contract closeout

cancel |

Contract configurations Material contract type configurations

Changes will be applicable to future contracts only.

English

Allow overdelivery on line items?

* Maximun

rerdelivery allowed per line item (%)

35.00%

Jlelg = Overdelivery percentage caps are defined at an organizational level. For example, if the
cap is 15%, a project can adjust to anything under 15% but cannot have a percentage
anything above 15%.
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LINE ITEM ACCOUNT SETTINGS

The second section under Contracts is Line item account settings, where you can toggle if a contract
can be split between multiple WBS codes.

WORKFLOW
BID PACKAGES CONTRACTS ASSIGNMENTS
Contract configurations Line item account settings Delivery address
0

Line item account settings

Allow multiple/split WBS account distribution?

~ I

DELIVERY ADDRESS

Below is the Delivery address section of this tab. This may be where your project’s materials will be
delivered (either on or off-site), or services will be performed. If your project has multiple job locations,
then enter them all. You must indicate which one will be the default location.

You may use your delivery address as your tax jurisdiction for states that have “point of receipt” taxes.
After the shipping addresses are entered, the team member with the tax-related information can enter
the tax jurisdiction code as needed. The tax jurisdiction code is used to drive how taxes will be
calculated for the project.

WORKFLOW CONTRACT

BID PACKAGES CONTRACTS ASSIGNMENTS TEMPLATES

Contract configurations  Line tem account settings roject ERP attibutes  Notifications  Contract closeou
cancel |
Delivery address
“Country “Address1 Address2 “city *State / Region *Postal / Zip code Taxjurisdiction code “Defauit
United States Of America Memphis Tennessee 38119 4315705600 . ®
United States Of America Memphis Tennessee 38119 4315705600 O] ®
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PROJECT ERP ATTRIBUTES

One of the purposes of Contract is to input the necessary information to create a purchase order (PO)
in your ERP system. Having a PO is important because without a PO, you cannot pay the vendor.
Typically, your ERP system will have certain required attributes to create a PO. Defining these

attributes in InEight will automate the filling in of those attribute fields in your ERP system for the
project.

WORKFLOW
ASSIGNMENTS

Contract configurations Line item account settings Delivery address Contract closeout

BID PACKAGES CONTRACTS

|Project ERP attributes |

Good receipts?

Company code Plant *Storage location ID *Description *Default

®

VALUATED VS NON-VALUATED GOOD RECEIPTS

When using an ERP system, this must match your ERP system.

When your Good receipts are Valuated, the costs will calculate for that GR and quantity and value of
the goods received displayed in the line item tab > Progress view.

Non-Valuated means that no costs are calculated and only the quantity received will display in the line
item view > Progress view.

Project ERP attributes

The table below provides definitions for each of these attributes.

Term Definition
1 Company The project legal entity, or the legal name you are doing business
Code under. It is where profit and loss will be reported. The company code

will populate from the default of the Organizational settings.
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Term Definition

2 Plant The project logistical entity and is tied to the company code. Any plant
associated to that company code will appear in the drop-down list.
Any plant associated to that company code will appear in the drop-
down list.

3 Storage A subset of Plant, it is the place where the materials are transferred or
Location delivered. If you are keeping inventory in SAP, it is where your
inventory is stored in the system, and where you can track that plan of
materials.

Once the plant is identified, enter the correct storage location using the drop-down.

Project ERP attributes
Good receipts?
[ o]
Company code o Plant o o *Storage location ID *Description *Default
®
o047 Van Nuys N Platf ® ®
L

There are some larger jobs which would have more than one storage location. Make sure you list all of
them but indicate the default location.

NOTIFICATIONS

The Notifications section of the Contracts tab lets you configure whether notifications for supporting
documents expiration is supported at the project level. The project-level setting functions
independently of the organization-level setting, so the person who works directly with the vendors
gets notification of expiring documents and can renew them on a timely basis. When you enable
notifications, the tab shows fields that let you specify the roles or users to receive notifications, the
number of days to be notified before document expiration, and the frequency of the reminder.
Settings in the document details specify whether the notifications go beyond the expiration date.
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WORKFLOW CONTRACT

BID PACKAGES CONTRACTS ASSIGNMENTS TEMPLATES

Contract configurations  Line item account settings  Delivery address  Project ERP attributes | Notifications | Contract closeout

E=a) -

Notifications

Supporting documents expiration
©

*Assign roles or users to receive notifications “Users

Users -

*Days to be notified before document expiration

B a

*Frequency of sending reminder (in days)

T -

CONTRACT CLOSEOUT

The final section of the Contracts tab is Contract closeout. This is where you can assign questions to
each closeout section. Any questions added here will be automatically applied to all new contracts.

[Contract closeout |

Closeout sections

English Spanish Questions FR hd
asfal 1 Questions @
HVT_Spanish HVT_Spanish Questions @
HVT_19.1_Section HVT_19.1_Section Questions @
Localization_1 Localization_1 Questions @
HVT_Sectionl HVT_Sectionl Questions @
HVT_section HVT_section Questions @

LK Test LK Test Questions @

To add a question to a close out step, click on the Questions link under the Questions column.
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Closeout sections
English
asfal
HVT_Spanish
HVT_19.1_Section
Localization_1
HVT_Section]

HVT_section

Spanish

1

HVT_Spanish

HWT_19.1_Section

Localization_1

HVT_Sectionl

HVT_section

LK Test

LK Test

Questions

Questions

Questions

Questions

Questions

Questions

Questions

Questions

m
H
-
E]
4

OMOMOMOIOMOMNO)

A slide out panel appears on the right. You will be able to see current questions assigned to that step
that can be removed if they have not been used yet. You will also be able to search through current
available questions. A question can be added by clicking the plus button to the left of the question.

Available questions

®®® 6

HVTSpanishQuestion2
HVTSpanishQuestion]
HVT_Question_19.1_2

HVT_Question_19.1_1

Localization_Question

) ®

Question

Assigned questions

X

Localization_Question
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You can delete a closeout section from project settings if it is not applicable and it is not used in any
contract. If the closeout section is used in a contract and the status is Not Applicable, Not started, or
Recalled, you can delete the section. You cannot delete contract closeout sections if they are used in a
contract and the status is Started or Complete.

Closeout sections and questions are added in the Organizational settings.

CONTRACT CLOSEOUT PERMISSIONS

Users assigned to complete contract closeouts do not have edit contract permissions. These
permissions are set at the Organization level and the Administrator should be contacted to set these
permissions. These permissions are assigned under Suite administration > Roles and permissions >
Contract.

2.0.2.7 CONTRACT TEMPLATES TAB

The contract templates tab lets you create and maintain contract templates at the project level. You
can also set up the recipients for eSignature via DocuSign.

PROJECT AND ORGANIZATION TEMPLATES

The Contract template tab in the project settings has headers for Project level templates and
Organization level templates. To create project-level templates, go to the Project level templates tab,
and follow the instructions described in the Organization settings topic.

Contract writer templates added at an organization level are available for projects by default and are
listed in the Project level tab register. Organization-level templates are marked with Organization level
in the Created by column.

uuuuu ption status Assignedcontr_ —  Templatetype Market Templste file Created dsts Tampiate

To deactivate an organization-level template for a project, use the Project level use column to change
the check mark to a minus, and then click Save.
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Select which Organization level templates to be available for use at the project level from the Project level use’ column,

‘‘‘‘‘‘‘‘

0]

You can copy an organization-level template to the project level, so you can make changes specific to a
project without affecting the organization-level template. The new project-level template is version 1.
The template details are editable. After the project-level template is published, changes at the
organization level do not affect the project-level template.

2.0.2.8 CONFIGURATIONS

CONFIGURATIONS

Project-level configurations let you customize Contract for your project. To see the configuration
settings, go to project settings, and then select Contract >Configurations. The configurable settings
include the following:

e Custom list

¢ Decimal precision

¢ eSign setup

¢ |D customization

e Payment claims configuration
e Tax settings

¢ Vendor change order responsible party

CUSTOM LIST

Custom lists let you create fields with drop-down lists. Values configured for the custom lists
automatically populate project drop-down lists in the specified order. Custom lists are also configured
at the organization level and are applied at the project level by default. You can add values for Contract
custom list 1 and 2 and Line item custom list 1 and 2.
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Custom list de

Espafiol ESMX

You can select a list item, and then click the up or down arrows to change the value's position in the
drop-down list.

If you do not want to use an organization-level custom list value for a project, you can disable it (that
is, set the Active toggle to No). When you no longer want to use a project-level custom list value you
can deactivate it, or if it has not been used, delete it.

See Organization settings for more information about custom lists.

DECIMAL PRECISION

You can use the Decimal precision configuration to set the number of digits that follow a decimal point.
The precision decimals are used in contracts, bid packages, line items, and detail pages. Imports and
exports also support decimal precision. All imports and exports can support five digits after the decimal
regardless of the setting. The fields are stored in the database with five digits after the decimal but are
shown on the Ul according to the settings.

(\[sp = Contract writer tag output uses two decimal places.

You can choose separate decimal precision for values, quantities, percentages, and unit price.

InEight Inc. | Release 25.3 Page 69 of 377



Contract User Guide

Configurations >  Edit configuration list

Decimal precision

These settings control only values which are displayed and entered.

Calculated values will show as rounded to the decimal precision below.

How many digits should be displayed after the decimal? (Standard rounding applied)

Value
Quantities
Percentages

Unit price

You can choose 0-5 digits. If you do not enter a value, Contract uses a default value of 2 for the Values,
Percentages, and Unit price settings and 3 for the Quantities setting.

ESIGN SETUP

If your project is integrated with an eSignature provider, you can embed common signees into your
project templates. The eSign setup configuration lets you add the names of up to 10 recipients, along
with their companies, titles, and email addresses that can be used with every contract in the project.

uuuuuuuuuuuuuuuuuuuu

(0] lly available on Changes will be applicable to new Contracts only.

Each eSign recipient field in the list has a corresponding template tag. You can add the tag to templates
to require the signee's signature. The tags are read when sending the document for signature. The
recipients are also available to add to a document when you send the document for eSignature. See
Contract Writer for information about sending documents for signature. See Template types subtab for
information about using tags in templates.
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If you edit the eSign setup, the recipients are available for new contracts only. You can override the
eSign recipients in the eSign section of the Contract header details.

ID CUSTOMIZATION

If projects are allowed to edit VCO IDs, that is, the Allow projects to edit settings check box at the
organization level is checked, you can override the organization-level numbering by setting the
Generate vendor change order IDs sequentially toggle to Yes. If set to No, IDs function as free text.

Confgurations > Edit configuration st Rl s |

Vendor change order

When the Generate vendor change order IDs sequentially toggle is set to Yes, the Allow users to edit
generated IDs toggle is shown, and the Prefix and Starting number fields are enabled. The last active
vendor change order ID number can be reused in the numbering scheme to reduce the number of gaps
when you must delete vendor change orders created in error. When the last vendor change order ID is
deleted, it is reused for the next vendor change order.

A VCO cannot be deleted or renumbered after it has been executed. For example, you
have vendor change orders are numbered 001, 002, and 003. Vendor change orders and
001 and 003 have been executed, and 002 has not been executed. If you delete change
order 002, change order 003 is not renumbered, and the next vendor change order
added would have the ID 004.

You can set the Allow users to edit Generated IDs to Yes to allow users to edit the generated IDs when
creating a VCO or for a VCO that has been generated from InEight Change. When the field is set to No,
you cannot edit the IDs and must use the IDs generated by Contract.

You can edit the starting number field only if a VCO has not been created.

PAYMENT CLAIMS CONFIGURATION

The Payment claims configuration lets you add or edit settings for your project. The fields on this page
are enabled only when the Allow projects to add/edit payment claim settings check box on the
organization-level Payment claims configuration page is selected.
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Payment claim configuration

ws T Active T  Defaull T | Scheduled date- ES-MX = Scheduled date - FR-CA = Scheduleddate - PT-BR = Scheduled date - NL-NL T Scheduled date - NE-NO =

000 O

The Allow users to add and remove date fields in a payment claim field indicates whether the dates
shown in the payment claim can be added or removed. When the toggle is set to Yes, you can add
dates or remove the default dates. When the toggle is set to No, you cannot add new dates or remove
default dates.

The Payment claim date due field shows the day of the month the payment claim is due. If the date is
different from the date in the organization settings, the date in the project settings is used.

When the Active toggle for a scheduled date is set to Yes, you can edit all fields. When the Active
toggle for scheduled date is set to No, you cannot edit values unless you switch it to Yes. When the
Allow users to edit dates in a payment claim toggle is set to Yes, you can add dates or remove the
default dates. When the toggle is set to No, you cannot add new dates or remove the default dates.

See Payment claims configuration for more information about the payment claims settings.

TAX SETTINGS

Tax settings at the project level are used in conjunction with organization-level tax settings to estimate
contract taxes before publishing a contract. You can use the project settings to add additional taxes to
a project, such as a state or county tax. Taxes entered at the project level are listed before those
configured at the organization level. Project level taxes cannot be deleted if the tax has already been
used. If a tax is no longer applicable, you can deactivate it for future contracts. Marking a tax as
inactive removes the tax type for future contracts estimated taxes, but the tax column remains in any
register where it was listed if any contract on the project was created before the tax type as
deactivated.

Projects can configure the following for taxes:
e Tax description

e Tax type
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ERP code

e Default percent

e Country code

¢ Calculate payment form tax (net amount or gross amount)
* Include in committed cost

e Active status

Organization-level taxes are shown based on the project's country and tax type country code. They are
marked with the information icon. Organization-level taxes without a country code appear in all
projects. You can activate or inactivate an organization-level tax, edit the default percentage, change
whether to calculate the tax in a payment form based on the net or gross amount, and whether to
include the tax in the committed cost.

The tax description is a label that makes the tax recognizable to users. When a tax is referenced, the
tax description is shown in the InEight cloud platform, which matches the tax type or ERP code used in
APls.

The tax type is used to identify the tax. Tax types must be unique by country code. The tax type values
are especially important in a proxy ERP environment to identify and match the taxes in the response. If
you use an invoice response from OneDrive to overwrite the taxes with a tax type that does not match
the project settings, Contract cannot read, store, or display the tax.

The ERP code is used to send information to the ERP system. If you are an ERP customer, you must
match ERP codes. The Tax type code should be sent in purchase order responses. If you use a Proxy
ERP, this field is ignored. You can set a country code, so the tax is only applicable to projects in a
specific country. You can also indicate whether to calculate the tax on the payment form net amount
(after retention is withheld) or the gross amount (before retention is withheld).

How tax is calculated depends on whether Contract is integrated with an ERP system, whether
Contract Tax Request (Application integration > Other) is configured, and whether the contract has
been published. Prior to publishing or clicking Estimate tax, the line item taxes are always estimated
from project settings. The table below represents how taxes are calculated when the purchase order is
published or Estimate tax is clicked.

If tax is

calculated in | ERP system or proxy ERP Used to figure tax

Unpublished ERP with Contract: Tax Contract: Tax Request
contract Request configured

Unpublished ERP system without Settings
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If tax is
calculated in | ERP system or proxy ERP Used to figure tax

contract Contract: Tax Request

configured
Unpublished Proxy ERP Settings
contract
Published ERP system PO response from ERP
contract
Published Proxy ERP Simulated purchase order response (using
contract settings)
Payment form Both Estimated proportionally from PO response
line items
Payment form Both User-entered tax when adding invoice. The tax
details fields and tax types are from the project settings
summary

Jlelg 2 Each tax type established here and in the organization settings defaults to include in
committed cost This configuration includes the taxes in the committed cost values in
Control.

VENDOR CHANGE ORDER RESPONSIBLE PARTY

You can configure vendor change order responsible parties for a project. The responsible parties
configured here populate the Responsible party drop-down list on the VCO record header. Responsible
parties for a project include those added at the organization level.

Confustons > Edtconfguaton st

7
H
i

©
i
H
H
)

,,,,,,,,,,,

© 0 © 0 o i

You can delete a responsible party only if the party is not in use by a project. Additions or changes
made at the organization level are for new projects only.
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When a responsible party has been used in your project, but you do not need it for future contracts,
you can deactivate it instead of deleting it. When the Active toggle is set to No, it can no longer be
used in the project.

2.0.2.9 CONTRACT CUSTOM LABELS TAB

To view the default values of custom labels set at the organization level, select the Contract Custom
Labels tab. You can use the read-only display as a reference, so you can see where tag information is
mapped in a contract. When custom labels configured at the organization level are not right for your
project, you can disable them by switching the Enable custom labels toggle to No. When set to No, the
default labels from InEight are used.

PACKAGES

= Clear all filters i Q

Custom label - EN Custom label - ES-MX Custom label - FR-CA Custom label - PT-BR Custom label - NL

2.0.3 WORKFLOW ASSIGNMENTS

The Workflow Assignments tab in project settings is where you set up approval processes for
approving contracts, vendor change orders, and payment forms. The settings include defining the
number of steps in your approval processes and making assignments of who approves each step. You
can set up the approval process for the following:

» Bid package approval setup

« Contract approval setup

* Vendor change order approval setup
» Payment claim approval setup

» Payment form approval setup

» Document approval setup

2.0.3.10 GROUP WORKFLOWS

Large contracts often have varying approvers, which can result in changing the project settings for each
segment of a contract. Configuring approver group workflows provides alternatives in the approval

InEight Inc. | Release 25.3 Page 75 of 377



Contract User Guide

process, which saves you from manually altering the workflow at the project level each time you
require a segment-specific workflow.

An approver group is a set of users or roles in steps, similar to an entire workflow. You can set up
multiple groups in a single step in a workflow. For example, when a project is done in segments, you
might have a different set of approvers for each segment. Instead of setting up a workflow that applies
to the whole project, you can create a multistep group workflow for each segment. You can have one
or more group steps in a workflow.

You can configure groups from the Group approver setup page (Project > Settings > Contract >
Workflow Assignments > Group approver setup). Each group can act as its own workflow. In the
sample image, a contract has two segments, each with a different field engineer and project engineer.
The business manager is the same for both segments. A business manager only group is set up for a
flow that only needs approval from the business manager, such as resubmitting a previously rejected
payment form. All contracts, VCOs, and payment forms in the project can use the groups.

CONTRACT CUSTOM
LABELS

Group approvers setup here will be available for selection within the approval setup process for Contraet, Vendor change order and Payment form

®

Group approval name & Approval steps Users/Roles

When you start the approval process from the contract, VCO, or payment form, you can select the
appropriate group workflow when you click Save and start approval.

CREATE GROUP WORKFLOWS

Use group approval workflows as a single step in a larger workflow. The group workflow contains users
or roles arranged in steps, like the steps used in thresholds. Group workflows let you set up segment-
specific workflows to use when a contract has multiple segments or when only one user or role has to
give an approval (such as a previously rejected payment form).
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Only one step in an entire workflow can have a group step.

1. Go to the Group Approver Setup page (Project > Settings > Contract > Workflow
Assignments >Group approver setup).

2. Click the Add group approval button. The Add group approver slide-out panel opens.

3. Enter the group approver name (for example, Segment 1), the step title of the first step (for
example, Field engineer), and the users or roles for that step, and then click Add. The
group and its step is added to the grid.

4. To add another step, click the Add another step link, and then enter the step title and
approvers. Click Add. Repeat this step as necessary to add all steps in a workflow.

You can change the order of the steps by selecting the step and using the up and down arrows. You can
use the group approval as a step when setting up contract, VCO, or payment form approval. Users who
are added to roles associated with active workflows can approve or reject workflow items. They do not
get a workflow notification, but the workflow item is shown in the Action items tab.

THRESHOLD-BASED APPROVAL SETUP

Contract gives you the ability to set up value thresholds based on bid package type, contract type, or
vendor change order type at both organization and project levels. Contract uses an approval matrix
where any amount equal to or over the threshold set must be approved. Contract considers currency
exchange rates when initiating the workflow and reviewing the budget. When the workflow is started,
Contract converts workflow values from the project currency to the contract currency to see if the
value is greater than the threshold. For example, if the project currency is US dollars and the contract
currency is euros, Contract uses the conversion rate configured in Project details to convert the euros
to US dollars to determine whether the contract is over the threshold. If the converted value is greater
than or equal to the threshold, workflow begins.

The approval matrix and thresholds are set up under the organization and project settings. Steps that
are set up at the organization level are performed after the steps that are set up at the project level.

Under the organization settings, select Contract > Workflow Assignments, and then choose Bid
package approval setup, Contract approval setup, or Vendor change order approval setup. The
threshold set-up is similar for each tab.

WORKFLOW
ASSIGMMENTS

BID PACKAGES CONTRACTS

Contract approval setup Vendor change order approval setup Payment form approval setup
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ADD A WORKFLOW THRESHOLD

A threshold is the value at which a bid package, contract, or vendor change order requires an approval.
You can add as many thresholds as required by your organization.

Steps configured at the organization level are performed in all approvals for a contract type. Additional
approval steps can be added at the project and contract levels, with organization-level steps
performed last. Organization and project-level thresholds cascade to every contract. In an individual
contract, you can add additional contract approval steps. These steps are first, regardless of the value
of the contract.

The following steps use contract approval set-up as an example. You can use the same steps for bid
package or vendor change order approval set-up.

1. To add a workflow threshold, select a Contract type, and then select the Add threshold icon to
open the Approval details.

o I WORKFLOW CONTRACT

BID PACKAGES CONTRACTS ASSIGNMENTS TEMPLATES

Contract approval setup Vendor change order approval setup Payment form approval setup
Contract type Approval details
Material contract
Material contract approval details
Subcontract
Service agreement
Rental agreement @
Threshold amount & Steps Roles

Test
New type Mo approval workflow is set up at org level.

Test contract type

2. In the slide-out panel, enter the Threshold amount, Approval step title, and the users, roles, or
groups for the Assign approval roles. Click Add to complete.
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Contract approval setup

Contract approval setup

CONTRACT
TEMPLATES

WORKFLOW
CONTRACTS ASSIGNMENTS

BID PACKAGES LABELS

Vendor change order approval setup  Payment form approval setup  Group approver setup

CONTRACT CUSTOM

Cancel

Add approval

Workflow

Contract type

Approval details

Material contract

New type

Material contract approval details

[o]

Threshold amount & Steps.

Test contract type

NSK

NSK Contract Type

NSK

To

=

~

Manager approval

eps added here are required at the contract level and cannot be edited in an individual contrac

Marked items MUST be edited. Users need to be selected based on the assigned approver r

Users/Roles/Groups

No approval workflow is set up at project/organization level

“Threshold amount

Approval step

“Step title

_————PO sddancther

Contract_Approve & SL-Admin

add additional approval steps at the threshold, click Add another step.

step

~

© Add ancther

step

Project manager required ()

Contract_Approve & SL-Admin

4. Repeat steps 2 and 3 as needed to add all organization-level steps.
5. Click Save.

You add approval steps at the project level in the same manner from the Workflow assignments page
(Settings > Contract > Workflow Assignments).

In a contract, select the Workflow Assignments tab. Organization- and project-level thresholds only
display after the contract value has reached the threshold.

Click the Add icon to add approval steps to the contract.

BID PACKAGES

Contract approval setup

Contract approval setup

Vendor change order approval setup

WORKFLOW
ASSIGNMENTS

CONTRACT
TEMPLATES

CONTRACTS

Payment form approval setup

Cancel

All existing projects will be affected with any approval setup changes. These changes will be applicable to future approvals only.

Contract type
Material contract
Subcontract
Service agleemen(
Rental agreement
Test

New type

Test contract type
NSK

NSK Contract Tvoe

InEight Inc. |

Approval details

Material contract approval details

®#|e®

Threshold amount & Steps Roles
id ~ $1222222.00 o Add anather step
[ Engineer Engineer
~

$1,000,000,000.00

Release 25.3

o Add anather step
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You can edit any approval setup from the organization or project settings area. To edit, select the
Contract type and the step and then click the Edit icon. You can also assign an approver as required by
the organization level when you edit a threshold at the project level. When you edit a project-level
step, the Edit approval slide-out panel includes a view of the organization-level steps at the same
threshold. If the organization-level steps require editing, you can assign a user. All other fields of the
organization steps are read-only. If the organization-level steps do not require editing, the entire step
is read-only.

Contract approval setup

Contr

Subcontract approval details

Organization steps that require editing are marked with a red triangle in the approval details. If there
are no project-level steps, you can assign approvers for the organization-level steps individually.

VENDOR APPROVAL SETUP

WORKFLOW
ASSIGMMENTS

BID PACKAGES CONTRACTS

Contract approval setup |\-fen|:|0rchange order approval setup | Payment form approval setup

The Vendor Change order workflow design is consistent with the Contract approval workflow.
Mandatory approval sets can be added at the project level using project settings or at an individual
contract level.

Like that of the Contract approval setup, you select the contract type from the left panel and create a
new one or edit an existing one. Assign threshold amounts can contain multiple steps and all steps for
all thresholds are always visible. To add a new step with a new threshold, select the Add another step
button.
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Vendor change order approval setup

Workflow steps added here are required at the contract level and cannot be edited in an
Contract al details
prov.

Material contract

Service agreement approval details
Subcontract

Service agreement |

®

Rental agreement

Test Threshold amount & Steps Users/Roles

New type a A 510000

Test contract type Stepl shyamala sathyanarayana

Newcontracttype

Add approval
Vendor change order approval setup

*Threshold amount
Workflow steps added here are requirec $100.00

Contract type Approval details

Material contract = R Approval step
Service agreement approval ¢

Subcontract *Step title

Service agreement | second approval |

Rental agreement

Threshold amount & Steps

Test *Assign approvers

New type A $100.00 @ users O Roles

Test contract type Stepl | |

Newcontracttype

NSK

ance ave
NSK

These steps appear as mandatory steps in a contract workflow assignments tab, Vendor change order
subtab for any contract created of the selected contract type. You can add additional contract specific
steps by selecting the plus icon.

Medi= All workflow steps added to a specific contract appear before steps added in the project

settings. Approval starts at the first step displayed and continues until all steps have
approved.

TIP You can add additional steps where the thresholds can be increased. If a Vendor change

order goes over the top amount, the first approval for first amount needs to be
approved, then the larger amount would be approved next.
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PAYMENT CLAIM APPROVAL SETUP AND PAYMENT FORM
APPROVAL SETUP

The Payment claim approval and Payment form approval is set up for each contract type. Mandatory
approval sets can be added at the organization and project levels or at an individual contract level.

Like the other approval setups, you select the contract type from the left panel and create a new
workflow or edit an existing one. Payment claim or payment form approval steps are performed for all
payment claim or form approvals. There are no thresholds. You can enter as many steps as necessary
for your organization and project. You can assign a user, role, or group to each step.

At the project level, you can set a toggle to allow payment forms to be automatically submitted after
they have been approved.

Payment form approval settings

Payment form approval setup

Contract type:

DOCUMENT APPROVAL SETUP

The Document approval setup lists document types for each contract type instead of thresholds. For a
contract type, you select a document type, and then add approval steps.

Page 82 of 377 InEight Inc. | Release 25.3



Contract User Guide

Document approval setup

Approval details

Service agreement approval details

Document type Users/Roles/Groups.

A Executed contract

Cancel

COPY A WORKFLOW

When threshold steps are the same within a workflow type (that is, a subtab), you can reduce set-up
time by copying a workflow threshold from one contract type to another. When you copy a threshold,
the amount, steps and step names, and users/roles are duplicated in the new contract type.

You can copy the workflow threshold by clicking a Threshold amount, which includes all the steps in
the threshold, and then clicking the Copy approval icon. You can copy only one threshold at a time. In
the slide-out window, select the Contract type from the Copy approval to contract type drop-down
menu. You make adjust the threshold amount, step title, and approvers. Click the Copy button. The
new approval shows in the list for the contract type.

W[eJp2 If a workflow step contains a group workflow, you cannot copy it to a workflow that
already has a group step.

PROJECT WORKFLOW PAGE

The project Workflow page enables you to view the details for your workflows for your project. It
collects information of all workflows that have been kicked off from Contract. Includes: Contract,
Payment Form, and Vendor Change Order workflows.

Access the Workflow page through the Project settings.
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Contracts -

Favorite projects & organizations

Actions 5100000 - PKS Incs

>

103361 _newda (The Bentway Project_n, b

105097 (Steel Training Job) »
[ o
O 73
[ TE}
O |
[ i}

Manage favorites

[ 2 : L

All projects & organizations
O |
| H Report >
= 2 Explore >
[ 13

Master data libraries >
[ i
0 77 Suite administration >
[ 13

Applications

Model

Plan I\ Contract

=) Document

Report ‘/ Progress & Change

By selecting the Workflows link, the Workflows screen opens.

Workflow type Contract ID Associated item
Payment form 7200000037 0001-Invoice )
Bayment form 1200000046 0001-Mobilization
Payment form 7200000037 0002-Payform 1
Payment form 1200000037 0003-Payform 1
Payment form 7200000037 0004-Payform 3
Payment form 7200000046 0002-Invoice 0002

0 | Payment form I 0001-Invoice 0001

0 | Paymentform 7300000043 0001-Invoice 001

[J | Payment form 7200000045 0002-Bond

O | Paymentform 7300000043 0002-Invoice 002

) | Paymentform 7200000046 0003-0003

] | Payment form T 0003-0003

) | Paymentform 7200000042 0001-001

{J | Payment form I 0003-Bond

] | Payment form 7200000042 0002-002

) | Paymentform 7400000029 0001-Pay App 001

) | Paymentform 7300000078 0001 -Invoice 003

= Schedule | Explore , Compliance
Control
Project Extensions
Project home Assigned users Design
Project details Operational rate codes
Billing
Settings Assigned operational resources
Workflows Assigned disciplines and commodities
@ Q

Status Started date/time Previous completed step Previous approver Current step Curr |
@ Becalled 12/14/2017 11:29:48 AM In approval
@ ZAppioved 12/21/2017 8:56:37 AM In approval Complete
° Approved 12/28/2017 4:28:56 PM KBS Compliance Complete
@ Appioved 12/28/2017 4:36:13PM KBS Compliance Complete
@ Appioved 12/28/2017 4:38:07 PM KBS Compliance Complete
@ 2pproved 01/17/2018 8:26:47 AM In approval Complete
@ 2pnroved 01/17/2018 8:46:06 AM In approval Complete
@ 2pnroved 01/24/2018 9:07:39 AM In approval Complete
@ Approved 01/24/2018 10:03:08 AM In approval Complete
@ 2oproved 02/23/2018 11:01:05 AM In approval Complete
@ Approved 02/23/2018 1:27:02 PM In approval Complete
@ Approved 02/23/2018 311:37 PM In approval Complete
@ Approved 02/23/2018 3:58:59 PM In approval Complete
© Bejected 03/15/2018 2:17:14 PM In approval
@ Approved 03/16/2018 8:47-42 AM In approval Complete
© Approved 03/19/2018 318:47 PM In approval Complete
© Anproved 04/04/2018 9:44:50 AM In approval Complete

Each column item, when selected, opens the details of that item. The Contract ID opens the contract

associated to that workflow type, etc.

Workdlow type Contract ID
Payment form 7200000037

Payment form

Paymentfom ‘7200000037
Payment form ‘200000037
Payment form 200000037
Paymentform 7200000045

O | Pamentfom 200000085
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Associsted tem
0001-invoice 1
0001-Mobilization

0002-Payform 1

0002:Invoice 0002

0001-Invoice 0001

Status Started s
Q hesalled 121420
© spproved 12721720
© sopoved 12728720
© soproved 12728720
© sopoved 12728720
© spproved ARz
© soproved o7/
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By selecting the items under the Status column, it allows you to view the progress of that payment

form.

ract |D Associated item Status Started date/time
1000429 7300000429-IW0-04 Traffi... 0 Approved 10/23/2019 8:50:17 AM
1000382 7200000882-Structural St... @ Recalled 09/05/2019 10:50:33 AM
1000789 D002-Payment form 2 @ Becalled 09/05/2019 9:45:00 AM
1000479 7300000479-IWO-testing I In approval 06/27/2019 2:04:41 PM
1000478 7300000478-IWO-testing 0 Rejected 06/27/201911:24:20 AM
1000105 D002-Progress invoice In approval 03/19/2019 11:39:31 PM
1000228 7300000228-IW0-04 Traffi.. 0 Approved 03/05/201912:03:02 PM
)000042 0003-0003 @& Approved 05/23/2018 10:19:54 AM

Previous completed step
Contract Approver
Project Engineer
Business Manager

In approval

step 1

In approval

Project Manager

In approval

The panel on the left of the screen enables you to view the general information on the contract

attached to this workflow. The body of the screen shows the whole life cycle of the workflow. If the
contract had been through workflow more than once, the most recent record is at the top of the
display, followed by the next recent. Each record shows the steps, and the user/role and how many

days each step has taken.

Workflows > 3752 - Payment form

ed on
07/08/2020 4:52:59 AM
Recalled
Cumulative days open.
5

Stepnumber  Step name User/Role Approver Step status Step completed date/time Step duration  Step ID

In approval 1 s1 Approved 05/15/2020 04:48:30 AM 16761

[ Rejected
(O Recalled 2 s1 Recalled

05/01/2020 04:49:15 AM 16768

3 52-1

< Workflows
In approval

0004-pay4
Stepnumber  Step name User/Role Approver Step status Step completed date/time Step duration  Step ID Workflow notes
1 s1 Approved 07/08/2020 04:52:09 AM 16761
2 s1 Approved 07/08/2020 04:52:59 AM 16768

Payment form

Associated item: 3 S2-1 In approval 5

0004-pay4
Stepnumber  Step name User/Role Approver Step status Step completed date/time Step duration  Step ID Workflow notes
1 s1 Approved 06/08/2020 04:50:14 AM 16761

In approval

2 s1 Rejected 06/08/2020 04:50:56 AM 16768

Started on:

07/08/2020 4:51:44 AM 3 s2-1

Workflow notes

2.0.4 PERMISSIONS

Permissions for each role are configured in Suite administration. Refer to the InEight Platform help

topics for more information about roles and permissions.
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2.0.4.11 SUPPORTING DOCUMENTS PERMISSIONS

If you want a role to be able to add, edit, or delete supporting documents for bid packages and
contracts, you must select the Add supporting documents, Edit supporting documents, and Delete
supporting documents permissions which are nested under the Edit bid packages and Edit contracts
permissions. The check boxes for Add supporting documents and Edit supporting documents are
enabled when the Edit contracts permission is selected. The check box for the Delete supporting
documents permission is enabled only when the Edit supporting documents permission is selected.

Contract

O selectall

Bid packages O selectall Contracts O selectall

O @) View bid packages [ Edit contracts

O ® Delete contracts

O Stop integration sync

O @ Add supporting documents

O [ Edit supporting documents

2.0.4.12 PAYMENT CLAIMS PERMISSIONS

Roles must have the Add payment claim, Edit payment claim, and Delete payment claim permissions to
use the payment claims functions in Contract. User must also have the Approve/Reject payment form
permissions to send a payment claim through the workflow.

2.0.4.13 ESIGNATURE PERMISSIONS

Roles must have the eSignature permission to correct DocuSign documents.

2.0.4.14 RETENTION RELEASE PERMISSIONS

Roles must have the Edit retention release permission to create, edit, convert or delete a retention
release invoice.
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CHAPTER 3 — NAVIGATION AND
BASIC TOOLS

The following topics describe how to use the pages and registers in Contract.
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3.0.1 PAGE NAVIGATION

In the following lesson, you will open the InEight cloud platform to explore the layout and start to
navigate around the application. You will access the platform through your web browser, using the link
provided by your manager or facilitator.

This takes you to the All projects & organizations page, where you can select any project you are
associated with.

If your project is not displayed on the initial screen, you can search by selecting the magnifying glass
icon in the top right corner. This search function will search all terms in all column:s.

@ ANprojects & organizations - @

ORGANIZATIONS

zation X
3 Incs : SA1000 - Kiewit Search...

3Incs : SAT1000 - Kiewit

NAVIGATE TO INEIGHT CONTRACT

1. From within the InEight cloud platform, click on the 15t Level Menu located at the top left of the
page. Then Select All projects & Organizations.
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All projects & organizatio -

Favorite projects & organizations

Central 70 KIC (102565) >

Manage favorites

All projects & organizations

Report >
Explore >
IMaster data libraries b2
Suite administration >

2. Select your project.

@ Allprojects & organizations -
PROJECTS ORGANIZATIONS
) Name Status Organization
a 105091 Steel Structure Job (USE for samp\is) Active 8100000 - (PKS Inc)
a 105092 Steel Structure Job Active 5100000 - (PKS Inc)
a 105093 Steel Structure Job 3 New $100000 - (PKS Inc)
a 105094 Steel Structure Job 4 Active 8100000 - (PKS Inc)

e When you select a project, it takes you to the Project home landing page

2 Project home +

Model Suite Custom project links a Change status @
PRosgct
Document . . SUITE M Ciosed | InPro Active
o d‘r& application
Jssue
Control a
Workspaces ) 3 5
2
Project librar
Jectiibrary Assigned users Control
Plan 0 0 0
Client change orders
aventty racking Clentchange orgrs
10 Manage budgets and
Work packaging forecasts 0 0 0
ogess ®
Daily planning Prime contract summary @
Weekdy time sheet Assigned employees 9 Bid packages
‘Time center Actual values
nspect ¥ é Unawarded orginal contact s
Contact
ontract ® 7 (o4 Executed Client CO's SNaN
Bid packages.
SNaN
Contracts Assigned equipme: Contracts
Change In Review Client CO's. SNaN.

3. Navigate to the InEight Contract application by selecting the 2"d level menu.
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Project home

4. Select Contract > Contracts from the 2"9 level menu.

Project home ~

Applications

Model Suite

Estimate

o]

Plan

| (@) contract

(@) Document

@ Control

Progress

Project

Project home

i

Project details
Settings

Workflows

@) Steel Training Job (105091)

Assigned users

Operational rate codes

@ Inspect

Assigned operational resources

Assigned disciplines and commodities

- Contract v

Bid packages

s v @
[m] D Descrip...

O | 1200000870  Rebarinst
O | 1200000869 ~ columnas
O | 7400001257 AnchorBol
O | 300000510 Environme
O | 7400001256  ABStructy
O | 7400001253  Structural

Type Status
Subcontract  Executed
Subcontract  Executed
Material ¢ In review
Senviceagr.  Executed
Material ¢ Draft

Material ¢ Draft

Confracts ~
SUPPORTING
CONTRACTS DOCUMENTS
Approv... R
Not ap.
Not ap. Success
Notsta
Not ap. Success
In appr...ses
Notsta

INVOICES

Vendor ...

Tonage Inc

Gilbert Con

Global Bolt

Duvics Inc

Merrill ron,

Merrill ron,

O

59690

55000

1043

52500

1043

S0

ACCRUALS /

RECEIPTS

Current..

$9690000

$5000000

51043961

$25000000

51043961

$1110000

CONTRACT
TEMPLATES

B B

Retaine...

Added by

addison ba.

addison ba.

addison ba.

addison ba.

addison ba.

dennis bolte

® Q

Added .
os/07/20°
os/07/20°
os/07/20°
os/07/20°
06106720

06/06/20°

Once on a page within InEight Contract, you can use the 3" |level menu to toggle between
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Contract modules (Bid package and Contracts).

Bid packages
CONTRACTS packag

Contracts

3.0.1.1 PROJECT HOME TILES

The Project home landing page contains Contract-specific shortcut tiles you can click on to navigate to
the appropriate Contract page. These tiles include:

» Bid packages

e Contracts

e Supporting documents

While the project is underway you see the status of all Bid packages, Contracts and Supporting
documents which support your project.

Bid packages ﬁ:ﬁ
N2
Unawarded

3 ®
Contracts ﬁ:ﬁ
&

Status Count
Executed 32
Non-executed 6
In approval 2
(O]
Supporting documents ﬁ:ﬁ
&

Pending Expiring

10 80

BID PACKAGES TILE

The Bid packages tile contains two key indicators:

» Awarded - Any bid package already associated to a vendor, and is ready to be or already
has been converted into a contract

» Unawarded - Scopes of work you are still processing

The View icon takes you to the Bid packages page to view all your bid packages.
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Bid packages (r:w
B
Unawarded

3 S

CONTRACTS TILE

The Contracts tile contains key indicators:
» Executed - Both Parties have signed the contract
» Non-executed - Contract is out for signature or the contract is still being drafted
 In approval - Waiting for signatures on all documents
» Rejected - Contract is rejected (need to expand

The View icon takes you to the Contracts tab of the Contracts page to view all your contracts.

Contracts @w
gy
Status Count
Ewecuted az
Mon-executed 6
In approval 2

SUPPORTING DOCUMENTS TILE

The Supporting documents tile contains three key indicators, reflecting the status of your supporting
documents:

» Pending

* Rejected

e Expiring
The View icon takes you to the Supporting Documents tab of the Contracts page, where you can view
all your supporting documentation.
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Supporting documents

Pending

10

Expiring

80 [5]

3.0.1.2 REGISTER PAGES

As discussed in Lesson 1 — InEight Contract Overview, there are two modules of InEight Contract, each
with their own page. Each of these main pages are considered register pages, meaning they consist of
rows and columns like a spreadsheet, to list out several lines of information at once.

BID PACKAGE PAGE

@ Steel Training Job (105091)

- Contract v

Bid Packages ¥

Actions ®

O D Descript...
] 3622 Ab - Train..
0 3620 Conerete £
] 3619 Earthwork
o 3618 Pre-Coolin
0 3617 PWB - Bid
] 3616 SC- Traini.-

Type
Permanent

Freight

Permanent...

Permanent

Permanent

Permanent...

Original...
$1274422
$10,000.00
$15,000.00
$125,000.00
$13,487,96.

$12,744,22..

Project...

01/07/2020

08/12/2019

09/07/2019

08/27/2019

10/08/2019

06/07/2019

CONTRACTS PAGE

K

2

Status Total available fl... Added by

Issued for owner r 19 addison balasbas
Issued for owner r 0 addison balasbas
Technical bid anal... 14 addison balasbas
Letter of intent/Aw. 20 addisen balasbas
Completed 0 addison balasbas
Issued for owner ... 0 susancappelloni

@ Q

Added on

06/07/2019

06/07/2019

06/07/2019

06/07/2019

06/06/2019

06/05/2019

0OOoo0o0oo0o00o0),

Not applicable:

i INvoICES jpsivand acTionems @)
Psync.. —  Vendorname ginalva. —  Cumentvalue
$1500 $1500
$ 40,007 00 $27.774.00
$2202600 $40007.00
$300 $300
5365000 $3650.00
$500.00 $ 50000
5000 000

5000

uuuuuuuuuuuuu

$363.00

3.0.1.3 CONTRACT TOOLS AND NAVIGATION

aaaaaa

7777777777

071772020

071772020

071772020

Each register page in InEight Contract contains menus and tools to help you navigate and perform key

functions on the page.
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Overview - Contract Register Page Tools and Navigation

T ™

1 Navigation Contains Home, 15t, 2"d and 3" level menus.

Bar
2 Profile View Notifications and Logout.
3 Tabs Depending on the page (e.g., Contracts page), you will have tabs you can
click on to access pertinent information.
4 Actions Contains key functions you can perform, specific to the page you are on
Menu such as, view import history, run a report, run a query, open an email log,
or launch the InEight Explore Contract dashboard.
5 Toolbar Contains functions for the register page you are currently viewing, with

specific editing options on the left (e.g., add, edit, delete, copy), and
options that involve the entire page on the right, including clear all filters,
search, import and export options, notes, and contract information. The
Contract register includes the Download purchase order icon on the right
side, which is enabled when you select a contract.

ACTIONS MENU

The Contracts’ Actions menu offers tasks that can be executed at the Contracts page level. They are:
* View import history
» Query builder
e Run report
e Email log
e Launch dashboard
» Generate contract document (on Contracts and VCO registers only)
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VIEW IMPORT HISTORY

Allows you to see the import history activities for documents which came into Contract. The history
includes the File name, location, status, total number of records, any errors and dates for modification.

QUERY BUILDER

When selected, a new window will open where you can create queries. You can choose from the
Default queries list for Contract or Payment forms/invoices or select Add new query to build a new
one. You can also access your previous queries which have been saved.

Add new «
Default query
Default queries A N

=

Contract query

Payment forms/Invoices query LR ETILEE

Saved queries ~ Column Operator Value
No saved queries available
@ Confract ID hd Contains hd ®
@ AND  vendor number v Contains v ®
—
@ AND | Contract Status hd Is equal to - Executed hd ®

RUN REPORT

Allows you to run canned reports for Buyout review, Procurement status and Payment form status.
When a report is selected, it will open in a new tab as shown below.

* Project ID [ ~| = Bid package type ID |(blanks) Engineered equipment Fi| s

* Discipline ID Blank Agaregates and Paving Bui “Sort by Account Code -

* standardVariance * show Al Bid Packages -
1< < of1 > >l O © 100% ~ v =] Find | Next

Buyout Review

Estimate to Award

org
£

Engineered equipment
o [ . pE— = o T S0 som) e

Freight

EMAIL LOG

From any project you have access to the Email log from the Action menu. When selected, the email log
will open then the support team will search and resend your email. The Email log is at the Organization
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level and is meant for your shared services team to find emails which were thought deleted or lost.

Resending the emails, when found, does not restart the workflow. It is a way to find lost, deleted or

misplaced emails.

LAUNCH DASHBOARD

You can launch the InEight Explore Contract dashboard without leaving the current application. When
you select Launch dashboard, Explore opens in a separate window.

Overview - Email log

1 Project ID ID of the project you want to find.

2 Recipient Name of the person who the email was sent to.
email ID

3 View email Selection of timeframe which you want (30 days or custom).
log for

4 Email log The list of emails sent.

5 Resend email Allows the selected emails to be resent to the receivers.

6 Reset Allow the parameters to reset to the default setting.

parameters

7 Information When selected opens a slide-out panel with information about the email
selected. It provides the date, subject, recipient and actual message.

8 Export Allows you to export selected emails.

9 Search Searches log for selected emails.

Project ID

Enter Project ID

O ey 1 17

Subject Sent date

o O

[0A19.1] Contract 7400001261 - 667078 - Conract Status change test for Project. 06/07/2019 071

=

[QA19.1] Contract 7400001254 - AB Structural Steel - Supply & Install for Project .. 06/07/2019 021

[0A19.1] Contract 7400001259 - 667078 - Conract Status change test for Project. 06/07/201912:5

0o

1na1911 0001 - td for Project 103351 .53

Sender

System genera
System genera

System genera

ted

ted

ted

ded

Recipient email id(s)
nagesh.rao@incight com
jitesh.rajoriya@ineight com
bhushan doddi@ineight com

bl
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TOOLBAR

The toolbar allows you to use functions for the register page displayed, with basic editing functions on
the left and other functions on the right. The toolbar options will change depending on what page you
are currently on. The toolbar displayed below is for the Bid Package page.

Overview - Toolbar

. | Contracts
Function Page

Add a new bid package/contract/issue to the register X X
page.

2 Edit Edit a selected bid package/contract on the register X X
page.

3 Delete Delete a selected bid package/contract from the X X

register page.

4 Copy Copy a bid package or contract that already exists.
5 Clearall  Clear all filters in the grid table. X X
filters

6 Export Export bid packages and contracts to an Excel X X
template.

7 Import Import bid packages and contracts from an Excel X X
template.

8 Notes View the notes for a selected bid package/contract X X

from the register page. The Notes slide out panel
displays the notes, and for contracts, the supporting
document notes. You can also add a note that will be
stamped with the author, time and date.

9 Info The Info slide out provides information about the X X
selected item.

10 Search Search all columns for content by the keyword you X X
enter.
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g % 8 = Clearall filters % % g g 9

3.0.1.4 CONTRACT RECORD PAGE

From the Bid Package and Contracts register pages, you can drill in on a specific item to open its record
and consume more information.

- lcon Function

1 Breadcrumbs  References the record you are on and the path to get there. You can
click on the breadcrumbs to go back to the register page.

2 Actions Menu  Contains key functions you can perform, specific to the page you are on
(e.g., view import history or run a report).

3 Tabs Depending on the page, you will have tabs you can click on to access
pertinent information.

4  Toolbar Contains functions for the page you are currently viewing, with specific
editing options on the left (e.g., add, edit, delete, copy), and options that
involve the entire page on the right (e.g., search, import and export
options, contract info).

5 Record Detailed information pertaining to the record tab you are on. This may be
Information in organized into a register or individual fields organized into sections.
6 View Menu Filter what appears on your display by selecting default viewsets from

the drop-down list, or by creating your own viewsets.

N
1 Contracts > 7200000789 - Construction... o
VENDOR CHANGE BACK CHARGES

Actions ¥ | | HEADER LINE ITEMS PAYMENT FORMS PAYMENT PROGRESS s >
ORDERLOG C
@ T 2 O B Q

Line items

Line ltem ... Type Material ID Description Product cat. Quantity UoM Unit price Per HNet amount

0001 Service Temp Conn 22100000 - HEAV! 1000 Lump Sum $15,000.00 $15,000.00

002 service Isolate 22100000 - HEAV' 1000 Lump Sum $112,000.00 $112,000.00
003 Service Construct.. 22100000 - HEAV' 1000 Lump Sum $1,320,000.00 $1,320,000 00
004 Service Disinfect 22100000 - HEAV' 1000 Lump Sum $49,000.00 $49,000 00

005 service Commission | 22100000 - HEAV' 1000 Lump Sum $151,000.00

006 Service a Restoration | 22100000 - HEAV' 1000 Lump Sum $264,000.00

$151,000.00

Oo0OoOoooaoaao

$264,000 00

Page 98 of 377 InEight Inc. | Release 25.3



Contract User Guide

3.0.2 COLUMNS

3.0.2.5 EXPAND COLUMNS

You can expand a column as needed to see the entire title of that column by using the same method
that you would in Excel. If you hover over the column, you will see that your cursor changes from the
arrow to the width selector.

Type Status Approval st.. ERP sy.. Vendor na... Current val...
Material contract Draft Not appli... Merrill Iron & ... $0.00
Material contract Draft Not appli... Merrill Iron & .. $14,000.00
Subcontract Executed Not appli... Success Gilbert Centr... $50,000.00
Subcontract Draft Not appli... Merrill Iron & .. $150,000.00
Subcontract Executed Not appli... Success Merrill Iron & .. $150,000.00
Subcontract Executed Not appli... Success Kiewit Financ... $200,000.00
Service agreement Executed Not appli... Success Duvics Inc $250,000.00

The following registers retain the new size if you leave and then come back to the page:

Bid Packages

Contract

Supporting Documents

Accruals/Receipts

Back Charges

Contract > Supporting Documents

3.0.2.6 MOVE COLUMNS

You can move a column from one place to another using drag and drop. If there are columns that you
do not use, you can hide and unhide them from the view as needed.
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MOVE COLUMNS

1. On the Contract > Contracts page, click on a column header, hold down the left mouse button
and drag the column to the right. It appears raised with a shadow box.

¢ Two black arrows will appear to guide you to the new column location

= | MENU Contract
$100000 - PKS Inc
~ NOV-13 Empire Floodgate |l > Contracts
SUPPORTING l
CONTRACTS DOCUMENTS
[m] D Description Type Original value Slalus' - mgmﬁmlue Current value

2. Drop the column header where you want to place the column.

3.0.2.7 SORT COLUMNS

You can sort any column by clicking once on the column header.

SORT COLUMNS

1. To sort a column, click on the column header.

¢ Avyellow up arrow appears on the column header indicating the column is sorted in
ascending order
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2. Click the column header again and the column will sort in descending order.

¢ The yellow arrow on the column header will now point down

1D @

3. Click the column header again to remove the sort.

InEight Inc. | Release 25.3 Page 101 of 377



Contract User Guide

» The yellow arrow will disappear

3.0.2.8 FILTER COLUMNS

You can filter columns to drill in on key information pertaining to your specific needs.

FILTER COLUMNS

1. From the Contracts page of InEight Contract, click the inverted pyramid of the Type column
header.

Actions - @

ID Description Type Status
7200000846 Concrete Foundations Subcontract Draft
7200000832 Structural Steel Modules 01-15 Subcontract Executed
7400001112 Structural Steel Modules 16-30 Material contract Draft
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» Depending on if the column rows are from a validated list, or a free text description,
you will get a drop-down list to filter the columns

« Ifthe rows are from a free text, you will filter by selecting the required operator and
entering a keyword

« Ifthe rows are from a validated list, you will filter by selecting the appropriate check
box

* You can also lock or unlock your filters using the lock buttons

» The operators available for selection are: Contains, Is equal to, Is not equal to, Starts
with, Does not contain, and Ends with

2. Hover over Filter, and a validated list appears.

Type Status Approval status ERP zync ..

Subcontract = Filter 4 Select All

Subcontract & Lock Subcontract

Material contra .
™ Matenal contract

Material contract Draft

Service agreement .

Subcontract Executed -
Clear | Filter

Subcontract Executed

3. Select Material contract from the drop-down list, then click Filter.
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Select All

Subcontract

«| Matenal contract

Service agreement
-

o)

» The Type column is filtered to Material contract, and the register only displays
contracts of that type

» The filter pyramid icon displays yellow to indicate the column is filtered

4. To clear afilter, click the filter pyramid icon, and then select Clear. To clear all filters, click
the Clear all filters button.

3.0.3 CUSTOM VIEWS

The Bid package, Contracts, Master agreements, and Vendor change order registers support custom
views. You can create custom views so that you can see a subset of columns of your choosing. You can
then save the view to use again or share the view with other users.

CREATE CUSTOM VIEW

Create a custom view when you want to view specific fields on the Bid package register.
1. Use the column chooser to add or delete columns from the current view, and then click Save.

2. Select Save view as from the View menu. The Save view dialog box opens.
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CONTRACTS

=  Type
Material c.

Material ¢

e

Material ¢

o

Material ¢

Material ¢

Material ¢,

Material ¢

1test Material ¢.

Material c.

AGREEMENTS

MASTER

Status

Draft

Draft

Draft

Draft

Draft

Draft

Draft

Draft

Draft

VENDOR CHANGE
ORDERS

Approv... =
Not ap
Not ap
Not ap.
Not ap.
Not ap
Not ap
Not ap.
Not ap.

Not ap

SUPPORTING
DOCUMENTS

Success

INVOICES

$500.00
$500.00
$500.00
$500.00
$0.00
$400.00
$0.00
$1.00

$10,00

ACCRUALS
RECEIPTS

Current.. =

$500.00
$500.00
$500.00
$500.00
$0.00
$400.00
$0.00
$1.00

$10,000.00

ACTION ITEMS

= Clear allfilters

Paidto.. =

$0.00
$0.00
$0.00
$0.00
$0.00
$0.00
$0.00
$0.00

$0.00

3. Enter a unique name for the view, and then click Save.

You can share custom views with other team members.

SHARE A CUSTOM VIEW

Retaine.. =

$0.00
$0.00
$0.00
$0.00
$0.00
$0.00
$0.00
$0.00

$0.00

View.
o

Added by =

Unsaved(All)

Al

Save view as.

New view

06/20/2022

06/07/2022

You can share custom views with other users, such as team members, so they can view the same

subset of columns to help with collaboration.

The users you are sharing the view with must have the View permission for that project.

1. From a saved custom view, select Share view from the View menu.

2. Enter the names of the users you want to share the view with, and then click Share. The users

receive a notification in their Notifications list.

Your team members can use and save your view.

SAVE A VIEW CREATED BY SOMEONE ELSE

When a team member sends you a custom view, you can save it and use as needed...
When a team member has shared a view with you, you receive a notification.

1. Click the Notifications icon in the upper right tool bar to see a list of notifications.

2. Click the notification to open it, and then click the link in the notification. A dialog box opens

prompting you to save the view.

3. Enter a unique name for the view, and then click Save.

3.0.4 IMPORTS AND EXPORTS

A convenient way to create items, such as bid packages, contracts, and line items, is through

importing. You can also export items to an Excel spreadsheet, so you can edit lines quickly or analyze

data using outside tools.
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3.0.4.9 IMPORT DATA

The import template lets you import data into the register. The template is a Microsoft Excel
spreadsheet with columns to import that correspond to columns on the register.

The first worksheet contains the Instructions for the template, where the legend and guidelines are
located. The guidelines describe the information on the Import template, exporting with data and how
to update or add more information to the existing data.

“« Data Masterdata

The second worksheet, Data, is where you enter your data for the import. The columns are color coded
to indicate which columns are system generated, required data, optional data and ignored data.

System System generated
REQUIRED Field is required for import
OPTIONAL Field is optional for import
IGNORED Field not to be populated

When using the template, keep in mind the following:
» The names of the tabs must not be changed.
« Column names in the Data sheet must not be changed.

e Columns must not be removed or rearranged.

Fle  Home Insert  Pagelayout  Formulas  Data  Review  view Help  Acrobat O Tell me what youwantto do | & share || = comments

i o ww| = - [ pw B BE @mE(I iy 0|0
o -
Paste E = Merge $ - % 9 | 8 gp | Condional Formatas Cell | Insert Delete Fommat Sort& Find& | Share Webex
- ¥ = 0030 | Formatting~ Tabler  Styles * - - & Clear~ Filter v Select~ | ThisFile

Clipboard I n ignment [ Number & Styles. Cells Editing Webex

Milestone[1]-Issued

for owner review- i i 1]-Issued |l 1]-issued i 1)-Issued

Actual completion forownerreview-  [forownerreview-  |for owner review-

ug08 DOR[8]-HVT3 Dor | DOR[9]-HVT2 Dor Forecasted duration _|Scheduled date’ |Scheduled duration__|Scheduled flo.
[Text [Text i

instructions  [JACEN Masterdata C]
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IMPORTING THE TEMPLATE
From the register, select the Import icon to begin the downloading.

Q Procurement and Project Support - Kru.. ~ Contract ~ Bid Packages ® ﬂ ® @

Actions v () = Clearall filters ® o Q

The Import data from template opens for you to import and save the template or for you to drop a
completed template to be uploaded. The template is updated frequently, and it is best practice to
download a new template each time you want to import any template.

Import bid package - Google Chrome

Import data from template

[import emplate
Data will be imported in to bid packages
Drag and drop the file here or browse
|
Update milestones based on |
i v e
|
@ Import Template -..xlsx A Show all X |

After the template has been downloaded, you complete the required areas. Do not change the name
of the spreadsheet tabs.

After you have completed the information in the template, you can import it into Contract.

IMPORT DATA FROM A TEMPLATE

Summary: Import data from a template when you want to add items in bulk.

Considerations: These steps assume that the Microsoft Excel template has been downloaded and
completed according to the template instructions. Because the available fields and their functionality
are frequently updated, it is best practice to download a new template each time you want to import
data.

Quick steps:
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1. From the Import data from template window, drag and drop or browse to your template file.

Import bid package - Google Chrome

Import data from template

ﬁ Import template

Datawill be imported in to bid packazes

Drag and drop the filc here or browse

Browse...

e

2. If the Import dialog box has a field that lets you indicate calculations, such as whether to update
milestones based on duration or dates, select the applicable option.

3. Click Import.

After you have imported your Excel file, you can correct any errors in the Import history window. After
you import, the new data shows in the register.

e} g=0 Contract validates the date format based on the person who imports the data. If the date
format does not match the preferences of that person, Contract generates an error in the
import history and removes the date.

3.0.4.10 EXPORT A TEMPLATE WITH DATA

From the register, select the Export icon, and then select With data.

I
> b

Total availab | Wwith data J
ne... Template 1.
ne... 0 | Jjagadish navath_..

In the exported file, you can use the Data worksheet to update the applicable fields before importing
it.
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iD

Engineered equipment 08/01/2019
Engineered equipment 07/01/2019
Engineered 12/2019

08/31/2019
07/31/2019
08/12/2019

currency

Susan Capp

[Text

Indian Rupee
Indian Rupee
Aruban Florin

Building
Building
Building

[=]

Issued for owr
Issued for owr
New
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CHAPTER 4 — BID PACKAGES

Bid packages are a scope of work that you intend to put under contract. Usually you create bid
packages after the estimate is complete and the project awarded, and use it to track design,
manufacturing, terms and conditions, and negotiations for long lead items, to follow their progress of
getting them from concept to under contract.
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4.0.1 BID PACKAGE OVERVIEW

InEight Contract allows the following seven types of Bid Packages:

1. Buyout Reserve - the amount of the original budget that is being set aside for completion
or additional purchases later. This is typically used when you want to account for all the
costs of your budget, including costs that have not yet been allocated to scopes of work in
other bid packages. You can create a Buyout Reserve bid package to account for your
unallocated costs, allowing all budgeted costs to be included in your reporting.

2. Engineered Equipment - a type of equipment that is engineered to unique specifications
and developed with a vendor or manufacture.

3. Freight - an agreement for shipping by a third party.

4. Permanent Material - for materials which have specifications tied to the prime contract.
These materials are part of the structure or project.

5. Professional Services - agreements for customized, knowledge-based service.

6. Rental Agreement - agreements that define the amount of rent you will pay and the term
during which you are responsible for paying it.

7. Subcontract - a contract for a company or a person to do work for another company as
part of a larger project.

TIP In Contract, you can create contracts for all your work, but it may not be necessary to
create bid packages for some of your contracts, such as professional services and rental
agreements.

4.0.1.1 OVERVIEW - BID PACKAGES PAGE

& ID = Descript. =  Type = | Projectdel. = Originalba. = Discipline = Risk = smuao; Totalavail. = Approvals.. = Kickoffdate = Milestonel. = Milestonel. = Customfie. = Customlis. =
Issued for b

/2412019 §4331.78200  Mechanical E High ssued for bid 8  Notstart 0an42ms 2 03n6/2018 testl

0411412022 $0.00 Lette ofinte. 8 Notappli 040642022

&
&
Engineered 03/01/2022 $100 ssued for . 16 Notappli 020242022 0 02/23/2022
Engineered 11/24/2019 §4331.78200  Mechanical E High Issued for bid 8  Recalled e+ 0314/2018 2 0311642018

TIP The bid package ID is automatically assigned after you submit your bid package.

I ™

1 View The View drop-down menu lets you specify whether to show all bid

Page 112 of 377 InEight Inc. | Release 25.3



Contract User Guide

T T S

packages in the register or only those in one of the following sets:

» Awarded
e Unawarded
 In approval
» Rejected

You can also create and share custom views.

2 Actions View import history; run buyout review, procurement status and payment
Menu form status reports; and launch the InEight Explore Contract dashboard.
The menu appears on all pages of the bid package. The Actions menu also
is available on the Overview, Milestones, and Supporting Document tabs
with the options to run reports or launch the Contract dashboard.

3 Tool Bar Allows you to add, edit, delete, copy, import, export, add notes, access
details and search bid packages.

4 Bid A list of your bid packages.
Package
Register

EDIT FIELDS FROM THE REGISTER

You can edit the following fields from the register:
e Custom lists 1 and 2
e Custom fields 1-10
 Kickoff date
e Project delivery date
e Original base value
¢ Contingency in estimate
¢ Un-awarded adjustment
e Escalation in estimate
e Owner change amount

¢ Milestone float, date, and duration fields

TIP When you hover over an editable cell, the borders are highlighted in blue.
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When you make a change to any of the editable fields, a blue dot shows to indicate a change that has

not been saved.

BID PACKAGES

= Risk = staus

E. High Issued for bid

Completed

Issuedforre..

ACTION ITEMS

Total avail...

49
85

26

Save changes =

= Kickoffdate = Milestonel. =

04/06/2022 05/02/2022 | 10

03/10/2022 03/14/2018 2

Approvals.. == Addedby = Addedon

Not appli.. —

Recalled ===

Not appli... 08/07/2020 08/06/2020 0

Clear all filters

Milestone[.. —
05/23/2022 ®
03/16/2018

08/06/2020

View: Al hd

C B B 0o Q

Custom fie.. =  Customlis.. =

test]

When you click Save changes, the edits are saved, and the blue dot is removed.

EDIT FIELDS IN BULK

When you need to make the same change to a free-text field or drop-down list in multiple bid

packages, you can select them all and edit them at the same time.

EDIT FIELDS IN BULK

Edit fields in bulk directly from the Bid packages register.

You can edit free-text fields and drop-down lists only.

1. Select the bid packages you want to edit, and then click the Edit icon. The Bulk edit dialog box

opens.

Bulk edit

Column

@ Select
Select
Account code
Currency
Custom list 1
Custom list 2
Custom field 1
Custom field 2

Cuietam fiald 2
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2. Select the field and the value. You can select up to five fields.

3. Click Save.

4.0.1.2 EDIT BID PACKAGE FIELDS IN BULK

You can edit field values for a single bid package or for multiple bid packages in bulk. Columns that can
be edited in bulk include those with free text or a drop-down list.

EDIT BID PACKAGE FIELDS IN BULK

When you need to make the same change to multiple bid packages, you can edit them in bulk instead
of updating them individually.

Only bid packages that are not yet approved or converted to a contract can be edited.

1. From the Bid package register, select the bid packages you want to edit, and then click the Edit
icon. The Bulk edit dialog box opens.

Bulk edit

Column

@ Select

Select

Custom list 2
Custom field 1
Custom field 2

Clictm fiald 2

2. Select the field you want to edit from the drop-down list, and then enter the value.

3. If you have additional fields, click the Add icon in the dialog box, and then repeat step 2. You can
add up to five fields.

4. Click Save to update the bid packages.
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4.0.2 BID PACKAGE IMPORT TEMPLATE

A convenient way to create bid packages is through import using the bid package import template. The
bid package template includes the budget and milestone dates for tracking progress of the bid package
and a division of responsibility.

Milestones are set at the project level, as well as Division of responsibilities and email addresses. In this
template, all columns which are required, and which are optional are indicated. This will enable you to
upload completed bid packages.

You can also export existing bid packages, make changes and reimport the data to append any bid
packages.

For more information about importing and exporting, see Imports and exports.

4.0.2.3 IMPORT DATA

When using the Bid package import template, keep the following in mind:
 All calculations are based on calendar days.

» The template supports the date format defined in your user preferences. Contract
validates the dates based on the person who imports the data. If the dates do not match
the preferences of that person, Contract generates an error in the import history and
removes the date.

» The template imports with DOR on project settings.
» Use email addresses for DOR user input.

4.0.2.4 UPDATING OR APPENDING EXISTING BID PACKAGES

New bid packages can be added as new rows to existing data import or through new imports.

 If abid package ID is provided, that bid package is updated. If the bid package ID is blank,
the system will generate a new ID.

» Only columns that have been added to the Bid package list are exported. Use the Column
Chooser to update your payout and save before exporting.

» WBS and Specifications are fully overwritten. For example, if there were four WBS codes
and you wanted to change only one WBS, you still must enter all four WBS codes in the
layout. If there is only one WBS code on the template, the system erases all existing
WBS’s and write this one only.
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* When milestones are completed, no updates to the preceding milestones are imported.
» When a column is not in the import layout, existing data is not affected.

« Ifthere is a column with a blank value, Contract erases the existing data or resets to
default data.

4.0.3 ADD BID PACKAGE

You can either add a bid package manually or import bid packages from an Excel template, as
described 4.0.2 Bid Package Import Template on page 116.

The following overviews provide key information on the fields you fill out when you create a bid

package manually.

Overview - Add Bid Package - Bid Package Details

e ossopuan

1 Description A brief overview which will show in your reports.
2 Type Used for grouping bid packages in your reports.

3 Discipline A specialty area for your bid package. The disciplines are pulled from the
master data set up in InEight Platform.

4 Currency The currency of your bid package. If the currency for the bid package is
different from the currency defined in the project details, Contract converts
the project currency to the contract currency when performing a budget
check during the workflow process. If a currency conversion rate has not
been configured, Contract assumes the rate is 1:1.

5 Kickoff date  The date you will issue your bid package to bidders or convertitto a

contract.
6 Project The date you need products delivered or services performed.
delivery
(Need By)
date

7 Package The overall breadth of your bid package.
scope

8 Risk The liability level of your bid package.
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Add bid package

o Bid packape seltails

s Description “Type
| Select cne -
[Disciphne «Curnency
Select ane - | L5 Dollas -
& Kickofl date * Prrogec] delreny (Nesded by) dale

Package scope

;0

et one i

:-'"
=
-

=l -

4.0.3.5 OVERVIEW - ADD BID PACKAGE - BUDGET

Overview - Add Bid Package - Budget

T T

1 Original base The amount from the estimate.
value
2 Contingency in A provision for incidental or unforeseen costs.
estimate
3 Escalation in Any anticipated increase in the estimate. This
estimate unusually represents the increase from when it
was originally estimated and when buyout
occurs.
4 Un-awarded Any amount from the original estimate which will

Page 118 of 377 InEight Inc. | Release 25.3



Contract User Guide

Overview - Add Bid Package - Budget (continued)

ST e T i

adjustment not be included now, but that you want to
contract.

For example, you may want to award only a
portion of the work to a sub now but plan to
award the remaining amount later. By putting
the unawarded amount in this field, you can still
account for the cost even though it is not yet
awarded.

5 Owner change The amount discussed for an owner change.
amount

Add bid package

o Budget

=Original base value

Contingency in estimate

Escalation in estimate o

Un-awarded adjustment

Owner change amount

Total estimate £0.00

(o] (o) (D

MeJi= Aside from the values associated with WBS code (covered later in this lesson), the values
defined on your bid packages are informational and do not integrate with other

applications until they become contracts.
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4.0.3.6 MANUALLY ADDING A BID PACKAGE

The following steps walk you through how to add a new bid package.

ADD A BID PACKAGE

1. Click on the 2"d level menu in the navigation bar, hover over Contract, and select Bid Packages.

@ Steel Training Job (105091) - Project home ¥

Applications
Applications

Model Suite Custom project links
Document Model Suite Estimate {3 &) Plan () Contract
e C i
Bid packages
Control &) Document @ Control @ Progress I—@_l
Workspaces Contracts
. @ Inspect s
Project
roject e Assigned users —
Plan
Project
Quantity tracking 4
Work packaging Project home Assigned users
Progress Project details Operational rate codes -
Daily planning mi
Settings Assigned operational resources
Weekly time sheet Assigned employees
Workflows Assigned disciplines and commodities
Time center
Inspect 7
Contract L)) oy

2. Click on the Add bid package icon to launch the bid package wizard.

@2 Steel Structure Job (105091) Contract v Bid packages

Actions v

ID fandd bid package | Description

12692 Rack 1800 and 2100 Bolted Connections

3. Complete the bid package details fields with the information below:
» Description: [Your Initials] - Training Bid Package
e Type: Permanent material
 Discipline: Metals
e Currency: US Dollar
» Kickoff date: [Pick date]
e Project Delivery (Need By) Date: [Pick date]
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» Package Scope: This is my structural steel training bid package
* Risk: Medium

Add bid package

o Bid package details

*Description «Type
[Your initials] Training Bid Package Permanent material -
Discipline sCurrency

Metals - US Dollar -
*Kickoff date “Project delivery (Needed by) date
08/24/2018 FEE 10/03/2018 ]

Package scope

This is my structural steel training bid package

Risk

Medium -

4. Click Next.

5. Complete the budget fields with the information below:
« Original base value: $12,744,227
Contingency in estimate: $10,000

Escalation in estimate: $0.00

Un-awarded adjustment: $0.00

Owner change amount: $0.00
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6. Click Submit and in the background your new bid package is assigned a unique ID and added to
the bid package register.

X
Add bid package
o Budget

*Orignal base value S12,744 227 00
Contingency in estimate 5100000.00
Escalation in estimate S0.00
Un-swarded ndjustment £0.00
Owner change amaunt S0.00
Total estimate £12.754.227.00

Cancel Back m

TIP The asterisk (*) at the beginning of a field name indicates it is a required field.

4.0.3.7 BID PACKAGE HEADER INFORMATION

When adding a new bid package, once you click Submit, the new bid package opens to the Overview
tab, with summary header information at the top of the page.

You can get to the bid package record page for existing bid packages as well by clicking the bid package
ID or Description from the Bid package register page, as shown below:
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@)  Steel Training Job (105091) - Contract + Bid Packages ~ ) 9

Actions - @ @ E @ Q

o] Descript... Type Original ... Project .. Kickoff ... Status Total available float Added by Added on

O 0O o0 o ojg|lo
E

3623 SC - Traini... Permanent... $12,74422.. 06/12/2019 04/08/2019 Issued for owner review 50 addison balasbas 06/10/2019 |

3622 Ab - Traini... Permanent... $12,74422.. 01/07/2020 06/10/2019 Issued for owner review 4 addison balasbas 06/07/2019

Concrete E Freight $10,000.00 08/12/2019 08/01/2019 Issued for owner review (] addison balasbas 06/07/2019
3619 Earthwork Permanent.. $15,000.00 09/07/2019 08/24/2019 Technical bid analysis 14 addison balasbas 06/07/2019

361 Pre-Coolin Permanent.. $125,000.00 08/27/2019 08/07/2019 Letter of intent/Award 20 addison balasbas 06/07/2019

361 PWB - Bid Permanent_. 51348796 10/08/2019 08/28/2019 Completed 1] addison balasbas 06/06/2019

Overview - Bid Package Header Information

Information

Group Description

1 Breadcrumbs  Shows your bid package ID and description. Click Bid packages to
return to the bid package register page.

2 Status Shows as New until you add milestones to your bid package. Then, the
status shows the milestone you are currently working to complete.

3 Original base  Shows the amount from the estimate you entered when you created the
value bid package.

4  Total estimate Shows the sum of the original base value, contingency in estimate,
escalation in estimate, un-awarded adjustment and owner change
amounts.

5 Approval Shows the status of the bid package approval.
status

6 Bid package Overview, Milestones, Supporting Documents, and Workflow
tabs Assignments.

7 Convert to Opens and prepopulates the Add contract dialog box. You must have
contract button selected values in the *Type, *Effective date and *Vendor fields. Click
the Add button to convert your bid package into a contract.

8 Cancel and The Cancel button closes your bid package and returns you to the bid
Save buttons  package register. The Save button saves changes you make to your bid
package. The Save and start approval button shows when there is a
workflow step at the organization, project, or bid package level. Click to
save your changes and start the approval process
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Bidpackages > 168~
Status 2 Original base value Total estimate el Approval status
Delivery

$10,000.00 $21,788.00
O [ oo oo RIS |

4.0.4 OVERVIEW TAB

Bid packages default to the Overview tab (indicated by a blue underline). There are seven information
groups. Values within the Bid package detail and Budget information groups are auto populated from
information you entered during bid package creation.

Information
Group Description

Bid package Specific attributes that describe and uniquely identify your bid package.
details

Budget Total estimated cost of the scope of work you intend to put under contract.
Additional A section that includes drop-down subsections for division of responsibilities,
details specifications, reporting, and custom fields.

WBS Work Breakdown Structure is a specific element of the scope of work to be

completed. If the project is reimported from inEight Estimate after creation, this
field is blank, and you must manually update it with a new WBS code.

Reference Agreement ID and value fields are retained in the Reference data sections of
data the contract after converting a bid package to a contract.

Meyp=n |f the Agreement ID or value is updated, similar to the DOR, it will
not go back to the Bid Package and update it there. It only happens

when you are converting from a Bid Package to a Contract.

eSign Lists of eSign recipients, Project contacts, and Division of responsibility names
that default as signees for an eSignature.

4.0.4.8 ADDING INFORMATION AND USER ASSIGNMENTS

In the following step by steps, you will add your awarded vendor, the account code, a specification, the
WABS code and assign users responsibilities within your bid package.
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ADD AWARDED VENDOR

1. Ensure the Overview tab of the correct bid package is selected.

OVERVIEW ( MILESTOMNES

SUPPORTIMG

DOCUMENTS

2. In the Bid package details information group click the + Add Awarded Vendor Icon.

%:Ic awarded vendor

3. Search for the search box in the top right and enter Merrill Iron & Steel.

- WA 2| 1ot & Steel

he 103 T oo 3iacindiods oo

4. Click the radio button to select Merrill Iron & Steel.

L 0010011153

Vendor 1D Vendor Name

Merrill Iron & Steel Inc

Ve

5. Click the Select button in the lower right to add the awarded vendor to your bid package and

close the dialogue box.

InEight Inc. | Release 25.3
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ADD ACCOUNT CODE

1. Ensure the Overview tab of the correct bid package is selected.

SUPPORTING

OVERVIEW / MILESTOMNES DOCUMENTS

2. In the Bid package details information group click the + Add account code Icon.

Account code

Add account code

3. Search for account code 62.03.02.

—p 62.03.03

4. Click the radio button to select the code.

/ Account code Description

L 62.03.02 Structural Steel Industrial Structures

P Cobriceiinal Cbcal bodloiniciol Bodociolilondlice

5. Click the Add button and the dialogue box closes.

Cancel
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ADD SPECIFICATIONS

1. Ensure the Overview tab of the correct bid package is selected.

OVERVIEW ( MILESTOMNES

SUPPORTIMG
DOCUMENTS

2. Expand the Specifications subsection of the Additional details information group, and click the

Add Specification Icon.

Additional details

Division of responsibilities (DOR) v

() Add specification

Reporting v

Custom fields v

3. Type AZ 22553-8976 in the text box.

Specifications

-

A7 22553-89T6

@ Add Specification

4. Click the Save button.

Specifications

Cancel

AZ 22553-8976

@ Add Specification

S
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1. Ensure the Overview tab of the correct bid package is selected.

SUPPORTING
DOCUMENTS

OVERVIEW / MILESTONES

Contract User Guide

2. In the WBS information group type 1074 in the WBS code field and click 1074 Erect Steel — Heavy

on the flyout window to populate the grid.

Current estimate

WBS code Description Current budget
@ 1U?4I‘/ Hint: type 'abe’
[r] Description $0.00
1074 %‘/Erect Steel - Heavy
3. Click the Add icon to commit it to the grid.
WEBS code Description Current budget Current estimate
J1 o74| Erect Steel - Heavy 5800,000.00 $20,700.00
Total 50.00
WEBS code Description Current budget Current estimate
@ Hint: type '"123' Hint: type "abc’
= 1074 Erect Steel - Heavy 520,700.00
$800,000.00 $20,700.00

Total

» Note that your Current budget and Current estimate values come directly from

Control

(\[e3p= If you use the same WBS item on more than one bid package, it will import the total
Current budget and Current estimate values for that item onto each bid package (rather

than dividing the total values between packages).
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ASSIGN DIVISION OF RESPONSIBILITIES

1. Ensure the Overview tab of the correct bid package is selected.

SUPPORTIMG

OVERVIEW ( MILESTOMNES DOCUMENTS

2. In the Division of responsibilities (DOR) subsection of the Additional details information group,
click the drop-down arrow to assign the following people to their roles:

» Responsible engineer: Bhavna Gupta

Contract manager: Paul Bennion

Purchasing manager: Paul Trippi

Field handler: Susan Cappelloni

Purchasing agent: Bridgette Quintero

Additional details

>

Division of responsibilities (DOR)

Responsible engineer

“

“

NONON N

“

Field handler

“

TIP The drop-down list will show you the names only of those assigned as members of
your project.

3. Click Save and a notification indicates your bid package has been updated.

@ Steel Structure Job (105091) Bid package updated.

Bid packages > 12696 - [Your Initials] - Training ...

Vendor Contract Status Qriginal base value Total estimate
Merrill Iron & Steel Inc 7400001111 - [Your Initials] - Anc... New
§12,744,227.00 $12,754,227.00
OVERVIEW  MILESTONES ~ SortORTING =2
: DOCUMENTS
R
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AGREEMENT AND PURCHASE ORDER FIELDS CONVERTED
WITH BID PACKAGE

When you convert a bid package to a contract, the Agreement ID, Agreement value, Purchase order ID,
and Purchase order value fields in the External purchase agreement section are retained in the

Reference data section of the contract.

Bid package details

(¥) Add awarded vendor

Budget

*Description “Type

Underground work Professienal services v
Discipline ~Currency

Concrete Us Dollar -
Package scope
Risk Account code

Selectane (%) dd account code

WBS code Description Current budget Current estimate
Total $0.00 $0.00

~Original base value
Contingency in estimate
Escalation in estimate

Un-awarded adjustment

$8,500.00

$0.00

$0.00

$0.00

Owner change amount

Total estimate

Additional details

$0.00

$8,500.00

Contract User Guide

Division of responsibilities (DOR)

Specifications
Reporting

Custom fields

Reference data

Agreement ID

240233448

Purchase order 1D

Agreement value

$8,500.00

Purchase order value
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Details Additional details Associated bid package 259-Underaiou - (=)
Cantract status Approval status
Bid package budget w
Draft -
Division of responsibilities (DOR) ~
*Description Tt o
Underground work [
Liguidated damages w
“Type Subitype Technical field assistance v
- elect one -
Reporting (Switch) v
"Effectve date "Wendor
02/24/2020 i 0000001036 - Kiewit Infrastructure West Co. | ¥ Reference data
. Pé_.'l“é' t term *Vendor cummenc y :IJII--"'I—: tiD :-Ju--‘:'l--: tvalue
ntercompany Payment terms with Payment blo. US Dollar - B40Z33443 $8,500.00

*Delivery address Purchase order 1D Purchase order value

This connection is not maintained beyond conversion. If you manually change these fields after
conversion in either the bid package or contract, the changes are not reflected in both locations.

4.0.4.9 CREATE FORMS OR MAIL IN INEIGHT DOCUMENT

If a project is associated with Document, you can create a form or mail item from a bid package.
Document saves the form or mail and creates a link in the Supporting documents tab.

Single-sign on is available for Contract-to-Document features, such as creating mail or a form. When
you use one of these features, the Document sign-on page opens, and you can enter your credentials.
This creates a sign-on token that lets you remain signed in until the session ends. The first time you
sign in to Document, a black secondary window and the Document home window also open. You can
close these windows. Single sign-on is activated, and they are not shown again.

Me)g= Creating forms or mail is initiated from the Actions menu. If Actions > Create document >
Form or Mail is inactive, you can select the Settings (cogwheel) icon in the Actions menu
to set up integration with Document.

CREATE A FORM IN DOCUMENT

You can create a Client RFl or Request For Information form in Document and add it to the Supporting
documents for the bid package in a single procedure.

InEight Inc. | Release 25.3 Page 131 of 377



Contract User Guide

1. From the Details page go to Actions > Create document, and then select Form.

2. If you are not already signed into Document, use your credentials to sign into InEight Document.

2

User ID

DOCUMENT

"=~ TeamBinder

Company ID
Password
+ Remember Login User ID & Company ID

Multiple Accounts? Login via Profile

English | Frangais | Italiano | Espaiol | (&6 | Farsi

Contact Support +1(800) 801 1426

Bookmark

A sign-in token is created that lets you remain signed in to Document until the session ends. If
this is the first time you are signing in to Document from Contract, a black secondary window
and the Document Home window are shown. After you close these windows, single sign-on
(SSO) to Document is activated, and they are not shown again.

3. The Create new form dialog box opens. Select the form type, and then click Next. The Request
for information window opens in Document.

4. Complete the form, and then select the users for distribution of your form. A success message is
shown and a link to the form is added to the Add supporting documents dialog box.

5. Click Add to add the form as a supporting document.

CREATE MAIL IN DOCUMENT

You can create a mail item in Document and add it to the Supporting documents for the bid package in
a single procedure.

1. From the Details page go to Actions > Create document > Mail.

2. If you are not already signed into Document, use your credentials to sign into InEight Document.
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DOCUMENT

"=~ TeamBinder

)

User ID

Company ID

Password

+ Remember Login User ID & Company ID

Multiple Accounts? Login via Profile

English | Frangais | Italiano | Espaiol | (&6 | Farsi

Contact Support +1(800) 801 1426

Bookmark This Page | Forgot your password?

3. The Create Document Mail dialog box opens. Select the mail type from the list defined in
Document that are specific to the project's mail type, and then click Next.

X

Create Document Mail

o Select Mail type

Select the Mail type to be created. Upon clicking the ‘Create’ button, you will be taken to InEight Document to create the mail
*Mail type

Change Order

-

Change Order Response
Formal Letter
General Correspondence
IDF Response

Issue Documentation Form

4. Optionally add an attachment. If you selected documents on the Supporting documents page
before you started the action, they are automatically included.

¢ To add an attachment from the Supporting documents tab, click Next. The Select
documents dialog box opens. You can choose documents from the Supporting documents
tab with the Document source My computer. After you attach the documents, click Create.
The Mail module opens in Document with your attachments included.

¢ To add an attachment in Document, click Create. The Mail module opens in Document.

Click Attach files > Attach Documents, where you can search for the document. After you
select a document, click Save.

¢ To send mail without an attachment, click Create. The Mail module in Document opens.
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5. Enter information in the To and Subject fields. The other fields on the page are optional. Enter or
update the fields as needed for the mail message, and then click Send. A summary page opens.

6. Edit links and notes, if needed. The mail is added in Document.

7. Close the Document window. You are then prompted to add the mail as a supporting document
in Contract. The document type defaults to Correspondence but can be changed.

8. Click Save to save the mail to the Supporting documents page.

4.0.4.10 ESIGN

The eSign section lets you view or add recipients to be used as default eSign signees. This section has
subsections for eSign, Project contacts, and division of responsibility. All signees must be added to at
least one section.

¢ Names in the eSign section are populated from the project eSign setup tab (Project settings >
Contract > Configurations >eSign setup). You can also manually enter the names of the signees.

¢ Names in the Project contacts section are populated with contact information from Project
contacts added in Project details. This section is for reference only. If you want to add or change
recipients, you must edit the Project Contacts.

¢ Names in the Division of responsibility section are populated with user information defined in
the Division of responsibilities section of the contract details. The company is populated from the
Company legal name in Project details. The title field is always blank. This section is for reference
only. If you want to add or change recipients, you must edit them in the Division of responsibility
section of the Additional details.

4.0.5 MILESTONES TAB

The Milestones tab displays the Scheduled dates and Milestones for your bid package, organized into
information groups.
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@)  Steel Structure Job (105091)

Bid packages > 12696 - undefined

-

Contract - Bid packages

®

Vendor Contract Status Original base value Total estimate
Merrill Iron & Steel Inc 7400001111 - [Your Initials] - Anc... New $ $
SUPPORTING
UVEHVIEW\MILESTONES DOCUMENTS
—
=3
Scheduled dates Milestones Total available float. 0 days (7)  Remaining float. 0 days
(¥) Milestone Scheduled Forecasted Actual comple..  Complete
Scheduled item Value
Duration (days) ~ Completion date  Float (days) Duration (days) ~ Gompletion date
+ Kickoff date 07/12/2018 [
+ Project delivery (Needed by) date 09/03/2018 [
Contract delivery (Lead time) (days) 0
Contract target execution date 09/03/2018 [7)
2018 InEight Inc. Privacy and Terms | v18.3 INEIGHT

4.0.5.11 SCHEDULED DATES INFORMATION GROUP

In the Scheduled dates information group, the Kickoff date and Project delivery (Needed by) date are

auto populated from the bid package wizard.

The Project delivery (Needed by) date represents when the material needs to be on site or when the

services need to happen. It is the date you are driving towards for having the contract finalized.

In the Contract delivery (Lead time) (days) field, you can indicate how much lead time you need for the
contract to be delivered, which is subtracted from the Project delivery (Needed by) date to calculate

the Contract target execution date field.

InEight Inc. | Release 25.3
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Scheduled dates

Scheduled item Value

* Kickoff date 08/02/2018 [
* Project delivery (Needed by) date 09/03/2018 [7
Contract delivery (Lead time) (days) 15
Contract target execution date 08/19/2018 7

4.0.5.12 MILESTONES INFORMATION GROUP

In the Milestones information group, you can view the milestones needed to complete the bid
package. Some of these milestones may already exist on the bid package by default if specified in your
project settings (see tip below). Depending on the scope and complexity of the bid package, you may
want to add additional milestones to track the package’s progress effectively. You can tell which
milestones you added manually because you have an option to remove them, by clicking on the
remove icon (minus sign).

Milestones
@ Milestone Scheduled
Duration (days)
Issued for owner review ]
6 Request for proposal ]
Proposal received ]
Letter of intent/Award 0
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TIP Customer bid package milestones can be added for our organization by your project

Milestones
These bid package milestones will be available for projects in this organization
English Spanish E R -
Position Milestone Required Milestone
= =
1 Issued for owner review No Issued for owner review @
2 Issued for review Yes . Issued for review @
3 Issued for bid No Issued for bid ®
Request for proposal Yes . Request for proposa @
5 Proposal received Proposal received @
[ Technical bid analysis Technical bid analysis @
-

4.0.5.13 SCHEDULED SECTION

administrator under Organization > Settings > Contract > Milestones.

For each milestone, there is a Scheduled section, where you can enter each milestone’s duration in
days or completion date. Each milestone has a completion date, set to the bid package’s Kickoff date
by default. Contract calculates the completion date or duration based on the values you enter. For
example, if you enter a duration, Contract calculates the completion date based on the milestone's
duration. If you enter a completion date, Contract calculates the duration based on the date.

Milestones
@ Milestone Scheduled
Duration (days)
Issued for owner review ]
@ Request for proposal ]
Proposal received 0
Letter of intent/Award 0

InEight Inc. | Release 25.3
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FORECASTED SECTION

Each milestone also contains a Forecasted section to help you predict the actual timeline of the bid
package. Use the Duration (days) or Completion date fields to adjust the Forecasted Completion dates.
The Completion date defaults for each milestone from the Kickoff date.

@ Milestone Scheduled Forecasted
Duration (days) Completion date Float (days) Duration (days) Completion date
@ Issued for owner review 0 08/28/2018 0 0 08/28/2018
(®  1ssued for bid 7 09/04/2018 Lx, 7 09/04/2018
(®  Request for proposal 14 09/18/2018 0 14 09/18/2018
(®  Proposal received 1 09/19/2018 0 1 09/19/2018
Letter of intent/Award 5 09/24/2018 0 5 09/24/2018

TIP The Duration (days) field and Completion date field work in tandem. Changing the
Duration of any milestone will change its Completion date and vice versa.

The Milestones information group also shows the float for the bid package. You can set the Calculate
float based on field to calculate the float based on the contract target execution date or the project

delivery (Needed by) date. The total available float and the remaining float for the bid package are
shown.

Total available float: 2days ()  Remaining float: 0 days
o

Actual completion date Complete
Completion date
f26/2018 08/27/2018 [-
A RLLEE [

Your float days calculated as the float days from the previous milestone plus the duration days of the
current milestone. The remaining float days are calculated as the difference between the Contract
target execution date and the date of the last forcasted milestone. The Total available float is now
calculated as the remaining float plus the sum of uncompleted scheduled milestone float..
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SCheduIed dates MI|ESt0nes Total available float: 15 days :!: Remaining float: 15 days
@ Milestone Scheduled Forecasted Actual comple..  Complete
Scheduled item Value Duration (days) ~ Completiond..  Float (days) Duration (days) ~ Gompletion d...
(=) lssuedforo. 0 08/28/2018 0 o 08/28/2018 =
= Kickoff date 08/28/2018 [
(=) ssuedforb. | 7 09/04/2018 0 7 09/04/2018 =
« Project delivery (Needed by) date 10/09/2018 £ O Requestior. 14 09/18/2018 a n 09/18/2018 =
Contract delivery (Lead time) (days) 0 (=) Proposal e 1 09/19/2018 0 1 09/19/2018 =

Contract target execution date 10/09/2018 [ Letter of int... 5 09/24/2018 i} 5 09/24/2018 ][,'.j

If you need any lead time for the contract delivery, you can enter this in the Contract delivery (Lead
time) (days) field, and it will subtract it from your float days. In this example, entering two weeks of
lead time lowers the total available float from 15 days to 1 day.

Scheduled dates M||ESt0nes Total available float: 1 days Q: Remaining float: 1 days
(&) Milestone Scheduled Forecasted Actual comple..  Complete
Scheduled item Value Duration (days)  Completiond..  Float (days) Duration (days)  Completion d...
(=) Issuedforo.. 0 08/28/2018 0 0 08/28/2018 =]
+ Kickoff date 08/28/2018 ()
) issuedforb. T 09/04/2018 0 7 09/04/2018 =
» Project defivery (Needed by) date 10/09/2013 5 () Requestfor. 14 09/13/2018 0 14 09/18/2018 =
Contract delivery (Lead time) {days) ©  proposalre ; 09/19/2018 0 ; 0919/2018 =
Contract target exccution date 09/25/2018) [} Letterofint.. & 09/24/2018 0 5 09/24/2018 =

You can allocate your total available float days to your milestones as needed. As you do so, the
Remaining float will deduct the days you have allocated to indicate how many float days you have
remaining. In this example, 1 float day is allocated to the Issued for bid milestone. The date of the

following milestone (Request for Proposal) moves forward a day and the Remaining float changes from
1to 0.

Scheduled daTeS MIleStones Total available float: 1 days \1: |F\emaining float: 0 days |

@ Milestone Scheduled Forecasted Actual comple..  Complete
Scheduled item Value Duration (days)  Completiond..  Float (days) Duration (days) ~ Completion d...

O ssuedforo. 0 08/28/2018 0 0 08/28/2018 =
* Kickoff date 08/28/2018 [

(=) issuedforb 7 09/04/2018 1 | 7 09/04/2018 =
+ Project delivery (Needed by) date 10/09/2018 [7]

& Request for 14 | 09/19/2018 0 14 09/18/2018 =
Contract delivery (Lead time) (days) 14

= Poposalre. 1 09/20/2018 0 1 09/19/2018 =
Contract target execution date 09/25/2018 [

Letter of int. 5 09/25/2018 o 5 09/24/2018 1[:3

The following steps walk you through how to add milestones to a bid package and define their
scheduled and forecast completion dates.
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ADD MILESTONES

1. Select [Your Initials] Training Bid Package from the Bid package page.

Steel Structure Job (Use for Samples) (.. ~ Contract ¥ Bid packages ¥
Actions b @
[ ID Description Type Status
. 13419 /WB - Training Bid Pack... Permanent material Letter c
[ 13191 Concrete Fxecuted Freiaht lzsued:

2. Select the Milestones tab.

\ SUPPORTING

OVERVIEW MILESTONES DOCUMENTS

» Before adding milestones, you will edit some of your Scheduled dates fields

3. Under the Scheduled dates information group, change the Kickoff date to [today’s date].

Scheduled dates

Scheduled item Value
_ e
* Kickoff date 08/28/2018 =

4. Change the Project delivery (Needed by) date to [six weeks from today’s date].
5. Enter 14 in the Contract delivery (Lead time) (days) field.
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Scheduled dates

Scheduled item Value

* Kickoff date 08/28/2018 [
* Project delivery (Needed by) date 10/09/2018 331
Contract delivery (Lead time) (days)
Gontract target execution date 09/25/2018 &=

6. Under the Milestones information group, click the Add icon to add a new milestone.

Milestones

Milestone Scheduled

\ Duration (day

7. From the Add milestones window, select the following available milestones by clicking their
respective Add icons: (these need to be added in Organization settings)

¢ |ssued for owner review

Issued for bid

Request for proposal

Proposal received

Letter of intent/Award

InEight Inc. | Release 25.3 Page 141 of 377



Add milestones

Available milestones

Milestone
@ Request for proposal
@ Proposal received
@ Technical bid analysis
@ Letter of intent/Award
@ elivery
Selected milestones
Issued for bid ¢ Issued for owner review
Request for proposal 3 Proposal received

Letter of intent/Award

8. Click Add.

» The selected milestones are now added to your bid package

Milestones

Contract User Guide

®

ONONONRO,

TIP

Milestone

Issued for owner review
Issued for bid
Request for proposal

Proposal received

Letter of intent/Award

Scheduled

Duration (days) Completion date
0 08/24/2018
0 08/24/2018
0 08/24/2018
0 08/24/2018
0 08/24/2018

Float {days)

You can delete milestones you added by clicking the remove icon. Milestones that
are required per the Project Settings cannot be removed.

Page 142 of 377

InEight Inc. | Release 25.3



Contract User Guide

9. Enter Scheduled Durations for your milestones as indicated in the image below:

@ Milestone Scheduled
Duration (days) Completion date
@ |ssued for owne... 0 08/28/2018
@ |ssued for bid 7 09/04/2018
@ Request for pro... 14 09/18/2018
@ Froposal received 1 09/19/2018
Letter of intent/... 5 09/24/2018

10. Change the completion dates for your forecasted items to match your scheduled completion
dates (example below).

Forecasted

Duration (days) Completion date
0 08/28/2018
T 09/04/2018
14 09/18/2018
1 09/19/2018
5 09/24/2018
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¢ Note that you have 1 remaining float day available of your total available float days

l Cancel J

Total available float: 1 days @ Remaining float: 1 days

Actual completion..  Complete

Completion date

08/28/2018 =

11. Enter 1 in the Float (days) field for the Issued for bid milestone.

@ Milestone Scheduled i

Duration (days) Completion date Float (days) [
9 Issued for owne... 0 08/28/2018 0 0
@ Issued for bid T 09/04/2018 1 T
@ Request for pro.. 14 09/19/2018 0 1

e Of your 1 available float day, you now have 0 remaining

Milestones Total available float: 1 days () | Remaining float: 0 days
® Milestone Scheduled Forecasted Actual completion date Gomplete
Duration {days) Completion date Float (days) Duration (days) Completion date

() Issued forownerreview | 0 08/28/2018 0 0 08/28/2018 (=]
(&) 1ssued forbid 7 09/04/2018 1 7 09/04/2018 =
(©  Request for proposal 14 09/19/2018 [ 1 09/18/2018 =
©  Proposal received 1 09/20/2018 0 1 09119/2018 =

Letter of intent/Award 5 09/25/2018 1) 5 09/24/2018 ‘Cj

MILESTONE COMPLETION

When you enter the actual completion date, the milestone Complete flag is automatically filled in. If
you delete the date, the flag no longer shows as filled in.
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@ Milestone Scheduled Forecasted Actual completion date Complete
Duration (days) Completion date Float (days) Duration (days) Completion date
Issued for owner review 2 08/26/2018 1 2 08/26/2018 [[..-J
(S Request for proposal 5 09/01/2018 1 5 0g/31/2018 /[CJ
Proposal received 2 09/04/2018 o 2 09/02/2018 [CJ
Letter of intent/Award 3 09/07/2018 o 3 09/05/2018 =

In the bid package’s header section, the Status of the bid package will then reflect the next incomplete
Milestone.

Bid packages > 13190 - Earthwork

Status
Request for proposal

When you create a bid package, a button appears on the top-right of the bid package record, to allow
you to convert the bid package to a contract. You will learn how to convert a bid package to a contract
in the next lesson.

Convert to contract (+)
.

4.0.6 SUPPORTING DOCUMENTS TAB

On the Bid Package Supporting Documents Tab, you can upload multiple documents such as:

e Blueprints/ drawings

Project Plans

Specifications

Quantity of Materials
Sketches

Timelines for Completion / Schedule
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» Background Information
» Information About Potential Delays

Any Document that is relevant to the bid package should be uploaded. The supporting documents can
be a file or a link. You can also upload documents from InEight Document. The Bid packages Supporting
documents register lists all documents associated to the bid package.

original base value Total estimate Approval status

$ 200.00000 $2,000.00000

ADD A SUPPORTING DOCUMENT

1. From the Supporting documents tab, click the Add supporting document icon, and then select
New Supporting document.

®~

Mew Supporting document nk

From InEight Document e

2. Complete the Add Supporting document page information. The Document type field uses the
defined list of document types that are available in Contract. You might have to enter additional
information depending on the document type. For example, if you use the Tax ID document
type, you enter a value in the Tax identification number field.

3. Enteralink to a document, or upload a file you have stored on your local laptop by clicking
Select File, and then selecting a file.

4. Click Add.

To view a supporting document, click the link in the File/Link column of the Supporting documents
register. The document opens a preview in a new tab, so you can view the pages of the document and
then decide if you want to download it to your workstation. You can use the Previous and Next
buttons to view all pages.
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HistoricalWeatherRecord_2023-April-05-.

Previous PageNo:1 /1  nex |
Historical Weather Record
Omaha, Nebraska, 68114, United States Of America, Lat. 41.2656 , Lon. -96.0493
(UTC-06:00) Gentral Time (US & Ganada)
Selected Range:  Date: Time: Date: Time:
From 04/05/2023 12:30 AM To: 04/05/2023 11:30 PM
Date Time Temperature  Weather condition Wind Precipitation
04/052023 1230 AM  20°C 67°F clear sky 0 mis, 0.00 mph
04/052023 0130 AM  22°C T1°F clear sky 3.6 mis, 8.00mph
041052023  02:30AM  22°C T2°F clear sky 6.17 ms, 14.00 mph
041052023  03:30AM  20°C 68°F clear sky 8.75 m/s, 20.00 mph
2023 04:30AM  14°C 58°F clear sky 11.32 m/s, 25.00 mph
2023 05:30AM  11°C ST°F. clear sky 9.26 m/s, 21.00 mph
2023 06:30AM  7°C 44°F scattered clouds 12.86 mis, 29.00 mph
07:30AM  5°C 41°F broken clouds 10.29 mis, 23.00 mph
08:30AM  4°C 39°F overcast clouds 823 s, 18.00 mph
09:30AM  3°C 38°F overcast clouds 10.29 mis, 23.00 mph
10:30 AM  3°C 37°F overcast clouds 11.83 mis, 26.00 mph
1130AM  2°C 35°F broken clouds 10.8 m/s, 24.00 mph
1230PM  2°C35°F overcast clouds 8.75 m/s, 20.00 mph
01:30PM  1°C 34°F broken clouds 9.77 m's, 22.00 mph
ontract Main.v23.4.20230410.01

To download the document to your workstation, click Download file.

4.0.6.14 SEND BID PACKAGE DOCUMENTS FOR ESIGNATURE
VIA DOCUSIGN

When a project is integrated with DocuSign, you can send a bid package document to DocuSign for an
eSignature.

DocuSign tags can be embedded in a bid package supporting document. The DocuSign tags correspond
to DocuSign recipients configured in the project settings, project contacts, and user information
defined in the Division of responsibility section of the bid package details.

Refer to eSignature support for information about sending documents for eSignature via DocuSign.

Refer to Organization settings for information about using tags.

4.0.7 WORKFLOW ASSIGNMENTS TAB

Each bid package is unique and might require various levels of approval. The Workflow Assignments
tab lets you set up the applicable approval steps.

Conversion to a contract is not dependent on approval. You can still convert the bid package at any
time; however, you cannot publish the purchase order for the contract until the bid package workflow
is approved. Bid packages that require approval are not available in a contract for association from the
Associate a bid package icon until they are fully approved.
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ADD WORKFLOW ASSIGNMENTS

Set up workflow assignments at the bid package level when there are approval steps specific to the bid
package. Steps added at the bid package level are performed before those at the project level and
organization level.

Workflow steps can be assigned to users, roles, or groups. Groups must be created in the project
settings before they can be added to an approval workflow. Only users or roles that have permission
for approving and rejecting bid packages are shown when setting up the workflow.

1. From any page in a bid package, go to the Workflow Assignments tab.

2. Click the Add approval icon. The Add Approval slide-out panel opens.

Bid package approval setup - Add approval
Approval step

3. Enter the step title, and then choose whether the step applies to users, roles, or groups.
4. Enter the name of the user, role, or group.

5. Repeat steps 2-4 as needed.

6. Click Add.

The steps are added to the workflow before the project-level and organization-level steps. The Save
and start approval button is added to the Overview page, and you can start the approval.

START THE APPROVAL WORKFLOW

Start the approval process when the bid package is ready for final approval.

Approval steps must be configured at the organization, project, or bid package level. If you want to
make changes to the approval steps, you must go to the Workflow Assignments tab to make your
changes. If your organization has chosen to not allow workflow when the bid package is over budget,
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an error message shows when you start the approval. See Organization settings for more information
about allowing a bid package type to go to approval when over budget.

1. Go to the Overview tab for a bid package, and then click Save and start approval. The Start
approval dialog box opens to the approval steps page.

Start approval

°Approval steps

A group workflow must be selected in order to start the approval

Bid package approval steps

step 1 Account Administrator

step 2 Group A - N

==l -

2. Review the approval steps as necessary, and then click Next.

3. Review the bid package budget. Contract converts the workflow values from the project
currency to the contract currency to see if you have exceeded budget. If there is no conversion
rate listed in the project details, the conversion rate is assumed to be 1:1. When the bid package
is over budget, a yellow warning banner shows at the top of the Budget check tab, and the loss is
shown in red in the Gain/Loss column.
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Start approval

eﬁudget check

Bid package exceeds Current budget for selected phase codes

Original base value Current budget Gain/Loss

$100.00 $0.00 ($ 100.00)

[ Cancel J [ Back J Next m

. Choose one of the following:

¢ If you do not want to add a message and attach supporting documents, click Start. The
approval process starts.

¢ If you want to add a message or attach supporting documents, click Next. The Add
messages page opens.

. Choose one of the following;

¢ If you want to add a message to be included in the workflow email, type and format it, and
then click Next. The Attach supporting documents page opens.

¢ If you do not want to add a message, click Next. The Attach supporting documents page
opens.

. Choose one of the following:

* If you want to attach supporting documents, click Next. The Attach supporting documents
page opens.

¢ |f you do not want to attach supporting documents, click Start. The approval process
starts.

. Select one or more supporting documents from the list of documents.

. Click Start. The approval process starts.

Page 150 of 377 InEight Inc. | Release 25.3



Contract User Guide

The approvers receive a notification of the approval item. If you are an approver, the workflow step is
shown on the Action items tab. When you start the approval process and you are the first approver in
the approval workflow, the first step of the workflow is automatically approved, and continues with
the next step, if applicable. If you are the only step in the approval, you receive a second email
confirming the new issue has been approved.

Users who are added to roles associated with active workflows can approve or reject workflow items.
They do not get a workflow notification, but the workflow item is shown in the Action items tab.

Worklfows that are not completed within 90 days are terminated and automatically removed from the
Action items tab.

When the workflow is complete, Contract sends a completion email to you as the initiator, people who
created the item, and the person who completed the last step.
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CHAPTER 5 — CONTRACT SETUP

The intention of the InEight Contract application is to manage and maintain your contracts. Your
company will still need to create, negotiate and execute a contract outside of the InEight module,
although you may use the Contract Writer tool covered in the previous section to generate the
documentation. Please refer to your legal department for contract negotiation and execution.
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5.0.1 INEIGHT CONTRACT WORKFLOW - CONTRACT
SETUP

W8S Structure
G
Contracts

Bid Packages

Create Bid
Package

Camiim g iy Gl Documents Contract Execute

(Details & Line Supporting gl ] Contract Create PO
Iltems) Documents
Add vCO
— 4
Contract
— Contract
E VCO Approval Closeout

Payment Management

|
L4

Manage
Milestones

Manage Scopes of Work
Schedule Procurement

- Estimate

Manage Certify
Payment Payment
Claim Claim

Add Payment
Claim

Create
Payment Form

Payment Form
Approval

Change Register

Review and
Receive Invoice
(Contractor)

Submit
Invoice
(Vendor)

Add
Supporting
Documents

Create Goods.
e Receipt &
Accrual

Budget/Contract
Adjustments

5.0.2 CONTRACT CREATION

The InEight Contract application is used to house your contracts after they have been awarded,
negotiated and executed. Within the tool you can manage all your supporting documents (e.g., vendor
insurance, bonding documents, workers compensation, and all executed change orders). By having all
your contracts in one spot, the Reports application within the InEight cloud platform will allow you to
run reports to see what your total project is spending on buyout.

Within the InEight Contract module, you can create a contract in two different ways:

» Convert a bid package to a contract

» Create a contract from scratch using the Contracts page

5.0.2.1 CREATE A CONTRACT FROM BID PACKAGE

The following steps walk you through how to convert a bid package to a contract when it is ready to be
awarded. When the bid package is converted, it will initially be empty, ready for you to add pertinent
information.
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(\eJ = Creating a contract from a bid package does not create a live connection between the
contract and the bid package. After a contract is created from a bid package, updates to
one do not produce updates in the other.

CREATE A CONTRACT FROM BID PACKAGE

Summary: Convert a bid package into a contract after the bid package is awarded, so you can use the
information that already exists for the new contract without having to enter it again.

Considerations: You can convert a bid package that has not gone through the approval workflow;
however, you cannot publish the purchase order for the contract until the bid package workflow is
approved. Bid packages that require approval are not available in a contract for association from the
Associate a bid package icon until they are fully approved.

1. From the Contract > Bid packages page, select a bid package.

2. Click the Convert to contract button located on the top-right portion of the bid package record.
The Add contract or master agreement dialog box opens.

3. Select a contract type from the Type drop-down list, and then enter or select values for all
required fields. You can optionally enter values for nonrequired fields as needed.
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Add contract or master agreement

Description *Type

new bid package Select one v

Subtype Effective date

Select one v month/day/year ﬁ

Vendor Storage location

v 0148 - CHMC-Hubbard Cen v

Discipline

Aggregates and Paving v

Scope of contract

Cancel

4. Click Add to add the contract. A new contract is created with an automatically assigned contract
number. This number ultimately becomes the purchase order number when the PO is created.
This PO or agreement number remains the same during the life span of the agreement

What's next: Sometimes your vendors might ask for a PO number to get material ordered or to start
the process of supplying material.

5.0.2.2 CREATE A CONTRACT FROM SCRATCH

During your project, you might identify a specific scope of work that you will need a contract for,
however, due to the nature of the work you will not need to produce a bid package. For example, you
may have rental or service agreements that are simple enough to set up the contract without a bid
package, or perhaps your project is a small infrastructure project that doesn’t require any long-lead
items that have a long buyout process. For instances like this, you will want to create a contract from
scratch.

The following steps walk you through creating a contract from scratch.

CREATE A CONTRACT FROM SCRATCH

Summary: Create a contract from scratch to start a contract from new information.
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Considerations: When you create a contract from scratch it is not associated with a bid package.

1. From the Contracts page, click the Add Contract icon. The Add contract dialog box opens.

@)  steel Structure Job (105091) - Contract »

Actions - @

2. Complete the following fields:
» Description
* Type
» Subtype (optional)
» Effective Date
» Vendor (optional)
» Storage location

» Scope (optional)
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Add contract
Description *Type
Select one v
Subtype Effective date
Select one v iz
Vendor Storage location
¥ 0057 - Blue Water Energ x
Scope of contract
Format v B 52 u = = = = = = 7

3. Click Add. The Contract Header tab opens.

5.0.2.3 CONTRACT TABS

Contract has the following Tabs which contain all the pertinent information for the contract. These
tabs are located along the top of the Contract record page and from left to right as follows:

» Header

e Line Iltems

e Schedule of values

» Vendor Change Order Log
e Back Charges

e Payment Forms

e Payment Progress

e Supporting Documents

» Workflow Assignments
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e SyncLog
e Contract Closeout

VENDORCHANGE oo o oo Lol oo oo SUPPORTING

. ENDC G WMENT FORMS PAYMENT PROGRESS s G WORKFLOW o . o
HEADER LINE ITEMS SROER 06 BACK CHARGES PAYMENT FORMS: AYMENT PROGRESS DoCUMENTS A5 CNVENTS SYNCLOG CONTRACT CLOSEOUT

You will need to use the arrows to scroll over to the next header.

TIP If technical field assistant lines are added to the contract, an additional header tab will be
created to house them.

The tabs are ordered based on how often are used; they do not reflect the order of a
typical contract management workflow.

You might need to use the arrows to scroll through all the tabs.

5.0.2.4 CONTRACTS TOOLBAR

The Contracts page has the Download purchase order, Contract Totals, and Notes icons available on
every tab.

DOWNLOAD PURCHASE ORDER

Click the Download purchase order icon to quickly download the default purchase order template for
the contract type when you are in a contract. If you want to use a purchase order other than the
default, you can use the Contract writer.

You can also download a purchase order directly from the Contract register. When you select a
contract in the register, the Download purchase order icon is enabled.

The organization-level default purchase order is attached in contract approval emails.

CONTRACT TOTALS

Clicking the Contract Totals icon opens a slide-out panel that has a breakdown of your contract’s
totals.
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Pbld

TOTAL TAX

The total tax is estimated when you click Estimate Tax in the Vendor or Delivery address field on the
header tab. Click the Information icon to see a break-down of the taxes. Taxes are calculated based on
the tax types and their default percent listed in project settings. When the contract is published, tax
information is updated from the purchase order response.

MANUAL ADJUSTMENTS

The Manual adjustments line lets you quickly see the total amount of updates to the contract that
were made outside of a vendor change order. The total is linked to the Changes drill-down view of the
line items tab, so you can see details of the Manual adjustments value. When you click the link, the
first line item with manual adjustments shows in the Manual adjustments table.
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Actions ¥

Contract totals
Created by:

Vendor
Status

Type

Contract retention

HEADER

Draft

Joint Venture agreement

0.00% $0.000

LINE ITEM

b @© 0001 -

Changes

Vendor CO ID

VENDOR CHANGE

SCHEDULE OF VALUES

ORDER LOG

= VCO description

= VCOstatus

16 WORKFLOW
S ASSIGNMENTS

SYNC LOG

X

CONTRACT CLOSEOU™

2 Q

= Value adjustment

Manual adjustments

Quantity before

2,312.0000

2,300.0000

= Quantity adjustment =

(12.0000)

1.0000

Total tax () $0.000 2,301.0000 199.0000
2,500.0000 50.0000
Original value Current value
N 5 2550.0000 0.0000
$ 284,376.000 $732,495.836
2,550.0000 0.0000
Manual adjustments $448,119.836 238.0000
Total change orders $0.000
Total potential change orders $0.000
Total proposed accrual $0.000
Accrued liguidated damages $0.000
Associations
Received to date
0.00%
$0.000 of $731,495.836
Contract invoices
Unassigned Assigned (@@ Submitted (JRemaining
0.34% - »

CONTRACT INVOICES

The Contract invoices section shows the state of all contract invoices in the system to gain visibility into
the processing of invoices. The section shows the amount and percentage of invoices in the contract
that have been assigned or submitted and what is remaining. The section is color-coded as follows to
give you a visual status of the contract invoices:

Orange = Invoices assigned to the contract but not assigned to a payment form

Yellow = Invoices assigned to a payment form in any status other than submitted

Green = Invoices that have been submitted

White = The contract total minus the submitted invoices

Click the Contract invoices link to go directly to the Payment Forms tab if your organization uses
payment forms or the Payment Progress tab if your organization does not use payment forms.

RETAINED TO DATE CALCULATION

In the Contract summary push panel, the Retained to date field calculation is Actual retained +
Remaining new retention value. This calculation considers what is already paid and new amounts even
if the retention rate is changed. If you make any changes on any retention line item It will calculate
only what is left on the line item.
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Contracts > 7300000579 - demo testing JPY ¥
TEC
- HEADER LINE ITEMS BACK CHARGES PAYMENT FORM PAYMENT PROGRESS
Cancel (=)
BI0 PACKAYE DUUGET v,
X o -
Contract totals Division of responsibilities (DOR) v
Created by. marianne Crane on 02/19/2020 %
Descr
| ¥0.00 of  ¥1.003650.00 - Retention 2
femo testing
Invoiced to date Retention Percent % Value ¥
0.00% “Type Subtype .
¥0.00  of  ¥1,003,650.00 - ervicesubtype - TR RN 10.00
S
Paid to date . LN ——
ontract retention 498 ¥50,000.00
0.00% & o .
¥0.00 of ¥1.003,650.00 Retained ¥0.00
alifornia Pipe Fabricators -
Retsined 1o date
0.00% Released ¥0.00
*Payment tenm *Vendor currency
Released to date Net due in 15 days - ven - Liquidated damages -
0.00%
¥000 of  ¥0.00 & . Technical field assistance v
2900 Blackhawk Drive, BELLEVUE, Arizona, 681. ¥ - Reporting (Switch) v
Technical field assistance used to date
0.00%
¥0.00  of  ¥43,000.00 s . Reference data

You can click the Notes icon to view the Notes slide out panel, which displays the contract’s notes and
supporting document notes. You can add notes in the bottom section, which will be stamped with the
author, time and date. It is important to remember that these notes, once entered, become a part of

the legal document and cannot be deleted.

e, .z [

Notes for X

5.0.2.5 SEND A CONTRACT FOR APPROVAL

To submit a contract for approval, click Save and start approval. If you have set up group workflows,
select the applicable group for the contract. For example, if you are starting the approval process for
Segment 1 of the project, select the Segment 1 group.
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Contracts > 7200002670 - Rebar furnish and Install usD §

Actions v HEADER

5.0.3 HEADER TAB

The Header Tab contains the following sections for capturing key contract information:

VENDOR CHANGE

LINE ITEMS i

Details

SUPPORTING WORKFLOW
DOCUMENTS ASSIGNMENTS

PAYMENT FORMS PAYMENT PROGRESS

Additional details

SYNCLOG

[ Cancel | [ save and start approval ]

Segment 1

Segment 2 ge

Contract status.

e Details

eSign
Additional details

Reference data

Details

Diversity participation

Contract terms

Approval status

Additional details

Segment 3

@ Associate a bid package

Contract status

Bid package budget v
Draft v
Division of responsibilities (DOR) v
*Description
Vendor contact v
“Type Subtype Retention v
Material contract
Selectone M Liquidated damages v
Effective date *Vendor ] estimate Tax Reporting (Switch) v
09/23/2024 ]
Custom fields @ v
Payment term *Contract currency
PO0S - Paywhen Paid -5 days fomrecpofC.. ¥ US Dollar + | Reference data
*Delivery address @ Estimate Tax Storage location Agreement ID
v v
Incoterms Incoterm location fint: Type Master agreement ID, Description or Vendor ID/N.
e —/'/_,,,, /wﬁ,emem value —/_,,,,
~—— — ——— e
| Diversity participation v
Contract terms
View details v
eSign
esign C v
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5.0.3.6 CONTRACT DETAILS

The Details section of the Header tab shows basic information about the contract

Details
Contract status. o
Draft

*Description e

*Type 9 Subtype o

Material contract Select one
Effective date e *Vendor e FEf Estimate Tax
09/23/2024 (i)
Payment term o “Contract currency 9

P005 - Pay when Paid - 5 days from recpt of C.. ¥ US Dollar

*Delivery address 9 ﬁ Estimate Tax Storage location 0
v

Incoterms. o Incoterm \ocaﬂone
v

Discipline

g
3
ES
w
-
c
i
1]
[
1)
]
lil

1 Contract status Drop-down of statuses you can change manually to track the

progression of the contract. Contract must be in Executed status to
publish a PO to the ERP system

a3 Changing the contract status to Executed is the action that
triggers the compliance review of supporting documents.
Once the supporting documents are approved by

Compliance, the Create Purchase Order button becomes
active.

2 Description Free text entry; Brief overview of the contract which will display in

reports. The description can be edited as needed.
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3

10

11

12

13
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Type

Subtype

Effective date

Vendor

Payment term

Contract
currency

Delivery
address

Storage
location

Incoterms

Incoterm
location

Country of
origin

Drop-down denoting the kind of contract. Different contract types map
to different PO types in ERP system.

An additional drop-down to further categorize contract type.

Beginning date of the contract, the date in which both parties have
signed the agreement.

Drop-down menu of all vendors set up in ERP system. You can click
the Advanced vendor search icon at the bottom of the list to see the
Select vendor dialog box that shows more vendor details and has its
own search function.

Drop-down menu to indicate terms of payment for the contract. Only
payment terms marked as Available in the Master data library are
shown in the drop-down menu.

Drop-down menu; currency in which the vendor will be paid. If there is
no vendor or if the vendor does not have a currency assigned to their
record in the master data library, the field has a drop-down menu, so
you can select the contract currency. A warning icon is shown when
the selected Contract currency does not have an exchange rate set up
in the Project details, and a yellow warning banner shows at the top of
the page.

Drop-down menu; Location where materials are delivered, or services
are performed.

Note: Delivery addresses can be added or modified in project settings
with proper permissions.

ERP entity for tracking materials within the ERP system.

International commercial terms that specify which party is responsible
for material while in shipment to destination. Only Incoterms marked as
Available in the Master data library are shown in the drop-down menu.

Names the destination for Incoterms.

The country where the project is being built.
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14 Discipline Drop-down menu to indicate the discipline category the contract falls

under.
15 Two-way Allows for paying invoices without formal goods receipts; typically used
match for progress payments.
16 Scope of Free text entry field to provide more information on the contract’s
contract

scope. You can use the Expand icon to expand the text box for easy

text entry and viewing. You can then collapse the text box when you
are finished.

Following are additional details about the header tab.
CONTRACT STATUS

The Contract status field is a drop-down that allows you to select the status of your contract.

Contract status

Draft -
*Description *Type
Steel - Supply and Install Service agreement i
*Effective date *Vendor
01/24/2018 B 0010011153 - Merrill Iron & Steel Inc =

The table below lists the status options available to select from.

Draft The contract is still being created.

In review Contract is following the workflow for approval.
Out for vendor Contract is with the sub or vendor for signature.
signature
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Out for internal Contract has been signed by vendor of subcontractor and is now routed
signature for internal signatures.

Executed Contract has been signed by both parties.

Terminated Removed vendor or supplier off site.

Cancelled Contract has been cancelled or never got executed.

Closed Contract has been completed and closed out.
DESCRIPTION

Description is a free text field where you can enter the information to describe what the contract is for
(e.g., Steel — Supply and Install).

Contract status

Executed v
*Description
Construction Contract SW
*Type Subtype
Subcontract labour -
*Effective date *Vendor
03/19/2019 o] California Corridor Constructors,

The contract type will already be populated from when the user added a new contract.

CONTRACT SUBTYPE

Created to further categorize contracts, subtypes which can be added to each contract type in your
organization settings. Configure your organization settings by first creating a new subtype and then
associate it to an existing contract type.
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Contract status
Executed hd
*Description
Construction Contract SW
*Type Subtype
Subcontract labour hd
*Effective date *WVendor
03/19/2019 £ California Gorridor Constructors,

From the Organizational settings, select Contract > Contracts > Settings.

S100000 - PKS Incs - Organization home ~

Favorite projects & organizations oucions

$100000 - PKS Incs »
Steel Training Job (105091) > Model Suite () Estimate g%
Steel Training Job 2 (105092) »
Van Nuys North Platform (103442) > Organization home
Organization home Assigned users
Se@gs Assigned projects

Manage favorites

All nrnierts & nrnanizatinns

Go to Contract configurations, then select the settings icon under Contract type name.

Contract configurations

Integrate tax calculation before publishing contract? Integrate Ariba for contracts?

English Espafiol E R -
~Contract type name ~ERP document ype range low.. - rangeupp...  Contract type name
MMM Contract E o JRRVIVY] 101 1200 MMM Contract ® -
CN-INEIGHT L meEeut 660 669 CN-INEIGHT ®
Master Service Agreement E xMsh 8100000000 8199999999 Master Service Agreement ®
CN-sL-001 £ onseom 670 690 CN-5L-001 ®

Page 168 of 377 InEight Inc. | Release 25.3



Contract User Guide

In the Subtype configurations slide out panel, select the subtypes tab.

CONFIGURATIONS SUBTYPES

Subtype configurations
Add contract subtypes

English
= Subtype name
Software
Consultant

Professional Service

ERP Code

X

- - N

= Subtype name

Software

®
Consultant ®
®

Professional Service

To add a subtype, click in the new field under the Subtype name. Type in the name of your new
icon to add to your list. Then click Save. The new subtype can now

subtype, then click on the Add
be added to any contract type.

EFFECTIVE DATE

The effective date is when your contract has been executed and becomes an official legal document.

Contract status

Executed

*Description

Construction Contract SW

*Type

Subcontract

*Effective date

03/19/2019

InEight Inc. | Release 25.3
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*Vendor

California Corridor Constructors,
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VENDOR

The Vendor drop-down list shows all vendors that you have set up in the system. After they are added
to your vendor database under Master data libraries, you can search for them by vendor number or by
company name.

It is important to make sure you have the correct vendor tied to this contract as it will determine who
gets paid from your ERP system. If you are using a schedule of values, and the Hide in plan and
progress check box for a schedule item is not selected, changes made to the vendor on this page are
automatically updated in InEight Plan.

Contract status

The Estimate Tax calculator for this field lets you estimate the tax for the contract line items. Prior to
publishing a contract, if you click Estimate tax, taxes are calculated based on the tax types and their
default percent listed in project settings. The estimated taxes are shown in the contract's line items
and the contract totals. When the contract is published, tax information is updated from the Purchase
order response.

PAYMENT TERM

Your payment terms are what you and the vendor or subcontractor agree on during contract
negotiations. From the drop-down list, you can select from several different options that InEight
Contract pushes to the ERP system. Once you have set these and executed the contract, it is difficult to
change afterwards.
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Payment term Contract currency

P030 - Pay when Paid - 10 Days net discount .. ¥ US Dollar v

Delivery address Storage location

ﬁ Estimate Tax

L 4 v

Incoterms Incoterm location

DES - Delivered ex ship v

*Country of origin

Q Search code

United States Of America hd

Two-way match Discipline

Only payment terms marked as Available in the Master data library are shown in the drop-down menu.

CONTRACT CURRENCY

You will need to select the correct currency for payment to the vendor. This should be determined
during contract negotiations and discussed with your business team to make sure you are able to pay
the vendor with the agreed upon currency prior to contract execution. If a vendor has not been
selected, the currency of the contract is used.

* Payment term

VPAY VENDOR OMLY - NTOD hd

* Delivery address

ﬁ Calculate tax

Wan Nuys Blvd, Van Muys, California, 91405, U..  +

*Incoterms

Free on board v

Country of origin
Thailand bl

Invoice plan
No

InEight Inc. | Release 25.3

*Contract currency

US Dallar

*Storage location

Van Muys M Platf

Incoterm location

Destination

Harmonized

1233444

Discipline
Bulk commodities

Q Search code
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DELIVERY ADDRESS / STORAGE LOCATION

The delivery address will be set up during your project initiation. For instances where you want the
material to be delivered to a yard or a storage facility, or a subcontractor to show up to perform work
at an identified onsite location, you will have the option of picking that address.

The Estimate Tax calculator for this field lets you estimate the tax for the contract line items. Prior to
publishing a contract, if you click Estimate tax, taxes are calculated based on the tax types and their
default percent listed in project settings. The estimated taxes are shown in the contract's line items
and the contract totals. When the contract is published, tax information is updated from the Purchase
order response.

INCOTERMS

Incoterms indicate who is responsible for the material during shipment to the jobsite or the storage
location. This will default into the Vendor Master Record as terms for the materials to be shipped.

Payment term Contract currency
P030 - Pay when Paid - 10 Days net discount v US Daollar v
Delivery address B Estimate Tax Storage location
v v
Incoterms Incoterm location
DES - Delivered ex ship v
* Country of origin QSea\ch code
United States Of America v
Two-way match Discipline
TN
I @ ) v

h, iy

Only Incoterms marked as Available in the Master data library are shown in the drop-down menu.

COUNTRY OF ORIGIN

A pull-down with a selection of countries where the project is located.
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*Payment term *WVendor currency
Intercompany Payment terms with Paymentbl.. ~ US Dollar b
*Delivery address @ calculate tax *Storage location
Van Muys Blvd, Van Muys, California, 91405, U ~ Van Nuys M Platf
*Incoterms Incoterm location
Free on board v Destination
Country of origin Harmonized Label Q Search code

Hint: type ‘country name’

Invoice plan Discipline
Mo

TWO-WAY MATCH

The two-way match function in the contract module allows you to set a predetermined plan to pay a
vendor. This plan is paid against a set schedule, such as completion milestones or progress payments.

If Yes is selected, the ability to create goods receipts against the purchase order and denotes the goods
receipt as not applicable for all line items is disabled. When the purchase order is published, the ERP
system can be mapped to create an invoice plan.

If you do not know if your contract will have an invoice plan, the best practice is to leave the setting
selected to No. Otherwise, if you select Yes and then determine that an invoice plan is not correct after
the contract has been pushed to the ERP system, the ERP system does not allow you to make this
correction; a new contract must be drafted.

Use the toggle to set Two-way match feature to Yes or No.

DISCIPLINE

The discipline pull-down list will provide the type of discipline categories you can choose for your
contract. The disciplines are pulled from the master data set up in InEight Platform.
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Invoice plan Discipline
Mo |

e

Aggregates and paving

Scope of contract Building

Construction Contract Bulk commodities

Change Orders,Contract Allowances and Back c...
Civil utilities
Commercial cost

Diversity participation Concrete

SCOPE OF CONTRACT

Free text area where you can indicate the scope of your contract.

Scope of contract 979

Construction Contract

5.0.3.7 DIVERSITY PARTICIPATION

Diversity participation is required on certain contracts and can be federally regulated. Diversity
participation can include, but is not limited to

» Disadvantaged Business Enterprise (DBE)

* Minority and Women Owned Business Enterprise (MWBE)

» Service Disabled Veteran Owned Business Program (SDVOB)
» On-the-Job Supportive Services Programs (OJT/SS)

The following steps walk you through how to add diversity participation to your contract.

ADD DIVERSITY PARTICIPATION

Summary: Add diversity participation information, so you can track the diversity participation in the
project.
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Considerations: The percentage and value of the diversity participation can be tracked at an individual

line item level. This allows lines that do not count toward diversity participation to be excluded from
reporting.

1. From the Header tab, expand the Diversity participation section, and then set the toggle
Diversity Participation to Yes.

2. Select an Applicable Diversity Category.

Diversity participation

F Y
Diversity participation
.'/.-—--\'.
|..\® --/.l
Applicable diversity categories Percent % Comments
Veteran Owned Small Busin.. ¥ 15.00000
Women Owned Small Busin.. ¥ @

@ Add category

To add multiple Diversity Participation Categories, click the Add Category lcon as many times as
needed.

3. Optionally enter the goal percentage represented by the vendor. You can have multiple diversity
participation categories on a contract, each with their own percentage. The sum of the
percentages does not have to equal 100%. The field is used for tracking and reporting purposes
only. It is not validated against the line items diversity participation fields.

5.0.3.8 CONTRACT TERMS

The Contract terms section of the Header tab includes free-text fields where you write the language
which is in the physical contract document, such as inclusions, exclusions, warranty information and
other contract terms. You can expand the View details section for easy text entry and viewing. You can
collapse the section when you are finished.
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Contract terms

View details

c

lil
~

Exclusions

Format v

3
L}
]
[

ll
Y

3
"
]
[}
[}
i}

Contract term 5

Contract term 6

Contract term 7

Contract term 8
Contract term 9

Contract term 10

Some contracts have paragraphs for inclusions that list all the items that are included in the contract. A

contract manager would write in that field and then use the tag for inclusions in Contract writer to
generate the Microsoft Word document.

read.

If you are not generating the Word document from Contract, you can use the field to write what is
included and then use that field for reference, so you do not have to open the scanned contract to
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Contract terms|

View details ~

Inclusions.

Exclusions

Warranty

5.0.3.9 ESIGN SECTION

The eSign section of the Header tab lets you view or add recipients to be used as default eSign signees.
This section has subsections for eSign, Project contacts, and division of responsibility. All signees must
be added to at least one section.

eSign
esign C a
Recipient ‘ Name ‘ Company Title Email
eSign 1 Type name of contact Type name of company Type title of contact Type email address of contact
eSign 2 Type name of contact Type name of company Type title of contact Type email address of contact

eSign 3 Type name of contact Type name of company Type title of contact Type email address of contact

eSign 10 Type name of contact Type name of company Type title of contact Type email address of contact

Project contact: Owner

Project contact: Designer
Project contact: Contact 1
Project contact: Contact 2
Project contact: Contact 3

Project contact: Contact 4

Responsible engineer
Contract manager
Purchasing manager
Field handler

Purchasing agent
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¢ Names in the eSign section are populated from the project eSign setup tab (Project settings >
Contract > Configrations > eSign setup). You can also manually enter the names of the signees.

¢ Names in the Project contacts section are populated with contact information from Project
contacts added in Project details. This section is for reference only. If you want to add or change
recipients, you must edit the Project Contacts.

¢ Names in the Division of responsibility section are populated with user information defined in
the Division of responsibilities section of the contract details. The company is populated from the
Company legal name in Project details. The title field is always blank. This section is for reference
only. If you want to add or change recipients, you must edit them in the Division of responsibility
section of the Additional details.

5.0.3.10 ADDITIONAL DETAILS

The Additional details section of the Header tab includes expandable sections for detailed contract
information.

Additional details @ Associate a bid package
Bid package budget v
Division of responsibilities (DOR) v
Vendor contact v
Retention v
Liquidated damages v
Reporting (Switch) v
Custom fields (i) v

Associate abid  Prompts a window containing a list of all unassociated bid packages in the
package project. This feature allows you to associate a bid package to the contract
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Bid Package
budget

Division of
Responsibilities

Vendor contact

Retention

Liquidated
damages

Technical field
assistance

Reporting
(Switch)

Custom fields

after creating the contract.

Generates a quick look on where production is from the budget.
Comes over from Bid package when converting.

The project assigned contacts associated to the contract vendor, or you
can enter any name in this field.

Amount entered will pre-populate each line item for hold back during
invoice payment.

Free text entry in terms of percentage or $ value. Maximum allowed
liquidated damages per the contract.

Select Yes or No to specify vendor or supplier to provide on-site
commissioning or training.

Allows some contracts to be omitted from standard reporting. Typically
used for low risk contracts which don’t require high visibility.

Fields you can use for entering information that is not covered on the tab.

BID PACKAGE BUDGET

Gives you a glance overview of the budget running against the bid package associated to your contract.
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Bid package budget A
Budget Value §
Original base value $0.00
Contingency in estimate 50,00
Escalation in estimate 50,00
Un-awarded adjustment 50,00
Owner change amount 50,00
Total estimate 50.00
Division of responsibilities (DOR) v
Retention v
Ligquidated damages v
Technical field assistance v
Reporting (Switch) v

DIVISION OF RESPONSIBILITIES (DOR)

These are roles that will be available to assign a person to when creating a bid package in Project
Settings.
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Bid package budget v
Division of responsibilities (DOR) ~
sp3

dz2

Retention v
Liquidated damages v
Technical field assistance v
Reporting (Switch) v

You can remove a role from being needed on a bid package. The drop-down for that role will then not
appear when creating a new bid package.

VENDOR CONTACT

Vendor contacts are defined in the project Assigned contacts associated with the contract vendor. Use
the Vendor contact section to select a contact to be the primary contact for the contract.

If there are no contacts defined for the vendor, the list is empty and you cannot add a contact. If a
vendor is changed or removed from the contract, the contact is removed.

RETENTION

Retention is the amount of money that is held back from each invoice until the contract is complete. A
contractor will always want to retain (hold back) a certain percentage of each invoice, as it ensures
that the vendor or subcontractor will continue to work until their scope is complete. In some cases,
retention will be waived. This typically happens when the relationship between vendor and contractor
is strong. In some cases, you will want to waive the retention; this is a case by case decision your
company would make.

The amount of retention appears on each line item in the contract but is editable to suit those lines
which should not have retention.
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Bid package budget v
Division of responsibilities (DOR) v
Retention A
Retention Percent % Value $

Default retention

Contract retention 0.00% 50.00
Retained $45,052.00
Released $4.418.00
Liquidated damages v
Technical field assistance v
Reporting (Switch) v

TAX JURISDICTIONS

All organizations do not require a notification with a tax jurisdiction, selecting the Tax Jurisdiction
notification has a toggle ON or OFF. These are for clients which do not have a tax system. Access this
toggle from the Organization settings > Contract > Notifications.
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WORKFLOW CONTRACT
o~ BID PACKAGES CONTRACTS
(&) General —- ASSIGNMENTS TEMPLATES
S

. Contract configurations Accrual/Receipt settings Line item account settings Diversity participation Notifications Contract closeout Supporting documents
& ] Control

fﬂ Plan
&3

E)D Progress
Notifications

(&) compliance
() Lomp

(@) Contract ;
(g Contrac Retention release requests

\:ﬁ\l Change e

|\.-B Design

(E5) Report Supporting documents expiration
©

Delivery address tax jurisdiction notifications

C

©

*Assign users or roles to receive a notification to input *Users

the tax jurisdiction when a new delivery address is ;

added? X Abhilasha Pasupulety
Users A

LIQUIDATED DAMAGES

Liquidated Damages will occur when your vendor or subcontractor fails to meet milestones, material
delivery dates and other specific dates that have been agreed on in the terms and conditions in the
executed document. Many times, this will result in financial compensation.
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Bid package budget v
Division of responsibilities (DOR) v
Retention v
Liquidated damages A
Liquidated damages Percent % Value §

Engineering submittals cap
Delivery cap
Substantial completion cap

Performance guarantee cap

Overall cap
Technical field assistance v
Reporting (Switch) v

TECHNICAL FIELD ASSISTANCE

Technical Field Assistance is used when your contracted vendor or supplier is specified in the contract
to provide field personnel for on-site commissioning or training. When a contract has technical field
assistance written into the vendor contract, those specifics can be added to the Technical field
assistance section in the Header tab. You can enter the Description, Contracted Quantity, Unit of
Measure, Unit Price, and comments for the purposes of tracking assistance from the Vendor. All this
information must be a part of the signed executed contract with the Vendor or subcontractor.
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Bid package budget v
Division of responsibilities (DOR) v
Retention v
Liquidated damages v
Technical field assistance A

Technical field assistance
v [

Reporting (Switch) v

Adding this to your contract will give you the capability to track your budget for your technical field
assistance. This helps as a tracking tool to reduce overruns.

The following steps walk you through how to turn on the tracking of technical field assistance for your
contract.

ENABLE TECHNICAL FIELD ASSISTANCE

1. On the record page for the contract you created in Step by Step 5.2.2, select the Header tab.

2. Under the Additional details section, expand the Technical field assistance menu and use the
toggle slider to set Technical Field Assistance to Yes.

Technical field assistance

Technical field assistance
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ey = Selecting Yes adds a Technical Field Assistance tab to the main contract page.

3. In the Technical field assistance table at the bottom of the form, complete the table below with
the following:

» Select the remove icon Double time and any other entries so you end up with just
Standard Time, Overtime, and Trip

e Standard time: 100 MH, $45/mh
e Overtime: 20 MH, $67.50/mh
o Trip: 5 EA, $500/EA

Technical field assistance

*Description *Contracted quantity *UoM *Unit price Total Comments
(© | standard Time 100.000 MH ¥ $45.00 $4,500.00
) | overtime 20.000 MH $67.50 $1,350.00

@ | ™ 5.000 Ea ¥ $500.00 $2,500.00

4. Click Save at the top of the page.

SUFPPORTI!
DOCUMEN

Cancel | Save

y reporting section?

IENT PROGRESS

To track technical field assistance on the Technical field assistance tab that is now enabled,
follow the steps below.

ADD TECHNICAL FIELD ASSISTANCE

1. On the record page for the contract you created in Step by Step 5.2.2, select the Technical Field
Assistance tab.
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3 7400001112 - XX - Structural Sesl

INE ITEMS R BACK CHARGES PAYMENT FORMS ”""5'_'--”'-'
ORDER LOG

2. Click the Add Technical Field Assistance icon at the top left of your screen under actions.

Contracts » 7300000572 - Environmental Testing

WVENDOR CHANGE
Actions - . o
< ORDER LOG BACK CHARGES
®|= s

3. In the Add technical field assistance window, complete the fields with the following information:
» Description: Standard time
o Date: last week
e Technician Name: Mary Smith
» Work performed: Inspection
e Quantity: 4
 Unit Price: [this will populate from the previous page]
» Warranty work: Select Yes or No depending on your specific operation
» Approved by: [Select a name]

e Comments: [None]
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Add techrmcal Nield assistance

*Description *Date

Standard Tiere - ornzRme i
Techniciam name Work performed
Mty Simith MR Hf

i L
4,000 -
1 pice Tivini
§45.00 HE

*Warranty ok Approved by

Fo - Adm E g -

==nl -

4. Select Add.

» The Widgets will update and track remaining technical field assistance (TFA)

Total amount contracted:
$8,350.00

Total amount used:
5180.00

Total remaining
$8170.00
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REPORTING (SWITCH)

The reporting toggle allows you to include or exclude each contract from reporting functions. Toggle
the button to “Yes” if you want this contract to show up in reports, (e.g., Buyout Log, Procurement
Status Report).

Bid package budget v
Division of responsibilities (DOR) ~
Retention v
Liguidated damages v
Technical field assistance v
Reporting (Switch) N

Include this contract in primary reperting section?

v

5.0.3.11 REFERENCE DATA

The Reference data section of the Header tab includes data generated by agreements and purchase
orders generated under the contract. These values can be entered manually or be received from a
JSON PO response from your ERP system. If the values received from your ERP system are different,
they will be updated in the Header tab. If values are blank in your ERP system, those fields will not be
updated in Contract. These fields are also available as columns in the Contracts list.
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Reference data

Agreement ID

Agreement value

Purchase order ID Purchase order value

Requisition 1D Requisition Value

When you copy a contract with an inactive vendor, the Agreement ID field still has the master
agreement ID, but the field is treated as a free-text field for reference; the contract is not actually
associated to the master agreement. If you activate the vendor, you must manually associate the
master agreement to the contract.

5.0.3.12 IMPORT A CONTRACT TEMPLATE

If you have contract details already established on a spreadsheet and want to import this data into
Contract, Contract enables you to import that data into the program. Select the Import icon to begin
the process of importing this data.

On the top right of the screen is the Import icon. When selected, it will open the download the Import
data from template screen. You can import a template to complete or drag and drop your existing
template for importing back into Contract.
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SUPPORTING WORKFLOW
DOCUMENTS ASSIGNMENTS SYNC LOG CONTRACT CLOSEOUT

z 0 2 Q

PAYMENT PROGRESS

Import delivery schedule - Google Chrome

& mt1t01kwt-qa-204-sea.hds.ineight.com/AppContract/FileUpload/FileUpload?projectid=158Contractld=7400001761&ContractDetailld=1...

Import data from template

Neede

03

Data will be imported in to delivery schedule

Drag and drop the file here or browse

Browse.

mport
B | C | D | 3 | F | G | H | ! ! |
Required
. _ (Vendor 1D 1 blank default from Ifblank default I blank default from

Required Required . . from vendor record|vendor record will be

without leading |vendor record will be used | "
will be used used

zeros)

Type. Subtype Effective date |Vendor Currency Pay terms Inco terms. Ineo terms Invoice D

location Plan

TAaterial contract Testl
Material eontract Testsubtype]

Servioe acreementServicesubtu

Template
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ey g= The following data will have values will be populated automatically.

For Contract Line import template, the following data will have their values populated:

e Currency

e Payterms
 Inco terms

» Discipline

e SubType

e Contract type

» Storage location

After the spreadsheet is completed, save and drag it onto the to import it into Contract. The contract
description is limited to 100 characters. If the description exceeds 100 characters, an error is shown in
the import pending area of the import history.

e =0 Contract validates the dates based on the person who imports the data. If the dates do
not match the preferences of that person, Contract generates an error in the import
history and removes the date.

PAYMENT PROGRESS SUPFORTING WORKFLOW SYNC LOG CONTRACT CLOSEOUT >

s B [p] @ a

DOCUMENTS ASSIGNMENTS

Import delivery schedule - Google Chrome

& mt1t01kwt-ga-204-sea.hds.ineight.com/AppContract/FileUpload/FileUpload?projectld=15&Contractld =7400001761&ContractDetailld=1...

Import data from template

j Import template

Data will be imported in to delivery schedule

Drag and drop the file here or browse

Browse

e

Contract automatically generates an email with the import results. The email contains a link to view
the Import History window where you can remove or fix the errors. To filter errors, click the Errors link
at the bottom of the page. A filtered error page shows the remaining errors.

No records are imported if there are any errors in the file.
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5.0.3.13 CREATE FORMS OR MAIL IN INEIGHT DOCUMENT

If a project is associated with Document, you can create a form or mail item from a contract.
Document saves the form or mail and creates a link in the Supporting documents tab.

Single-sign on is available for Contract-to-Document features, such as creating mail or a form. When
you use one of these features, the Document sign-on page opens, and you can enter your credentials.
This creates a sign-on token that lets you remain signed in until the session ends. The first time you
sign in to Document, a black secondary window and the Document Home window also open. You can
close these windows. Single sign-on is activated, and they are not shown again.

Me)g= Creating forms or mail is initiated from the Actions menu. If Actions > Create document >
Form or Mail is inactive, you can select the Settings (cogwheel) icon in the Actions menu
to set up integration with Document.

CREATE A FORM IN DOCUMENT

You can create a Client RFl or Request For Information form in Document and add it to the Supporting
documents for the contract in a single procedure.

1. From the Details page go to Actions > Create document, and then select Form.

2. If you are not already signed into Document, use your credentials to sign into InEight Document.

)

User ID

DOCUMENT

"=~ TeamBinder

Company ID
Password
+ Remember Login User ID & Company ID

Multiple Accounts? Login via Profile

English | Frangais | Italiano | Espaiol | (&6 | Farsi

Contact Support +1(800) 801 1426

Bookmark This Page | Forgot your

A sign-in token is created that lets you remain signed in to Document until the session ends. If
this is the first time you are signing in to Document from Contract, a black secondary window
and the Document Home window are shown. After you close these windows, single sign-on
(SSO) to Document is activated, and they are not shown again.

3. The Create new form dialog box opens. Select the form type, and then click Next. The Request
for information window opens in Document.
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4. Complete the form, and then select the users for distribution of your form. A success message is
shown and a link to the form is added to the Add supporting documents dialog box.

5. Click Add to add the form as a supporting document.

CREATE MAIL IN DOCUMENT

You can create a mail item in Document and add it to the Supporting documents for the contract in a
single procedure.

1.
2.

From the Details page go to Actions > Create document > Mail.

If you are not already signed into Document, use your credentials to sign into InEight Document.

nEight'
@ DOCUMENT
=2 TeamBinder

User ID

Company ID
Password
+ Remember Login User ID & Company ID

Multiple Accounts? Login via Profile

English | Frangais | Italiano | Espaiol | (&6 | Farsi

Contact Support +1(800) 801 1426

Bookmark This Page | Forgot your password?

3. The Create Document Mail dialog box opens. Select the mail type from the list defined in
Document that are specific to the project's mail type, and then click Next.

Create Document Mail
o Select Mail type
Select the Mail type to be created. Upon clicking the "Create’ button, you will be taken to InEight Document to create the mail,
*Mail type

| -

Change Order

Change Order Response

Formal Letter

General Correspondence

IDF Response

Issue Documentation Form -

Cancel
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4. Optionally add an attachment. If you selected documents on the Supporting documents page
before you started the action, they are automatically included.

¢ To add an attachment from the Supporting documents tab, click Next. The Select
documents dialog box opens. You can choose documents from the Supporting documents
tab with the Document source My computer. After you attach the documents, click Create.
The Mail module opens in Document with your attachments included.

e To add an attachment in Document, click Create. The Mail module opens in Document.
Click Attach files > Attach Documents, where you can search for the document. After you
select a document, click Save.

¢ To send mail without an attachment, click Create. The Mail module in Document opens.

5. Enter information in the To and Subject fields. The other fields on the page are optional. Enter or
update the fields as needed for the mail message, and then click Send. A summary page opens.

6. Edit links and notes, if needed. The mail is added in Document.

7. Close the Document window. You are then prompted to add the mail as a supporting document
in Contract. The document type defaults to Correspondence but can be changed.

8. Click Save to save the mail to the Supporting documents page.

5.0.4 LINE ITEMS TAB

The Line Items tab displays the line items that you will pay against in the ERP system, including
information about budget and commitment, schedule of values, change orders, payment progress,
payment forms, and accruals and receipts.

Line items are pay items for the contract. These can be materials, services, or credits. Material, Service,
and Credit lines each have a description, product category, quantity, unit of measure, value, WBS
phase code and general ledger account. Additionally, line items may contain delivery schedules,
retention, tax amounts, equipment details, batch characteristics and comments as needed.

Each line item on the contract needs to be added within the Contracts module, and these will become
the line items on the associated PO once the contract is pushed to an ERP system for PO creation. The
Line item details page includes sections for you to enter all relevant information for the line item. You
can add line items individually or import them via the import template.

5.0.4.14 LINE ITEMS REGISTER

The Line items register lists all line items for the contract. The line items grid contains sections that let
you see related columns concurrently. The Line items sections include Details, Budget and
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Commitment, Change Orders, Progress, Payment Forms, and Accruals/Receipts.

If the Change orders, Payment forms, or Schedule of values features are not enabled in the Contract
type configuration in the organization settings (Settings > Contract > Configurations > Contract type
configuration setup), the corresponding sections are not shown on the Line items tab.

Line ftem 10 = Tyme = Materialld

uuuuuuu

rrrrrr 2 Seected: 0 View selecs eatrors Liams | 170000

Items with errors show a yellow exclamation point indicator. You can hover over the indicator to see
the error. You can then click the Line item ID to edit the field.

The bottom of the grid shows the number of items in the grid, the number of items selected, and the
number of errors. To see only the selected items, click View selected. Click Clear selection to deselect
all items. You can click the number of errors to see all items with errors.

Many fields in the Details section are editable from the register, so you can quickly update a value
without opening the Edit details panel. Editable fields are highlighted in blue when you hover over

them.
Details
Product category =  Quantity = UoM = Unit price =
MPB - SUB,BUILDING 1.000 | Ea ($ 5.0000)

Some of the views contain links that take you to a detailed page view for additional information.

Page 196 of 377 InEight Inc. | Release 25.3



Contract User Guide

nnnn

(-]
H
|
3
NN N
|
H
|
H
H
|
i

© 0001 - Domestic Waterline E

Budget and commitment

LINE ITEMS COLUMN MANAGEMENT

The Line items register uses sections to group data. You can expand or collapse the columns and the
column selector builder to choose the information you want to see.

You can choose between the standard grid and the enhanced single grid registers. The enhanced single
grid register features faster loading and scrolling times, and collapsible sections that are color coded to
their corresponding drill-down viewsets. The standard presentation, features collapsible sections that
are in a light gray color. Delays in scrolling and loading might occur. Use the Line item single grid toggle
at the top of the page to switch between the presentations. When the toggle is set to On, the
enhanced single grid version shows. The toggle defaults to On.

Actions v HEADER LINE ITEMS SCHEDULE OF VALUES

@ Go to Line Item 1D

Line item single grid

I:‘ o Line lte.. = Type = Material ID = Description
D 0001 Material
The first section of the grid contains identifying information, including the line item ID, type, material
ID, and description. The columns in the first section are stationary and cannot be collapsed. You can

expand the columns until the section takes half of the screen area. After you have reached the
maximum expansion, the scroll bar shows at the bottom of the section.
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You can click the arrow in the column header of the other sections to expand or collapse that section.

The Collapse icon for each section is floating, so it is always visible as you scroll. You can manually size
columns, so you can see the information you want. To collapse all collapsible sections, click the double
arrow in the first section.

SUPPORTING WORKFLOW
DOCUMENTS ASSIGNMENTS

@) Cancel | Soeames @ 0 L S B @ o a

BACK CHARGES PAYMENT FORMS PAYMENT PROGRESS

e wecen e somurorvaues  YSERCGE smews  comscrerostour

........

The column management feature lets you rearrange grid sections, add or remove columns within the
sections, and remove sections if they are not needed. Click the Manage columns icon in the toolbar to
open the Column Selector Builder dialog box.

Column Selector Builder
Available columns Selected Columns
Search Q Search
[ section/column name [ | section/column name
wes O Tyee
0B total cost [ Materiat 0

CB total cost (] Description

Line item commitment
[ Product category
Pending line tem commitment

O auantity
O 0 v

[J | scheduled value

[ unit price
0O per

[ Netprice

[J  value claimed

[J % Complete

[ Lower limit

1 Uppertimit

Number of potential changes.

[ cost center
Potential change quantity

[J wBs category
Potential change net amount

[ wes code

The Available columns section shows all columns that are available for each section. To add a section
or column, select it, and then move it to the Selected Columns section. To remove a section or column,
select it, and then move it to the Available columns section. You can also rearrange sections from the
Column Selector Builder dialog box. To move a section, select it, and then use the arrows to move the
section up or down. You cannot move columns between grid sections, except in the following
instances:
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e The Type, Material ID, and Description columns can be moved from the first section to the
Details section.

¢ Any columns from the Details section can be moved to the first section.

Click Save to apply the changes. The changes are saved for as long as you are on the Line items page.
To save the column arrangement as a view, expand the View drop-down menu, and then select Save
view as.

When you open the Line items register, only the Details and Budget and commitment tabs show. You
can add other sections and columns as needed. After you have added the sections or columns they
remain in the view until they are removed, or you reset the defaults in the Column Selector Builder
dialog box.

5.0.4.15 ADD OR EDIT LINE ITEMS

You can use icons on the Line items register to add new line items or edit existing line items.

To add a line item, click the New line icon, and then select New line. See 5.0.4.17 Line items from
master agreements on page 209 for information about the From master agreement option to add
lines.

Actions ¥ <HEADER LINE ITEMS

®~

New line

From master agreement

= Type

| 0001 Credit

To edit a line item, select it and then click the Edit line item icon.

When you add a new line or edit a line, the Add or Edit line item slide-out panel opens. The panel
shows a condensed view of the Line item Details page.

You can also add a line by copying an existing line. To copy a line in the Line items register, select the
line and then click the Copy icon. Select Line item to copy to the register and assign a line number. You
can then edit the line item is needed. If the schedule of values is enabled for the contract, you can copy
a line item to the Schedule of values page. See Schedule of values tab for information about copying a
line item to the schedule of values.

SAVE

After you have filled out the Line item details page, save it. There are several options for saving:
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» Save - will save and take you back to the Line Items tab

» Save and new - will save and then take you into a new blank Line item details page to start
a new line item

» Save and create delivery schedule - will save and take you to the schedule delivery page

| Cancel | ‘ Save and new | | Save and create delivery schedule ‘ Save

5.0.4.16 LINE ITEM DETAILS

When you add a new line item, the Line item details slide-out panel opens, where you can fill in the
pertinent information for the line item. If you prefer to work with a full screen, you can click the View
full page icon at the bottom of the slide-out panel to show the full page view.

The Line item details page is organized in sections to group like information.

Line item details Q Quantity & pricing 9
“MaterisliD nced material sea Quantity o
Materal - 0000

sssssss Valve §

Additional fields o

Custom fields (D

Account assignment detai\sa

Additional details e Additional links

Comments

LINE ITEM DETAILS SECTION

The Line item details section of the Line item details page contains the basic details for the line item.
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The Line type allows you to select what type of line this will be paid on. There are four different line
items to pick from:

e Material

e Service

o Limit

» Credit (this would be used when there is a deposit or an expected refund)

Line item detalls Type
Material -
[Ype Material
Material M Service
Limit
Credit

MeJi= When working with multiple line items you can Jump between line items navigation,
details, status for open and close a line item by selecting the downward arrow.

10002276 -Test > Line ltem 0001

Line item 0001 - details ~ Status | Open v

Line ltem ID  Description

Line 0001 Lirnit

Line 0002  Limit

MATERIAL TYPE

When using Material ID numbers, companies use these 11-digit numbers to represent something
which is purchased, sold or rented. These companies mandate the usage of these numbers because of
their business processes. Other companies decide not to use the numbers and want to use free text.
This is so they don’t have to search for the 11-digit number to represent what was used.
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Line item ID 0007 Quantity

Type

Material

*Description

Country of origin

Afghanistan

Hint: type 'country name’

Material ID Q Advanced material search *Quantity

111 114,000

ID Description
160000.. SUBCONTRACTFIBER OPTIC TERMINATION,FABRICATE
160000.. RENTALMIXERREMIXER 5.5-10CY,DIESEL

160000 RENTAL MIXER,SMALL VOLUMETRIC PLANTELECTRIC

1RNANN RENTAI MIYER | ARRE VNI HIKMETRIN DI ANTEI ECTRIC

Q Advanced material search

Contract User Guide

If your organization uses a material master that has material attributes, the Long description field in

the Line item details is disabled, regardless of the Long description field configuration in the

Organization settings. You must click the Assign material attributes icon to add attributes that will

populate the long description.

The Product category field holds the 8-digit UNSPSC (United Nations Standard Products and Services
Code). These codes are universal and no longer the hierarchy. Your Materials Master will be brought in

automatically for you if you use it. If you do not use a Materials Master, then you need to go and find

a UNSPSC or product category. If you cannot find the code, you can search using the advanced material

search.

Line item details

Line item ID 0007

Type

Material

*Description

Install Rebar

Country of origin

Afghanistan

Hint: type 'country name”

*Valid from

06/07/2019
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Material ID Q Advanced material search

*Product category
mhb M

D Description
12350000 COMPOUNDS/MIXTURES
31230000 MACHINED RAW STOCK
MR MAT.. MR MATGROUP 123

MR MAT.. MR MATGROUP 1123
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SERVICE TYPE

When Service is selected from Type, you will notice only one difference from Material. You will lose
the Material Master ID within this tool. The Service type most likely acts differently in your ERP system,
so you will receive that differently in your ERP system as well.

LIMIT TYPE

Limit lines are a special line type that do not have a quantity or unit of measure, but that you know you
will be paying for. Limit line items allow you to specify a lower dollar value and an upper dollar value
for the line item. The upper limit represents the most you would pay for that line item, and is the
amount calculated into contract totals. This can be helpful for items such as freight, which may be
spread over multiple invoices and do not have a quantity associated with it, but that you can specify an
upper and a lower dollar amount for that the total cost needs to fall between. If it falls within those
parameters, you will pay the invoice.

CREDIT TYPE

Sometimes you may need to reduce the scope of your contract and add a credit line to reduce the
contract amount accordingly. For these instances, you would use the Credit line item type. Credit line
items contain the same fields as material line items, but any pricing you enter will automatically be a
negative (credit) value.

For example, when you enter 100 cubic yards at a unit price of $10, the system will display the unit
price as (510.00) and the total price as ($1,000.00).

Credit lines reduce the total overall value of your contract. This is different than back

NOTE

charges, which allow you to maintain your total contract value and just short pay the
invoice. See Back Charges for more information about back charges in a contract.

VALIDITY

Valid from and Valid through is the time frame when that line item is in effect. Think of Valid from as
your delivery date or first date of service. You can leave the end date blank unless there is a date
where claiming against this line item must no longer occur.

Line item details Line item ID

*Valid from Valid through

06/25/2019
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After the date entered in the Valid through field has passed, the line item is automatically set to
Closed. When the contract is already published and the line item closes, the Line Item ID field shows
the Revised line item icon. If you do not want the line item status to be Closed, you can manually
change the status and extend the Valid through date to a future date. Closed line items cannot be
added to vendor change orders or payment forms.

Line ltem ID = Type =
U

O 0001 Material (

AGREEMENT ITEM ID

If the contract is associated to a master agreement, you can use the Agreement item ID field to
associate an unpublished line item to the master agreement. See Line items from master agreements

for more information about associating an existing line item to a master agreement.

QUANTITY & PRICING SECTION

Under Quantity & pricing, you can enter your quantity, unit of measure, and price for the line item and
then click Estimate tax. When it comes back, you get a response when the fields are completed. That is
when the tax is calculated, because the tax component lives outside of your ERP system, but Contract
must retrieve that tax information from your ERP system prior to calculating. If the organization has
been configured to Allow edits to Is taxable field (organization Settings > Contract > Configurations >
Line item type configuration), the Is taxable check box shows above the pricing summary for the line
item. This check box defaults to selected. The taxes for the line are estimated either from project
settings or from a third-party integration. When the Is taxable box is not selected, no taxes are
estimated from project settings. Any tax information that is provided in the Tax request response,
purchase order response, or manually uploaded via LogicApps file are shown regardless of the Is
taxable check box and are considered when calculating taxes on payment form line item.

Quantity & pricing

*Quantity *UoM *Unit price *Per

$000 1 EA

Pricing Value §
Net price $0.00

Tax amoun it sgnol ®

Gross amount it $0.00

Click the Information icon to see estimated tax information based on the project settings.
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ACCOUNT ASSIGNMENT DETAILS SECTION
ACCOUNT ASSIGNMENT DETAILS

Assignments encompass the WBS and Cost Centers giving you the flexibility to assign contract line
items to different account assignments. This gives the project flexibility to be able to assign line items
to a WBS as well as a cost center within the ERP system based on the project specific requirements.

Account assignment details

Account assignment type

1

WEBS

WBS

Cost center

UL ialdie s

WBS CATEGORY

For WBS Category, the selections available to choose from are Permanent, Consumables and Rentals.
You need to pick the appropriate drop-down for that line item.

Whatever is selected for the WBS category, it triggers the General Ledger Account and the type of
materials. You must have the category selected because it controls your ERP system’s GL and taxability.
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*WRBS category

Consumables -

Consumables
Permanent

Rentals

Me3=0 Once a Purchase Order (PO) is created, you cannot change the vendor or the line type
because these become hard coded. If mistakes were made, you must create another line
item and delete the wrong one.

ACCOUNT DISTRIBUTION

When Account distribution is selected as “Single” all your costs for that line item will be tied to one
WBS code.

Account distribution “WBS code *General ledger account

Single - 1034 - 170338 PG Connector, 521320 - Supplies-Consuma, ¥

A Split by drop-down appears with the option to split your costs by Quantity, Percentage or Value.
Once you have that determined, you can split as needed between multiple WBS elements in the boxes
below. You can also add as many WBS items to that line item as needed.
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Account distribution

Split by Percentage -

Single

Split by Quantity
General ledger account
Split by Percentage

521320-5upplies-Consumable/ ..

Split by Value

521320-Supplies-Consumable/ ..

Total

COST CENTER

Cost center adds an account assignment type to complement the existing WBS type. Some projects
need to be charged to a different type of an account that does not integrate with Control but does
integrate with the ERP system. They would get their numbers through Control, Plan or Progress. Having
the Cost Center option gives you the flexibility to assign contract line items to different account
assignments in the ERP system. Based on project specific requirements.

Account assignment details

Account assignment type Account distribution *Cost center *General ledger account

I Cost center - I Single v 501030 - Consumption - Qua

The Cost Center is a free-text field. However, in the Master Data Library, cost centers can be defined to
use. If your organization maintains cost centers in the Master Data Library, they | appear as an auto-fill
under the cost center pull-down. There is nothing in this field which forces you to have an exact make
with any other items listed.

Cost center fields and columns appear throughout the application where WBS code fields and columns
already exist. Cost Center selection would be used when costs are being charged to the overall project
and not to a specific WBS.

ADDITIONAL FIELDS SECTION

The Additional fields section contains five custom fields, which you can define in the Organization
settings. You can use these fields to map a custom line item JSON to your ERP system. Organizations
specify the names of the custom fields on the Contract Custom Labels page of the organization
settings.
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Custom fields (D

LICL1

Select one

Internal Order

Custom field 3

Custom field 5

Custom list 2

Select one

Custom field 2

Custom field 4

ADDITIONAL DETAILS SECTION

Contract User Guide

The Additional details section contain fields that let you add a percentage for goods receipt, diversity
participation, and overdelivery tolerance at a line-item level.

DIVERSITY PARTICIPATION

Diversity participation fields let you manage the diversity participation percentage and value for a line
item. The Percentage field calculates a value based on the percent of the value of the line item. The
Value field calculates a percent based on the value of the line item. The two lines work together. When
you update one, the other updates automatically. For example if the value of the line item is $50,000,
and you update the percentage of the diversity participation to 10%, the value of the line item
becomes $5000. If you update the value of the line item to $6000, the percentage becomes 12%.

Additional details

Retention percent

Goods receipt

Required
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Diversity participation

0.00%

$0.00

Overdelivery tolerance (%)
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W[ed2 When the line item value is updated using a vendor change order, the percentage is used
to calculate the new diversity value.

5.0.4.17 LINE ITEMS FROM MASTER AGREEMENTS

A master agreement is a type of contract, set at the project level, between a general contractor and a
supplier to purchase goods or services later. When a contract has been associated with a master
agreement, you can add a line item from the master agreement to take advantage of the terms,
conditions, and pricing of the master agreement. You can also associate an existing line item to the
master agreement. See Master Agreements for more information about master agreements.

ADD A LINE ITEM FROM THE MASTER AGREEMENT

You can add a line item directly from a master agreement. When you add lines from the master
agreement, line item details are predefined, and the association to the master agreement line item is
automatically created.

The contract must already be associated with a master agreement.

1. From the Line items tab of the contract, click the Add line item icon, and then select From
master agreement. The Add from master agreement dialog box opens.

2. Select a line item from the list.

3. Click Add. The line item is added to the line item register. The Type and UoM columns are
dimmed and cannot be changed.

You can now create a purchase order from the line item.

ASSOCIATE AN EXISTING LINE ITEM TO A MASTER
AGREEMENT

You can associate a line item to a master agreement, so you can use the terms of the master
agreement to purchase the line item.

The contract must already be associated to a master agreement, and the line item must already be
created and saved. You can only associate a contract line item that has not been published. After the
contract line item is published on the purchase order you can no longer associate it to a master
agreement. Line items that are already associated to a master agreement have the Line Item Id and
Type fields dimmed in the Line items register; all other fields are editable in the register.
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1. From the Line items tab in the contract, click the line item number. The line item Details page
opens.

2. Select a master agreement line item from the Agreement item ID field drop-down list.

Line item 0002 - details - Sttus | Open ¥ Quantity & pricing

Type *Quantity *UoM *Unit price *Per
Service v 10000 Hr v $5000 1 HR
Description Product category Pricing ot

v Net price. §$50000

Tax amount B catcutate tax so00 @

Country of origin Harmonized Tariff Schedule Q search code Gross amount $50000

Additional fields

Long description

Custom fields (&) a

Valid from *Valid through
AG-01 AG-02

01/26/2022 & 01/31/2022
Select one v

*Delivery address Agreement item ID
Internal Ordgr LF2
22495 Van Buren Bivd, Riverside, California, 92.. ¥ v

Agreement item ID  Description
0001 SUBCONTRACTINTERIOR FINISHES,INSTALLATION 4
0002

0003 ELECTRICAL CORD ASSEMBLY

3. Click Save. The line item is associated to the master agreement.

DISASSOCIATE A LINE ITEM FROM THE MASTER AGREEMENT

You can disassociate a contract line item from the master agreement item when you no longer want
the item tied to the master agreement line item.

You can remove the association at any time. After the association is removed you can reassociate the
contract line item to the same master agreement line item.

1. From the Line items tab in the contract, select the line item, and then click the Edit line item
icon. The line item Details page opens.

2. Click the Disassociate icon next to the Agreement item ID field, and the click Yes in the
confirmation box.
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Line item 0002 - details ~ Status | Open v
Type
Description Product category

v
Country of origin Harmonized Tariff Schedule Q Search code

Long description

Valid from *Valid through
01/26/2022 & 01/31/2022 =
*Delivery address Agreement item ID

22495 Van Buren Blvd, Riverside, California, 92 v 0003 - ELECTRICAL CORD ASSEMBLY

3. Click Save. The association is removed from the contract line item. The value of the line item
goes to the generic MPA 0000 line.

You can associate the line item to a different master agreement line item.

5.0.5 SCHEDULE OF VALUES TAB

As you work on a contract, you often need to see the quantity or value of a line item claimed against a
component, so you can progress the contract. A component is used in InEight Plan and InEight Progress
to divide a cost item into manageable and identifiable parts, so they are easy to track. The schedule of
values lets you see the totals claimed by a component. You can also use the totals to reconcile a
vendor invoice with the contract line items.

The Schedule of Values tab shows the details of line item parts. Each part is made up of a description,
schedule quantity, unit of measure, unit price, schedule value, and WBS code. You can choose whether
to have the schedule item available to use in Plan and Progress or to hide it from those applications.
The Schedule of values page lists all of the schedule items for the contract. A warning shows if the
schedule value exceeds the Net price of the line item.
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o= The Contract discipline (Project Settings > Assigned disciplines and commodities) must
be set to Available to send schedule of value items to Plan.

5.0.5.18 QUANTITY AND VALUE IN THE SCHEDULE OF VALUES

The schedule of values can help you track values and quantities of line items. If you want to track only
the value of a line item, you can create a value-only schedule item. A value-only schedule item can
include positive, negative, or zero value but have zero quantity, so you can track and claim value
without entering a quantity.

5.0.5.19 ADD A SCHEDULE OF VALUES

To add a schedule of values, click the Add schedule of value icon on the Schedule of values tab.

Contracts > usD §

Actions. - VENDOR GHANGE SUPPORTING WORKFLOW
< HEADER LINEITEMS ‘SCHEDULE OF VALUES ORDER LOG BACK CHARGES PAYMENT FORMS PAYMENT PROGRESS DOCUMENTS ASSIGNMENTS

Schedule of value items

Schedule item ID Contract line item ID Description Schedule quantity UoM Unit price Schedule value WBS code. Hide in plan and
prog

5.0.5.20 ADD SCHEDULE ITEM

When you add a new schedule item, the Add schedule of value slide-out panel opens, where you can
fill in the pertinent information for the schedule item.

1 Contract line item ID Select the line item associated with the schedule of value item.

2 Description Free text entry field to describe what the schedule of value
itemis.

3 Schedule quantity The total quantity of the item. When this field is enabled, the
quantity must be greater than zero.

4 UoM Select the unit of measure for the schedule of value item. The
unit of measure can be different from the unit of measure for
the line item.

5 Unit price The unit price, in the currency of the contract, of the schedule

of value item. The unit price is automatically calculated when
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I "

the schedule value or schedule quantity is updated. A negative
number can be entered for the unit price when an item has a
negative value.

6 Schedule value Contract calculates the schedule value based on the quantity
and unit price.

7 Value only Select the Value only check box to create a value-only
schedule item. Checking this box disables the Schedule
quantity and Unit price fields. Also, the Hide in plan and
progress field is set to Yes and then disabled.

8 WBS code The WBS code assigned to the line item.
9 Hide in plan and Select the box to hide the schedule item from Plan and
progress Progress. Deselect the box to track the schedule item as a

contract component in Plan. If an item has a value other than
zero in Plan and Progress, you cannot deselect this check box.
If you have made a mistake and need to deselect the check
box, you must go to Plan or Progress, and then edit the item
there. After it is edited, you can deselect the check box. A
schedule item that is hidden in Plan and Progress can be
claimed directly from Contract.

When the check box is not selected, any changes made to the
vendor in the contract details are automatically updated in
Plan.

10 Custom fields The contract-level custom fields.
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DETAILS CONTRACT CLAIM CONTRACT CLAIM HISTORY

Contract line item ID o

Select item.

Schedule quantity e

Unit price

WBS code e
External Order @
List 1

Custom field 3

Custom field 5

0.0000

$ 0.00

*Description 9
o

Select item..

Scheduled value e

Hide in plan and progress e

YES

Internal Order
List 2

Custom field 4

Contract User Guide

o () value on\y'\D

$ 0.000

Cancel

You can also add a schedule of value item from the Line items register. Any line item type can be

copied. To copy a line item from the Line items register to the schedule of values, select the line item,

and then expand the Copy icon. You can then select To schedule of values. A notification shows that

the line item has been added to the schedule of values. The following columns are copied with the line

item:
e Line ltem ID
e Description
* UoM
¢ Quantity
e Unit Price
e WBS code

e Custom fields
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The Hide in Plan/Progress field in the schedule of values defaults to Yes. You must manually fill in the
remaining fields. The line item is automatically associated to the schedule of values.

When you copy a limit line item to the schedule of values, the Value only check box is automatically
checked and disabled. The unit of measure defaults to a value of PLS.

If the line item had been deleted or closed, the line item is copied, but the line item ID is left blank.

You can use the import and export feature to set up and maintain a large schedule of values.

5.0.5.21

5.0.56.22 SCHEDULE OF VALUES REGISTER

After you add a schedule of values item, Contract adds a Schedule item ID and adds it to the schedule
of value items register. The register lists all schedule items for the contract. The schedule of values grid
has sections for schedule of values details, Contract claims, component progress, and summary
progress. Arrows in the column headers let you collapse or expand the section. Multiple sections can
be collapsed. The first section, which includes the Schedule line item ID, Contract line item ID, and
Description cannot be collapsed. You can click the double arrow in the first section to collapse the rest
of the sections.

OoooooooD

The bottom of the grid shows the total number of items and the total number of selected items. To see
only the selected items, click View selected. Click Clear selection to deselect all items. The Go to
Schedule ID link helps you quickly find Schedule items that are not visible on the page.

You can rearrange the columns within a section using the Column Selector Builder. To open the
Column Selector Builder, click Manage columns. The Available columns section shows all columns that
are available for each section. To add a selection or column, select it, and then move it to the Selected
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Columns section. To remove a section or column, select it, and then move it to the Available columns
section. Click Save to apply the changes. You can also rearrange sections from the Column Selector
Builder dialog box. To move a section, select it, and then use the arrows to move the section up or
down. You cannot add columns to the first section in the grid. You cannot move columns between
sections.

Column Selector Builder

Available columns Selected Columns.

Search C Search

Section/coulmn name [J  section/coulmn name
Schedule Of Value ltems - Schedule item ID
Schedule Quantity Description
Uom a

[[] Schedule Of Value Items
Unit Price

[] Schedule Quantity

[ vom

[ unitPrice

Schedule Values
Wbs Code

Hide In Plan And Progress

[ schedule Values
Custom List 1

] wbs Code
Custom List 2

]
O
=]
=]
=]
=]
=]
5]
O
O
O

[J | Hide In Plan And Progress
Custom Field 1 v <

You can search for specific available or selected columns. For example, you could search for value
Claimed, and the search results show all columns called Value Claimed in all sections.

SCHEDULE OF VALUES DETAILS

The Schedule of value items section shows the schedule quantity, component quantity, unit of
measure, unit price, schedule value, WBS code, and whether the item is hidden in Plan and Progress.

If the schedule values for a line item exceed the net price of the line item, all schedule items for that
line item are marked with a warning icon in the Schedule values column. To keep totals in sync, you
must change the number in the line item or the schedule items. If a schedule item has been claimed in
Plan or Progress, you cannot delete the schedule of values item. You can update the item, and then the
update goes to Plan or Progress.

If a schedule item is not hidden in Plan and Progress, the Component quantity column shows the
Component quantity from Plan. If the value is modified in Plan by splitting the contract component, a
blue dot shows next to the quantity to indicate the component quantity does not match the schedule
quantity.

If there is no quantity claimed, you can delete a schedule of values item that is not hidden from Plan
and Progress.

The total schedule value amount shows at the bottom of the section.
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CONTRACT CLAIMS

The Contract grid section shows the quantity and value claimed in Contract. The total amount claimed
in Contract shows at the bottom of the section. If the current date is not between the valid from and
valid through dates of the associated line item, an error icon shows in the Contract line item ID column
of the register, and no claims can be made from associated schedule items.

See Claim schedule items from Contract for information about claiming in Contract.

COMPONENT PROGRESS

The Component progress grid section shows claims that were made in Plan and Progress. Click on a link
in the Quantity claimed or Value claimed column to go to quantity tracking in Plan.

The total amount claimed in Contract shows at the bottom of the section.

SUMMARY PROGRESS

The Summary progress grid section shows the total of claims made in Contract and in Plan and
Progress.

Quantity claimed The total number of items claimed.

Value claimed The total amount (that is, the quantity multiplied by the unit price)
claimed.

% Complete The percent of the schedule value that has been claimed.

Quantity remaining The number of items that remain to be claimed (that is, the schedule

quantity minus the quantity claimed).

Value remaining The value that remains to be claimed (that is the schedule value
minus the value claimed).
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Contract < Component progress < Summary progress <
Quantity claimed = Value claimed = | Quantityclaimed =  Value claimed = | vty = vawe = Zﬂﬂmplm a mal'rl|t\¥|g = | Valoe . T

14 $140.00 0 $0.00 14 $140.00 14.00% 86 $860.00 =
0 $0.00 0 $0.00 0 $0.00 0.00% 10 $1,000.00
15 $3,000.00 0 $0.00 15 $3,000.00 75.00% 5 $1,000.00
0 $0.00 0 $0.00 0 $0.00 0.00% 30 $9,000.00
0 $0.00 0 $0.00 0 $0.00 0.00% 40 $3,600.00
25 $1141.75 0 $0.00 25 $1,14175 50.00% 25 §1141.75
60 $19.80 0 $0.00 60 $19.80 100.00% 0 $0.00
0 $0.00 0 $0.00 0 $0.00 0.00% 70 $12,523.00
0 $0.00 0 $0.00 0 $0.00 0.00% 80 $6,160.00
12 $480.00 0 $0.00 12 $480.00 1333% 8 $3,120.00
9 $1,800.00 0 $0.00 9 $1,800.00 9.00% 9 $18,200.00
10 $2000 0 $0.00 10 $2000 9.09% 100 $200.00
12 $4.20 0 $0.00 12 $4.20 10.00% 108 $37.80
13 $1872 0 $0.00 13 $1872 10.00% n7 $168.48
i $21.70 0 $0.00 14 $21.70 10.00% 126 $195.30
0 $0.00 2 $10.00 2 $10.00 20.00% 8 $40.00
1 $62.00 0 $0.00 1 $62.00 5.00% 19 $1,178.00
$6,708.17 $10.00 $6718.17 1031% $58,424.33

Date fields in the toolbar let you narrow the dates that components were claimed.

The total value claimed, percent complete, and value remaining show at the bottom of the section.

PAYMENT CLAIMS

The Payment claims grid section shows the quantities and values used in payment claims. For
information about Payment claims, see Payment claims.

I " S

Vendor quantity The quantity of the claim for a vendor.

Vendor value The value of the claim for a vendor.

Certified quantity The quantity of claims that have been certified.

Certified value The value of claims that have been certified.

Certified delta The difference between the vendor value and the certified value.
Pending quantity The quantity of claims that are pending certification.

Pending value The value of claims that are pending certification.

Pending delta The difference between the vendor value and the pending value.
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REMOVE OR DELETE A SCHEDULE ITEM

When a schedule item is not needed, you can remove it or delete it from the schedule of values. When
you remove a schedule item, it is permanently removed from the contract, and subsequent schedule of
value items are renumbered. When you delete a schedule item, the item shows in the register with a
strikethrough, and it cannot be edited. The remaining schedule items are not renumbered, so you can
maintain the schedule of values ID order. Only schedule items that have not been claimed in InEight
Plan, InEight Progress, or Contract can be removed or deleted.

You can remove a schedule item if it has never been associated to a vendor change order, payment
claim, or payment form. To remove a schedule item, select it, and then click the Remove schedule of
value icon.

. VEND
Actions ¥ HEADER LINE ITEM SCHEDULE OF VALUES OF
Df e ® @ Go to Schedule 1D
& Schedule of value items
|E| Schedule = Contract line = Description ="| Schedulequantity —= Comp
line item ID item ID Quani
1 o000 Guardrails with No Handrail 284.0000
[] 2 0001 Guardrails with SS Handrail 257.0000
[] 3 0001 Stainless Steel Rail 181.0000

You can delete a schedule item when the vendor change order, payment form, or payment claim has a
net value of 0 and the following conditions are met:

¢ The Contract claim sum of all claims is O
e The Payment claim Certified section is 0
e The Payment form This submission section is 0

To delete a schedule item, select it, and then click the Delete schedule of value icon. The item is
deleted and shows a strikethrough. The Hide in plan and progress check box is automatically set to Yes
and disabled.
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Vi SUPPORTING
Actions ¥ HEADER LINE ITEM SCHEDULE OF VALUES / PAYMENT FORMS PAYMENT PROGRESS DOCUMENTS

M @ @ Go to Schedule ID MM/DD/YYYY
4

& Schedule of value items / {
li‘ Schedule = Contract line = Description ="| Schedulequantity = L. ~e = Schedule = WBS code = Hideinplan =
line item ID item ID Q values and progress
|:\ 1 0001 Guardrails with No Handrail 284.0000 / $224.00 $63,616.00 4567 - Yakima St...
I y |
3 0001 Stainless Steel Rail 181.0000 / $231.00 $41,811.00 4567 - Yakima St...

VIDEO | Delete or Remove Schedule of Values

UNDO A DELETION OF A SCHEDULE ITEM

If a schedule item was deleted from the schedule of values, you can re-add it from the contract
Schedule of values tab or the vendor change order Schedule of values tab. To re-add the item, click the

Undo schedule removal icon.

VCO total Remaining amount to allocate
$0.00 $0.00
peas  SOHEDULEOF
Actions ¥ B O || cotoScheduleid El

A Line Item total value does not match Schedule of val

& Current schedule line value
|E| Schedule = Contract = Description = WBScode = Cust(Schedule quantity =  Component = UoM = Unitprice = Schedule
line item ID line item ID Quantity value
\:\ 1 I:ln 1 0.0000 0.0000 Cubic Meter $0.00
\:\ 2 I:ln 2 4.0000 0.0000 Barrel $2.00
\:\ 3 I:ln 3 3.0000 0.0000 Acre $3.00
: 5 I:ln 5 1.0000 0.0000 Cubic Yard $20.00

The strikethrough is removed from the schedule item, and the value of the schedule item is added
back into the contract. When you re-add a deletion in a vendor change order, the Change order
adjustment section of the vendor change order Schedule of values tab is updated.
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5.0.5.23 CLAIM SCHEDULE ITEMS FROM CONTRACT

CLAIM SCHEDULE ITEMS FROM CONTRACT

You can claim individual schedule items or multiple schedule items from the Schedule of values page.
Claiming in Contract lets you track claims that might not be tied directly to work performed daily in the
field.

You can view claim history of an item from the Contract claim history tab of the Edit schedule item
slide-out panel (Edit > Contract claim history).

Schedule items must be within the valid from and valid through dates of the associated line item to be
claimed. If the current date is outside of those dates, you cannot claim the schedule item. An error icon
shows in the Contract line item ID column of the Schedule of values register and in the Claim multiple
schedule items dialog box when the posting date is invalid for the associated line item. If there is a
valid from date, but no valid through date, an error is shown when the date is not after the valid from
date. If there is only a valid through date, an error is shown when the posting date is after the valid
through date.

CLAIM A SCHEDULE ITEM IN CONTRACT

You can claim a schedule item from the Edit schedule item slide-out panel.

The schedule item Hide in plan and progress check box must be set to Yes. After an item has been
claimed, the value of the Hide in plan and progress field cannot be changed.

1. Select a schedule item, and then click the Edit schedule icon. The Edit Schedule item slide-out
panel opens.

2. Go to the Contract claim tab.

ASSIGHMENTS * CoNTRACTELOsEouT
= es T Ceaatites 3 9 O @@ Q

P

Conteact e tem D Deceription Pscode = Mdein,
........

usriity csimed (o date) Value laimed (1o date)

Notes

L o o < 1)
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3. Enter the claimed quantity or claimed value. The other value is automatically calculated. A
prompt asks if you want to recalculate the other field based on the entered value.

¢ If you choose to recalculate, the other value is calculated.

¢ If you choose not to recalculate, you can enter a value, including values that are rounded.
The values might not match mathematically.

\[e312 When you make a claim against a value-only schedule of values item, you can only
claim value. The ability to claim quantity is disabled and cannot be recalculated.

4. Enter the claimed date and any notes.

If you want to claim additional items, click the Add claim icon in the slide-out panel, and repeat
steps 2-5 as needed.

6. Click Add.

The Quantity claimed and Value claimed columns in the Contract section of the register are updated.
All columns in the Summary progress section are updated.

CLAIM MULTIPLE SCHEDULE ITEMS

You can claim multiple schedule items at one time from the Schedule of values register.

The schedule item Hide in plan and progress check box must be set to Yes. After an item has been
claimed, the value of the Hide in plan and progress field cannot be changed.

1. From the Schedule of values register, click the Claim multiple schedule items icon. The Claim
multiple schedule items dialog box opens.
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Claim multiple schedule items

Posted date
osn72022 ]

Claim muliiple actuals:

e w2

3 Load remplne [ save 25 templae

Action  Scheduleitemid = Description

Quantity claimed (o = Valua claimed
= gumydamed(e = Vawcamedto =

0

Unchecked Hide in Plan and Progress: schedule items are not displayed in the list

Seareh. Q

= Clamedvalve = MNous

2. Enter the claimed quantity or value for each item. The other value is automatically calculated. A

prompt asks if you want to recalculate the other field based on the entered value.

 If you choose to recalculate, the other value is calculated.

¢ If you choose not to recalculate, you can enter a value, including values that are rounded.
The values might not match mathematically.

3. If you want to claim additional items, click Add schedule item. The Add schedule items dialog

box opens.

InEight Inc. | Release 25.3
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Add schedule items

‘Hide in Plan and Progress' schedule items are not displayed in the list

[] Schedule item ID = i = Value remaining = Percent complete

$1.125.00
$11.00
$25.00
$8:800.00
$2:340.00

$6.900.00

4. Select one or more schedule items, and then click Add. The items are added to the Claim

multiple schedule items dialog box.

5. Enter the claimed quantities or values for the added items.

6. Click Claim.

The Quantity claimed and Value claimed columns in the Contract section of the register are updated.

All columns in the Summary progress section are updated.

CLAIM SCHEDULE ITEMS FROM A SPREADSHEET

When you have many schedule items to claim at one time, you can use the import function to claim

these items.

The schedule item Hide in plan and progress column of the spreadsheet must be set to Yes. Claims for
schedule items with Hide in Plan and Progress set to No are ignored upon import. After an item has

been claimed, the value of the Hide in plan and progress field cannot be changed.
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1. On the Schedule of values tab, optionally select items to be exported.
¢ If you select items, only those items selected are exported.
¢ If you do not select any items, all items are exported.

2. Click the Export icon, and then select With data. A Microsoft Excel spreadsheet with the
schedule items is downloaded.

3. Open the template, and then claim items in the Quantity claimed or Value claimed columns, and
then save the file.

4. Click the Import icon. The Import data from template dialog box opens.
Browse for the file or drag and drop it to the dialog box.

Indicate whether to import values based on the quantity, value, or both. If you select Quantity,
the Value claimed is recalculated regardless of what was entered and vice versa. If you select
Quantity and Value, both columns are read regardless of whether they match. You are
responsible for maintaining those fields.

Import schedule of values - Google Chrome = O X

Import data from template

[‘;huporr template

Data will be imported in to Schedule of values new

Drag and drop the file here or browse

Browse...

Claim Option
Quantity v
Quantity

Value

7. Click Import. Data is imported and the results are emailed when completed.
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From the email notification, click Review data. The import history page opens, and you can review the
import. The Schedule of values page is updated. The import history shows the import type Schedule of
values.

CLAIMING TEMPLATES

If you have many schedule items or if you have a group of claims that you use on a regular basis, such
as at the end of the week or each time concrete is poured, you can create a claim template. The
template can help you quickly find the schedule items you need each time the event occurs.

CREATE A CLAIMING TEMPLATE

You can create a claiming template when you claim multiple schedule items.

1. From the Schedule of values register, select one or more schedule items, and then click the
Claim multiple schedule items icon. The claim multiple schedule items dialog box opens.

Claim multiple schedule items
Ot

&

= Description

2. Add the schedule items for the template as you do when you Claim multiple schedule items, and
then click Save as template. The Save template dialog box opens.

3. Enter the name of the template, and then click Save.

You can use the claiming template to make a claim from contract.
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CLAIM MULTIPLE ITEMS FROM A TEMPLATE

You can load an applicable template when you have a group of claims that are used regularly, so you
do not have to search for each item.

A template must already be created.

1. From the Schedule of values register, select one or more schedule items, and then click the
Claim multiple schedule items icon. The claim multiple schedule items dialog box opens.

X

Claim multiple schedule items

Unehecked Hide in Plan and Progress schedule ems are not displayed inthe ist

= Qumycamed(o = Yewddmed(o = Chmedqamty = Gamedviie

cate)

2. Click Load template. The Load template dialog box opens.

3. Select the template you want to use, and then click Load. The template opens in the Claim
multiple schedule items dialog box.

4. Review the template, and add or remove items as needed.
5. Enter the claimed quantities or values for the added items.

6. Click Claim.

5.0.5.24 CONVERT A SCHEDULE SCHEDULE OF VALUES TO A
PAYMENT FORM

You can quickly convert schedule of value items to a payment form from the Schedule of values
register. The new payment form is automatically populated with values from the schedule of value
items for the date range selected.
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CONVERT A SCHEDULE OF VALUES TO A PAYMENT FORM

Convert a schedule of values into a payment form when a claimed schedule item is ready to be paid.

You must have payment form permissions to convert schedule of values items to payment forms, and
the Contract type must be configured to use payment forms. Items must be claimed before they can
be converted to a payment form. The item can be claimed in Contract or Plan or Progress.

1. From the Schedule of values register, select the claimed items to convert. Click the Associate
schedule item icon, and then select Payment form. The Add payment form dialog box opens.

Add payment form

~Description

“Work completed from “Work completed through

month/day/year B month/day/year

Progress estimate number Progress estimate billing period

month year

2. Enter the payment form information, and then click Add. The payment form is added, and the
Payment form Details page opens.

You can continue adding payment form information on the Payment form Details page. The schedule
items you selected show in the Payment forms Schedule of values page.

5.0.5.25 CONVERT A SCHEDULE ITEM TO AN ACCRUAL OR
RECEIPT

You can convert a schedule item into an accrual or receipt from the Schedule of values register.

CONVERT A SCHEDULE ITEM INTO AN ACCRUAL OR RECEIPT

Convert a schedule item into an accrual or receipt from the Schedule of values register, so you do not
have to enter the information on the Accruals page.
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You must have accrual/receipt permissions to convert schedule of values items to an accrual or receipt.
Only items that are eligible for goods receipts can be converted. If the receiving amount causes the line

item to be over the allotted tolerance, an error message is shown when you convert to a goods receipt
or accrual.

1. From the Schedule of values register, select one or more schedule items.

2. Click the Associate schedule item icon, and then select Accrual/Receipt. The Add new item
dialog box opens.

Contracts > usD §

Actions v HEADER LINE ITEMS SCHEDULE OF VALUES VE%

3. Select the type, and then add a description and posting date.

Add new item

Type
@ Accrual O Receipt

“Deseription

+Contract

7200009182 - Subsurface Construction LLC / 0010092414 - Subsurface Construction LLC

+Posting date

month/day/year i)

Cancel

4. Click Add. The accrual or receipt is created, and the schedule of values quantity is shown on the
corresponding line item. If the value of the Summary Progress Value Claimed field is 0, the item
is added to the accrual, but defaults to a 0 value. When you convert a value-only schedule of
values item, Contract converts the sum of the claimed values of the schedule of values
associated to the parent line item.

5.0.6 SUPPORTING DOCUMENTS

The Supporting Documents tab contains all the documentation for the contract in one location. This
includes all insurance, surety, waivers, etc. Because this information is in one tab, the contract,

InEight Inc. | Release 25.3 Page 229 of 377



Contract User Guide

compliance, and finance teams can verify the vendor has supplied all necessary documentation for
compliance with the subcontract.

5.0.6.26 ADD SUPPORTING DOCUMENT

On the Add supporting document window, you are required to specify the document type. All system-
managed and custom document types are supported.

The Add supporting document window requires additional data dependent on the type of document
you attach. For example, the Insurance document type requires the following addition fields: Subtype,
Insurer, Effective date, Expiration date and Notes. You can also add a document from InEight
Document.

Single sign-on is available for Contract to Document features, such as adding a document
from Document. When you use one of these features, the Document sign-on page opens,
and you can enter your credentials. This creates a sign-on token that lets you remain
signed in until the session ends. The first time you sign in to Document, a black secondary
window and the Document Home window also open. You can close these windows.
Single sign-on is activated, and they are not shown again.

Document types Insurance, Surety, Certification, Tax ID form, and Other have the option to send
notifications when the document expires. An expiration value is set at the organization and project
levels that indicates the number of days before the responsible parties receive notification. When the
Expiration notification enabled toggle is set to Yes, notifications are sent until you turn off the setting
in the document or after 180 days past the expiration date. The Expiration notification enabled toggle
remains set to Yes, so you can quickly see that notifications were sent. The Tax ID form document type
also has a field for the Tax identification number.
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ADD SUPPORTING CONTRACT DOCUMENTS

1. On the record page for the contract, select the Supporting Documents tab.

SUPPORTIMNG
DOCUMENTS

WORKFLOW
ASSIGMMENTS

SYNC LOG

2. Click the Add Document icon, and then select New supporting document.

@v

= New supporting document [Link

a From supporting document list Iple Te
' Fromn Eight Document g HM2ZW
_J 103442 ITWO-04 Traffi... 103442 IW

3. Add Supporting Document details — Title, Document Type, File/Link, Executed date (if applicable)

and Notes.

4. Click Add.

ADDING DOCUMENTS TO SUPPORTING DOCUMENTS

REGISTER

For a quick way to add documents to a central location to add all at once to a contract can be done at
the Contract tab. You can add a new supporting document or a document from InEight Document.

To add a new document, go to the Contracts > Supporting Documents tab. Click the Add Supporting

document icon, and then select New Supporting document.

Complete all the fields required, including upload your document you want to be attached from your

desktop or from InEight Document.
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*Title

DRAFT INSURANCE

Contract

- ¥ I -

Hint: 'ype a contract iL vendor IL or

*File/Link

newdoc.docx @

Description to tie this supy

*Document type

Insurance

Contract User Guide

X

*Subtype
Umbrella A
*Insurer *Policy number
abc ins 111333
*Effective date “Expiration date
01/06/2020 iz 01/24/2020 s
MNotes Expiration notification enabled?
© ;
After you select Save,the document is saved to the register and ready to be linked to a contract later.
SUPPORTING
CONTRACTS DOCUMENTS
Actions bt @ E ®
Contract ID Contra... Title File/Link Document ... s
DRAFT INSUR.. newdoc.docx Insurance u
7400002210 Smoke Tes.. abc INSURANCE newdoc.docx Insurance u

When you upload a document of type Proposal, subtype from Vendor in InEight Change and associate
it to a Contract ID, the document is visible in Contract as read-only on the main Supporting document

register and the Contract supporting document tab.
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If a VCO was selected in Change, it is also shown on the VCO supporting document tab. The proposal
has an approval status of Not applicable, and Contract Document workflow is not considered. Only the
Change workflow for the document is considered. The document is read-only in Contract.

5.0.6.27 VIEW A SUPPORTING DOCUMENT

To view a supporting document, click the link in the File/Link column of the Supporting documents
register. The document opens a preview in a new tab, so you can view the pages of the document and
then decide if you want to download it to your workstation. You can use the Previous and Next
buttons to view all pages.

HistoricalWeatherRecord_2023-April-05-.

Previous PageNo:1 /1 Next
Historical Weather Record
Omaha, Nebraska, 68114, United States Of America, Lat. 412656 , Lon. -96.0493
(UTC-08:00) Central Time (US & Canada)
Selected Range:  Date: Time: Date: Time:
From: 04/05/2023 12:30 AM To: 041052023 11:30 PM
Date Time Temperature  Weather condition  Wind Precipitation
04052023  1230AM  20°C 67°F clear sky 0mis, 0.00 mph
041052023  01:30AM  22°C 71°F clear sky 36 m's, 8.00 mph
2023 0230AM  22°C T2°F clear sky 6.17 m's, 14.00 mph
2023 0330AM  20°C 68°F clear sky 8.75 m/s, 20.00 mph
2023 0430AM  14°C 58°F clear sky 11.32 mis, 25.00 mph
2023 0530AM  11°C 51°F clear sky 9.26 m/s, 21.00 mph
2023 06:30 AM 7°C 44°F. scattered clouds 12.86 m/s, 29.00 mph
2023 O7:30AM  5'C 41°F broken clouds 10.29 mis, 23.00 mph
2023 0830AM  4°C 39°F overcast clouds 823 m/s, 18.00 mph
2023 0930AM  3C 3¢°F overcast clouds 10.29 m's, 23.00 mph
2023 10:30AM  3'C37T°F overcast clouds 11.83 mis, 26.00 mph
041052023  11:30AM  2°C 35°F broken clouds 10.8 ms, 24.00 mph
0410572023  12:30PM  2°C 35°F overcast clouds 875 m/s, 20.00 mph
040052023  01:30PM  1°C 34°F broken clouds 9.77 m's, 22.00 mph
fontract Main.v23.4.20230410.01

To download the document to your workstation, click Download file.

5.0.6.28 UPLOAD A DOCUMENT TO INEIGHT DOCUMENT

You can upload a saved supporting document to InEight Document from Contract, so you do not have
to load it in Document, and then link it back in Contract.

UPLOAD A DOCUMENT TO DOCUMENT

Upload a supporting document to Document when you want to take advantage of Document's
organization and versioning features.

Only documents with the document source My computer can be uploaded.
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1. From the Supporting documents register, select a document with the document source My
computer, and the click the Upload icon.

= = dopowdfeee. T Mdedon =
Not applcable o2ori2022

2. If you are not already signed into InEight Document, use your credentials to signin to
InEight Document.

The Upload window in the Documents module of Document opens with the document you
selected in Contract already attached.

If you want to add more documents, you can add them at this time.
Click Save and Transmit. The document is now saved in the Document Documents module.

5. Close the Document window. Contract shows the Edit supporting document dialog box. The file
link is replaced with the document link form Document.

6. Click Save. The Supporting documents register refreshes with the file link to the Documents
module. The Document source is replaced with InEight Document, and the External document
type and status are now populated.

5.0.6.29 SUPPORTING DOCUMENTS APPROVAL

Document approvals can be started for one or more documents. To start the approval process, select
the documents, and then click the Start approval button.

Approved 06/01/2018 namoT nnane

After you start the approval process, the Start approval dialog box shows all of the steps for each
document selected.
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Start approval
A group workllow must be selected in order to start the approval.

Approval steps Users/Roles/ Groups
- ~ .C0I10.31.2022 pdf
step 1 project group step (D) Select agroup
KBS Compliance approval () Contracts - Bocument Review
- _CO1_10.31.2022.pdf
step 1 projectgroupstep (D) Select agroup

KBS Compliance approval ([}  Contracts - Bocument Review

Cancel

Group steps include a drop-down menu for group selection. You can add the Current approvers column
to the register to easily see the person or role responsible for the current approval step. For workflows
with one or more group steps, you must select groups for each group step in each document. After you
enter all information, click Start to start the approval process. The Start approval dialog box stays open
until all workflows have successfully started.

If you have an approver role, you can review and either reject or approve the contract's supporting
documents from the Supporting documents register or from your Action items register.

With appropriate permissions, you can recall a document after it has been approved. To recall a
document, click the Edit icon to open the Edit supporting document dialog box, and then click Recall
approval.

5.0.6.30 SHOW OR SUPPRESS A DOCUMENT IN A GENERATED
CONTRACT DOCUMENT

You can specify whether a supporting document details are shown in a generated document. A toggle
on the Supporting documents register, Show in generated document, lets you indicate whether the
document is shown in a collection table in a generated document based on the collection table type.
When you have a supporting document that you do not want to show in a collection table, set the
toggle to No. When a document is generated, only the documents that were set to Yes are shown.
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A document that is available at more than one level, such as a contract-level document available on
the contract and VCO Supporting documents pages, can have a different setting at different levels. For
example, you might set the toggle at the contract level to Yes to show in a generated document. You
could set the toggle at the VCO level for the same document to No to not show in a VCO document.
Contract uses the setting that corresponds to the level of the collection table tags in the template.
Using the previous example, Contract shows the supporting document in a collection table as follows:

¢ When you generate a document for a contract, the document is shown because the only
collection table type in a contract document is a contract table.

¢ When you generate a document for a VCO that has a contract-level collection table, the
document is shown because it is part of a contract-level collection table.

¢ When you generate a document for a VCO that has a VCO-level collection table, the document is
not shown, because the document is suppressed at the VCO collection table level.

5.0.7 WORKFLOW ASSIGNMENTS

Each contract is unique and may require various levels of approval. The Workflow Assignments tab
allows you to set up the proper approval steps. The approvals are broken down into different parts of
the contract management process (contract, change order, and payment form) to allow for maximum
flexibility in the approval workflow.

When the Projects must select specific users... check box in the organization workflow approval setup
(organization Settings > Contract > Workflow assignments > [Bid package or Contract type] > Add
approval dialog box) is selected, you must assign specific users to each role in each step. When the
check box is not selected, and there are multiple roles assigned in a single step, you can assign one
user to any role in each step before workflow can begin.

(\[e)p= If arole in a workflow assighment has no users assigned to it, the workflow cannot be
started. A warning indicating that there is no applicable user for the step is shown.
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WORKFLOW ASSIGNMENT

1. From the Workflow Assignments tab of a contract, select the type of approval setup.

@ Steel Structure Job (105091) - Contract v Contracts v ©)
Contracts > 7400001489 - PB - Structural .. /
Acions - I [ TEGHNIGAL FIELD SUPPORTING WORKFLOW - -
CHENT FORMS AYMENT PROGRESS ACSISTANCE DOCUMERTS ASSICNMENTS SYNC LOG CONTRACT CLOSEOUT
Cancel b

2. On the approval set up page, click the Add approval icon. The Add approval slide-out panel
opens.

VENDOR CHANGE SUPPORTING WORKFLOW .
EOF VALUES ORDER LOG BACK GHARGES PAYMENT CLAIMS PAYMENT FORMS PAYMENT PROGRESS DOCUMENTS. ASSICNMENTS SYNG L0G GONTRAGT GLOSEOUT

tapproval setup  Vendor change order approval setup  Payment form approval setup  Document approval setup (cance | BT s )
Add | x
Vendor change order approval setup - — approva

Approval step

*$tep title

Approval steps Users/Roles/Groups

* Assign approvers

@ ® Users

Cancel

3. Enter the step title and then assign users, groups, or roles as approvers, and then click
Add.

4. Click Save on the approval setup page.

START THE APPROVAL WORKFLOW

Start the approval process when the contract or vendor change order is complete and ready for final
approval.

Approval steps must be configured at the organization, project, or contract level. If you want to make
changes to the approval steps, you must go to the Workflow Assignments tab to make your changes. If
your organization has chosen to not allow workflow when the contract is over budget, an error
message shows when you start the approval. See Organization settings for more information about
allowing a contract type to go to approval when over budget.
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1. Go to the Header tab for a contract or the Details page for a vendor change order, and then click
Save and start approval. The Start approval dialog box opens to the approval steps page.

X

Start approval

| oApprovm steps | || | |

Contract approval steps

Startup

PE

==al -

2. Review the change approval steps as necessary, and then click Next.

3. Review the contract budget. Contract converts the workflow values from the project currency to
the contract currency to see if you have exceeded budget. If there is no conversion rate listed in
the project details, the conversion rate is assumed to be 1:1. When the contract is over budget, a
yellow warning banner shows at the top of the Budget check tab, and the loss is shown in red in

the Gain/Loss column.
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Start approval

o Commitment check

Contract Current value exceeds Current Control budget for the assigned WBS phase codes

Current value Current budget Gain/Loss

$10,040,000.00 $860,428.93 ($9.179,571.07)

[ Cancel J [ Back J Next

W[e g2 If information required for the workflow is missing, the applicable section header in
the contract Additional details section on the Contract Details page shows a red

warning icon.

4. Choose one of the following:

¢ If you do not want to add a message and attach supporting documents, click Start. The
approval process starts.

¢ If you want to add a message or attach supporting documents, click Next. The Add
messages page opens.
5. Choose one of the following:

¢ If you want to add a message to be included in the workflow email, type and format it, and
then click Next. The Attach supporting documents page opens.

¢ If you do not want to add a message, click Next. The Attach supporting documents page
opens.
6. Choose one of the following:
¢ If you want to attach supporting documents, click Next. The Attach supporting documents
page opens.
» If you do not want to attach supporting documents, click Start. The approval process

starts.
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7. Select one or more supporting documents from the list of documents.
8. Click Start. The approval process starts.

The approvers receive a notification of the approval item. When you start the approval process and
you are the first approver in the approval workflow, the first step of the workflow is automatically
approved, and continues with the next step, if applicable. If you are the only step in the approval, the
item is set to Approved.

Users who are added to roles associated with an active workflow can approve or reject workflows
items. They do not get a workflow notification, but the workflow item is shown in the Action items tab.
Worklfows that are not completed within 90 days are terminated and automatically removed from the
Action items tab.

You can view document approval workflow progress and history on the project Workflows > Workflow
details page. If the workflow has been recalled, the name of the person who recalled the workflow is
shown in the workflow heading.

When the workflow is complete, Contract sends a completion email to you as the initiator, people who
created the item, and the person who completed the last step.

5.0.8 CONTRACT WRITER

If there is a need to create a customized contract document between the contractor, owner or
subcontractors, Contract provides Contract writer to aid in the development. This is a legal document,
which needs to be signed by all parties and stakeholders.

5.0.8.31 CREATE A CONTRACT DOCUMENT

When you are ready to create a contract document, you can generate it from one or more templates.
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CREATE A CONTRACT DOCUMENT

1. To use a template in a contract, open Contract, and then select the Contracts tab.

SUPPORTING
DOCUMENTS INVOICES ACCRUALS / RE

notons v @ ® Q

( D Descrip... Type Status Approv... ER.. Vendor ... ori.. Current... Paidto .

[ 7400001714 773134 Test Material c. Executed Not ap. Success  Byrons Offi. $1,500. $6,275.00 i
[ 7400001681 TestMateri.. Material c. Executed Approv... == Success  Byrons Offi. $83.33 $166.67

[ 7200001738 structural .. Subcontract Draft Recalled s Kiewit Fina $800.00 $800.00

[ 7400001581 hguguytu Material c. Draft Inappr.. e=e Byrons Offi. $1,000. $1,000.00

[ 7400001580 773134 Test Material c. Executed Not ap. Success  Byrons Offi. $1.500. $1,500.00 $100.00

[ 7400001556 Line impotr Material c. Draft Not ap. Byrons Offi. $0.00 $0.00

[ 7200001737 Lineitem i Draft Not ap. PTI Manito. $0.00 $0.00

2. Select a contract ID to open a contract.

@ 105091 (Steel Training Job) - Contract Contracts ~
comers SO
Actions - ®
O 1D Descripti... Type Status Approval... ERP...
O 7200000870 Rebar Install... Subcontract Executed Not appli...
O 7200000869 Column Ass... Subcontract Executed Not appli.. Succes
O 7400001257 Anchor Bolt... Material con... In review Mot start..
O 7300000510 Environment... Service agre... Executed Not appli... Succes
O 7400001254 AB Structura... Material con... Draft In appro... we=
O 7400001253 Structural §t... Material con... Draft Not start...

» The contract Details opens for the selected contract

o
@) 105091 (Steel Training Job) v Contact v Contracts v @ 9

Contracts > 7400001253 - Structural Steel Module...

Actions HEADER LINEITEMS VENDOR CHANGE BACK CHARGES PAYMENT FORMS PAYMENT PROGRESS SUPPORTING VORKFLOW
ORDER LOG DOCUMENTS ASSIGNMENTS

Save and start approval T

Details Additional details N Associate a bid package
Contract status Approval status
Bid package budget v
Draft -
Division of responsibilities (DOR) v
*Descrption Retention v

3. From the Actions drop-down menu, select Generate contract document.
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Contracts > 7400001253 - Structural Steel Module..

WENDOR CHANGE

Actions - HEADER LINEITEMS BACK CHARGES I
ORDER LOG
View import history Cancel
Generate contract document l\.l
Runreport
Details Ad
Contract status Approval status B
Draft -
D

4. Select the template type from the submenu
you are currently on are enabled.

Contracts > 7300008657 - On-site Insulation Labor usD §

Actions v HEADER LINE ITEMS SCH

View import history

Generate contract document  »
Contract

Run report >

Launch dashboard

Details

Purchase Order

Other

Contract status

» The Contract template page opens

. Only template types applicable to the Contract tab

for you to select the created contract template

» The list shows available templates assigned to the contract type

» The Contract template details sections lets you specify details about your contract

document

5. Move one or more templates from the Avail
column.

Contracts > 7200006651 - Conditonal Tags > Generatece

able templates column to the Selected templates

Select contract templates & Contract template details
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10.

Use the up and down arrows to the right of the Selected templates column to change the order
of the templates, if needed.

In the Contract template details section, choose one of the following in the Generate document
as field:

 Individual documents to get a separate document for each template you selected.
» Merged document (PDF only) to merge the templates into a single PDF document.

If you selected Individual documents in the previous step, use the Generate document file type
as field to indicate whether to download as a template file type or download as a PDF. If you
selected Merged document in the previous step, skip this step.

Use the toggle to indicate whether to save the contract document in the Supporting documents
tab. If you choose to save in the Supporting documents tab, add the name of the document. This
document name shows in the Title and File/Link columns of the Supporting documents register
after the document is generated.

Select the watermark text. If the organization-level settings require a watermark and the end
watermark event has not occurred, the Select watermark stamp field is required. If the end
watermark event has occurred, the watermark is optional.

Click Next. The Review templates page displays the templates in the order you selected.

Choose the template you want to review from the Review templates list. The template tags
display as fields in the display area. The message, "No general tags found in this template" in the
display area can indicate that the table consists of only collection tags. If the Allow users to edit
the document during creation toggle in the template details is set to No, the fields on the Review
page are disabled.
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o Review templates

Review templates ~ conl

Template Name
AW- 01 slfield values will replace the corresponding tags in contract document.
conl

AW- -03

Project ID
Contract ID
Company code
Blank1

CF1
Vendor name

Company code name

Vendor address

(o ) (o)

The Review templates dialog box lets you edit or add information to the fields that populate the
document after it is generated. Any field that is blank is not added to the document, and you
cannot add information later.

11.  Make changes and additions to the contract information. Use the Review templates list to select
the next template, and make changes.

12. After you have reviewed all changes, you can see a preview of your document by clicking the
Preview document button. The preview opens in a separate window with the tags filled in. If you
used collection tables in any of your templates you can view them in the preview document. The
content of the preview varies as follows:
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¢ If you selected Download as a PDF document when you generated the document, the
preview contains all of the templates in the order you specified.

¢ If you selected Download as individual documents when you generated the document, the
preview contains only the template that was displayed when you clicked Preview
document. You can preview other documents by selecting the file from the Review
templates list and clicking preview document.

13. Click Finish. If you created a merged document, Contract writer downloads a PDF that includes
all of the templates. If you created individual documents, Contract writer downloads a PDF for
the selected template only.

\[e = Changing data in Review contract fields updates the data published in the contract
document but does not update the data field in Contract.

CREATE A CONTRACT DOCUMENT FROM THE REGISTER

You can generate a contract document from the Contract, VCO, or Master agreement register without
having to open the contract or VCO.

1. Select one contract, VCO, or master agreement in the register.
2. Expand the Actions menu, and then click Generate contract document.

The Generate contract wizard opens for you to follow the procedures and generate a contract
document.

5.0.8.32 ESIGNATURE SUPPORT

When a project is integrated with DocuSign, you can use Contract's Supporting documents pages to
send and manage documents that have DocuSign tags. DocuSign functions are supported on the
Contract-level, bid package, document, back charge, and payment form Supporting documents pages.

SEND CONTRACT DOCUMENTS FOR ESIGNATURE VIA
DOCUSIGN

When a project is integrated with DocuSign, you can send a document to DocuSign for an eSignature.

DocuSign tags can be embedded in the contract template. The DocuSign tags correspond to DocuSign
recipients configured in the project settings, project contacts, and user information defined in the
Division of responsibility section of the contract details.
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SEND A DOCUMENT FOR ESIGNATURE

After a document has been created, you can send it for official eSignatures via DocuSign.

Documents must be in Word, Excel, or PDF format. They must be saved to the contract or VCO
supporting documents page with the document source My computer. You must have Edit contract
permissions to send documents. Ensure that your browser's pop-up blocker is disabled before you click
Send from the Contract DocuSign wizard. You must have the permission Send for eSignature to send a

document for signature.

1. From the contract or VCO Supporting documents page, select one or more documents with the
document source My computer, and then click the Send for signature icon.

Somoredrier

The Send for signature wizard opens.

2. Review the Names in the Assigned section of the wizard. If you want to add additional recipients,
find their names in the Unassigned section, and then click the Add icon. All signees in the
Assigned section have ad-hoc signee tags that can be placed on the document in DocuSign.

Send for signature -

Assigned recipients dictate who will receive an email to sign the document.
Signing order can be assigned based on the order of needed signatures

Assigned

Recipient Name Company Title Email Action Signin.
©  Project contact : E Needs tosign ¥ 1
o Project contact : C Needs tosign ¥ 2
Unassigned
Recipient Name Company Title Email

Cancel m Send
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3. For each assigned recipient, specify in the Action column whether they need to sign the
document or if they are just to receive a copy.

¢ When the value is Needs to sign, the recipient receives a document that is ready to sign.

e When the action is Receives a copy, the recipient receives a snapshot of the document in
the signing order. For example, if the recipient marked Receives a copy is second in the
signing order, they receive the document after those first in signing order, even though
they are not signing.

4. Review the values in the Signing order column. The numbers in the column specify the order in
which the recipients are sent the document for eSignature. You can assign a single number to
multiple signees. The signee or signees with signing order 1 are notified first by DocuSign. After
all signees in signing order 1 have signed, DocuSign notifies all signees with signing order 2, and
So on.

5. If recipient information is missing from the Assigned section, update the information as needed.
Any updates you make are saved in the DocuSign section on the header tab of the contract.

6. Click Next. The Add message page opens.

7. Enter an email subject line and message to the recipients, and then click Send. A DocuSign
window opens with the documents you chose.

\[eJp2 If the DocuSign window does not open, ensure that your browser's pop-up blocker
is disabled.

8. If your DocuSign administrator has configured Advanced Options, you can expand the Actions
menu, and then select Advanced Options.

=== @] scrom - |[Lssvmer]
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You can then customize the following options:

¢ Branding — Select a logo and brand colors, set up by the DocuSign administrator, for the
envelope.

¢ Recipient privileges — Give recipients options for how they sign the document, such as
signing on paper, assigning delegates, and editing documents.

e Reminders — Specify whether DocuSign sends reminders to signees, when to start sending
them, and how often to send them.

e Expiration — Set the number of days until the envelope expires and how often to send
alerts.

e Comments — allow senders and recipients to enter comments on documents in the
envelope.

Click Save. You are returned to the document.

9. Optionally, add additional tags for signatures, initials, and dates. All names from the Assigned
section of the wizard are shown in a drop-down list in the upper left pane. Select the name of
the person you want to add, and then select Signature, Initial, or Date Signed, and then click the
place in the document. If the document has tags for a text box, drop-down list, check box, or
radio buttons, add the values to the document.

Previous Subcontract Amount: $ 120.00
Change Order Amount: $ 15,000.00

New Subcontract Amount $ 15,120.00
Acceptance of the terms of this Change Order constitutes full and final settlement of all costs and time associated with this

Change, and Subcontractor agrees to waive all rights to make any further claim arising out of, or resulting from, this Change. Except
as hereby modified, all terms and conditions of the Subcontract as heretofore modified remain unchanged and in full force and effect.

IN WITNESS WHEREOF, the parties hereto have executed this Change Order by their proper officers or duly authorized agents
Payment tem this 10*" day of September 2019.

Co

| sign

By:| i

Tridie]

10. Click Send.

Page 248 of 377 InEight Inc. | Release 25.3



Contract User Guide

The documents are routed for signature, and DocuSign sends an email message to each recipient
based on the signing order. In Contract, the DocuSign status column on the Supporting documents
page is populated with the status of Sent. You can hover over the status to see the name of the person
who sent the document and the status of the signatures. The Contract writer automatically adds the
sender to the last position of the list with the action Receives a copy. After it is completed, the signed
document is loaded as a supporting document with a document type Signed document. The person
who sends the document to DocuSign receives an email notification when the document signatures
have been completed and also receives a copy.

When a supporting document has a DocuSign status of Created, Sent, Completed, or Signed, you can no
longer edit the file link.

CORRECT DOCUMENT SENT TO DOCUSIGN

Sometimes you find you must make corrections, such as changing signees or adding or changing
documents, after the envelope has been sent to DocuSign. Often, going through the eSignature
provider to make a correction results in voiding the envelope and incurring the charge of creating a
new one. You can avoid the expense of additional envelopes by initiating corrections to the envelope
in Contract.

EDIT A SENT DOCUMENT

Make corrections to an envelope after it has been sent to DocuSign.

When a supporting document has a DocuSign status of Created, Completed, or Signed, you can no
longer edit the file link. When the status is Sent, you can edit the document in the original eSign
envelope without incurring the expense of additional envelopes.You must have the Correct eSignature
permission to correct DocuSign documents.

1. On the Supporting documents register, hover over the ellipsis in the DocuSign status column for
a sent document. The DocuSign Status dialog box is shown.

InEight Inc. | Release 25.3 Page 249 of 377



SUPPORTINC

pocuMENTs DocuSign Status: Sent

dsfds

Sent by File/Link: 74_org temp 22_2022-Jul...
i Shov
Company Name DocuSign Status
@ g Sent
hj (Receives a copy) Delivered

Void eSignature |

Contract User Guide

|a

2. Click the Correct button. DocuSign opens with the view of the original envelope.

Make the corrections in the DocuSign envelope. Refer to DocuSign documentation for more

information about envelopes.

DOCUSIGN CERTIFICATE OF COMPLETION

After signing is completed, the certificate of completion is now available when you hover over the
ellipsis in the DocuSign status field in Supporting documents.

The certificate of completion is stored in Supporting documents, but it does not take up a separate
entry in the Supporting documents register. The certificate does not expire in Contract.

P,

Not applicable
Not applicable

Signed

DocusSign Status: Completed

Claim

File/Link: Purchase Order Standard....

Completed ass
Company

Name

DocuSign Status

Modified on

Not applicable

Completed

06/09/2023 07:33 am

Not applicable

Mot applicable

View certificate of completion

=

When you click View certificate of completion, a preview of the certificate from DocuSign opens in a
new tab. You have the option to download the file if you want to store it separately.

Page 250 of 377

InEight Inc. | Release 25.3



Contract User Guide

5.0.9 PO CREATION

Purchase Orders are used to send the contract line items and financial data to your ERP system. This
creates a platform for you to acknowledge the receipt of goods and services, as well as track quantities
and pricing so vendor payments can be processed.

(\[e3= The following items are required for the Create Purchase Order button to become
available:

» The contract must be approved by a project administrator if indicated within
the workflow assignments.

» All required supporting documents must be uploaded and approved by the
compliance team. Note: This includes a copy of the executed contract.

« |f the contract is in the approval process, the purchase order cannot be
created until approval is complete.

CREATE A PURCHASE ORDER

1. From the Contract > Contracts page, open the Structural Steel contract you have been
working in.

2. Click Save.
» The Create Purchase Order button will appear on the top right corner of the screen

3. Click on the Create purchase order button at the top right of the screen.

SYNG LOG CONTRACT CLOSEQUT >

| Cancel ‘ Create purchase order

» Atoaster message appears notifying you of the creation of a purchase order
4. Return to the top navigation and select the Sync Log tab.

» This is where you would be able to see if your sync was successful. If Success
appears in the field, then you know it got to your ERP system. If you have a proxy
ERP environment, the success message is autogenerated.
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SYNC LOG

Published by Status Log token ID

Marianne Crane Success 97ebb5a73-8d81-418c-99e2-3b0cdd6063...

 Ifthere is a failure message, click on the Log token ID link to see the errors. This
information can be helpful for Support to resolve the issue

[\[eJ 2 Note that after a PO is created you cannot change the vendor or the invoice plan
selection on the Header tab. On the Line Items tab, you cannot change the line

item type, the product category, or the account distribution selection. All other
fields are still editable, and the PO can be updated.

\[e) )= Validations around supporting documents or workflow settings are still applicable.

5.0.10 MASTER AGREEMENTS

A master agreement is a type of contract, set at the project level, between a general contractor and a
supplier to purchase goods or services later. A master agreement lets you set up the terms, conditions
and pricing of a contract. You do not commit the value of the agreement until you write an associated
contract or purchase order against it. For example, a master agreement could be an agreement to
purchase services across multiple years of a contract. Instead of purchasing all the services now, you
can write contracts for the services against the agreement as needed over the duration of the project.
All transactions of the contract purchase order associated to the master agreement for visibility.

A master agreement is not a standard contract purchase order. Because you receive and pay against all
the contracts and purchase orders associated to it, it is not necessary to create a goods receipt or
payment term against a master agreement. These are made against the individual associated
contracts.

5.0.10.33 CONFIGURATION

You configure a new contract type to be specific for master agreements. A contract type that is
configured to be a master agreement can only be used as a master agreement.

Settings in the Contract type setup configuration in the organization settings (Settings > Contract>
Configurations > Contract type configuration setup) let you indicate whether a contract type is a
master agreement and, if so, whether to publish to the ERP system. For contract types that are not
master agreements, you can indicate whether to allow association to the master agreement.
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B Define the following options for this contract type

To configure a contract type as a master agreement, set the Is this a Master agreement toggle to Yes,
and then indicate whether to publish to the ERP system. After the master agreement has been used,
you can no longer change these settings. The master agreement tab is only shown in the register home
page if there is one contract type that has the Is this a master agreement setting set to Yes.

When defining the required fields for the master agreement, it is best practice to set the Enable,
Require for purchase order, and Lock after purchase order settings to Yes. A vendor is required by the
ERP system. If you publish to an ERP system, you must enable the Vendor field and require it for a
purchase order or publishing will fail. Other field requirements must match those of your ERP system's
requirements, so you can successfully sync the master agreement to the ERP system.

For contract types that are not master agreements, you can indicate whether the contract type can be
associated to a master agreement. A contract must be associated to a master agreement to be able to
write contracts of that type from the master agreement. Set the Allow association to Master
Agreement toggle to Yes to allow associations. Set the toggle to No if you do not want to be able to
write contracts against the agreement.

5.0.10.34 CREATE A MASTER AGREEMENT

You can use Contract to create and manage master agreements. The following steps walk you through
the process of creating a master agreement.

CREATE A MASTER AGREEMENT

Create a master agreement in Contract when you want to have an agreement about contract terms
and pricing without having to commit the financial resources right away.

Master agreements are created on the Master agreements tab. You must have at least one contract
type configured as a master agreement to see this tab.
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From the Contract >Master agreements tab, click the Add master purchase agreement icon. The

Add master purchase dialog box opens.

Complete the following fields in the dialog box:

Description
Type

Subtype
Effective date
Vendor
Storage location

Scope of contract

Click Add. This brings you to the Master agreements Header tab, which is similar to the
Header tab for a contract.

4. Complete the header information, and then click Save.

You can now complete the remaining tabs as you would with a regular contract.

5.0.10.35 MASTER AGREEMENT TABS

Master agreements can have the following tabs, based on your master agreement contract

configuration:

Header

Line items

Schedule of values

Vendor change order log

Back charges

Supporting documents

Workflow assignments

Sync log

Contract closeout

Associations

The Associations tab is unique to master agreements. The other tabs work the same as the Contracts

tabs.
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5.0.10.36 CONTRACT TOTALS ICON

Click the Contract totals icon to display a slide-out panel that has a breakdown of the master

agreement's totals.

Master agreement totalg X
Created by on 07/22/2021

Vendor

Status Draft

Type Purchase Agreement
Contract retention 0.00% $0.00
Total tax $227,500.00
Original value Current valus

$ 385,000.00 $ 387,881.00

Total change orders $0.00
Total potential change orders $0.00
Accrued liquidated damages $0.00

Associations

Received to date

0.00%
$0.00 of $26,772.35

Contract invoices

Unassigned [ Assigned (@Submitted [_JRemaining

0.00%
$0.00 of $26,772.35

Submitted to date

0.00%
$0.00 of $26,772.35
Paid to date
0.00%
$0.00 of $26,772.35
Retained to date
0.00%
$0.00 of $0.00
Released to date

0.00%

$0.00 of $0.00

The slide-out panel is similar to the Contract totals slide-out panel with the following exceptions:

¢ A section for change orders shows the total amount of change orders, total amount of potential
change orders, and the accrued liquidated damages.

¢ The Received to date, Contract invoices, Submitted to date, Paid to date, Retained to date
amounts, and percentages come from the contracts that have been associated to the master
agreement and not from the master agreement itself.

See Contract creation for more information about the Contract totals slide-out panel.
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5.0.10.37 MASTER AGREEMENT BANNER

The master agreement banner shows at the top of all pages in the master agreement to help you track
the current value and associations.

uso s
Current val lue Associations value Received to date value Invoiced to date Paid 0 date Retained to date Released to date
$10,000,000,000.00 $7,130.00 $0.00 $7,130.00 $0.00 $0.00 $0.00

N TEE CHEDULE OF VA VENDOR CHANG - SUPRORTING WORKFLOW .
HEADER UNE ITEMS SCHEDULE OF VALUES e BAGK CHARGES o oo SNG Lo

The Current value is the amount of the master agreement. The remaining fields come from the
contracts associated with the master agreement. For example, as you write associations to the master
agreement, the Associations value increases.

The Remaining to buy field on the Associations and Vendor change order tabs is automatically
calculated. The remaining to buy is the difference between the master agreement current value and
the total associations current value.

5.0.10.38 MASTER AGREEMENT LINE ITEMS

The Line items tab lets you define the line items of the master agreement. These line items can be used
when you add line items to an associated contract. You must have at least one line item to publish the
master agreement.

The line items register is similar to the register for contract line items. The first line in the line item
register of every master agreement is a default placeholder 0000 line item, where a net price can be
manually entered. This line item is used to hold value that is not specifically applied to numbered line
item. For example, if you add an associated contract or purchase order that already has a line item, the
value of the associated line item will show in the 0000 line item progress viewset.

VENDOR CHANGE SUPPORTING

Actions v
HEADER LINEITEMS SCHEDULE OF VALUES ORDER LOG BACK CHARGES DOCUMENTS

Line items { sescee >

Line Ite... = Type = Material ID = Descripti.. | Productcat.. = Quantity = UoM = Unit price = Per = Net price =

$0.00 |

@] 0001 Material line item 10,000,000.000 Ea $1,000.00 1 $10,000,000

Contract line items can be reassigned to master agreement line items. All information, other than
guantity, from the master agreement line are updated.

See Line items tab for information about line item details.
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5.0.10.39 PUBLISH A MASTER AGREEMENT

After you have added one or more line items, you can publish the master agreement.

PUBLISH A MASTER AGREEMENT

When you publish the master agreement to the ERP system, the ERP system creates a master contract.
You then write purchase orders against the master contract.

The master agreement must have at least one line item.

1. Go to a master agreement.

2. Click Publish master agreement. The master agreement is available for association. If Contract is
configured to publish the master agreement to the ERP system, a master contract is created in
the ERP system.

You can now associate contracts to the master agreement.

After the master agreements has been published, you can still update it. To update, enter your
changes, and then click Save. The Update master agreement button is enabled. Click the button to
update the master agreement.

5.0.10.40 ASSOCIATIONS

The Associations tab lists all contracts that are associated to the master agreement. After a contract is
associated with the master agreement, any purchase orders created from the contract go against the
master agreement.

The values in the banner do not include tax. You can see tax values in the Total tax column on the
Associations register. The tax amount is the sum of the Tax amount field in all line items for associated
contracts. To see a break-down of all taxes that make up the total tax, hover over the information icon
in the Total tax column.

You can associate a new or existing contract to a master agreement from the Associations tab. Bid
package vendor flow to Master agreement vendor upon association.

You can download a purchase order from the Associations tab.

ADD A NEW CONTRACT TO A MASTER AGREEMENT

You can create a contract and associate it to a master agreement in a single procedure.
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You can use only those contract types that are allowed to be associated with a master agreement.

1. From the Associations tab, click the Add contract icon, and then select New contract/purchase
order. The Add contract dialog box opens.

2. Enter information in the fields as you would with any contract. The contract type drop-down list
includes only those contract types that are allowed to be associated with a master agreement.
The Vendor field is disabled as is filled with the vendor name from the master agreement.

3. Click Add. The contract Header page opens.

You can then add contract details with any other contract. See Line items tab for information about
adding line items to an associated. contract.

ADD AN EXISTING CONTRACT TO A MASTER AGREEMENT

Associate an existing contract to a master agreement
You can associate an eligible contract to a master agreement from the Associations tab.

Contracts are eligible when the contract type allows association with a master agreement and the
vendor is the same as the vendor of the master agreement or has not been assigned.

1. From the Associations tab, click the Add contract icon, and then select Existing
contract/purchase order. The Add existing contract dialog box opens.

2. Select a contract from the list of eligible contracts, and then click Add. The contract is added to
the Associations register. If the contract had no vendor assigned, the vendor in the contract is
updated to the vendor of the master agreement.

You can add line items from the master agreement. See Line items tab for information about adding
line items to an associated contract.

5.0.10.41 CLOSE OUT MASTER AGREEMENT

When you no longer want contracts to be written against the master agreement, you can close it out.
You can either close out the entire master agreement, which closes all line items, or you can close
individual line items.
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CLOSE OUT MASTER AGREEMENT

Close out a master agreement when you no longer want contracts to be written against it. Closing out
the master agreement closes all of its line items. Any existing contracts associated with the master
agreement remain open until they are closed.

You cannot add line items from a closed master agreement even if the contract is already associated to
it.

1. From the Details section on the Header page of the master agreement, change the Status field to
Closed.

2. Click Save. The Update master agreement button becomes the Closeout Master agreement
button.

3. Click Closeout Master agreement to close out the master agreement. The master agreement is
removed from the Agreement ID drop-down list on the Contract header.

4. Click Update master agreement to publish the closure to the associated contracts. The master
agreement is no longer available for use.

CLOSE OUT A MASTER AGREEMENT LINE ITEM

Close out a master agreement line item when the line item has run out of resources or for any reason
you no longer want contracts written against the line item.

This function is recommended when the master agreement has multiple line items. If the master
agreement only has one line item, it is best practice to close out the master agreement.

1. From the line item details, change the value of the Status drop-down list to Closed.

2. Click Save. The line item is no longer available in lists when you add a line item from a master
agreement.
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CHAPTER 6 — CONTRACT
MANAGEMENT

The topics that follow describe these contract management concepts:
¢ Line item maintenance and management
e Creating and managing vendor change orders
¢ Logging back charges to the vendor

¢ Create accrual or goods receipt submissions and reversals
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6.0.1 INEIGHT CONTRACT WORKFLOW - CONTRACT
MANAGEMENT

WBS Structure

Contracts

Bid Packages

Create Bid
Package

Contract Setup Add
(Documents, Documents Contract Execute

_ . S ti
Details & Line Lo Approval Approval Contract
Documents
Items)

Create
PO

|
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Milestones Add VCO

Create Payment Form Contract

Contract Payment Form Approval Closeout

Award

VCO Approval
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Estimate Update PO

<
Reference issue to VCO
Control

Change Register

Submit invoices

Manage Scopes of Work
Schedule Procurement

Receive payment progress, goods receipts

PCO
Management

cco
Management

Issue
Management

Execute Budget/Contract
cco Adjustments

Progress

Issues
imported
from the
field

6.0.2 LINE ITEM MANAGEMENT

After you add a line item, Contract adds a line item ID and adds it to the Line items register. The
register lists all line items for the contract, and you can view line item information and copy, edit, and
delete line items.

The total net price is shown at the bottom of the page.

6.0.2.1 VIEW LINE ITEM INFORMATION

The Line items register includes the following tools to help you quickly see line item information in one
place.

e =

View You can view additional data blocks to show information related to line
items.
2 Line error A yellow warning icon shows whether an error, such as a missing
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D T ™ S

indicator required field, exists in the line item. Errors must be fixed before you
can publish a line item. If you try to publish the contract without fixing
the errors, a red warning icon is shown

3 Selection  Show you how many line items in the list are selected and lets you
tools view only the selected items. You can also click Clear selection to
clear the selections.

4 Errors Shows the number of line items with errors. You can click the n Items
link to view only the line items with errors.

5 Net value The net value of all line items.

®
=
~
ai -
©
o
o

EEEEEE veioncutce [ PuEiTroRS  Peme PRoaResS spronng Joaion
------ ) T
Q = 3 P = P prica = wes = OBtatalcost = CBtotalcost == CCtotalcost == Linemtemec. = Pandinglin_ =
0011 Seviee  Blindin §76809 1 $81,11030 $000 $000 §0.00
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6.0.2.2 VIEW DATA BLOCKS

You can view the following data blocks to supplement the line item view:

e Budget and commitment

Schedule of values

Change orders

e Progress
e Payment forms
¢ Accruals/receipts
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6.0.2.3 COPYING A LINE ITEM

Select the line item you want to copy and click the copy icon. You can then choose the sections of the
line item that you want to copy. The system duplicates the line item details of the selected sections.
This function can be useful when inputting multiple lines on a contract. After you have copied line
items, you can edit the line item details to reflect any necessary changes.

Copy line item

Which sections would you like to copy?
Delivery schedule
Equipment details

Material attributes

6.0.2.4 EDITING A LINE ITEM

There are two ways to edit line item details once a line item has been created or copied. You can edit
line item details in the line item overview page, or you can select the line item you wish to edit and
click the edit line item icon to open the Line item details page for that line item.

® ®
Line ltem I... Type Matenal ID
1 0001 Material

o= You cannot edit the Type field after starting an approval.
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6.0.2.5 DELETING A LINE ITEM

You can delete a line that has not been published to the PO. Highlight the line item and select the
delete icon.

® = B [®]

Line ltem I... Type Matenial ID

&l

&l

001 Material

o= If you need to delete a line item which has been published to a PO, you would perform
the same process. However, a strike-through will appear on that line item until it is
carried through to your ERP system and processed.

If goods receipt and invoice payments have been applied to the line item, you can delete
that line item without having GR/IR adjustments performed on the back end. Contract
line items are automatically closed when they are deleted. The Deletion, No further
delivery, and No further invoice indicators are sent to the ERP system.

If you see a yellow pencil on a line item it means that this line has never been sent over to your ERP
system.

L UL Marternal

0 o003 Limit

b

6.0.3 VENDOR CHANGE ORDERS

On your contracts, you may need to manage and track contract changes between you and the vendor
(subcontractor or supplier) to account for unforeseen changes that come up during the execution of
the project. In the system, these are called vendor change orders or VCOs, and on each contract record
within the software, you can add VCO records to keep track of these changes.

6.0.3.6 VENDOR CHANGE ORDER (VCO) CREATION

You add VCOs by opening a contract’s record and selecting the Vendor Change Order Log tab.
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Contracts > T400001112 - Structural Steel Modules 16-30

: VENDOR CHANGE
Actions -
HEADER LINE ITEM3 ORDER LOG BACK CH
Vendor CO ID Description VGO status Approval status
1 Remaove grating fasten... In review Mot applicable

The Vendor Change Order Log tab lists all the VCOs for your contract. You can add new VCOs by
clicking the Add button. To open an existing VCO, click on the hyperlinked VCO ID. The Unassigned
Change items field shows the sum of any issue, PCO and CCO pricing items for the vendor contract that
have not been association to a VCO. The Remaining to buy field shows how much money is left in the
unawarded value of the bid package. The Totals row at the bottom of the Vendor CO amount column
shows the total of all vendor change orders for a contract.

$0.00000] = Clearallfilters I 2 Q

= Ceaedon =

Totals 4$1,000.00000

The Vendor change order record contains a header and two tabs of information to track your change
order.

1 VCO total The total cost for the change order agreed upon between you and the
vendor.
2 Remaining The remaining change order cost not covered by the line items on the
amount to VCO. The value of this field must be zero +/- 0.00999 to start
allocate workflow, submit, publish, or execute the VCO. The +/- 0.00999

accounts for differences in decimal precision.

3 Delay days Documents how long of a delay the change order causes.
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due to issue

4 Responsible Tracks who is responsible for the next step in processing the VCO.

party Options include (e.g., client, vendor/sub, your company name). These
options are defined by your administrative team.
With the correct permissions, you can change the responsible party.

5 Vendor CO Tracks what step the VCO is on in the change order approval process.
status While the options on the drop-down list are company-specific,

examples include:
e Draft
e Inreview
» Out for signature
» Execute and publish
With the correct permissions you can change the status.

6 Approval Displays the status of the VCO approval.
status

7 Contract totals Displays a slide out panel that contains a breakdown of your contract’s
icon totals.

8 Add Lets you create a new supporting document or add a supporting
supporting document from the Supporting document list or InEight Document.
document

9 Notes icon Opens a slide out panel for entering notes related to the contract.

10 Cancel, Save  Select to cancel, Save and start Approvals or save the VCO.
and Start
Approval, and
Save buttons

VCOto\alo Remaining amount to allocate oe wzsuee ponsive i o vencov:os-awse Roprovalstatus 6

$0.00 $0.00 @ v | [ omn

SUPPORTING
A INE ITEm:
DETAILS unemems SRR o e e
z 2

The following steps walk you through adding a vendor change order to your contract.
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ADD A VENDOR CHANGE ORDER

1. From the Contract > Contracts page, click a contract ID or description to open a contract.

2. Click on the Vendor Change Order Log tab.

Contracts > 7400001418 - PB - Structural Steel

; VENDOR CHANGE
Actions v
HEADER LINE ITEMS ORDER LOG BACK Ct

3. Click the Add icon to add a vendor change order.

Actions - HEADER

Vendor CO ID Descrniption

The Vendor change order details page opens.

4. Fill out the vendor change order information.

VGO total Remaining amount to allocate

$0.00 $0.00 nere v o

Vendor change order details
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5. Inthe banner at the top of the page, select the Responsible party from the drop-down list, and
then enter Draft for the Vendor CO status.

6. Click Save.

The Vendor change order record contains three tabs for entering the VCO details: Details, Line Items
and Supporting Documents.

6.0.3.7 DETAILS TAB

Use the Details tab to enter vendor change order details, terms, associated change items, and back

charges.

1 Vendor
change order
details

2 Vendor
change order
terms

3  Associated
change items

4 Back charges

Where you can enter basic information about the VCO, including
Vendor change order number, Description, Vendor change order
amount, Effective Date, Change order type, and Scope of change.

Where you can enter terms about the VCO, including vendor change
order inclusions, exclusions, and warranty. You can also configure
ten custom terms in Organization > Settings > Contract custom
labels.

Where you can add issues or existing change items to the section,
indicating the issue status, value type, contributed value, PCO name,
and CCO name. You can also add an existing issue. If the issue has
multiple pricing items, a line for each pricing item is added. The
Contributed value column shows the amount of each pricing item.
Contract converts the contributed value from the project currency to
the contract currency.

Enables you to add a back charge to VCO. Any back charges
associated with the VCO from the Back charges detail page are
displayed here automatically.
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Vendor change order demlso

..........

6.0.3.8 SCHEDULE OF VALUES TAB

The Schedule of values tab contains schedule of value items from the contract-level Schedule of values
page. You can use the schedule items in the vendor change order to provide detail that is not provided
by line items. You can also push values from schedule items to the Line items tab or pull schedule item
values into the Line items tab.

The vendor change order Schedule of values tab format is similar to the contract Schedule of values
tab. It contains the following sections:

Current The line value in its current state in the contract schedule of values.
schedule line
value

Change Detailed information about the change order for the scheduled item.
order
adjustment

Total revised The total revised value of the schedule item. As you make changes to a
value schedule item through a vendor change order, the total revised value reflects
the value after the change order is executed.
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VCO total Remaining amount to allocate Delay days due to Issue Responsible party
$30.00 $30.00 ot
~ ® 01 3 8% Q
schadie | Conat | Desciptl. | WeSende | | Schede = | Lo e | e e e v e — ————
OO gty = ey, = Do H === e = - v = - - Y = - -
O 0001 1115 - Valid. 100 Cubic Meter $25.00 $250000 0 $0.00 2 $12.00 $1.27400 102 $3.77400
O New 0001 TEST 1115 - Valid. 4 $1.00 $4.00 4 $4.00
Items: 2. $1,278.00 $3,778.00

See Schedule of values tab for more information about the schedule of values.

ADD NEW SCHEDULE ITEMS

You can add a new schedule item to the vendor change order schedule of values when the item does
not already exist on the contract-level schedule of values.

1. From the vendor change order Schedule of Values page, click the Add icon, and then select Add
new schedule item. The Add Schedule item slide-out panel opens.

VCO total Remaining amount to allocate

$ 5,950.00 $950.00

000 000

2. Enter the schedule item information, and then click Add.
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Contract line item ID
Select item

Schedule quantity

Unit price

WBS code

custom list] hvt

Custom field 1

Custom field 3

Custom field 5

0.000

$0.00

*Deseription

“UoM

Select item

Scheduled value

Hide in plan and progress

YES

custom list2 hvt

Custom field 2

Custom field 4

Cancel

$0.00

Contract User Guide

3. The schedule item is added to the VCO schedule of values with a schedule ID of New.

The schedule item can be edited as needed. After the VCO is executed and published, Contract assigns
a Schedule item ID and adds it to the Contract Schedule of values register.

ADD AN EXISTING SCHEDULE ITEM

You can add a schedule item that already exists in the contract-level schedule of values to the vendor

change order schedule of values.

1. From the vendor change order Schedule of Values page, click the Add icon, and then select Add
existing schedule item. The Add Schedule item dialog box opens with a list of schedule of value

items from the contract-level schedule of values.
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Add schedule item

oooooao
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2. Select one or more items, and then click Add. The items are added to the schedule.

You can update the Quantity or Value columns in the Change order adjustment section. When you
update the Quantity column, the value in the Value column is automatically adjusted, and vice versa. If
you want to include the items in the vendor change order, you must push them to the line items tab.

You can also add a schedule of value item from the Vendor change order Line items register. Any line
item type can be copied. After the line items are copied, the schedule of value items show in the
Change order adjustment section of the vendor change order schedule of values and are automatically
associated to the line items. To copy a line item from the Line items register to the schedule of values,

select the line item, and then expand the Copy icon. You can then select To schedule of values. A
notification shows that the line item has been added to the schedule of values.

VCO total Remaining amount to allocate
($ 2,200.00000) ($ 6,700.00000)
DETAILS SC:‘;ES; oF LINE ITEMS
Actions v D& @ @ Go to Line ltem ID
Line item < | Current line value < Change order adjustments
E o Lineitem.. = Descriptiol 1, opadule of values COSt center Quantity = Unitprice = Net price = Per = |Quantity = Unit price
0001 Acre 265.000 §15.00 $ 3,975.00000 1 795.000

265.000

Ne Acre

=

The following columns are copied with the line item:

e Contract line item ID
e Description

e UoM
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e Quantity
¢ Unit price

In the Change order adjustments section, the values of the Quantity, Unit Price, and Value columns are
calculated as follows:

e When the line item has a positive net price, a quantity, and a unit price in the Change order
adjustments section, the copied schedule item uses the line item change order adjustments
quantity and unit price.

¢ When the line item has a positive net price and a quantity in the Change order adjustments
section but no unit price change, the copied schedule item uses the line item change order
adjustment quantity and calculates the unit price as the adjusted net price divided by the
adjusted quantity.

¢ When the line item has a positive net price and a unit price in the Change order adjustment
section but no quantity change, the copied schedule item uses the line item change order
adjustment net price divided by the change order adjustment unit price to calculate the quantity.

¢ When the line item has a negative net price in the Change order adjustment section, the copied
schedule item will be value-only.

The Hide in Plan/Progress field in the schedule of values defaults to Yes. You must manually fill in the
remaining fields. The line item is automatically associated to the schedule of values.

Any deleted line items are copied, but they do not have a line item ID.

VIDEO | Copying VCO Line Items

PUSH SCHEDULE ITEMS TO THE LINE ITEMS TAB

Push schedule items to the Line items tab when you want them to be included in the vendor change
order.

Contract pushes only the line items that are associated to the Contract schedule of values. If there are
schedule items that are not associated to the Contract schedule of values, you must execute and
publish the vendor change order. The Push to line items button is enabled if any of the schedule items
have a Contract line item ID. When the Contract line item ID is blank for all items, the Push to line
items button is disabled, and you cannot push items to the Line items tab.
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1. From the Vendor change order Schedule of values page, click Push to line items.

SUPPORTING

oooa

A warning message indicates that the push updates the Line Items tab with values from the
schedule items. If the associated line item has a zero unit price, the message indicates that the
adjustment quantity and unit price cannot be calculated and asks if you want to proceed.

2. Click Yes to push the schedule items to the line items tab. Any value or line item that was added
to the Line Items tab is removed. Contract then pushes only the line items that are associated to
the Contract schedule of values and calculates the line item values. If the line item has a zero

unit value, no values are calculated for the Change order adjustments section of the vendor
change order. You can add them manually.

On the Line items page, the total values are shown in the Net price column in the This submission
section. If there are multiple schedule items tied to the line item, Contract adds them together to
populate the Net price column.

6.0.3.9 LINE ITEMS TAB

Vendor change order line items show how you are going to apply the amount you indicated in the VCO
to the contract. Under the VCQO’s Line Items tab, you indicate what line items in the contract pertain to

this change order.

The Line items tab lets you manage the line items for a vendor change order. The Line items tab is

described below.

1 Line item
details

2 Current line
value

This section of the register contains the Line item ID, Description, UoM,
WBS, GL account, and Product category. You can scroll to view all the
columns.

For line items that already exist, containing their original quantities and
pricing.
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Change order Displays the adjusted quantities and pricing you add to existing line
adjustments items or define on newly added line items.

4 Total revised  The total of the Current line values and Change order adjustments

line value added together.

5 Remaining As you total up your line items, their total amounts subtract from the
amount to VCO total to give you the remaining amount that needs to be allocated.
allocate

6 Pull from Lets you pull items from the Schedule of values page to update the line
schedule items.
items

ing amount to allocate Dcloy days e to e, esponsitic party Ventor CO stats prm——

pr— =
59435032 @ s 0.00

UseitemiD= Desciption = Ul = Costoms o iy = epies = Napies =

Seiectes

When a line item has been revised but not published, a Revised line item icon shows in the Line item ID
column for that line item. The icon lets you quickly see that changes have been made to the line item,
and you can decide if you want to proceed with the VCO or payment form.

LINE ITEMS REGISTER

The Vendor change order line items register lists all line items for the vendor change order. Arrows in
the column headers let you collapse or expand the section. Multiple sections can be collapsed. The first
section, which includes the Line item ID, Description, UoM, and Cost center, cannot be collapsed. You
can click the double arrow in the first section to collapse the rest of the sections.
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VGO total Remaining amount o allocate

$94,350.32 $0.00

- o
w238 o
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The bottom of the grid shows the total number of items and the total number of selected items. To see
only the selected items, click View selected. Click Clear selection to deselect all items.

You can rearrange the columns within a section using the Column Selector Builder. To open the
Column Selector Builder, click the Manage columns icon. The Available columns section shows all
columns that are available for each section. To add a selection or column, select it, and then move it to
the Selected Columns section. To remove a section or column, select it, and then move it to the
Available columns section. Click Save to apply the changes. You can also rearrange sections from the
Column Selector Builder dialog box. To move a section, select it, and then use the arrows to move the
section up or down. You cannot add columns to the first section in the grid. You cannot move columns

between sections.

Column Selector Builder

Available columns Selected Columns
Search Search

[ section/column name [0 | Section/column name
O  current Line Value = Line item 1D

[ Quantity Description

O  unitPrice UoM

O per

[ NetPrice

[ changeOrder Adjustments.

O | Quantity
[ unit Price
O Neterice

=1k

Reset to default

You can search for specific available or selected columns. For example, you could search for value
Price, and the search results show all columns called Unit Price and Net Price in all sections.

VENDOR CHANGE ORDER LINE ITEMS

On your VCOs, you can indicate the line item breakdown of the agreed upon change order amount in

one of the following ways:
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« Add line items that already exist on the contract and alter them
» Copy line items from the VCO Line items page
» Create new line items to document the change

You must publish the contract before you can bring line items into the VCO or create a new line item
from a VCO.

[\[eJg = Executing a vendor change order will update the contract line items, contract total, and
the ERP system purchase order

ENTER LINE ITEMS INTO A VENDOR CHANGE ORDER

1. Click the Line Items tab in the Vendor Change Order.

IVETTIQININIY Qi s aiit-aues

$25,430.00

DETAILS LINE ITEMS

2. Click the Add line item icon, and then select Add existing line item or Add new line item. If you
have a master agreement in place for the contract, you can select From master agreement. For
this step by step, select Add existing line item.

v total

$25,430.00

®

The Add existing line item dialog box opens.

3. Select a line item.
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Add existing line item

Line item ID Type Description

D 000 Material SUBCONTRACT,STRUCTURAL STEELINSTA..

4. Click Add. The line item is added to your vendor change order

VCO total Remaining amount to allocate
$25,430.00 $25,430.00
® DETAILS LINE ITEMS

Current line value

Line item ID Description UoM WBS Quantity Price Per Net amount Quantit

You can also add a line by copying an existing line. To copy a line in the Line items register, select the
line and then click the Copy icon. Select Line item to copy to the register. You can select which sections
you want to copy. You can then edit the line item is needed. The copied line item ID is New. A line item
ID is assigned after the VCO is executed.

PULL SCHEDULE ITEMS INTO THE LINE ITEMS PAGE

After you update the quantities for a submission in the Schedule of values tab, you can pull the items
from the schedule of values to update the line items page.

Considerations: The Pull from schedule items button is enabled if any of the schedule items have a
Contract line item ID. When the line item ID is blank on all schedule of value items, the Pull from
schedule items button is disabled, and you cannot pull items from the schedule of values.

1. From the Line items tab, click Pull from schedule items. A warning message indicates that values
in the line items will be overwritten. If the associated line item has a unit price of zero, the
message indicates that the adjustment quantity and unit price cannot be calculated and asks if
you want to proceed.

2. Click Yes. The values from the Schedule of values page overwrite the values on the Line items
page. If there are no values on the Schedule of values page, Contract sets the quantity and net
price to 0.00. Any value or line item that is not associated to schedule items is removed. If the
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line item has a unit value of zero, no values are calculated for the Change order adjustments
section of the vendor change order. You can add them manually.

IMPORT AND EXPORT LINE ITEMS

A convenient way to add line items is to import them using a line items template. You can also export
line items for reviewing and updating offline. You can import or export from the vendor change order
Line items tab.

> 7300009035 WORKFLOWTESTING > me02-testingproposal  USD §
VGO total Remaining amount to allocate
$0.00 $0.00

DETALS

IMPORT LINE ITEMS

Contract provides an import template that you can use to enter line items in bulk. From a vendor
change order, go to the Line items tab, and then click the Import data from template icon.

VCO line item import - Google Chrome

Import data from template

Data will be imported in to VCO line item

Drag and drop the file here or browse

Browse

=ul -

The Import data from template opens, and you can click Import template to download the template.
InEight updates the template frequently to match the updates to Contract, so it is recommended to
download a new template each time you plan to import.
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The first page of the template contains the instructions for the templates. The guidelines describe the
information on the import template, exporting with data, and how to update or add more information
to the existing data. The Template page is where you enter you line items. The columns are color
coded to indicate which columns are system generated, required data, optional data, and ignored data.
You can complete the required areas for the line items. After you complete the spreadsheet, save it
and drag it onto the dialog box, and then click Import to import the line items into contract.

\[eJ = Contract validates the dates based on the person who imports the data. If the dates do

not match the preferences of that person, Contract generates an error in the import
history and removes the date.

[\[e3 = Do not change the name of the spreadsheet tabs.

After importing, you receive an email message listing status, the total line items, the total imported,
and number of errors. If the status is pending, click the Review data link to see the line items that have
completed and those with errors. You can correct the lines with errors from the Import history grid,
select them, and then click Import to continue with the import process. The import is reprocessed, and
Contract sends you an email message when the import is completed. The VCO line items tab shows the
lines that were imported with the Line item ID New.

EXPORT LINE ITEMS

The export function lets you export line items with data. If there are no line items in the VCO but there
are line items for the contract, the export template lists all lines tied to the contract. If you add a line
to the VCO and you export with data again, it only pulls the line that you added. The line does not have
a line item ID.

6.0.3.10 SUPPORTING DOCUMENTS TAB

You can add a supporting document a Vendor Change Order by selecting its tab. From the Supporting
Documents tab under the Vendor Change Order tab, the add button now has two drop-down options
to add a New supporting document or From supporting document list. When you add from the
supporting document list, a window is shown with a list of existing documents to choose from.
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@-

J New supporting document [Link

' From supporting document list Iple Te
' Fromn Eight Document g HM2ZW
_J 103442 TWO-04 Traffi . 103442 W

When New Supporting document is selected, the Document type is set by default Draft change order
and Vendor change order ID is automatically filled in with the current VCO ID. Vendor change order ID
is also filled if you change Document type to Executed change order.

Add supporting document
*Title *Document type
Draft change order hd
*File/Link
SELECT FILE... »
Vendor change order ID Consent of surety signed

Executed date

MNotes 1000

Selecting the From Supporting document list will show those documents, which are out in the register
and have not yet been assigned a contract. By choosing the documents you need, they will be added to
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the VCO. You can associate a Draft change order or Executed change order supporting document to

multiple VCOs.

From supporting document list

Title
ertificate
o Test
Test_Meeting
o Over_ride
Action - ’.B -
Title File/Link

Test Templatedocument (35).docx

Over_ride

Bid_Package_import_200data (1).xlsx

Document type

Certification

Draft change order

Meetings

Override memo

Document type

Draft change order

QOverride memo

X

Subtypea

Other

Payment Term Waiver

EERl -

DETAILS

Subtype Approval status Approved/Rej...
Approved Ajay GK 03/02/2020
Payment Term W.. Approved Ajay GK 02/17/2020

Selecting From InEight Document takes you to the InEight Document log-in window, where you can

sign into the application and select a document.

When you remove an approved supporting document from within a VCO, it is still associated to the
contract but not to the VCO. If you want to disassociate a VCO document from a Contract, you must

disassociate it from the Supporting document tab or the Supporting document register.

VIEW A SUPPORTING DOCUMENT

To view a supporting document, click the link in the File/Link column of the Supporting documents
register. The document opens a preview in a new tab, so you can view the pages of the document and
then decide if you want to download it to your workstation. You can use the Previous and Next

buttons to view all pages.
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HistoricalWeatherRecord_2023-April-05-

Previous | PageNo:1 /1 Next
Historical Weather Record
Omaha, Nebraska, 68114, United States Of America, Lat. 41.2656 , Lon. -96.0493
(UTC-06:00) Central Time (US & Canada)
Selected Range:  Date: Time: Date: Time:
From 041052023 12:30 AM To: 041052023 11:30 PM
Date Time Temperature ~ Weather condition  Wind Precipitation
04/05/2023  12:30 AM clear sky 0 m/s, 0.00 mph
01:30 AM clear sky 36 m/s, 8.00 mph
0230AM 2 clear sky 6.17 m's, 14.00 mph
03:30 AM clear sky 8.75 m/s, 20.00 mph
04:30 AM 11.32 mis, 25.00 mph
05:30 AM 21.00 mph
06:30 AM  7°C 44°F scattered clouds
07:30AM  5°C 41°F broken clouds
08:30AM  4°C 39°F overcast clouds 823 m/s, 18.00 mph
09:30AM  3'C 38°F overcast clouds 10.29 mis, 23.00 mph
10:30AM  3°C 3T°F overcast clouds 11.83 m's, 26.00 mph
11:30AM  2°C 35°F broken clouds 10.8 ms, 24.00 mph
1230PM  2°C 35°F overcast clouds 8.75 m's, 20.00 mph
040052023  01:30PM  1°C 34°F broken clouds 9.77 m's, 22.00 mph
‘ontract Main.v23.4.20230410.01

To download the document to your workstation, click Download file.

CREATE FORMS OR MAIL IN INEIGHT DOCUMENT

If a project is associated with InEight Document, you can create a form or mail item from a VCO.
Document saves the form or mail and creates a link in the Supporting documents tab.

Single-sign on is available for Contract to Document features, such as creating mail or a form. When
you use one of these features, the Document sign-on page opens, and you can enter your credentials.
This creates a sign-on token that lets you remain signed in until the session ends. The first time you
sign in to Document, a black secondary window and the Document Home window also open. You can
close these windows. Single sign-on is activated, and they are not shown again.

\[eJ 2 Creating forms or mail is initiated from the Actions menu. If Actions > Create document >
Form or Mail is inactive, you can select the Settings (cogwheel) icon in the Actions menu
to set up integration with Document.

CREATE A FORM IN DOCUMENT

You can create a Client RFl or Request For Information form in Document and add it to the Supporting
documents for the VCO in a single procedure.
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1. From the Details page go to Actions > Create document, and then select Form.

2. If you are not already signed into Document, use your credentials to sign into InEight Document.

)

User ID

DOCUMENT

"=~ TeamBinder

Company ID
Password
' Remember Login User 1L & Company 1

Multiple Accounts? Login via Profile

English | Frangais | Italiano | Espaiol | (&6 | Farsi

Contact Support +1(800) 801 1426

Bookmark This Page | Forgot your

A sign-in token is created that lets you remain signed in to Document until the session ends. If
this is the first time you are signing in to Document from Contract, a black secondary window
and the Document Home window are shown. After you close these windows, single sign-on
(SSO) to Document is activated, and they are not shown again.

3. The Create new form dialog box opens. Select the form type, and then click Next. The Request
for information window opens in Document.

4. Complete the form, and then select the users for distribution of your form. A success message is
shown and a link to the form is added to the Add supporting documents dialog box.

5. Click Add to add the form as a supporting document.
CREATE MAIL IN DOCUMENT

You can create a mail item in Document and add it to the Supporting documents for the VCO in a single
procedure.

1. From the Details page go to Actions > Create document > Mail.

2. If you are not already signed into Document, use your credentials to sign into InEight Document.

InEight Inc. | Release 25.3 Page 285 of 377



Contract User Guide

DOCUMENT

"=~ TeamBinder

)

User ID

Company ID

Password

+ Remember Login User ID & Company ID

Multiple Accounts? Login via Profile

English | Frangais | Italiano | Espaiol | (&6 | Farsi

Contact Support +1(800) 801 1426

Bookmark This Page | Forgot your password?

3. The Create Document Mail dialog box opens. Select the mail type from the list defined in
Document that are specific to the project's mail type, and then click Next.

X

Create Document Mail

o Select Mail type

Select the Mail type to be created. Upon clicking the ‘Create button, you will be taken to InEight Document to create the mail
*Mail type

Change Order

-

Change Order Response
Formal Letter
General Correspondence
IDF Response

Issue Documentation Form

4. Optionally add an attachment. If you selected documents on the Supporting documents page
before you started the action, they are automatically included.

¢ To add an attachment from the Supporting documents tab, click Next. The Select
documents dialog box opens. You can choose documents from the Supporting documents
tab with the Document source My computer. After you attach the documents, click Create.
The Mail module opens in Document with your attachments included.

e To add an attachment in Document, click Create. The Mail module opens in Document.

Click Attach files > Attach Documents, where you can search for the document. After you
select a document, click Save.

¢ To send mail without an attachment, click Create. The Mail module in Document opens.
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5. Enter information in the To and Subject fields. The other fields on the page are optional. Enter or
update the fields as needed for the mail message, and then click Send. A summary page opens.

6. Edit links and notes, if needed. The mail is added in Document.

7. Close the Document window. You are then prompted to add the mail as a supporting document
in Contract. The document type defaults to Correspondence but can be changed.

8. Click Save to save the mail to the Supporting documents page.

6.0.3.11 ASSOCIATED CHANGE ITEMS

Often there will be issues or pricing items captured by the foreman or superintendent in the field that
you want to tie to your vendor change order. These issues and pricing items reside in InEight Change,
but you associate them to vendor change orders on your contracts. You can also add a new issue to
associate to your change order. The following Step by steps describe how to associate an issue or
vendor pricing items from a PCO or CCO to your VCO in Contract.

(e 2 Issues are any potential concern that you want to track and monitor on a project, that
may or may not become change orders. Issues are further defined in the training

materials for the InEight Change application.
ADD A NEW ASSOCIATED CHANGE ITEM

1. From the contract header page, click the Vendor Change Order Log tab.

Contracts > 7400001418 - PB - Structural Steel

T - VENDOR CHANGE
Actions v DE i
HEADER LINE ITEMS ORDER LOG BACK Ct

2. At the Associated issues section, click the Add Icon to add an issue.

~N

Associated issues ®

O Issue ID - Name. Issue status Value type Current value PCO ID - Name Client CO ID - Name

No results found in this issue.

Total $0.00

3. Select Add new issue.
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Add existing change item

Valu-l Add new Issue I

4. On the Add a new issue window, fill in the fields, and then click Add.

X

Add a new issue

*Issue name *Issue start date

Additional fabrication 09/11/2018

*Description

Additional fabrication needed per Appendix B

The issue is now added to the register under Associated change items.

Associated change items ®

(m] Issue ID - Name = PCOID-Name = CCOID-Name = Pricing ltem =  Status = Valuetype = Contributed.. =

[w] Additional fabrication

Total

$0.00

5. Click Save. The issue is now in Change on the Pending issues page if you are not an issue
approver or the Issue log if you are an approver.

ADD AN EXISTING CHANGE ITEM

From the Associated change items section of the Vendor change order details, click the Add
issue icon, and then select Add existing change item. The Add Change item dialog box opens.

Select a pricing item. Items in the issue column have pricing that was added at the issue level. If
the Issue column is blank, and there is a value in the PCO or CCO column, the pricing items were
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added at the PCO or CCO level.

Add Issue

lssueD-Name =  PCOID-Name = CCOID-Name = Vendor assigned = Staws =
pricing item CCO pricing Concrete Designs Inc cco
CCO pricing Concrete Designs Inc New

42- brand new CCO with auto syn. cco

38- 813 - issue 8/13 cco

a]
a]
a]
a]
a]
a]
a]
a]

Cancel

W[e) 2 Adding the issue does not automatically add the PCO and CCO pricing items added
at the PCO and CCO levels. If you want to add the pricing items added at the PCO
and CCO levels, you must select them.

3. Click Add. The pricing items are added to the Associated change items register. If you delete a
PCO later, all rows associated with the PCO are removed.

After pricing items are added, you can click the Add notes icon in the Description column to add a
description. After a description is added and saved, the column shows a View icon that you can click to
see the description of the pricing item.

VCOS CREATED IN CHANGE

VCOs can also be created by InEight Change users. VCOs created in Change come in with a Draft status
and are automatically associated with the issue, PCO, or CCO where it was created. The Created by
field is set to the name Service Account for VCOs created in Change.

6.0.3.12 SCHEDULE OF VALUES TAB

Vendor change orders have their own schedule of values pages. You can add a schedule of values, so
you can see the quantity or value the change order has against a component.

You can add new or existing Schedule items. Items added to this page are added to the Schedule of
values at the contract level only after the VCO is published. When you add a value-only schedule item
to a vendor change order, only the Value field is editable.
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IMPORT AND EXPORT SCHEDULE ITEMS

You can use the VCO schedule of values template to quickly add schedule items and then import them
to a vendor change order. Use the import template to add new schedule items or edit existing items.
For more information about how to use the template, refer to the Instructions tab of the Microsoft
Excel template.

VCO total Remaining amount to allocate Delay days due to issue Responsible party Vendor CO status Approval status

$0.00 $0.00
/ SCHEDULE OF SUPFORTING
[ e UINE ITEMS <

nnnnnn MENTS

« < | Change order adjustment < |Toha\vemedva\ue

[] Schedule = Comtract = Description = WBScode = CustiSf . = Unitpice = Schedule = |quantity = UnitPrice = Valve = [quantity = Value = Unitprice
Tine item 1D line item 1 b value |

For information about importing, see Imports and exports.

DELETE A SCHEDULE ITEM

When a schedule item is not needed in the contract, you can delete it via the Vendor change order
Schedule of values tab. When you delete a schedule item, the item shows in the register with a
strikethrough, and it cannot be edited. The Schedule quantity and Unit price values are moved to the
Change order adjustment section as negative values. When you execute and publish the vendor
change order, the schedule item is deleted with a strikethrough in the parent contract.

6.0.3.13 PROJECT-LEVEL VENDOR CHANGE ORDER LOG

You can view a log of all VCOs for a project on the Vendor Change Order tab at the project level. The
log provides visibility to all VCOs for all the contracts in the project for tracking purposes, including
those created from InEight Change.

The register has filtering, column resizing, and information features like other registers in Contract.
Data in the columns are linked to any associated issues, PCOs, or CCOs in Change. You can see
associated issues, PCOs, and CCOs, in the Issue ID, PCO ID, and CCO ID columns.

Click the Information icon to see information about the VCO. The information slide-out panel has links
to the line items, associations, back charges, supporting documents, and contract.
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W= VCOs that were automatically created in Change have the Name Service Account in the
Created by column.

6.0.4 BACK CHARGES

A back charge is a billing for work or costs incurred by one party that, in accordance with the
agreement, should have been performed or incurred by the party originally contracted to do the work.
For example, if you have a subcontractor responsible to move aggregate from one location to another
and their loader goes down, you may have them use one of your own loaders onsite and then back
charge the sub for the hours they used your loader.

Back charges can also be used to assess liquidated damages. You will log back charges under the Back
Charges tab of your contract record. You can associate a back charge to an issue to enable tracking in
InEight Change.

ADD A BACK CHARGE

1. From the Contract > Contracts page, open the Structural Steel contract.
2. Click on the Back Charges tab.

Contracts  *  T400001418 - PB = Structural Steel

fetions v ¢ LINE ITEMS "'[’;'3“3%‘;:;‘(‘_‘"[ |az-:k-:-|me|:s| BAYMENT FORMS PAYMENT PROGR

3. Click the Add Back Charge Icon.

4. Complete the Add back charge page by filling in the following:
» Description: Redo galvanizing
» Date supplier Notified: [Yesterday]
» Date back charge work completed: [Last Wednesday]
» WBS Code: 1087 - Structural Steel
» Back Charge Amount: 5000

o Comments: Galvanizing rubbed off due to improper shipping. Used ABC Co. to
reapply
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Back charge amount

$0.00

SUPPORTING
DOCUMENTS = 2 Q

Back charge details Created by:on Assignments

Back charge ID “Desciption

ppler noti Date back charge work completed
Account assignment type WBs code Split back charge
Bs - -
Back charge amount
$0.00
Comments 1000

Associated issue &

Issue ID/Name Issue status Value type Current value

5. Click Add.

» The back charge is now logged in the register to reference for billing the vendor

Contracts > 7400001418 - PB - Structural Steel

" VENDOR CHANGE SUPPOR
Actions h < HEADER LINE ITEMS BACK CHARGES PAYMENT FORMS PAYMENT PROGRESS

ORDER LOG DOCUM
® # ®
=] Description WBS code Date supplier notified Date back charge work completed Back charge amount Comments
C | Rede galvanizing 09/13/2018 09/05/2018 $65,000.00 Galvanizing rubbed off due to improper shipping. Used A...

6.0.4.14 ASSOCIATE AN ISSUE TO A BACK CHARGE

Frequently, when a vendor receives a back charge, they want to track it in InEight Change. You can
associate an issue from Change to the back charge from the Back charge Details tab. Only one issue can
be associated with a back charge.

TIE AN EXISTING ISSUE TO A BACK CHARGE

After an back charge has been added, you can associate an issue from InEight Change to it.

1. Click the Add associated issue icon, and select Add existing issue.
2. Select an issue from the list in the Add issue page.

3. Click Add.
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TIE A NEW ISSUE TO A BACK CHARGE

After a back charge has been added, you can associate a new issue to it. When you create the new
issue and associate it with the back charge, the issue is added to InEight Change.

1. Click the Add associated issue icon, and then select Add new issue.

2. Use the Add new issue window to add the issue name, issue start date, and a description
of the change.

3. Click Add. The issue shows in the Associated issue grid, but it has not been added to
InEight Change.

4. Click Save. The issue is added to the InEight Change application.

6.0.4.15 ADD SUPPORTING DOCUMENTS TO A BACK CHARGE

On the back charge Supporting Documents tab, you can upload multiple documents, such as email
messages and invoices. Any document that is relevant to the back charge should be uploaded. The
supporting documents can be a file or a link, or can be added from InEight Document.

ADD A NEW SUPPORTING DOCUMENT

—

. Go to the Supporting Documents tab.

N

Click the Add supporting document icon, and then select New Supporting document.

w

Complete the Add supporting documents page with the following information:
o Title
e Document type
 File orlink
* Notes
4. Click Add.

ADD AN EXISTING SUPPORTING DOCUMENT

1. Go to the Supporting Documents tab.
2. Click the Add supporting document icon, and select From supporting document list.
3. Select one or more documents.
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4. Click Add.

o= The supporting documents in the list are associated with a contract. When you
disassociate a contract from the Supporting document register, the back charge is also

disassociated

6.0.4.16 SEND BACK CHARGE DOCUMENTS FOR ESIGNATURE
VIA DOCUSIGN

When a project is integrated with DocuSign, you can send a back charge document to DocuSign for an
eSignature.

DocuSign tags can be embedded in the contract template. The DocuSign tags correspond to DocuSign
recipients configured in the project settings and project contacts.

See 5.0.8 Contract Writer on page 240 for information about sending documents for eSignature via
DocuSign. See 2.0.1 Organization settings on page 19 for information about using tags.

6.0.4.17 ASSIGN A BACK CHARGE TO A PAYMENT FORM OR
VENDOR CHANGE ORDER

You can assign a back charge to either a payment form or a vendor change order by clicking the
appropriate link in the Assignments section of the Back charge Details tab. Assigning the back charge to
a vendor change order or payment form can help you with tracking the back charge through the
system.

When you assign a back charge to a payment form, it is automatically added to the list of back charges
on the Payment form detail page. The back charge is automatically listed on the Vendor change order
detail page when you associate it with a vendor change order.

6.0.4.18 SPLIT A BACK CHARGE

You can split a back charge into multiple charges. After the back charge has been split, you can treat
the back charges independently of each other, and associate different issues or assign to payment
forms or vendor change orders.
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6.0.5 ACCRUALS/RECEIPTS

After goods or services are provided, you can use the Accruals/Receipts tool to track the associated
cost. If you have a receipt or invoice, you can enter it in Contract to send the cost to your ERP system.
If you have received goods or services but have not yet been invoiced, or you intend to pay for it later,
you can create an accrual.

To access the Accruals/Receipts log, select the Accruals/Receipts tab.

105091 (Steel Training Job)

SUPPORTING ACCRUALS / CONTRACT

fetons @ Q
Type D Contract ID Description Created date Posting date WBS Total Status File/Link
Accrual | 0002 7200000870 Rebar Section P2 Install. 06/13/2019 06/14/2019 1086-Concret. $100.00 Draft
Accrual 1 0001 7200000870 06/13/2019 06/21/2019 1086-Concret. $0.00 Draft
Receipt 0001 7200000869 06/13/2019 06/17/2019 1071-Concrete $10,000.00 Draft Column Asse.

CREATING A NEW ACCRUAL OR GOODS RECEIPT

You can create new goods receipts by clicking the Add icon.

Actions - |z; ®

Type 1D Contract ID
Accrual 002 7200000870
Accrual 001 7200000870

To open an existing goods receipt, click on the hyperlinked ID. You must select the ID of the receipt.

2] 105091 (Steel Training Job) - Contract
CONTRACT!
Actions ®
Type b Contract 1D Contract description
Accrgal 0003 7200000870 Rebar Installation
Accrua 0001 Bebar Installation
Receipt 2901 Column #ssemblies

The Accrual/Receipts record contains a header with key information and actions.
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Overview - Accrual/Receipts Record Header

1

2
3
4

Contract

7100002460 - Rental-Mandrels-Allwe.

Contract
Vendor
Description

Posting Date

Delivery
number

Supporting
Documents
file/link

Save and
Submit

Save

-0

The Contract ID and name the accrual or goods receipt is associated to.
The Vendor ID and name on the contract.
Description of the receipt or accrual.

This is the date of when the cost will hit the back-end accounting
system or ERP system.

The delivery number of the goods receipt.

Upload or link any items associated to the goods receipt or accrual
(e.g., invoice, material receipt, PO, pictures, etc.).

Submit the goods receipt or accrual. This will send the registered
quantity or amount to the accounting system/ERP system and adjust
any associated line items. In a proxy ERP environment, this adds the
goods receipt or accrual information to the contract line items in the
accrual/receipt view set. Contract sends accruals to InEight Control only
after they have been submitted.

This will save the goods receipt or accrual information as a draft. No
information will be sent to the accounting system/ERP system. In a
proxy ERP environment, no information is added to the accrual/receipt
view set.

0010002923 - VOID Allwest Undergro, Wates o6n182021 =] 0 o}

The following steps walk you through adding a goods receipt using the accruals/receipts tool.

ADD AN ACCRUAL OR GOODS RECEIPT

Summary: Add a goods receipt when the goods or services have been delivered. Add an accrual when

the goods have been delivered, but you have not yet received an invoice and want to post the costs in
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the current month.

1. From the Contracts register, select the Accruals/Receipts tab.
2. Click the Add icon. The Add new item dialog box opens.

Actions v @ ET @

Type 1D Contract 1D
Accrua 0002 7200000870
Accrua 0001 7200000870

3. Select the Accrual or Receipt item type, and then enter a description, contract ID, and posting

date.
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Add new item

Type

O Accrual @ Receipt

*Description

Column Assemblies A1-A10

*Contract

7200000869 - Column Assemblies / 0010016082 - Gilbert Contracting Inc b

*Posting date

06/30/2019

Cancel Save

Mo = When creating a goods receipt, the Contract drop-down list shows only contracts
with line items that are expecting a goods receipt.

When creating an accrual, the Contract drop-down list shows all contracts
containing line items.

4. Click Save. The Accruals Receipts Line items page opens.

5. Click the Add icon to add line items from the contract previously selected.

®

Line ID Line Des... Type PO Qty

There are no line items in this receipt.
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6. Select the line items you want to add to the goods receipt or accrual.

Add existing line items

o Lineite... Type Description WES Code

0001 Matenal 3/4 clean stone 1071

7. Click Add. You can see the following details: Line ID, Line Description, Type, PO Qty, and unit of
measure (UoM). If you are adding a goods receipt, the following values are also shown:
previously received quantities, quantity, receiving amount, ERP system status, and ERP system
document ID. If you are adding an accrual, the following values are shown: previously received
guantities, accrual type, accrual GL account, accrual amount, ERP system status, and ERP system
document ID

(\[eJ1 3 When creating a goods receipt, if a line item has been tagged in the contract as not
requiring a goods receipt, or if a line item has been fully received, it will not

populate in the list of available line items.

When creating an accrual, all the line items that have not been paid out in full are
available for selection.

8. If you are adding a goods receipt, enter the value received in the in the quantity field. If a
submitted goods receipt has quantities that were entered in error, you can enter a negative
guantity up to the amount that has already been received. The receiving amount will auto
calculate based on the quantity entered, multiplied by the unit price.

If you are adding an accrual, enter an amount in the Accrual amount column.

9. Optionally attach a copy of the receipt or invoice to the goods receipt or accrual. Click the Add
attachment link in the right side of the header. The Add supporting document dialog box opens.
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+ Posting date Supporting document file/link

06/30/2019 i No attachment is added @

[ Cancel ] [ Save and submit ]

Q

10. Upload or link files via a URL, and then click Save.

Add supporting document

Title
Receipt 0002 - Column Assemblies A1-A10

File/Link
Add file 7 link here SELECT FILE... -

This opens a window where a document can be uploaded or linked to via URL.

11. Click Save or Save and submit.

[ Cancel Jl[ Save and submit ]l

0
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SUPPORTING ACCRUALS / CONTRACT
CONTRACTS DOCUMENTS INVOICES RECEIPTS TEMPLATES

Actions  + ®

Type - Contract ID Contract descr... Description

Q

Create... Posting... WBS Total Status

Receipt

7200000869 Column bli Golumn blies A1-410 06/14/2019 06/30/2019 1071-Conc. $10.00 Success |

Receipt

7200000869 Column bl Column blies Reciept 06/13/2019 06/17/2019 1071-Conc. $10,000.00 Success

What's next: In the Accruals/Receipts register, you can now see the receipt total and status have been
updated .

6.0.5.19 EDITING AN ACCRUAL OR GOODS RECEIPT

There are two ways to edit an accrual or goods receipt once a line item has been created. You can edit
the accrual or goods receipt by clicking the corresponding ID, or you can select the item you wish to
edit by checking the leftmost box and clicking the edit icon adjacent to the add icon.

Actions - @ ®

Type 1D Contract ID
Accrual 0oo2 7200000870
Accrual 0001 7200000870

6.0.5.20 DELETING AN ACCRUAL OR GOODS RECEIPT

You can delete an accrual or goods receipt which has not been submitted. Select the line item you
would like to remove and click the Delete icon. Accruals and goods receipts cannot be deleted once

submitted. To adjust a submitted accrual or receipt, a reversal must be done. This is covered in the
reversals section of accruals and receipts.

Actions - @ B} @

Type 1D Contract ID Contract description

Accrual 0002 7200000870 Rebar Installation

6.0.5.21 REVERSING AN ACCRUAL/GOODS RECEIPT

If an accrual or goods receipt has been submitted, it can no longer be adjusted or deleted. Instead, a
reversal can be made. Reversals send a negative amount equivalent to the original accrual or goods
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receipt. This is an all-or-nothing process, intended to keep accruals and receipts clear cut regarding
submissions and changes made with the ERP system or accounts payable.

INITIATING A REVERSAL

1. From the Contract > Contracts page, open the Accruals/Receipts tab.

2. Select the line item for reversal and click Reverse Submission.

DOCUMENTS VoleEs RECEIPTS. TEMPLATES
- © @ ®  a
Accru: 0002 7200000870 Rebar Section P2 Installed 06/13/2019 06/14/2019 $100.00 Draft
Accrual 1l 0001 7200000870 Rebar Section S1 Installed 06/13/2019 06/21/2019 $100.00
Receipt 06/14/2019 06/30/2019 $1000
Receipt 0001 7200000869 06/19/2019 06/17/2019 ($10000.00)

* A new page opens with the reversal information

* You may change the description to signify it is a reversal

Accruals / Receipts > 0001 -X - Rebar Section 1 Inst...

Supporting document file/link

Contract Vendor + Description « Posting date
7200000870 - Rebar Installation 0010060218 - Tonage Inc Rebar Section S1 Installed - Reversal 06/21/2019 Rebar Accrualpdf (S
[ Cancel ] [ Save and submit ] m

Line ID Line Des... Type Accrua... Accrua.. Accrua.. ERP st... ERP do...

PO G‘ Previo...

3. Make any additional adjustments to the posting date and supporting document as needed.
4. Click Save and submit when done for submission to the ERP system or proxy ERP.

* Anew Line |d appears in the Accrual/Receipts register with the reversal

CONTRACTS SUPPORTING INVOICES ACCRUALS / CONTRACT

DOCUMENTS RECEIPTS TEMPLATES
scions (3 7 Q
Type Contract ID Contract descr... Description Create... Posting... wes Total Status
Accrual reversal 00. 7200000870 Rebar Installation Rebar Section S1 Installed - Reversal 06/19/2019 06/21/2019 1086-Conc.. ($100.00) Success

NEGATIVE GOODS RECEIPTS

If the values were entered in error, instead of reversing a goods receipt, you can back out the error by
adding a line with a negative quantity up to the amount that has already been received. For example, if
you submitted a goods receipt for a line item with a quantity of 100 and it needs to be adjusted to a
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quantity of 10, you can create a goods receipt for a quantity of -90. After the goods receipt is
submitted, Contract automatically calculates the submitted receipt amount accordingly.

A goods receipt must already be submitted before you can create a goods receipt for a negative
quantity.
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CHAPTER 7 — PAYMENT
MANAGEMENT

The following topics describe payment forms and how to track payment progress.
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7.0.1 INEIGHT CONTRACT WORKFLOW - PAYMENT
MANAGEMENT

WBS Structure
E
.

Contracts

Bid Packages

Create Bid
Package

[\ ELErS

Contract Setup Add
(Documents, s i Documents Contract Execute Create
Details & Line Lo Approval Approval Contract

PO
Documents oods v

Items) eipts &
Accruals

|
v

RllESronEs RefEe Create Payment Form Contract

Payment Form Approval Closeout

Contract
Award

VCO Approval

Submit invoices

|
Executed
Contract

Manage Scopes of Work
Schedule Procurement

o5 Receive payment progress, goods receipts
%28

- Estimate Update PO

Control

Change Register

Budget/Contract
Adjustments

7.0.2 INVOICES

Invoices for a project can be added to the Invoices register. Invoices must be associated with both the
contract and the actual pay form. Invoices can be added at a project level, assigned to a contract and a
payment form on a later date. This helps businesses to manage an influx of invoices.

7.0.2.1 INVOICE REGISTER

The Invoice register shows a list of all invoices associated with a project, including ERP system,
contract, invoice, payment form, and vendor-submitted invoice information. You can use the Invoice

type columns to quickly identify whether the invoice is a standard invoice or a retention release
invoice.

You can add standard invoices and retention release invoices into the invoice register and then assign
them on a later date. See Invoice attachments for more information about standard and retention
release invoices.
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ADD A INVOICE

Summary: Add an invoice to a project when a vendor has sent an invoice and you must add it
manually.

You can associate the invoice to a contract when you create the invoice or on a later date. An invoice
must be associated before it can be converted to a payment form.

1. From the Invoices register (Contract > Invoices), click the Add invoice icon. The Add invoice
dialog box opens.

2. Add the invoice information, including the invoice file or link, and then click Add if you are only
adding one invoice or Add and new if you want to add more invoices.

(M3 = You cannot link to password-protected PDF documents.

3. Repeat step 2 as needed. If the Vendor invoice status column is used in the register, the invoices
have a vendor status of Not applicable.

If you did not assign a contract to the invoice, you can edit the invoice later.

To edit an invoice, select it, and then click the Edit icon. The Edit invoice dialog box opens, and you can
add or edit the contract or edit any other field.

To assign an invoice to a payment form, select one or more invoices, and then click the Convert invoice
icon. You can assign the selection to an existing payment form or convert to a new payment form..
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ERP do...
+ | 60908
¥ | 27498
¥ | 80916
v | 72791
91369
v | 91379
12600

®

Invoice...

ff

Inv234

Testla

Test2a

123

325

1234

g ®

Assign to existing payment form

Convert to new payment form

AY s

09/17/2019 $11.00
09/17/2019 5201.00
09/16/2019 $101.00
09/16/2019 $220.00
09/16/2019 $330.00
09/16/2019 $270.00
09/16/2019 $360.00
09/16/2019 $0.00

Purchas

Purchas

Purchas

Purchas

Purchas

Purchas

Purchas

Contract User Guide

Meaga In a proxy ERP environment, you can only put one invoice on a payment form.

7.0.2.2 INVOICE NOTES

To add a note to an invoice, select an invoice, and then click the Notes/feed icon. You can then add

notes to the Invoice tab of the Notes/Feed slide-out panel.
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Notes/Feed for X

\\\\\\\

vvvvvvvvvvvvvvvvvvvvvvvvvvvvvv

Notes added to the Invoice tab show for the invoice only. You can add a note for the contract on the
Contracts tab of the slide-out panel.

If a vendor has submitted the invoice into Contract from the Vendor contract summary page, notes
from the vendor show with a blue bar on the left side of the note. When you add a note to a vendor-
submitted invoice, you can specify whether the note is sent to the vendor by selecting the Send note to
vendor check box. If the check box is not selected, the note is internal only. See Working with vendor-

submitted invoices for information about vendor-submitted invoices.

7.0.2.3 WORKING WITH VENDOR-SUBMITTED INVOICES

When you select a pending invoice, the Decline and Received buttons become enabled. Click Received
to accept the invoice or Decline to reject the invoice and send it back to the vendor. These buttons are
disabled when you select multiple invoices or an invoice created in the project.

When you click the Decline button, the Reject invoice dialog box opens. You must then enter a note
describing why the invoice was rejected, and then click Save to save the rejection and send it to the
vendor. The invoice remains in the register with a status of Declined until the vendor users recalls it.
After the vendor recalls the invoice, it is no longer shown in the register.

When you click the Received button, the Receive invoice dialog box opens. After you add an approval
note and click Save, the Vendor status column shows the Received status, and the invoice can be
added to a payment form like an invoice that was created in the project.

7.0.2.4 VENDOR INVOICE SUBMISSION

The Contract vendor invoice submission feature lets vendors submit invoices in InEight Contract.
Vendor-submitted invoices help you save time and reduce the chance of errors that come with
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entering information on the vendor's behalf.

When a vendor submits an invoice, it shows immediately in the Invoices register, so you can assign it to
a payment form or decline it if needed.

VENDOR INVOICE SUBMISSION SETUP

Before a vendor can submit invoices, you must set them up as a user with specific roles and project
access.

VENDOR ROLES AND PERMISSIONS

Vendor users must be assigned to a role that includes the View Contract vendor page permission (Suite
Administration > Roles and permissions > Suite administration > Vendor > View Contract vendor
page). This permission automatically includes the Documents permissions under Suite Administration >
Roles and permissions > Organization and project > Documents.

Contract

O select all

Bid packages O Select all Gontracts [ Select all
1:@) Viewbid packagce [ Edit contracts

O (®) Delete contracts

(0 stop integration sync

O (#) Add supporting documents

@] E Edit supporting documents

When you create a vendor permission, set the administrator level to base level 0. The Vendor landing
page view must be assigned in the View assignments section.

USER MANAGEMENT

The vendor user must have a vendor assigned in the Vendor field of the User details. You can assign a
vendor user to a specific project on the project home page or assign the user at the organization level.

After you add the vendor user, they receive an InEight notification with a link and sign-in information.

GETTING STARTED WITH VENDOR INVOICE SUBMISSION

As a vendor, you can submit invoices directly into your contractor's invoice register where they can be
processed quickly. After you have been set up as a vendor by the contractor, you will receive an email
from ineight.mail@ineight.com with a link to the vendor home page and sign-in credentials.
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VENDOR HOME PAGE

To access the InEight system, click the link provided in the notification email, and sign in using your
credentials. After you have successfully signed, the home page opens to a vendor view. A tile labeled
Contracts lists the contracts you have with the contractor.

Vendor (Default) v Y @
/ [
J © OpenStreethap contributors
@ EarthCam ;) Contracts u Yy B C
Contract value Contract status Contract ID - Description Project ID - Name

$4,125,531.00000 Executed 105302 - 1501 Mike Fahey - aka Build

$115,000.00000 = Draft

/ $000000 Draft

]

@& Dashboards v Reports All v 1) Tasks
2 [ Account Code Structure Report

[ Adjusted budget 0

| Steel Material 104160 - Northampton Solar

0006651 - Testing_lnvoices 104160 - Northampton Solar

®

You can click a contract ID to go to the Vendor contract summary page.

VENDOR CONTRACT SUMMARY PAGE

The Vendor contract summary page shows contract information, including contract totals and contact
details. A grid shows all invoices that you have created for the contract. The total number of invoices
and their total value are shown at the bottom of the grid.
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¢« 7200010307 - Structural Steel

Contract totals Contract details

Original value $100,000.00 Contract ID 7200010307

Current value $4.125,531.00 Description Structural Steel
Type Subcontract
Subtype
Effective date 12/15/2022
Payment term Pay when Paid - 10 days from
Contract currency usbh
Delivery address
Inco terms Free on board
Inco terms location: Destination

Country of origin
Harmonized system / schedule

Invoices ®

Invoice number Invoice date Record status Invoice total Paid amount Date cashed

U 1111101 05/31/2023 Recalled $1.00 $0.00

J 07/07/2023 Pending $105.00 $0.00

L 07/07/2023 Pending S 500.00 $0.00

J 01/24/2023 Pending $32,000.00 $ 31,040.00

U 02/24/2023 Pending $ 56,000.00 $ 53,350.00

J 03/24/2023 Pending $ 838,000.00 $0.00

() 05/23/2023 Pending $1.00 $0.00
ltems : 7 $925,607.00 $ 84,390.00

After the contractor applies the invoice to a payment form and the payment form is submitted, the
value in the Paid amount column is updated with the amount paid.

You can use this page to add new invoices, edit existing invoices, and add notes to invoices.

ADD INVOICES

You can add an invoice directly from the Vendor contract summary page. After the invoice is
submitted, it is automatically sent to the contractor. The Add invoice interface lets you upload or link
to invoice documentation from your organization, so you do not have to send it by some other means.
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7.0 STEP BY STEP 1—-ADD AN INVOICE

Summary: Add an invoice directly into the contractor's InEight system.
Considerations: You must be set up as a vendor user by your contractor.
Quick steps:
1. From the Vendor contract summary page, click the Add icon at the top right of the grid. The Add

invoice dialog box opens.

¢ 7200010307 - Structural Steel

Contract totals Contract details

Original value $100,000.00 Contract ID 7200010307

Current value $4.125531.00 Description Structural Steel
Type Subcontract
Subtype:
Effective date 12/15/2022
Payment term Pay when Paid - 10 days from .
Contract currency UsD
Delivery address
Inco terms Free on board
Inco terms location: Destination

Country of orngin
Harmonized system / schedule

Invoices

Invoice number Invoice date Record status Invoice total Paid amount Date cashed
J 1111101 05/31/2023 Recalled $1.00 $0.00 :
O 07/07/2023 Pending $105.00 $0.00
O 07/07/2023 Pending $500.00 $0.00
(] 01/24/2023 Pending $32,000.00 $ 31,040.00
(] 02/24/2023 Pending $ 55,000.00 $ 53,350.00
O 03/24/2023 Pending $ 838,000.00 $0.00
O 05/23/2023 Pending $1.00 $0.00
ltems :7 $925,607.00 $84,390.00

2. Enter the invoice number, invoice date, invoice amount, and tax information.
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Add invoice

Contract

* Invoice number * Invoice date

I month/day/year ﬁ

* Invoice amount *US Tax
$§ 0.00 $ 0.00

$ 0.00 $ 0.00

$ 0.00 $ 000

CaHCFI m

3. Inthe File/Link field, enter a URL for an online invoice, or click the Select file button to add an
invoice file from your computer.

4. Enter comments regarding the invoice if needed.

5. Click the Submit button. The invoice is sent to the contractor added to the grid with a status of
Pending, and the item total and the Invoice total at the bottom of the grid are updated. You can
no longer edit the invoice unless it is recalled by the contractor first.

What's next: The contractor either receives or declines the invoice. When the Record status is
Received, the contractor has agreed to it and will enter it into their payment for system. When the
Record status is Declined, you can recall it and resubmit it to the contractor.

EDIT INVOICES

Sometimes the contractor identifies problems with the submitted invoice that must be corrected.
When the contractor identifies errors, they decline the invoice, and the Vendor invoice submission
page shows the Record status for the invoice as Declined.

7.0 STEP BY STEP 2 - RECALL AND EDIT AN INVOICE

Summary: Recall an invoice when you want to edit it and resubmit it to the contractor for payment.
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Considerations: You can edit invoices with the Record status Declined or Pending. You cannot edit an
invoice with the Record status Received.

Quick steps:

1. From the Vendor contract summary page grid, click the invoice number of the invoice you want
to correct. The Edit invoice dialog box opens.

2. Scroll to the bottom of the dialog box, and then click the Recall button. The fields become
editable, and the button name changes to Submit. The Record status in the Invoices grid changes
to Recalled. The invoice is also removed from the contractor's invoice list.

Edit invoice

mount

3. Update the information as needed, and then click the Submit button. The invoice is sent to the
contractor, and the Record status of the invoice changes to Pending.

ADD AND READ INVOICE NOTES

You can view or read notes on an invoice without opening the invoice. To view or add a comment to
the invoice, select an invoice and then click the Notes/feed icon. The Notes/feed slide-out panel
opens. You can then add notes. Any comments entered when adding the invoice are automatically
applied and are shown in the feed.
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Notes/Feed for : X

Invoice submitted - Status ‘Pending': 07/07/2023 1008 AM

THESE ARE COMMENTS

0/1000

After you add notes and then click Add, the note is added with a time stamp. The contractor can also
add notes to an invoice. These are shown with a blue bar on the left side of the note.

Notes/Feed for : i X

Invoice submitted - Status ‘Pending’: 07/07/2023 10.08 AM

THESE ARE COMMENTS:

Note to Contractor: 07/07/202310:09 AM

| HAVE SUBMITTED THE INVOICE WHERE DO | GET PAID

Note from Contractor: 07/07/202310.12 AM

NOTE TO THE VENDOR

Type note here

0/1000

7.0.3 PAYMENT FORMS

7.0.3.5 OVERVIEW

An InEight Contract payment form is the form used to communicate with the Accounts Payable team,

to ensure that invoices are paid. The payment form allows the Contract Manager to identify the work
period represented by the invoice and to which line items the invoice should be applied.
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As invoices are received at the jobsite, you can attach them to your payment form and allocate how
much of the invoice will go towards your contract line items. As the contract manager, you can then
submit the payment form for approval. Once the payment details are reviewed to validate the charges
are correct and approved according to the project’s workflow assignments, the payment form will
directly sync to your ERP (Accounts Payable) system for accounts payable to process. The ERP system
will then send back an APAY number for reference on your payment form, along with the status of the
invoice in the ERP system.

The following diagram illustrates the typical workflow for processing payments between InEight
Contract and your ERP system.

Payment Workflow — InEight Contract and ERP

InEight Contract .« Status Updates

Receive and scan

invoices at jobsite Create payment
i form
Upload invoices Fill out payment
into payment form with invoice LaEale} GRS L e
form information Yes — review and
approval -
Allocate payment Payment
to line items approved
? Post invoice
Submit for ?

approval

In a proxy ERP environment, the payment form is used to track line items for an invoice. Responses,
such as status, are autogenerated.

The payment form is initiated at the project level, routed to your Business Services team for approval,
and then submitted to Accounts Payable. A goods receipt or service confirmation must be completed
(if required) before the Accounts Payable team will approve the pay form.

7.0.3.6 ADD A PAYMENT FORM

The following steps walk you through how to add a new payment form to your contract.
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ADD A PAYMENT FORM

You can add a payment form when all invoices are received, and you want a standardized form to
submit for approval.

1. On the Contracts register, select a contract.

2. Select the Payment forms tab, and then click the Add payment form icon.

Contracts  » 7400001418 - PB - Structur...

Actions v £« CHARGES PAYMENT FORMS F
Payment form D Current ... Back ch... Net p

The Payment form details page opens.
3. Enter payment form information.

4. Click Save.

MeJg=0 If you leave the Payment form details page without saving, the details you added
are discarded.

The default payment form automatically downloads as the cover letter.

Overview - Payment Form Header

1 Net payable The total amount you are paying to the vendor towards the invoices on
this payment form.

2 Remainingto  The total amount of this payment form’s invoices that are not yet
allocate (pre-  allocated to contract line items. The value of this field must be zero +/-
tax) 0.009989 to start workflow, submit, publish, or execute the payment

form. The +/- 0.00999 accounts for differences in decimal precision.

3 Previous gross The total amount from the invoices of all payment forms submitted
before the one you are currently on.
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Overview - Payment Form Header (continued)

4 Current gross
5 To-date gross
6 Percentage
complete
7 Payment form
status
8 Tabs
9 Download
payment form
as PDF
10 Cancel, Save
and start
approval and
Save Buttons
Net payable
$26,000.00 $20,000.00

Remaining to allocate (pre-tax)

The sum of the invoices attached to the payment form you are on.

The total of all invoices on all this contract’s payment forms. This is the
sum of your Previous gross and To-date gross amounts.

The percentage that the To-date gross is of your total contract amount
(contract Current value).

Indicates if the payment form is new, in review, or submitted.

The payment form is organized into three tabs: Details, Invoice
Attachments, and Line Items.

Provides a PDF summary of the payment form, including line items,
invoices attached, back charges, and approvers. This summary
becomes the cover sheet for Accounts Payable when the form is
submitted.

These buttons allow you to cancel, save and begin approval or save
the payment form.

> Payment form 0_

Previous gross Current gross  To-date gross  Percentage complete Payment form status o

New -

$10,000.00 $20,000.00 $30,000.00 3.00%

DETAILS INVOICE ATTACHMENTS LINE ITEMS Q O)
o [ Cancel } [ Save and start approval

Overview - Payment Form - Details Tab

1

2
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Tabs

Toolbars

Tabs that let you add invoice attachments, line items and supporting
documents to payment forms.

Tools that let you do the following:
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Overview - Payment Form - Details Tab (continued)

2 Actions menu

3 Payment form
details

4 Summary

5 Back charges
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» Download a payment form.

» View contract totals.

» Add a supporting document.

» View and add notes. The Notes slide-out panel has tabs for
Contract notes, Supporting document notes, and Administrative
notes. Administrative notes are captured automatically when an
administrator makes changes to a payment form record or invoice
on the Payment progress tab.

Lets you generate a payment form document.

Where you can input or review the payment form’s basic information,
including: description, work completed dates, progress estimate
number and billing period, and comments.

Summarizes the total gross amount of the invoices attached to the
payment form, less retention and back charges, resulting in the Net
amount payable this request, which is the amount you will pay to the
vendor.

The Progress estimate number and Billing period fields in invoices that
are associated to a payment form are manually entered by the user in
the payment form. If the information is different from the values from the
ERP system, Contract updates the fields with what was sent from the
ERP system.

Allows you to apply back charges from your contract’s Back Charges
tab to the payment form, to short-pay the invoice according to the back
charge amounts.
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INVOICE SCHEDULE OF SUPPORTING
DETAR INE TEM
o DETALE, ATTACHMENTS VALUES IIE REME: DOCUMENTS e
Cancel Savean

WL
Payment form details @) s by o erchinen /2, summary @

5000

5000
Work compléted from “Wark eompleted theough

0672112022 06/23/2022

5000

Progress estimate number Progress estimate biling period

Back charges Q

Backeharge 1D Daserption  Costean ter WeScode  +GLaccount Amaunt

Total $000

® Add anotmer ackcharge

o) = When the Progress estimate number and Progress estimate billing period fields are
required for the payment form, you can still save the form. The fields are required for
submittal and workflow. When the status of the payment form is New, a yellow warning
icon shows next to the Progress estimate number and Progress estimate billing period
fields to remind you that the fields are required for approval and submission.

7.0.3.7 OVERVIEW - SCHEDULE OF VALUES TAB

The Schedule of values tab contains schedule of value items from the contract-level Schedule of values
page that you can use to build a payment form. Using a schedule of values to populate a payment form
gives you the flexibility to create a payment form based on the values claimed in a specific period. For
example, you could use the schedule of values to track the values used in a month. You can then push
the values to the Payment form Line Items tab, so you pay against the line items.

The payment form Schedule of values tab format is similar to the contract Schedule of values tab. It
contains the following sections:

| Secton | Desopton

This submission  The values used in this payment form.

Pending The values used in previous payment forms that are not in Submitted
submission status.

Previous The values used in previous submissions that have been submitted.
submissions

Current total The sum of values in the This submission and Previous submissions
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columns.

Remaining The Schedule quantity column in the Schedule of Values items section
minus the current total.

Net payable Remaining to allocate (pre-tax) Previous gross

dateg ge compl
$0.00 $0.00 $0.00 $0.00 $0.00 0.00% N

@

Schedule line flem 10 = Contract ne ftem 1D

ooo o

e 3 $25000.00 3320000 000 $1100000 s000 so00 so.

See 5.0.5 Schedule of values tab on page 211 for more information about the schedule of values.

ADD SCHEDULE ITEMS

Add a schedule item to the payment form schedule of values to use in creating a payment form.
You can add schedule items that have already been added to the contract-level schedule of values.

1. From the Payment form Schedule of values page, click the Add icon. The Add schedule item
dialog box opens with a list of schedule of value items from the Contract schedule of values,
including the value remaining and the percent complete.
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Add schedule item

Schedule item ID = Description = Valueremaining =  Percent complete

o s testing reducing less tha. $0.00 0.00%
O s Sov4 $0.00 0.00%

7 sov7 $0.00 0.00%

2. Select one or more items, and then click Add. The items are added to the schedule.

3. Update the Quantity or Value columns in the This submission section. When you update the
Quantity column, the value in the Value column is automatically adjusted, and vice versa.

You can push the schedule of value items to the Line items tab. From the Line items tab, you can also
pull the items from the schedule of values.

PUSH SCHEDULE ITEMS TO THE LINE ITEMS TAB

You must push the schedule items to the Line items tab, so they can be included in a payment form.

Considerations: The Push to line items button is enabled if any of the schedule items have a Contract
line item ID. When the Contract line item ID is blank for all items, the Push to line items button is
disabled, and you cannot push items to the line items.

1. From the Payment form Schedule of values page, click Push to line items. A warning message
indicates that the push updates the Line Items tab with values from the schedule items.

2. Click Yes to continue. All schedule items are pushed to the line items. Any value or line item that
was added to the Line Items tab is removed.

Contract pushes only the line items that are associated to the Contract schedule of values and
calculates the line item values. On the Line items page, the total values are shown in the Net price
column in the This submission section. If there are multiple schedule items tied to the line item,
Contract adds them together to populate the Net price column.
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7.0.3.8 PREVIOUS, CURRENT, AND TO-DATE GROSS
AMOUNTS

To follow along, select Contract > contracts > Payments forms tab and select a form which you just
completed.

The Previous gross, Current gross, and To-date gross amounts displayed in the payment form header
help you keep track of how much you have been invoiced.

Previous gross represents any invoices already submitted on previous payment forms. When you fill
out your first payment form for the contract, your Previous gross will be $0.00 since no previous
payment forms are submitted.

Previous gross Current gross  To-date gross  Percentage complete

$0.00 $10,000.00 $10,000.00 1.00%

Your Current Gross is the total amount of the invoices you’ve added to your current payment form.

Previous gross Current gross  To-date gross  Percentage complete

$0.00 $10,000.00] $10,000.00 1.00%

Once you've submitted the first payment form, when you add a second payment form to the contract,
the Current gross from your first payment form becomes the Previous gross amount.

Previous gross Current gross  To-date gross  Percentage complete

$10,000.00| $20,000.00 $30,000.00 3.00%

The Current gross ($20,000.00) is the total of the invoices attached to your current payment form, and
the To-date gross amount is the total of all invoices on all your payment forms to date.
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Previous gross Current gross  To-dafe gross  Percentage complete

$10,000.00 $20,000.00 |$30,000.00 |3.00%

7.0.3.9 INVOICE ATTACHMENTS

Invoice attachments associate an invoice you receive from a vendor to a payment form. You can add
standard invoices or release retention invoices and track them on the Invoice attachments tab. The
values you enter in the invoice attachment are used to populate the values in the header.

Retention release invoices help you manage retention release activities. Using a retention release
invoice lets you follow your regular process for submitting standard invoices and requesting retention
release, without leaving Contract.

Overview - Payment Form - Invoice Attachments Tab

1 Invoice details Shows the invoice information you enter when adding the invoice,
including invoice number, date, amount, tax, and invoice total, and
retention release requested.

2 Taxes The Total tax column shows a sum of all tax columns. The subsequent
tax columns are the active project-level tax types. You can hover over
the Information icon in the Total tax column to see a summary of all
taxes.

3 File/Link References the link to or file name of the invoice When you click the file
name to access it, the document opens a preview in a new tab, so you
can view the pages. The preview lets you view all pages of the
document by clicking the Previous and Next buttons. If you want to
download the document, click the Download file button in the preview.

4 Record ID and These fields update with the number and status of the payment form
Invoice status  once itis processed, so you don’t have to manually search for it. The
status updates every time you open the payment form.

5 Estimated For organizations that use a proxy ERP, this column lets you define your
posting date own posting date instead of using the submitted date. If you are relying
on the integration with InEight Control for actuals, using the estimated
posting date with your proxy ERP can prevent incorrect actuals in
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Overview - Payment Form - Invoice Attachments Tab (continued)

Control. When you use an ERP system, the ERP system provides the
posting date regardless of the value of this field. You must have
permission edit payment form to update the Estimated posting date
column. The actual posting date is on the Payment progress tab.

ADD A STANDARD INVOICE ATTACHMENT

Summary: Add a standard invoice attachment to a payment form when the payment is not for
retention release. The invoice provides the Invoice pre-tax remaining to allocate and Net payable
amounts required to submit a payment form.

Considerations: Taxes calculated on the gross and on the net show in the dialog box. Payments for
retention release must use a separate invoice attachment.

1. From the Invoice attachments page for a payment form, click the Add invoice icon, and then
select Add new invoice. The Add new invoice dialog box opens.

2. Enter the invoice information.

3. Click Add. Alternatively, you can click Add and new to add additional standard invoices. The Net
payable and Invoice pre-tax fields in the Payment forms header are updated with the amount of
the invoice.

What's next: You can submit the payment form.
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ADD A RETENTION RELEASE INVOICE ATTACHMENT

Summary: Add a retention release invoice attachment to a payment form so you can submit a payment
form specifically for retention release. The invoice provides information for the Retention release
remaining to allocate amount required to submit a payment form for retention release.

Considerations: Only taxes calculated on the net show in the dialog box. The retention amount cannot
be greater than the total of the retention withheld.

1. From the Invoice attachments page for a payment form, click the Add invoice icon, and then
select Add retention release invoice. The Add retention release invoice dialog box opens.

2. Enter the invoice information.

3. Click Add. Alternatively, you can click Add and new to add additional retention release invoices.
The Net payable and Retention release Remaining to allocate fields in the Payment forms header
are updated.

What's next: You can submit the payment form.

7.0.3.10 SCHEDULE OF VALUES TAB

The payment forms function has its own schedule of values page. You can add a schedule of values, so
you can see the quantity or value the payment form has against a component.

You can add or edit existing schedule items. Edits to schedule items show in the Schedule of values at
the contract level. When you add a value-only schedule item to a payment form, only the Value field is
editable.

IMPORT AND EXPORT SCHEDULE ITEMS

You can use the payment form schedule of values template to quickly add schedule items and then
import them to a vendor change order. Use the template to update the amount that will be submitted
for payment on this payment form. For more information about how to use the template, refer to the
Instructions tab of the Microsoft Excel template.

Net payable woicepre-tax  Retention releat se . Pprevious gross Current gross. To-date gross % Complete Payment form status. Approval status
emaining to allocate Remaining to allocate

Ri
$4,777.06 $4,777.06 $0.00 5$0.00 $4777.06 $4,777.06 28317% Pending CO v Not started

£ SCHEDULE OF ™ < SUPPORTING
IMENTS VALUES : DOCUMENTS

«

[ Schedule = Comract = Description -
line item 1D line ite

Sche. < | This submission < | Pending submission

Sciy =| Ouantity = Value = Retention = | Quantity = Value = Retention

For information about importing, see Imports and exports.
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7.0.3.11 LINE ITEMS TAB

The Line items tab for a payment form shows the line items that are paid with the payment form. With
any invoice, it is important to pay on the correct line items of your contract that you are being invoiced
for. If for some reason you or your team receive an invoice that has line items on it that are not on the
contract, you must verify that these charges are in fact correct. You will then need to determine if your
company's policy on change orders should be followed.

OVERVIEW - PAYMENT FORM - LINE ITEMS TAB

Overview - Payment Form - Line Items Tab

Details Provides detailed information for the line items added to the payment form.
This The total net amount and quantity allocated for this payment form. When you
submission enter the Net amount, the Quantity, Tax, and Retention are automatically

calculated. The tax column calculates a proportional estimate of the line item
taxes based on the taxes received in the purchase order response or
manually uploaded via a Logic Apps file, and whether the tax type should
calculate on net price or gross amount. These taxes are shown as a total and
hovering over the information icon shows the individual taxes. When the
payment form is for retention release, you can enter the value in the
Retention release column. See Payment form submittal for information about
submitting payment forms.

Pending The total amount and quantity allocated to this line for pending payment
submissions forms.

Previous The total net amount and quantity allocated to this line item from previously
submissions submitted payment forms.

Current total Calculates the total quantity and net amount allocated to the line item from all
payment forms (previous and current) on the contract, along with the
percentage of the total line item amount that has been allocated.

Remaining Calculates the total quantity, amount, and retention release remaining for this
line in the payment form.

Pull from Lets you pull items from the Payment form Schedule of values tab into the line
schedule items items. The values on the Line items page are overwritten. A warning message
indicates that values in the line items will be overwritten. When you click Yes,

Page 328 of 377 InEight Inc. | Release 25.3



Contract User Guide

Overview - Payment Form - Line ltems Tab (continued)

the values from the Schedule of values page overwrite the values on the Line
items page. If there are no values on the Schedule of values page, Contract
sets the quantity and net price to 0.00. Any value or line item that is not
associated to schedule items is removed.

u]
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1

ooooo
g

Mema:§ Seleted 0 View ssected Clas ssection sson66000 6400 S000 $000 S0 5000 $64000 s000 ss0102000 s000

You can use the arrows in the column headers to collapse or expand the section. Multiple sections can
be collapsed. The first section, which includes the line item ID, description, and WBS, cannot be
collapsed. You can click the double arrow in the first section to collapse the rest of the sections.

You can rearrange the columns within a section using the Column Selector Builder. To open the
Column Selector Builder, click the Manage columns icon. The Available columns section shows all
columns that are available for each section. To add a selection or column, select it, and then move it to
the Selected Columns section. To remove a section or column, select it, and then move it to the
Available columns section. Click Save to apply the changes. You can also rearrange sections from the
Column Selector Builder dialog box. To move a section, select it, and then use the arrows to move the
section up or down. You cannot add columns to the first section in the grid. You cannot move columns
between sections.
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Column Selector Builder

Available columns
Search
[] | section/column name
[ Dpetails
Uom
Unit Price
Per

[7] | Net Price

[ vom

[ unit Price

O per

[J netprice

[Z] | Tax Amount
[] | Gross Amount

[Z] | Retention (%)

[  uantity

[J | Tax Amount
[Z] This Submission

PULL ITEMS FROM SCHEDULE OF VALUES

You can pull items from the Payment form Schedule of values tab into the line items. When you click
the Pull from schedule items button, the values on the Line items page are overwritten.

A warning message indicates that values in the line items will be overwritten. If there are no values on
the Schedule of values page, Contract sets the quantity and net price to 0.00. Any value or line item
that is not associated to schedule items is removed.

PULL ITEMS FROM SCHEDULE OF VALUES

You can pull in schedule of value items to the line items page to update line item values.

The values from the Schedule of values page overwrite the values on the Line items page. If there are
no values on the Schedule of values page, Contract sets the quantity and net price to 0.00. Any value or
line item that is not associated to a schedule item is removed. The Pull from schedule items button is
enabled if any of the schedule items have a Contract line item ID. When the line item ID is blank on all
schedule of value items, the Pull from schedule items button is disabled, and you cannot pull items
from the schedule of values.

1. From the payment form Line items page, click Pull from schedule items. A message warning that
the values in the line items will be overwritten is shown.

Page 330 of 377 InEight Inc. | Release 25.3



Contract User Guide

LINE1TEMS

2. Click Yes. The values from the Schedule of values page overwrite the values on the Line items
page.

IMPORT AND EXPORT LINE ITEMS

You can use the payment form Line items template to quickly add line items and then import them to a
payment form. Use the template to update the amount that will be submitted for payment on this
payment form. For more information about how to use the template, refer to the Instructions tab of
the Microsoft Excel template.

Net payable Invoice pre-tax Retention release Previous gross Gurrent gross To-date gross % Complete Paymentformstatus  Approval status
Remaining to allocate Remaining to allocate

e
$0.000 $0.000 $0.000 $0.000 $0.000 $0.000 0.00% New v Not started

= cearatfites [ L % B Q

< | This submission <

SCHEDULE OF LINE ITEMS SUPPORTING

Actions ¥
o VALUES DOCUMENTS

®

e NN\

Current total <

o

[] Lineitemm = Description = WBS Quantity = MNetp

U
2

= Taxamount = Gross = Retention =| Quantity = Metprice = Tax = Retention = Retention = Netpayable =
amount (%) release

For information about importing, see Imports and exports.

7.0.3.12 PAYMENT FORMS REGISTER

When you are on a payment form record, you can go back to the payment forms register page, by
clicking on the Contract title in the breadcrumbs.

Contracts  >| 7400001470 - PB - Structural Stee Payment form 0001

hlat maarnalbla Damanimime o allanatra faea +ad

On the Payment forms register, you can check the status of all the payment forms on the contract. The
Unassigned invoices field in the toolbar shows the total amount of invoices from the Invoices register
that have been assigned to the contract but have not yet been added to a payment form in the
contract. The totals bar shows the sums of the Current gross, Retention, Net earned, Back charge
amount, Tax, and Net Payable columns. The active project tax types show in columns on the Payment
form register.
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usD §

HEADER LINE TEMS VENDOR CHANGE BACK CHARGES PAYMENT FORMS PAYMENT PROGRESS SUPPORTING HORKFLOW SYNCLOG CONTRACT CLOSEOUT

ORDERLOG DOCUMENTS
Unassigned invoices  $000 = Clearallfiters 3" . 2 Q

Work comp. Work com. Created by Created on

000 g : g

Payment form ID. Description Current gro.. Retention Net eamed Back charg.. Tax Net payable Payment form status
0

$0.00 $000 $000 $000 $000 $000 New 09/05/2019 09/27/2019 Ellie Barko 09/05/2019

0001 Invoice 1complete $7,500.00 $0.00 $7,500.00 $000 5000 $7,50000 Submitted Not applicable 03/31/2019 03/31/2019 Michael Maslen  04/08/2019

[fotats $7500.00 $000 $7500.00 5000 5000 s7s0000 |

To make scrolling through a large number of payment forms easier, you can click the Export icon to
export the information on the Payment Form register to a Microsoft Excel spreadsheet.

From the Contract Line Items tab, you can change the Viewset to Payment forms and the Payment
forms data block appears, so you can see how much of each line item has been submitted for payment.

Aetions = HEADER LINEITENS

EDIT PAYMENT FORMS FROM THE PAYMENT FORMS
REGISTER

Users with the Edit payment progress permission can edit payment forms from the Payment forms
register.

EDIT PAYMENT FORMS FROM THE REGISTER

Edit one or more payment forms when you must make changes to the payment to keep Contract in
sync with an ERP system.

You can make changes to the Payment form status, Record ID, Record status, and Notes fields only.
Changes made on the Payment forms tab affect the Payment forms tab only. They do not affect the
Payment progress tab. When you edit the Payment form tab, no APIs are triggered, so duplicate items
are not created and submitted to the ERP system.
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1. Select up to 10 forms, and then click the Edit icon. The Edit payment form slide-put panel opens.

Actions, . <ADER LINE ITEMS 'SCHEDULE OF VALUES SCHEBULES:{VALUES . VEZ‘;?;:}:;:GE BACK CHARGES PAYMENT PROGRESS Snlé
® ®
O | Paymemtfomid = Description =  Cument. = Retenti. = Netean. = Backc. = USTax Tax = Netpay. = Paymentfomst. = Approval status =
0003 0003 - Inv 20120 $14,322.00 $0.00 $14322.00 $0.00 $0.00 $0.00 $14.322.00 Submitted Approved =
u] 0002 0002 - Inv 20059 $27810.35 $0.00 $2781035 $0.00 $000 $0.00 $27,810.35 Submitted Approved
(u] 0001 0001 - Inv 19981 $413828. $0.00 $413828. $0.00 $0.00 $0.00 $413828. Submitted Approved

2. Make changes to the Payment form status, Record ID, Record status, and Notes fields for each
payment form.

Edit payment form
il not The Staws n the P
\de n the Payment form

0018 - New Payment form status  New x
Invoices

nvoice num ber Record D Record status

No records found.

Notes 500
0017 - 0017 - 24822 Payment form status ~ Submitted
Invoices

nveice numi ber RecouID Record status

a2 000696508 Retention Cleared
Notes 500

Cancel

3. Click Save.

The changes are recorded on the Administrative notes tab of the Notes slide-out panel.

7.0.3.13 GENERATE A PAYMENT FORM DOCUMENT

You can generate a payment form document from selected templates. The templates are specific to
payment forms and are configured in the project settings.

GENERATE A PAYMENT FORM

Generate a payment form when you want a document that has more information than what is
supplied in the payment form download. Payment form documents are saved in the Payment forms
Supporting documents tab.
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You must have templates with the template type Payment Form. If no templates of this type are
available, you can click the Settings icon in the payment forms wizard to go to the Contract templates

page of the project settings to add templates.

1.

From any page in a payment form, expand the Actions menu, and then select Generate Payment
form. The Payment forms wizard opens.

Select the Payment form templates you want to use from the Available templates column and
move them to the Selected templates column.

Select payment form templates & Contract template details

Use the up and down arrows to the right of the Selected templates column to change the order
of the templates, if needed.

In the Contract template details section, choose one of the following in the Generate document
as field:

¢ Individual documents to get a separate PDF or template file type document for each
template you selected.

e Merged document (PDF only) to merge the templates into a single PDF document.

Use the toggle to indicate whether to save the contract document in the Supporting documents
tab for the payment form. If you choose to save in the Supporting documents tab, add the name
of the document.

Select the watermark text. If the organization-level settings require a watermark and the end
watermark event has not occurred, the Select watermark stamp field is required. If the end
watermark event has occurred, the watermark is optional.
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6. Click Next. The Review templates page shows the templates in the order you selected them.

7. Choose the template you want to review from the Review templates list. The template tags show
as fields in the display area. The message, "No general tags found in this template" in the display
area can indicate that the table consists of only collection tags. If the Allow users to edit the
document during creation toggle in the template details is set to No, the fields on the Review
page are disabled.

The Review templates dialog box lets you edit or add information to the fields that populate the
document after it is generated. Any field that is blank is not added to the document, and you
cannot add information later.

8. Make changes and additions to the payment form information. Use the Review templates list to
select the next template, and then make changes. Changing data in Review contract fields
updates the data published in the contract document but does not update the data field in
Contract.

9. After you have reviewed all changes, you can click Preview document to see a preview of your
document. The preview opens in a separate window with the tags filled in. If you used collection
tables in any of your templates, you can view them in the preview document. The content of the
preview varies as follows:

e If you selected Download as a PDF document when you generated the document, the
preview contains all the templates in the order you specified.

¢ If you selected Download as individual documents when you generated the document, the
preview contains only the template that showed when you clicked Preview document. You
can preview other documents by selecting the file from the Review templates list, and
then clicking preview document.

10. Click Finish. If you created a merged document, Contract writer downloads a PDF that includes
all the templates. If you created individual documents, Contract writer downloads a PDF or
original file type for the selected template only.

If you chose to save the document to the Supporting documents tab, the document is saved to the
Payment forms Supporting documents tab with type Payment request. It is not saved to the project-
and contract-level Supporting documents tabs.

7.0.3.14 PAYMENT FORM DOWNLOAD

From the Payment form record, you can download a PDF summary of your payment form, which
includes the following information:

e Summary information
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e Contract number, current value and work completed dates
o Gross amount this request

* Net amount this request

» Net payable this request

e Lineitems

» Back charges

* Invoice attachment

« List of supporting documents

» Approvers

Downloading a PDF version of your payment form allows you to see how the payment form will look
for Accounts Payable and gives you an opportunity to verify the Gross amount this request amount
matches the Invoice amount (pretax).

Page 336 of 377 InEight Inc. | Release 25.3



Contract User Guide

7.0.3.15 PAYMENT FORM SUBMITTAL

The process for submitting your payment form depends on whether you have an approval workflow
set up on your project or contract level Workflow Assignments tab. See Workflow Assignments for
more information on how to set up an approval workflow.)

When you are ready to submit a payment form, you must update the columns in the This submission
section of the line items tab for the payment form.

¢ If you are submitting a payment form with a standard invoice, update the value in the Quantity
or Net price column for the line item.

¢ If you are submitting a payment form with a retention release invoice, update the value in the
Retention release column for the line item.

VIDEO | Retention Release via Payment Form

SUBMITTAL WITHOUT WORKFLOW ASSIGNMENTS

If your company has not enabled workflow assignments, the submittal process is managed from the
Payment form status drop-down list on your payment form record. From the drop-down list, you can
keep track of the payment form’s status by selecting either New, In Review, Submitted, or Dropped.

Percentage complete Payment form status

Hew -

3.00%

New

In review >

Submitted

Selecting Submitted will send the payment form automatically to your ERP (Accounts Payable) system
for processing. Once submitted, you cannot recall the payment form, and you can no longer make
changes the form.

SUBMITTAL WITH WORKFLOW ASSIGNMENTS

Note that even before starting the approval process, you still have access to the Payment form status
drop-down list, but it is limited to only the New, In Review, and Dropped options.
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ymplete Payment form status App
New -
New
In review 1
Can . start approva

This allows you to track the progress of the payment form prior to sending it off for approval.

With workflow assignments enabled for your payment forms, once your payment form’s invoice
amount is allocated to your contract line items, submittal of your payment form begins by clicking the
Save and start approval button, located next to the Save button on the top right of the page.

MEW -

Cancel | | Save and start approval |

After you click on the Save and start approval, the following occurs:

» Email notification is sent to the first approver in the workflow assignments specified for
your project or contract. The default payment form downloads as the cover letter. If no
payment form is marked as a default, Contract uses the standard payment letter provided
with the product.

Page 338 of 377 InEight Inc. | Release 25.3



Contract User Guide

[QA19.9] Payment form 0002 - Payment form 2 for Project 103442 & Contract 7200000789 requires your app...

B

Thu 9/5

Please review payment form 0002 - Payment form 2 for 7200000789 - Construction Contract SW with 0000001171-California Corridor Constructors, for project 103442-
an Nuys MNorth Platform in the amount of 50.00 for work completed from 09/05/2019 through 08/27/2019.

Payment form comments:
‘You can approve or reject using the buttons in this email.
To view this payment Trm, click here.

Click on the attachment name below to download.
PaymentRequestCoverletter 05 09 19 11 45 53.pdf

This is @ QA19.9 system generated email. Do not reply.

Action
Approve - Click here
Reject - Click here

» The approver can view the payment form by clicking the appropriate link within the email

» When you start the approval process and you are the first approver in the approval
workflow, the first step of the workflow is automatically approved, and continues with the

next step, if applicable. If you are the only step in the approval, you receive a second email
confirming the new issue has been approved.

» Any invoices that were attached to the payment form are added to the attachment

» Once reviewed, the approver can approve or reject the payment form by clicking on the
appropriate link within the email

» Once approved, the next approver receives email notification to view and approve or reject
the payment form

» When the final approver approves the payment form, it is sent automatically to the ERP
system (Accounts Payable) for processing.

Me) = Once submitted, you cannot recall the payment form, and you can no longer make
changes to the form.

At any time during the approval process, you can:

» Recall the payment form. You do this by clicking on the Save and recall approval button on
the payment form record
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1cel | | Save and recall approval |

» Check which workflow step the payment form is on by hovering over the three blue dots
Approval status

Payment form status Approval status

New h In approval - Fmal

new In approval -Final step

S o

Auto submission fails when the retention on a line item across payment forms is more than the total
retention withheld.

OVERPAYMENT TOLERANCE

When you attempt to overpay a line item, Contract shows notifications and acts according to settings
for the contract type set at the organization level.

The contract type configuration setup (organization > Settings > Contract > Configurations > Contract
type configuration setup) has an Allow overpayment of line items toggle for each contract type. When
the toggle is set to No, overpayment of line items is not allowed. When the toggle is set to Yes,
overpayment is allowed with either unlimited overpayment or with a maximum percentage of
overpayment tolerance.

When the toggle is set to No and you try to submit a payment form, either through workflow or
manually, that exceeds the amount of the line item, a red warning message shows, and the form is not
submitted.

When the Allow overpayment online items toggle is set to Yes, and you have entered a percentage
instead of checking the Unlimited check box, Contract validates that the total of all submitted payment
forms does not exceed the overpayment percentage before submitting the form. A red warning icon is
shown on the Line items tab of the payment form. If the project is set up for auto submission, the
payment form is not submitted.
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When multiple payment forms are submitted on a line item, and one of the payment forms changes
the overpayment calculation to exceed the overpayment tolerance, auto submission of the form fails,
even if it had been approved. For example, if the overpayment maximum percentage is set to 25% and
the line item is $1000, the overpayment tolerance is $250 for a total of $1250. If you send a payment
form through workflow for $750, it is under the $1000 and, if approved, can be submitted. However, if
another payment form for $750 had already been sent through workflow, and your payment form is
approved, it is not submitted because the total paid is $1500 and exceeds the overpayment tolerance.

Contract sends an email to let you know the submission failed due to the overpayment tolerance.

7.0.3.16 SUPPORTING DOCUMENTS TAB

The Supporting documents tab contains all the documentation for a payment form in a single location
so you can view documents in one place. You can add a new supporting document, a document from
the Supporting documents list, or a document from InEight Document.

Documents added directly in the Payment for Supporting documents tab do not show in the main
Supporting Documents register by default. If you want them to show in the main register, you can add
them there and then associate them to a payment form by adding a document from the supporting
document list.

See 5.0.6 Supporting Documents on page 229 for more information about how to add and approve
supporting documents.

VIEW A SUPPORTING DOCUMENT

To view a supporting document, click the link in the File/Link column of the Supporting documents
register. The document opens a preview in a new tab, so you can view the pages of the document and
then decide if you want to download it to your workstation. You can use the Previous and Next
buttons to view all pages.
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HistoricalWeatherRecord_2023-April-05-
Previous | PageNo:1 /1 Next

Historical Weather Record

Omaha, Nebraska, 68114, United States Of America, Lat. 41.2656 , Lon. -96.0493

(UTC-06.00) Central Time (US & Canada)

Selected Range:  Date: Time: Date: Time:

From 04/05/2023 12:30 AM To: 04/05/2023 11:30 PM

Date Time Temperature Weather condition Wind Precipitation
clear sky
clear sky
clear sky

clear sky

clear sky

06:30AM  7°C 44°F

AM  5°C 41°F

AM  4°C 39
AM 3 overcast clouds

AM  3°C3T°F overcast clouds

broken clouds

overcast clouds 8.75 m/s, 20.00 mph

041052023 1°C 34°F broken clouds 9.77 m/s, 22.00 mph

i
‘ontract Main v23.4.20230410.01

To download the document to your workstation, click Download file.

SEND PAYMENT FORM DOCUMENTS FOR ESIGNATURE VIA
DOCUSIGN

When a project is integrated with DocuSign, you can send a payment form document DocuSign for an
eSignature.

DocuSign tags can be embedded in a payment form supporting document. The DocuSign tags
correspond to DocuSign recipients configured in the project setting sand project contacts.

See 5.0.8 Contract Writer on page 240 for information about sending documents for eSignature via
DocuSign. See 2.0.1 Organization settings on page 19 for information about using tags.

CREATE FORMS OR MAIL IN INEIGHT DOCUMENT

If a project is associated with Document, you can create a form or mail item from a payment form.
Document saves the form or mail and creates a link in the Supporting documents tab.

Single-sign on is available for Contract to Document features, such as creating mail or a form. When
you use one of these features, the Document sign-on page opens, and you can enter your credentials.
This creates a sign-on token that lets you remain signed in until the session ends. The first time you
sign in to Document, a black secondary window and the Document Home window also open. You can
close these windows. Single sign-on is activated, and they are not shown again.
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J[elg 2 Creating forms or mail is initiated from the Actions menu. If Actions > Create document >
Form or Mail is inactive, you can select the Settings (cogwheel) icon in the Actions menu
to set up integration with Document.

CREATE A FORM IN DOCUMENT

You can create a Client RFl or Request For Information form in Document and add it to the Supporting
documents for the payment form in a single procedure.

1. From the Details page go to Actions > Create document, and then select Form.

2. If you are not already signed into Document, use your credentials to sign into InEight Document.

)

User ID

DOCUMENT

"=~ TeamBinder

Company ID
Password
+ Remember Login User ID & Company ID

Multiple Accounts? Login via Profile

English | Frangais | Italiano | Espaiol | (&6 | Farsi

Contact Support +1(800) 801 1426

Bookmark This Page | Forgot your password?

A sign-in token is created that lets you remain signed in to Document until the session ends. If
this is the first time you are signing in to Document from Contract, a black secondary window
and the Document Home window are shown. After you close these windows, single sign-on
(SSO) to Document is activated, and they are not shown again.

3. The Create new form dialog box opens. Select the form type, and then click Next. The Request
for information window opens in Document.

4. Complete the form, and then select the users for distribution of your form. A success message is
shown and a link to the form is added to the Add supporting documents dialog box.

5. Click Add to add the form as a supporting document.
CREATE MAIL IN DOCUMENT

You can create a mail item in Document and add it to the Supporting documents for the payment form
in a single procedure.
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1. From the Details page go to Actions > Create document > Mail.
2.

If you are not already signed into Document, use your credentials to sign into InEight Document.

@ DOCUMENT
"=~ TeamBinder

User ID

Company ID
Password
+ Remember Login User ID & Company ID

Multiple Accounts? Login via Profile

English | Frangais | Italiano | Espaiol | (&6 | Farsi

Contact Support +1(800) 801 1426

Bookmark This Page | Forgot your pasoword?

3. The Create Document Mail dialog box opens. Select the mail type from the list defined in
Document that are specific to the project's mail type, and then click Next.

X

Create Document Mail

o Select Mail type

Select the Mail type to be created. Upon clicking the "Create’ button, you will be taken to InEight Document to create the mail
*Mail type

Change Order

Change Order Response
Formal Letter
General Correspondence
IDF Response

Issue Documentation Form

4. Optionally add an attachment. If you selected documents on the Supporting documents page
before you started the action, they are automatically included.

¢ To add an attachment from the Supporting documents tab, click Next. The Select
documents dialog box opens. You can choose documents from the Supporting documents
tab with the Document source My computer. After you attach the documents, click Create.
The Mail module opens in Document with your attachments included.

¢ To add an attachment in Document, click Create. The Mail module opens in Document.
Click Attach files > Attach Documents, where you can search for the document. After you

Page 344 of 377 InEight Inc. | Release 25.3



Contract User Guide

select a document, click Save.
¢ To send mail without an attachment, click Create. The Mail module in Document opens.

5. Enter information in the To and Subject fields. The other fields on the page are optional. Enter or
update the fields as needed for the mail message, and then click Send. A summary page opens.

6. Edit links and notes, if needed. The mail is added in Document.

7. Close the Document window. You are then prompted to add the mail as a supporting document
in Contract. The document type defaults to Correspondence but can be changed.

8. Click Save to save the mail to the Supporting documents page.

7.0.4 PAYMENT CLAIMS

The Payment claims module lets you manage payment claims from Contract. The payment claims
function can be used when you are required to certify a vendor's claim of work in advance of receiving
an invoice or before the payment form is created. The payment claims functionality also can be used
when you want to create payment forms based on the schedule of values for the project instead of line
items. After a schedule item is associated to a payment claim, and you certify the claim, you can
convert the schedule item to a payment form.

The contract must have a schedule of values to use payment claims. You can add an existing or new
schedule items to the payment claim.

7.0.4.17 PAYMENT CLAIM DATES

The payment claims function uses a series of dates scheduled based on your monthly payment claim
due date. Each date represents a requirement that you or your vendor must meet to ensure that the
vendor invoices match the work completed. You can configure up to 10 dates.

The Payment claims details and the Payment claims register show scheduled payment claim dates and
actual claim dates. You enter the date that scheduled event was completed. The Created date,
Submission date, and Certification date are always required. The Created date is generated by the
system when you create the payment claim. The Certification date is generated when you set the
Payment claim status to Certified. You must enter the actual date for any remaining dates.

For information about configuring scheduled dates, see Payment claims configuration at the

organization level and Payment claims configuration at the project level.
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7.0.4.18 INVOICES

You can add new or existing invoices to the payment claim. All invoices must be added before the
claim is certified.

7.0.4.19 SUPPORTING DOCUMENTS

You can add supporting documents to the payment claim. All supporting documents must be added
before the claim is certified.

7.0.4.20 PAYMENT CLAIMS REGISTER

The Payment claims register lets you see a summary of all payment claims in a project or contract.
Contract has Payment claims tabs at both the project and contract levels.

The column chooser shows only the dates set to Active in the settings.

opoooooo 0o

You can add a payment claim from the Payment claims register at both the project and contract levels.

ADD A PAYMENT CLAIM

Summary: Add a payment claim when you want to track communication dates with a vendor, to show
agreement on the work done and the amount to be invoiced.

Considerations: You must have a schedule of values and payment claims configured for the project.
Quick steps:

1. From the Payment claims register, click the Add payment claim icon. The Add payment claim
dialog box opens.

2. Enter the payment claim information, including the description and work completed from and
work completed to dates. If you added the claim at the project level, you must assign a contract.
If you added a claim at the contract level, the claim is automatically assigned to that contract.
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Add payment claim
*Contract
v
*Description
*Claim ID Alternate payment claim 1D
*Work completed from *Work completed to
month/day/year ﬁ month/day/year a

Date of request/claim

10/19/2023 &

| Cancel

3. Click Add to add one claim. Click Add and new if you want to add additional claims. The claim is
added to the Payment claims register.

What's next: You can add comments and the scheduled dates on the Details tab. You can also add
schedule of values items, invoices, and supporting documents on their respective tabs.

IMPORT PAYMENT CLAIMS

A convenient way to add payment claims is to import them using a payment claims import template.
Contract provides an import template that you can use to enter payment claims in bulk. To import
payment claims, click the Import data from template icon on the project level Payment claims register.

coumicrs | MASTE  VDDORCHAGE  SUPORTNG s ivokes e §
= cewotiies [ L ¥} ® a
o = status = from = Work eted ?‘ Description = Paymentclaimvalue = Certified by = Centifiedon o received = im . Schedule= P: 1 [ Actual dat
e v—— — - s00000 — v——
New 10/19/2023 10M7/2023 Claim 1019 §0.00000 10/19/2023 10/19/2023
o v— wonwam - S000M0 | manypecier | 20001 | winaraza v—
ew - — o s0.00000 vr—
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For more information about importing, see Imports and exports.

After importing, you receive an email listing status, the total payment claims, the total imported, and
number of errors. If the status is pending, click the Review data link to see the payment claims that
have completed and those with errors. You can correct the lines with errors from the Import history
grid, select them, and then click Import to continue with the import process. The import is
reprocessed, and Contract sends you an email when the import is completed.

7.0.4.21 PAYMENT CLAIM DETAILS

The payment claim Details tab lets you view a summary of values, add and manage payment claim
dates, and add comments, and update the status.

$ 0.00000 $0.00000 $0.00000 o ™ v | Notapplicabie

SUPPORTING

EEEEEEEEEEEEEEEEEEEEEEEEEEEEEE

Summary

Requested Sertified

Schedule items §0.00000 $0.00000

$0.00000

*Payment claim 1D Altemate payment claim ID Total $0,00000 $0.00000

epaymem Claim Dates (@ Add payment claim date

10/05/2023 =5 10/19/2023 & Dates Schedule date Actual dates

10/20/2023 10110/2023 @

3

10722023 @

I ™ S

1 Header The value of the payment claim. Values are read from the schedule of
values values for the claim.
2 Payment The current status of the payment claim. When you are ready to certify

claim status  the claim, you can set this value to Certified. The Certified by fields
shows the person who certified the claim. The Certified on field shows
the date the claim was certified.

3 Payment The scheduled dates configured in the settings for claims in this project.
claimdates  The grid shows all dates that are set to Active and Default in the settings.
If the Allow users to edit dates in a payment claim toggle in the Payment
claim configuration at the project level (project > Settings > Contract >
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T T

Configurations > Payment claim configuration) is set to Yes, you can add
dates or remove dates except for the submission and the certification
dates.

4 Comments A text box for comments. You can continue to add comments after the
claim is certified.

MANAGE CLAIM DATES

The dates shown in the Payment Claim Dates section of the Details page were configured in the
organization and project settings. You can add or remove dates to align with your business needs. You
can also enter the actual dates for dates other than the Created date, Certified date, and Submission
date, which are system generated.

ADD A PAYMENT DATE

Summary: Add a payment date when you need additional dates for your business needs.

Considerations: Only dates that are set to Active in the settings are available. The toggle for Allow
users to edit dates in a payment claim in the Payment claim configuration at the project level (project >
Settings > Contract > Configurations > Payment claim configuration) must be set to Yes.

Quick steps:

1. Click Add payment claim in the Payment Claim Dates section of the Details page. The Add
payment claim dialog box opens.
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Add payment claim date

Available payment claim dates.
Scheduled date

testing 1
testing 2

Date name 3

Selected payment claim dates

2. Click the Add icon next to the dates you want to add. The dates show in the Selected payment
claim dates box.

3. Click Add. The dates are added to the Payment Claim Dates grid.
4. Click Save.

What's next: When the requirements for a date has been met, you can add the actual date to the grid.

UPDATE A PAYMENT DATE

Summary: Update the payment date when the communication for the date has been completed.
Considerations: The Created date, Submission date, and Certification date are generated automatically.

Quick steps:
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1. Click the Actual date field for the scheduled date.

Paym ent C|a|m Dates @ Add payment claim date

Dates Schedule date Actual dates

*Created date 10/20/2023
*Submission date 10/10/2023 @
*Certification date 10/27/2023 @

@) *Payment date 10/30/2023 month/day/yearfill[§5

@ payment claim 1 11/14/2023

2. Use the calendar toggle or manually enter the actual date.

3. Click Save.

REMOVE A PAYMENT DATE

Summary: Remove a payment date when it is not needed for the payment claim.

Considerations: You cannot remove the Created date, Submission date, or the Certification Date. The
toggle in the Payment claim configuration at the project level for Allow users to edit dates in a
payment claim(project > Settings > Contract > Configurations > Payment claim configuration) must be
set to Yes.

Quick steps:
1. In the Payment Claim Dates section, click the Delete icon next to the payment.

2. Click Save. The payment date is removed from the list.
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7.0.4.22 SCHEDULE OF VALUES

The Payment claims function has its own schedule of values page. You can add a schedule item to the
payment claim, so the payment claim is associated to work on the project. After the payment claim is
certified, you can convert the schedule item to a payment form instead of having to create the
payment form from a line item. You can also convert a certified payment claim to a contract claim
without leaving the Schedule of values page.

SCHEDULE OF VALUES REGISTER

The schedule of values register for payment claims includes the following sections:

| secton | Desorpton

Schedule Shows schedule item details from the contract's schedule of values.
items

Summary Lets you track the contract and component progress claims on existing
progress schedule of values items. The Quantity claimed is the contract quantity

claimed plus the component progress quantity claimed. The Value claimed is
the contract value claimed plus the component progress value claimed. When
you add a schedule of values from the Payment claims Schedule of values
page, these fields are zero.

Previous Shows the quantity and value of the schedule item that have already been
certification  certified.

Vendor Lets you enter quantities, values, and percent complete information that were
submission submitted by the vendor outside of InEight. You can also import Vendor
submission values.

Certification  Lets you update the quantity, value, and percent complete that are to be
certified. To save time and reduce entry errors, you can click the Copy Vendor
Submission button to copy the information from the Vendor Submission
section into the Certification section. If the Schedule item ID is New, you
cannot certify if the quantity is greater than 0.

Currenttotal  The current quantity and value of the schedule item.

Remaining The quantity and value left to claim in the schedule item.

Page 352 of 377 InEight Inc. | Release 25.3



Contract User Guide

ADD AN EXISTING SCHEDULE ITEM

Summary: Add an existing schedule of values item when you want to associate a known schedule item
to a payment claim.

Quick steps:

1. From the payment claims Schedule of values register, click the Add icon, and then select Add
existing schedule of value. The Add schedule item dialog box opens.

2. Select one or more schedule items.

3. Click Add. The are added to the Schedule of values register.
ADD A NEW SCHEDULE ITEM

Summary: Add a new schedule of values item when an existing item does not exist.

Considerations: New items are added with a schedule item ID of New. You cannot certify a claim if the
schedule item ID is New and the quantity in the Certification section is not 0. New shedule of value
items cannot be added to payment forms.

Quick steps:

1. From the Schedule of values register, click the Add icon, and then select Add new schedule of
value. The Add schedule item dialog box opens.

2. Select a contract line item ID, and then enter the schedule item information. A description and
unit of measure are required.

3. Click Add. The item is added to the Schedule of values register with a schedule item ID of New.

What's next: To assign a schedule item ID, you must associate the schedule item to a vendor change
order and then execute the vendor change order. After the vendor change order is executed, the
schedule item gets an ID, and you can then add it to a payment form or certify the claim.
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CONVERT A SCHEDULE ITEM TO A VENDOR CHANGE ORDER

Summary: Convert a schedule of values to a vendor change order when you and the vendor agree that
the schedule item represents a new scope of work.

Considerations: If you convert to an existing vendor change order, the selected schedule items
overwrite any existing schedule of value items on the vendor change order.

Quick steps:

1. From the Schedule of values register, select a schedule item, and then click the Convert schedule
of value icon.

Requested value Certified value Defta/Variations
$0.00000 $0.00000 $ 0.00000

SCHEDULE OF SUPPORTING
TAIl
DETAILS VALUES INVOICES DOCUMENTS

Actions ¥ ® ¢ ®

Convert to accrual/receipt Schedule items ¢ | Previous certification < | Vendor submission

Schedule = Description ert to Payment Form Schedule = UoM = Unitprice = Schedule —=| Quantity = Value =| Quantity =
tem 1D quantity value

1 Steel materials 1 5.000 Ea $0.0000 $ 0.00000 0.000 $0.00000 0.000

2. Select Convert to vendor change order. The Associate schedule item dialog box opens.
Indicate whether to associate the schedule item to a new or existing schedule item.
4. Complete the vendor change order information.
e When converting to an existing vendor change order, enter the vendor change order ID.

¢ When converting to a new vendor change order, enter the vendor change order details,
vendor change order number, description and vendor change order type are required.

5. Click Save.

CONVERT A CERTIFIED PAYMENT CLAIM TO A CONTRACT
CLAIM

VIDEO | Converting Payment Claims to Contract Claims

Summary: You can convert a certified payment claim to a contract claim from the payment claim
schedule of values page to take advantage of a single entry of values.
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Considerations: The payment claim must be certified. The schedule item's Hide in Plan and progress
check box must be selected. If the check box is not selected, the schedule items are not available for
contract claims.

1. From the payment claim schedule of values page, select one or more schedule items.

2. Click the Convert schedule of value icon, and then select Convert to contract claim. The Update
contract claim for below schedule of value items dialog box opens.

Update contract claim for below schedule of value items

Schedule quantity UoM Quantity claimed (to date) — Value claimed (to date) Claimed quantity Claimed value — Notes

e A 100000000 Barrel 10000000 $200.00000 10000000 $200.00000

e : A 2 200000000  Acre 20000000 §400.00000 20000000 $400.00000

The Posted date field defaults to the date the claim was certified. You can edit the date as
needed.

3. Optionally, click Add schedule item to add more schedule items to the claim. The Add schedule
items dialog box opens, where you can select and add schedule items to the contract claim.

4. Click the Claim button to claim the schedule items.

The columns in the Summary progress section of the contract schedule of values are updated with the
claim information.

PERCENT COMPLETE CLAIMING

The % Complete columns in the Vendor Submission and Certification section show the percentage of
the schedule item that has been claimed. The % Complete values are updated if any quantity or value
changes are made to the Schedule of values from the contract-level schedule of values or as part of a
vendor change order.

You can also manually enter % Complete column values. The Period Quantity and Value are used as the
source of truth if changes occur.
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When a change is made to the Vendor submission Quantity or Value columns, Contract recalculates
the Vendor submission % Complete value as

( (Vendor submission value + Scheduled value) + (Previous certification value + Scheduled value) ) x
100

When a change is made to the Certified Quantity or Value columns, Contract recalculates the Certified
% Complete as

(Previous certification value + Certification value) + Scheduled value) x 100

When a Schedule of value item is on multiple pending claims, a pending uncertified claim warning
shows in the Schedule ID column. The icon shows so that you can be aware that totals for the schedule
of values item will change.

Requested value Certified value Delta/Variations Certified on Certified by Payment claim status Approval status

$0.00 $0.00 $0.00

7.0.4.23 CERTIFICATION

When you and the vendor have agreed on a payment amount, you can certify the payment claim. You
must certify a claim before you can convert a schedule item to a payment form. After the payment is
certified, you might have a certain number of days to make the payment, depending on your business
practices and local laws.

APPROVAL WORKFLOW

If workflow is configured for the payment claim, the claim must be approved before it can be certified.
To start the approval workflow, click Save and start approval on the payment claim Details page.

CERTIFY A PAYMENT CLAIM

To certify a payment claim, select Certified from the Payment claim status drop-down menu in the
Payment claims header. The Certification Actual date is updated on the Details page and on the
Payment claims register.
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Requested value Cenified vahue Delta/Variations. Certified on Certified by Payment claim status Approval status

$0.00000 $0.00000 $0.00000

ppiscale

® ¥ ® H Soewmmes [ [y [ F ® q

After the payment claim is certified, the claim becomes locked, and you can edit only the Comments
field on the Details page.

7.0.4.24 CONVERT TO A PAYMENT FORM

After the claim is certified, you can convert the payment claim to a payment form, so you can start
your internal payment process. The conversion lets you base the payment form on the schedule of
values instead of a line item. A payment claim can be associated with only one payment form, and a
payment form can be associated with only one payment claim.

CONVERT TO A PAYMENT FORM

Summary: After a payment claim is certified, you can convert the schedule items to a payment form.
Converting from the schedule of values lets you create a payment form that reflects the work you and
the vendor have agreed upon rather than a line item.

Considerations: The payment claim must be certified. All schedule of value items are used in the
payment form regardless of what is selected. If workflow is configured for approving payment forms,
the payment form must go through workflow.

Quick steps:

1. From the payment claim Schedule of values page, select a schedule item, and then click the
Convert schedule of value icon.

2. Select Convert to Payment Form. The Convert to Payment Form dialog box opens.
3. Enter the payment form details, and then click Next.

4. Optionally, select the applicable invoices to convert to the payment form, and then click Next. By
default, all invoices are selected.

5. Optionally, select any of the supporting documents listed to convert to the payment form, and
then click Convert. The schedule of values is converted to a payment form. The certification
values are now included in the Current total in the schedule of values register.
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7.0.5 PAYMENT PROGRESS

Payment progress shows you the actual invoice payments once they are processed in your ERP system
or by your Accounts Payable department. As they are processed, ERP software syncs the information
back to InEight Contract, populating it in the Payment progress tab on your contract record for your
review. In a proxy ERP environment, you can update the Payment progress tab manually if the edit
progress payment permission is assigned to your role.

Confracts > 7400001418 - PB - Structural Steel

VENDOR CHANGE 1
Actions h HEADER LINE ITEMS ORDER LOG BACK CHARGES PAYMENT FORMS PAYMENT PROGRESS

Vendor invoice number Invoice amount Invoice date Paid amount Method Check number/ACH

Overview - Payment Progress Register

1 Invoice Shows the invoice information, including, the invoice total specified by
information the vendor, the invoice tax amount from the ERP system or the proxy
ERP, the date of the invoice from the vendor, and the number of days
the invoice has been opened before payment.

2 Paymentform  The payment form ID associated with the payment.
ID
3 Record ID The record ID associated with the payment.
4 Record status  The status of the record associated with the payment
5 Posting date The date the payment was posted.
6 Paid amount The amount of the invoice paid by Accounts Payable. If you have a

proxy ERP, you can update this field manually.

7 Method What method was used for invoice payment. If you have a proxy ERP,
you can update this field manually.

8 Check The check or ACH number used for payment. If you have a proxy
number/ACH ERP, you can update this field manually.

9 Date cashed The date the check or payment was cashed. If you have a proxy ERP,
you can update this field manually.

10 Withheld The amount the invoice was withheld for retainage.
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Overview - Payment Progress Register (continued)

11 Retention How much of retention was released. If you have a proxy ERP, you
released can update this field manually.

12 Progress The estimate number from InEight Progress
estimate
number

13 Billing period The billing period associated with the payment.

14 Document The year the payment took place. If you have a proxy ERP, the
year document year is based on the Estimated posting date in the
Payment form Invoices Attachment register and is not updated when
you update the value in the Posting Date column. You can manually
update the document year as needed.

15 Export Lets you download a version of the Payment progress grid in a
Microsoft Excel spreadsheet.

16 Notes Lets you view and add notes about the payment. The Notes panel has
tabs for contract notes, supporting document notes, and
administrative notes. The Administrative notes tab is updated when
there is a change to the payment form or the payment progress made
by an administrator with Edit payment progress permission.

17 Totals The total amounts of the Invoice totals, Paid amounts, Invoice net
amount, and Invoice tax amount columns.

If you have the permission EditPaymentProgress, you can edit the following fields from the Payment
progress register to keep Contract in sync with an ERP system:

e Record ID

e Record status
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Paid amount
Method

Check nhumber/ACH
Date cashed

Retention released

Changes made on the Payment progress tab affect the payment progress tab only. They do not affect
the Payment forms tab.

7.0.5.25 PAY WHEN PAID

In some cases, the invoices may be posted, but the check or ACH does not go to the vendor right away
because the payment terms may say “pay when paid”. This means even though the invoice is
processed, the money is not sent to the vendor until the project is paid from the client/owner.

Additionally, one payment may reflect several invoices; this tab is a way to tie those together.
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CHAPTER 8 — CONTRACT
CLOSEOUT

When a contract is deemed complete and all the work has been verified by onsite, or when all material
has been delivered and accounted for, you can close out your contract.
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8.0.1 INEIGHT CONTRACT WORKFLOW - CONTRACT
CLOSEOUT

WBS Structure
E
‘

Contracts

Bid Packages

Create Bid
Package

[\ ELErS

Contract Setup Add
(Documents, Documents Contract Execute

Details & Line S Approval Approval Contract
Documents
Items)

Create
PO

0ods ‘
eipts &
Accruals

|
v

RllESronEs RefEe Create Payment Form Contract

Payment Form Approval Closeout

Contract
Award

VCO Approval

Submit invoices

Manage Scopes of Work
Schedule Procurement

o5 Receive payment progress, goods receipts
%28

- Estimate Update PO

Control

Change Register

Budget/Contract
Adjustments

8.0.2 CONTRACT CLOSEOUT OVERVIEW

To make sure all items have been verified and closed out, you follow a closeout process located on the
Contract Closeout tab of your contract.

PB - Struct_
TECHNICAL FIELD SUPPORTING WORKFLOW ’
1ENT PROGRESS ASSISTANCE DOCUMENTS ASSIGNMENTS SYNCLoG
Refresh checklist = (o

From the Contract Closeout tab, you assign people to approve and verify that all the requirements of
the contract are fufilled.

8.0.3 CONTRACT CLOSEOUT PROJECT SETTINGS

Before you can initiate contract closeout, the setup of contract closeout needs to be completed in
Project settings. This setup consists of selecting what closeout sections you want to include in the
closeout process, and what questions you want in each closeout section. These will be the questions
the person doing the closeout will need to answer to consider each section of closeout complete. This
setup will typically be done by a project administrator.
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The following steps walk you, as a project administrator, through setting up your contract closeout

settings.

SET UP CONTRACT CLOSEOUT SETTINGS

1. From the Project home page of the Steel Structure Training Job, click on the 15t level drop-down

menu and select Settings.

105091 (Steel Training Job) - Settings

| Favorite projects & organizations Appiications

5100000 - PKS Incs >
] ™ =
105091 (Steel Training Job) » Model Suite o &) Plan B) Contract
| Document .*J Contral %) Progress ! Change
|
4) Inspect
|
Project
i Manage faverites
All projects & organizations Project home Assigned users
() Report > Project details Operational rate codes
(&) Explore > Assigned operational resources
Master data libraries > Workflows Assigned disciplines and commodities

Suite administration >

2. Select the Contract tab on the left.

@ 105091 (Steel Training Job)

@ General
@ Control
)

Q; Plan
@ Progress
@ Inspect

o
| L\@/ Contract

P
[£] Change

@ Design

3. Click on the Contracts sub-tab.
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21 105091 (Steel Training Job) - Settings
WORKFLOW
-~ BID PACKAGES CONTRACTS | . n
:<_>) General —_— ASSIGHVENTS

:; ] Control
= Use bid packages?

\{j Plan |
\“f’,] Progress
Inspect .
Milestones

|[B) Contract

o These bid package milestones will be available for projects in this organization.
£] Change

’{ﬁ Design English Spanish

4. Select the Contract closeout tab under Contracts.

» Under the Contract closeout section, you have the following default sections
included on your project:

- - WORKFLOW
BID PACKAGES CONTRACTS ASSICNMENTS
Contract configurations  Line item account settings  Oelivery address  Project ERP attributes | Contract closeout

Engineering closeout Cierre de ingenieria Questions ®
- o
Field clogeout Cierre de campe Questions ®
. =
Commissioning closeout Cierre de puesta en marcha Questions ®
. . P
Commercial closeout Cierre comercial I CQuestions ®
3 N )
Business management closeout Cierre de gestidn comercial Questions *)
)
Retainage release closeout Cierre de liberacion de retencian Questions (*

* You can remove any of these sections if they are not needed in your closeout
process by clicking on the minus sign

» Each section has a Questions link you can click on to decide what questions to
include in that section

5. Click on the Questions link for Engineering closeout.

Engineering closeout Cierre de ingenieria Questions '\ e

~

» A slide out panel appears with two sections:

» Available questions - Contains a list of questions you can select from to include in
your selected closeout section

» Assigned questions - Displays the closeout questions you have selected for the
section (This is blank because you haven’t selected any yet.)
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JUESTION T
Ques
nued Afallablequestmns
Fe
Ques @ Reviewed specifications
Seller/Subcontractor has complied with requirements described in the
Ques @
Specifications
Ques @ All engineenng submittals received and approved (APP)
@ Vendor Data/0&M manuals approved (APP) by (Contractor & Owner) ~

Assigned guestions

Oues
Ques
(yes

6. Click the Add button next to each question you want to add.
* You can add as many as necessary as per the project’s requirements

» The questions show up under the Assigned questions section below
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ae Avaliable questions

™ .
G—/.' Reviewed specifications

[ Al ¢ o, I Bt g g i

= } .
r\'b' Vendor Data/0&M manuals approved (APP) by (Contractor & Owner) -
g
u Assigned questions
x Seller/Subcontractor has -.'J"";.'II ed with requerements descr bed in the '.-;:t‘?:fl-: atians
i X All engineenng submittals received and approved (APP) -

TIP The questions you select from in Project settings are created in the Organizational

settings by your company’s designated administrative group. Your company should
have a procedure for requesting the addition of new questions for you to use on
your projects.

7. Click Save.
8. Follow these same steps to select questions for your other closeout sections.

» Once you have your questions set, they will populate for all new contracts

8.0.4 CONTRACT CLOSEOUT PROCESS

When your contract is closed, you can initiate the closeout process by reviewing and answering the
closeout sections you are responsible for. Once completed, you can Save and mark as complete. If your
company has an overall contract closeout process set up in your Project settings, you will Save and
send closeout request, and the person assigned to the closeout sectionwill be notified via email. Upon
completion the contract manager receives a notification email stating that the closeout section is
complete.

The following Step by Step walks you through the contract closeout process. Note that this Step by
Step assumes that setup of your contract closeout sections and questions has already occurred.
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CONTRACT CLOSEOUT PROCESS

1. From the Contracts page of InEight Contract, select the Structural Steel contract used in
previous Step by Steps.

2. Select the Contract Closeout tab.

e You may need to click the side arrow to locate the tab

TECHNICAL FIELD SUPPORTING WORKFLOW
- VNG LOG
REss ASSISTANCE DOCUMENTS ASSIGNMENTS SYNCLOG
avnnt |

3. On the Contract Closeout tab, click the Refresh checklist button. This will pull the information
from Project settings and refresh your Contract Closeout tab. You can refresh a checklist in a
contract if any questions have been updated in the project settings. Only checklists that have not
been started, are not completed, or are not recalled are refreshed.

WORKFLOW SYNC LOG CONTRACT CLOSEOQUT
ASSIGNMENTS o . ?

== = -

» Your closeout sections display in boxes as either Not Started or Not Applicable,
depending on what you set up in your project workflow

Contract closeout checklists (6)

Engineering closeout Field closeout Commissioning closeout Commercial closeout Business management close..
/, NOT STARTED i, NOT STARTED Ay NOT STARTED /i NOT APPLICABLE /4 NOT APPLICABLE

Retainage release closeout
iy NOT STARTED

4. Select the Engineering section by clicking on the Engineering closeout box.
» The Engineering closeout page appears

5. Answer the closeout questions for the Engineering closeout section, by selecting the appropriate
answers from the drop-down lists.

* You can add notes to further explain and clarify your responses

InEight Inc. | Release 25.3 Page 367 of 377



Contract User Guide

Engineering closeout questions

eerng submittals recerved and approved (APF)

» On the left hand side of the page, you have the Scheduled Closeout Date and
Forecasted Closeout Date

Engineering closeout

/\ NOT STARTED

MNumber of questions: 3

Number of questions answered: 0
Completed date: N/A

Completed by: M/A

Scheduled closeout date:

08/23/2018 [

Forecasted closeout date:

[ "
os/24/2018 [

6. Select the appropriate Scheduled and Forecasted closeout dates.

 This function will push to InEight Report where you can run reports to see what is
closed out and what is remaining

7. Repeat these steps for the other closeout sections.
8. After you have filled in the sections, click Save and send closeout request.

¢ If you feel that something may not be complete yet, you can click Save to revisit later

| -ance | =ave and send closeout request m
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e The first approver that is assigned in the workflow will then receive an email from
InEight.Mail@ineight.com to review the closeout section and either mark it as complete or
recall the closeout section

Please review and complete the Engineering closeout checklist for 7200000846 - Test Contract Close out with
Merrill Iron & Steel Inc started by Devon Stephenson for project 105091-Steel Structure Job (Use for samples).
Scheduled closeout date: 8/23/2018

Forecasted closeout date: 8/24/2018

To view this closeout checklist, click here.

9. If you are the approver, review the closeout section that was submitted.

10. If you are ok with marking this complete, do so by selecting Save and mark complete.

‘ Save and recs: seout request | Save and mark as complete m

* You can always see the status when you click the contract totals button

Engineering closeout Engineering closeout Engineering closeout

- STARTED X) RECALLED v) COMPLETE

Yumber of guestions: 3
of quesbons ancwered: 3
date: 08/22/2018

ST e Compléted by: Devon Staphenso

TR E

» Once all your applicable closeout boxes on the Contract Closeout tab are marked as
complete, your contract is closed

» When your closeout section is marked as complete they will display the following:

Contract closeout checklists (6)

Engineering closeout Field closeout Commissioning closeout Commercial closeout Busin
) COMPLETE () COMPLETE ) COMPLETE /4 NOT APPLICABLE i NC

Retainage release closeout
&) COMPLETE
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¢ A notification email message is sent to the contract creator when the checklist is complete.
English is the only language supported for any localization settings in email.

8.1 CONTRACT FREQUENTLY ASKED
QUESTIONS

Can the contract commitment amount and change orders automatically flow to the project
budget?

Yes, InEight Control can be configured to automatically receive contract commitment and change
order values.

To have contract commitment amounts update the Control budget automatically from Contract,
the Drive committed cost values from Contract setting must be turned on under Project Settings >
Control > Project Tracking > Actuals:

Drive committed cost values from Contract @ @

For change orders, if both InEight Change and InEight Control are active, executed change orders
from Change will update the Changes Register of InEight Control automatically, where they can go
through a final review and be accepted into the budget.

Can contract deliverables be broken down into scheduled quantities for detailed on site con-
firmation and contractor claiming?

Yes. Contract line items can be broken down into detailed Schedule of Value (SOV) items.
See the following for more information:

Schedule of Values Tab

Can InEight Contract be used to manage Purchase Orders?

Yes, when a contract is set up with costs for deliverables, documentation, and all related
information, it can then be created as a Purchase Order.

See also:

PO Creation
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How do | Reverse a VCO in contract ?

If the VCO is executed and published, then there is no way to reopen it. If the published VCO has
no details, however, you could create a new VCO with the appropriate details.

How do | adjust my line item quantity to zero when | no longer need the line item?

Line items must have a positive quantity and cannot be 0. You can instead reduce the unit price to
0, which will remove the value of the line item from the contract. You can also delete a line item
which is no longer needed if it has not had any goods receipts or invoices posted against it.

When setting up notifications under Contract organization-level settings, is there a way to have
these notifications default into project-level settings for new projects?

Under Organization Settings > Contract > Contracts > Notifications, you can set up Supporting
documents expiration settings. Once configured, any role or user specified to receive notifications
will receive notifications for each product they are assigned to by default.

Any notifications set up at the project level will be considered in addition to the organization-level
settings and will be for that project only.

Supporting documents expiration

©

*Roles
*Assign roles or users to receive notifications
% Project Manager
Roles v

*Frequency of sending reminder (in days)
7 a
*Days to be notified before document expiration

5 a

Can Contract claiming be done in bulk?

Yes. From the Schedule of Values tab of a contract, you can select Export > With data from the
right toolbar to export your schedule of values to an Excel spreadsheet. Once exported, you can
open the spreadsheet and use columns K, L, and M to claim quantities.
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il

Supporting documents expiration

*

Contract User Guide

After adding values and saving the spreadsheet, you can select Import on the Schedule of Values

tab to import the updated values. On the Import data from template window, you can select the

claim option to use for updating values.

Can you apply multiple taxes to a contact?

| J K L M
Hide in Plan
and Quantity Value Posting
WBS code Progress claimed claimed date
Alphanumeric Select one Numeric Numeric MM,/DD/YYYY
0 1071 - Concrete Yes 100.00000 0.00000
0 1071 - Concrete Yes 200.00000 0.00000
0 1086 - Concrete - Materi Yes 0.00000 0.00000
0 1086 - Concrete - Materi Yes 0.00000 0.00000
0 1071 - Concrete Yes 400.00000 0.00000
0 1071 - Concrete Yes 350.00000 0.00000
0 1086 - Concrete - Materi: Yes 42.00000 0.00000
0 1086 - Concrete - Materi: Yes 0.00000 0.00000

Under Organization Settings, you can set up one to many taxes. Taxes will automatically flow

down to projects based on the Country code of the tax in Settings matching the Country code in

the Project details page. Those taxes are then applied to each line item in the contract when the

Is taxable setting is set to True. When the organization is not integrated with an ERP, the taxes

from the project tax settings will be applied to all line items when Is taxable is set to True. When

the organization is integrated with an ERP, the taxes from the ERP will be applied to the line items

based on the purchase order response.
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When using the integration between Contract and Control, can you control the posting date of
actuals in Control?

Yes. On the Payment Form tab of a contract, when creating or editing a payment form, the
Estimated posting date under Invoice Attachments is used as the posting date in Control when
there is not an ERP integration. When there is an ERP integration, the posting date sent from the
ERP will be used.

Can supporting documents be linked from document management?

Yes, when the InEight Document module is set up to integrate, supporting documents can be
added from InEight Document to InEight Contract.

See also:

Document Issue Correspondence

8.2 INEIGHT CONTRACT WORKFLOWS

8.2.1 INEIGHT CONTRACT - FOCUSED
WORKFLOW

This workflow illustrates the main functions of InEight Contract’s two modules, Bid

Packages and Contracts, how they relate to each other, and how they integrate with other
applications (Estimate, Control, and ERP).

W8S Structure

Contracts

Bid Packages

Contract Setup Add

g Contract E It
Create Bid (Details & Line Supporting D:C“'r‘;iglts As;r;zl Cz:i:’a:t Create PO
Package Items) Documents e
Manage
Milestones Add vco

Contract
Award

Contract
Closeout

VCO Approval

Payment Management

[ELERS Certify
Payment Payment
Claim Claim

Add Payment
Claim

Submit
invoices

Create
Payment Form

Payment Form
Approval

Control

Change Register

Submit Review and
Invoice Receive Invoice
(Vendor) (Contractor)

Add
Supporting
Documents

Create Goods
Receipt &
Accrual

Budget/Contract
Adjustments

Update PO

INEIGHT CONTRACT PRODUCT WORKFLOW
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Bid Packages

Create Bid
Package

Manage
Milestones

Contract
Award

Manage Scopes of Work

Schedule Procurement

| +x

: *S

|

(- Estimate

Control

Change Register

Budget/Contract
Adjustments

Contracts

Contract

Closeout

Payment Management

Create Goods
Receipt &

o

Submit
invoices

Receive payment
progress, goods
receipts

Accrual

Update PO

8.2.2 BUSINESS PROCESS WORKFLOWS

8.2.2.1 CONTRACT AND PROCUREMENT MANAGEMENT: PRE-

AWARD

This workflow shows the business process for developing contracts before they become awarded, from
initial tender estimates, to bid packages, and finally to become draft contracts.
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8.2.2.2 CONTRACT AND PROCUREMENT MANAGEMENT: POST-
AWARD

This workflow shows the business process for managing contracts post-award, including management
of contract commitments, claiming, and payments.
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8.2.2.3 CONTRACT AND PROCUREMENT MANAGEMENT: POST-
AWARD VARIATIONS

This workflow walks through variations in how contracts can be managed post-award using the InEight
Suite.
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